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About This Document 

Purpose

This document provides instructions for working with the Cataloging module.

Intended Audience

This document is intended for Voyager customers who are responsible for 
customizing and implementing Voyager Cataloging.

Reason for Reissue

This user’s guide incorporates and is being reissued for the following reasons:

• Updated Figure 10-9 on page 10-12 that now displays the count of 
bibliographic records linked to an authority heading.
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Document Summary

This document consists of the following:

Chapter 1 “Getting Started”
Chapter 1 provides an overview of Cataloging, including logging 
into the application, printing screens, and exiting from the 
application.

Chapter 2 “Record Types and Creating”
Chapter 2 discusses the different types of records used by the 
Voyager system to contain your MARC records and procedures 
for editing the leader and other related MARC tags.

Chapter 3 “Creating, Opening, and Viewing Records”
Chapter 3 details the creation of new records, and opening and 
viewing existing records.

Chapter 4 “Changing, Saving, and Printing Information”
Chapter 4 details editing records, saving edited records and 
printing records, spine, and piece labels.

Chapter 5 “Cataloging & Bibliographic Record Linking”
Chapter 5 details the implementation and use of bibliographic 
record linking from within the Cataloging module for related 
records.

Chapter 6 “Diacritics and Non-Roman Characters”
Chapter 6 details the implementation and considerations of 
diacritics and non-Roman characters in a Unicode environment.

Chapter 7 “Pick and Scan (Cataloging/Circulation)”
Chapter 7 details the procedure for using the Pick and Scan 
feature.

Chapter 8 “Templates”
Chapter 8 details the procedure for using templates when 
working with new records.

Chapter 9 “Authority Control”
Chapter 9 details the methods of maintaining Authority Control.

Chapter 10 “Authority Load Reviewer”
Chapter 10 details the options provided with the Authority Load 
Reviewer.

Chapter 11 “Session Defaults and Menu Options”
Chapter 11 details Session Defaults and Preferences for 
application throughout the Cataloging module, and also gives a 
list of options available through the menus at the top of the 
Cataloging window.
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Appendix A “MARC Tag Tables”
Appendix A contains information on viewing, using and 
configuring the MARC tag tables used by the Cataloging client.

Appendix B “Voyager Call Number Logic / Processing”
Appendix B contains information on using different classification 
schemes with the Cataloging module.

Appendix C “Voyager with Unicode Considerations”
Appendix C contains information regarding considerations 
relative to the Voyager with UnicodeTM implementation.

Index The Index is an alphabetical, detailed cross-reference of topics 
about which this document contains information.

Conventions Used in This Document

The following conventions are used throughout this document:

• Names of commands, variables, stanzas, files, and paths (such as 
/dev/tmp), as well as selectors and typed user input, are displayed in 
constant width type. 

• Commands or other keyboard input that must be typed exactly as 
presented are displayed in constant width bold type.

• Commands or other keyboard input that must be supplied by the user are 
displayed in constant width bold italic type.

• System-generated responses such as error messages are displayed in 
constant width type.

• Variable portions of system-generated responses are displayed in 
constant width italic type.

• Keyboard commands (such as Ctrl and Enter) are displayed in bold.

• Required keyboard input such as “Enter vi” is displayed in constant 
width bold type.

• Place holders for variable portions of user-defined input such as ls -l 
filename are displayed in italicized constant width bold type.

• The names of menus or status display pages and required selections from 
menus or status display pages such as “From the Applications drop-down 
menu, select System-wide,” are displayed in bold type.

• Object names on a window’s interface, such as the Description field, the 
OK button, and the Metadata tab, are displayed in bold type.
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• The titles of documents such as Curator Web Client User’s Guide are 
displayed in italic type.

• Caution, and important notices are displayed with a distinctive label such 
as the following:

NOTE:
Extra information pertinent to the topic.

! IMPORTANT:
Information you should consider before making a decision or configuration.

! CAUTION:
Information you must consider before making a decision, due to potential 
loss of data or system malfunction involved.

TIP:
Helpful hints you might want to consider before making a decision.

RECOMMENDED:
Preferred course of action.

OPTIONAL:
Indicates course of action which is not required, but may be taken to suit your 
library’s preferences or requirements.

Document Reproduction/Photocopying

Photocopying the documentation is allowed under your contract with Ex Libris 
(USA) Inc. It is stated below:

All documentation is subject to U.S. copyright protection.  CUSTOMER 
may copy the printed documentation only in reasonable quantities to aid 
the employees in their use of the SOFTWARE.  Limited portions of 
documentation, relating only to the public access catalog, may be copied 
for use in patron instruction.
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Comment on This Document

To provide feedback regarding this document, use the Ex Libris eService or send 
your comments in an e-mail message to docmanager@exlibrisgroup.com. 
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Getting Started

Introduction

This chapter describes the prerequisite installation and configuration informatin 
necessary for beginning work in the Cataloging module and information related to 
logging in.

For information on how the settings in the System Administration module affect 
the Cataloging module, see the Voyager System Administration User’s Guide.

Prerequisite Skills and Knowledge

To use this document effectively, you need knowledge of the following:

• Basic Microsoft® Interface navigation

• Basic UNIX® commands and navigation

• Basic Voyager® System Administration Module

• Basic WebVoyáge® configuration

• Intermediate knowledge of MARC record formats (for creating customized 
WebVoyage display directories)
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Before You Begin

Working with the Voyager Cataloging software is enhanced by the availability of 
documentation, online help, and the use of common conventions. This section 
describes the purpose of these resources in order for you to effectively use them.

Documentation and Online Help

The documentation and online help are designed to work together to provide you 
with the information you need when you need it. You can access online help by 
pressing the F1 function key (F1) on your keyboard. 

The user’s guides are designed to cover the applications in greater detail to 
include screen shots, advanced topics, and cross references to other user’s 
guides and topics.

Conventions

Most conventions used in the Voyager documentation are Windows standard 
conventions. For more information about these conventions, please refer to your 
Windows documentation. 

Commands

Voyager functions and activities are accessed primarily through the menu and 
sub-menu options. To designate which menus and sub-menus are being referred 
to in the user’s guides and online help, we have adopted a convention of 
specifying the menu, sub-menu, and function or activity. For example, referring to 
the Exit activity on the File menu is specified as File>Exit. 

Ellipsis Button

The Ellipsis button (see Figure 1-1) indicates that additional information is 
available either in a dialog box or in an expanded textbox. Click the ellipsis button 
to access this additional function or information. 

Figure 1-1. Ellipsis Button
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Keyboard Functions

Some functions listed on Voyager menus have corresponding keyboard 
equivalents. In addition, certain functions are assigned keyboard shortcuts. Both 
types of keyboard access are described below. Keyboard equivalents and 
shortcuts are indicated on the menus.

Keyboard equivalents allow you to perform activities without requiring you to use 
the mouse. Keyboard equivalents are indicated by an underlined letter in the 
name of a menu or function. To access a menu or function using keyboard 
equivalents, press the alternate key (Alt) followed by the underlined letter. For 
example, to exit a Voyager module, press and release the Alt key, followed by the 
f key (for the File menu), followed by the x key (for Exit). 

A number of functions are also assigned keyboard shortcuts. Keyboard shortcuts 
allow you to press and hold the control key (Ctrl) and then press the designated 
letter. For example, when the Save command is available you can press and hold 
the Ctrl key followed by the s key (for Save).

Following Windows conventions, the tab key (Tab) can be used to move the 
cursor to fields and buttons within dialog boxes and windows. Press and hold the 
Shift key and then press the Tab key to move the cursor in the opposite direction 
through the dialog box. 

The F4 function key (or F8 in some instances) can be used to display drop-down 
arrow selections. These keys can also be used to display fields represented by 
ellipsis button. In addition, items listed in drop-down menus can be scrolled 
through by typing the first letter of the item that you want to display. To scroll 
through additional items that begin with the same letter, type that letter again.

You can use the arrow keys on your keyboard to move through lists of options. 
The up and down arrows can also be used to select radio buttons. The escape 
key (ESC) can be used to close certain dialog boxes. The space bar can be used 
to highlight selections in list boxes. Once a selection has been highlighted in a list 
box, you can press the Enter key to select it. 

Logging into Cataloging 

Before you can begin working in Voyager’s Cataloging module, you must log in 
with your operator ID and password. Your operator ID and password determine 
what Cataloging operations you can perform as well as at which Cataloging 
locations you can perform them. Your system administrator defines this security 
information in the Voyager System Administration module. See the Voyager 
System Administration User’s Guide for details.
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The procedure for logging into cataloging is described in Procedure 1-1, Logging 
into Cataloging.

Procedure  1-1.  Logging into Cataloging

Use the following to access Voyager Cataloging.

1. Open the Cataloging module on your PC. 

Result: The Login dialog box opens (see Figure 1-2).

Figure 1-2. The Voyager Cataloging login dialog box

2. Enter your Operator Id, Password, and click OK or Exit. 

Result: The main Cataloging window displays if you successfully entered your 
Operator Id and Password. Using Exit closes the log in dialog box without 
logging you into the Cataloging module.

NOTE:
Voyager allows you to make up to three unsuccessful attempts to log in before 
terminating the program.

3. (Optional) For systems with more than one happening location defined in Voyager 
System Administration, a Select a cataloging location dialog box displays from 
which you need to select an appropriate Cataloging location (see Figure 1-3); and 
click OK.

Result: The main Cataloging window displays.
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Figure 1-3. Select a cataloging location dialog box

Exiting Cataloging

You can exit Cataloging by selecting File>Exit. If you have open records that 
have been edited but not saved, you are asked to save the records or ignore the 
changes.   

Login Information

From the Cataloging client, you can access the following login information by 
clicking File > Login Information:

• Operator name

• Operator ID

• Location

• Encryption (enabled/disabled)

• Server (as defined in the Server= parameter in the voyager.ini file)

• Database
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Figure 1-4. Login Information Displayed
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Introduction

Voyager’s Cataloging module provides a powerful and user-friendly means by 
which MARC 21-based records are created and maintained. You can create 
authority, bibliographic, holdings, and item records using the convenient and 
straightforward record displays. Integration between Cataloging and the Online 
Public Access Catalog (OPAC) means that you can easily build and maintain a 
complete, MARC 21-based catalog.

Types of Records

Voyager uses MARC 21 standard authority, bibliographic, and holdings records 
and a Voyager-defined item record. See Table 2-1 on page 2-1. 

The bibliographic record is the key component in the relationship of these different 
types of records. See Figure 2-1. 

Table 2-1. Description of Record Types

Authority Bibliographic Holdings 
(MFHD)

Item

Format MARC 21 MARC 21 MARC 21 Voyager

Linked to Bibliographic Bibliographic Holdings
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Authority records are optional and link to bibliographic records as either type of 
record is saved. 

A Holdings record is also known as a MFHD, MARC Format for Holdings Data. 

Item records are used for circulating library material.  

Record Relationships

Holdings records are linked to bibliographic records to represent each copy that 
your library has. Item records are linked to holdings records for each volume and/
or circulating piece of a copy. See Figure 2-1. 

Figure 2-1. Voyager record relationships

Source Original or 
Utility

Original or 
Utility

Original Original 

Table 2-1. Description of Record Types

Authority Bibliographic Holdings 
(MFHD)

Item
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Fields

Voyager uses the 852 field for the location and call number. 

• Subfield b records the item’s location using location codes defined in 
System Administration. 

• Subfields h and i have the call number. 

! IMPORTANT:
These are the only indexed fields in the holdings record.

The 866 field is often used to display a library’s summary holding information for 
serials and multi-volume sets. This displays in the OPAC to inform library patrons 
of what you own.

Voyager item records include information about an item’s permanent and 
temporary location and an item’s type and temporary type. This information along 
with the barcode stored in the item record is used by the Circulation module for 
circulation transactions. The copy number, enumeration, and chronology fields in 
an item record are used to augment the OPAC display when the item is charged 
out or has another informational status.

Bibliographic Records

Bibliographic records contain all the bibliographic information for a library item. 

The bibliographic record displays with the following three tabs.

• MARC tab

• System tab

• History tab

For information about creating a bibliographic record, see Creating Records on 
page 3-1. 

Only the MARC and System tabs display when you initially create a bibliographic 
record. Subsequently, the History tab displays when an action is taken against 
the record such as saving it to the database.
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MARC Tab

The MARC tab of the bibliographic record (see Figure 2-2) contains the Suppress 
from OPAC option, a Leader, a 005 fixed field, a 008 fixed field, and variable 
fields. It can also contain multiple 006 and 007 fields. All values correspond to the 
published MARC standard. 

Figure 2-2. Bibliographic Record - MARC Tab

Suppress from OPAC Option

To prevent a bibliographic record from displaying in the OPAC module, mark the 
check box labeled Suppress from OPAC (or press Alt + P). This also prevents 
any information about attached holdings and item records from displaying in the 
OPAC. However, if the Suppress from OPAC check box for a location is checked 
in the System Administration module, you cannot uncheck the Suppress from 
OPAC check box in Cataloging. See the Voyager System Administration User’s 
Guide for details.

Parentheses surrounding the ID number for bibliographic and holdings records 
are used throughout the Voyager application to indicate that a record is 
suppressed. The book icon in the record title bar also changes color as an 
indication that a record is suppressed. See the figures below for examples.
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Figure 2-3. Suppressed bibliographic record

Figure 2-4. Suppressed holdings and bibliographic records

Figure 2-5. Hierarchy view with suppressed bibliographic and holdings records
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Figure 2-6. Display of suppressed bibliographic record in the Acquisitions client

Bibliographic Leader

The Bibliographic Leader information allows you to select the Bibliographic 
Record Status, Type of Record, Bibliographic Level, Type of Control, Encoding 
Level, and Cataloging Form.

The Bibliographic Leader displays as a grid which is completely configurable 
using Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details 
on the MARC tag tables.

The procedure for viewing the Bibliographic Leader is shown in Procedure 2-1, 
Viewing/editing the Bibliographic Leader, on page 2-6.

Procedure  2-1.  Viewing/editing the Bibliographic Leader

Use the following to select the Bibliographic Leader information from a 
bibliographic record.

1. Click the Leader button. See Figure 2-7. 



 Ex Libris Confidential 2-7

Chapter 2: Record Types and Creating

Figure 2-7. Bibliographic Leader Button

Result: The Leader dialog box opens as a grid. See Figure 2-8.

Figure 2-8. Leader dialog box

2. Select values from the grid by clicking a particular cell and the down arrow to display 
drop-down menu selections.

Result: Leader options display for you to select.

NOTE:
Use either the mouse or the up/down arrow keys on your keyboard to move from 
cell to cell within the grid or from option to option in the drop-down lists. The Tab 
key is not available for use within the grid. Using the Tab key takes you outside 
the grid altogether.
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NOTE:
When the type of record is changed in the Leader, the existing values in the 008 
field that are common to all record types are retained.

TIP:
You can also enter the letter or number that precedes an option in a drop-
down list to make a selection. For instance, if you want to jump from 
subfield z within the drop-down list to subfield a, simply press the letter a.

3. Click OK or Cancel.

Result: This saves your work and exits the Leader dialog box or exits the dialog 
box without saving.  

Bibliographic 005 Fixed Field

The 005 field is a system-applied field containing 16 characters that specify the 
date and time of the latest record transaction. These characters are recorded in 
the pattern YYYYMMDDHHMMSS.F that represents year, month, day, hour, 
minute, second, and decimal fraction of a second.

Bibliographic 006 Fixed Field

The 006 field is a repeatable field that allows you to add other bibliographic 
formats.

The 006 field displays as a tabbed dialog box which is completely configurable 
using Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details 
on the MARC tag tables.

The procedure for editing the 006 field on the MARC tab is shown in Procedure 2-
2, Editing the 006 Field, on page 2-8.

Procedure  2-2.  Editing the 006 Field

Use the following to edit the 006 field on the MARC tab of an open bibliographic 
record.

1. Click the 006 button (see Figure 2-9) on the MARC tab of an open bibliographic 
record.
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Figure 2-9. 006 Button

Result: The 006 field displays a tabbed dialog box (see Figure 2-10) from which 
you can select a bibliographic format type. 

.

Figure 2-10. 006 dialog box

2. Select a tab representing the bibliographic format type you want to enter. 

Result: A blank workspace displays with the New button active.

TIP:
You can use the mouse or keyboard shortcuts to access tabs. To use the 
keyboard shortcut, hold the Alt key; and type the letter that is underlined in 
the tab name such as Alt+b to access the Books tab. See MARC Tag 
Tables on page A-1 for details on how to define your own keyboard access 
keys.

3. Click the New button. 
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Result: A grid displays with various options. See Figure 2-11. 

4. Select options from the grid by clicking a particular cell, and the down arrow to 
display drop-down menu selections.

NOTE:
Use either the mouse or the up/down arrow keys on your keyboard to move from 
cell to cell within the grid or from option to option in the drop-down lists. The Tab 
key is not available for use within the grid. Using the Tab key takes you outside 
the grid altogether.

TIP:
You can also enter the letter or number that precedes an option in a drop-
down list to make a selection. For instance, if you want to jump from 
subfield z within the drop-down list to subfield a, simply press the letter a.

5. Click Apply. 

Result: This stores the options you selected and a check mark displays in the 
check box directly to the left of the tab name indicating that values have been 
selected for that tab. See Figure 2-11 which has values for the Books tab added 
and applied. 

Figure 2-11. Bibliographic 006: Grid displayed and values set 
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NOTE:
The Delete button becomes active allowing you to delete what you have applied.

6. Click Close. 

Result: You exit the 006 linking field dialog box. 

Bibliographic 007 Fixed Field

The 007 field is a repeatable field that allows you to add other material categories. 

The Bibliographic 007 field displays as a grid which is completely configurable 
using Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details 
on the MARC tag tables.

The procedure for editing the 007 field on the MARC tab is shown in Procedure 2-
3, Editing the 007 Field, on page 2-11.

Procedure  2-3.  Editing the 007 Field

Use the following to edit the 007 field on the MARC tab of an open bibliographic 
record.

1. Click the 007 button (see Figure 2-12) from the MARC tab of an open bibliographic 
record. 

Figure 2-12. 007 Button

Result: The 007 field displays a tabbed dialog box (see Figure 2-13) from which 
you can select a material category. 
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Figure 2-13. 007 - Physical Description dialog box

2. Select a tab representing the physical material you want to enter. 

Result: A blank workspace displays with the New button active.

TIP:
You can use a mouse or keyboard shortcuts to access tabs. To use the 
keyboard shortcut, hold the Alt key; and type the letter that is underlined in 
the tab name such as Alt+m to access the Map tab. See MARC Tag Tables 
on page A-1 for details on how to define your own keyboard access keys.

3. Click the New button. 

Result: A grid displays with various options. See Figure 2-14. 

4. Select options from the grid by clicking a particular cell, and the down arrow to 
display drop-down menu selections.

Result: You can enter the 007 field information to match your material.

NOTE:
Use either the mouse or the up/down arrow keys on your keyboard to move from 
cell to cell within the grid or from option to option in the drop-down lists. The Tab 



 Ex Libris Confidential 2-13

Chapter 2: Record Types and Creating

key is not available for use within the grid. Using the Tab key takes you outside 
the grid altogether.

TIP:
You can also enter the letter or number that precedes an option in a drop-
down list to make a selection. For instance, if you want to jump from 
subfield z within the drop-down list to subfield d, simply press the letter d.

5. Click Apply. 

Result: This stores the options you selected and a check mark displays in the 
check box directly to the left of the tab name indicating that values have been 
selected for that tab. See Figure 2-14 which has values for the Books tab added 
and applied. 

 

Figure 2-14. 007 - Physical description dialog box with grid displayed

NOTE:
The Delete button becomes active allowing you to delete what you have applied.

6. Click Close. 

Result: You exit the 007 linking field dialog box.  
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Bibliographic 008 Fixed Field

The 008 is a header in the main record used to describe the main format in the 
Leader. The 008 is required and non-repeatable. 

The Bibliographic 008 field displays as a grid which is completely configurable 
using Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details 
on the MARC tag tables.

The procedure for editing the 008 field on the MARC tab is shown in Procedure 2-
4, Editing the 008 Field, on page 2-14.

Procedure  2-4.  Editing the 008 Field

Use the following to edit the 008 field on the MARC tab of an open bibliographic 
record.

1. Click the 008 button (see Figure 2-15) from the MARC tab of an open bibliographic 
record. 

Figure 2-15. 008 Button

Result: The 008 field displays a grid-style dialog box (see Figure 2-16) with 
various drop-down menus and text boxes.
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Figure 2-16. 008 - General Description dialog box

2. Enter the required information in the 008 dialog box. 

These fields accept ASCII characters. See MARC Tag Tables on page A-1 for 
more information.

Use either the mouse or the up/down arrow keys on your keyboard to move from 
cell to cell within the grid or from option to option in the drop-down lists. The Tab 
key is not available for use within the grid. Using the Tab key takes you outside 
the grid altogether.

Result: The required information is identified for the 008 field.

NOTE:
The date information must be 4 characters long. The first character must be a digit 
greater than zero followed by another digit or the characters u, x, y, or a question 
mark (?). 

TIP:
You can also enter the letter or number that precedes an option in a drop-
down list to make a selection. For instance, if you want to jump from 
subfield t within the drop-down list to subfield b, simply press the letter b.
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3. Click OK or Cancel.

Result: This saves your work and exits the 008 dialog box or exits the dialog box 
without saving.  

Variable Fields (MARC Tab)

The variable fields grid allows you to add tags with first and second indicators and 
bibliographic data (subfields). The grid is made up of rows which store information 
about each tag. Each row is broken into segments for the tag, two indicators and 
the variable subfield text. When you create a bibliographic record, a grid template 
is supplied by the system and provides the required title statement (245 tag) row. 
See Figure 2-17.

Figure 2-17. Variable fields grid with 245 tag row

880 Fields and Unicode Implementation

Voyager supports the creation and editing of bibliographic 880 (Alternate Graphic 
Representations) fields in Cataloging.

For more information about the support of non-Roman characters and Unicode, 
see Chapter 6, Diacritics and Non-Roman Characters on page 6-1 and Appendix 
C, Voyager with Unicode Considerations on page C-1.



 Ex Libris Confidential 2-17

Chapter 2: Record Types and Creating

Adding and Editing Variable Fields (MARC Tab)

There are several features that are common to adding and editing variable fields. 
Right click the selection column (containing the row marker) of the grid on the 
MARC tab to display the following input and editing options. See Figure 2-18 and 
Figure 2-19.

• Cut this field

• Copy this field

• Paste before this field

• Move this field up by one (moves the focus row up by one row)

• Move this field down by one (moves the focus row down by one row)

• Delete this field

• Validate heading in the field

This menu dynamically changes for the conditions of each row. Only the active 
options display.

NOTE:
These menu options only apply to the row that you clicked. When more than one 
row is selected, use the menu bar options for cut, copy, or delete. 

Figure 2-18. Selection Column
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Figure 2-19. Editing options

The procedure for adding and editing variable fields is shown in Procedure 2-5, 
Adding and Editing Variable Fields, on page 2-18.

Procedure  2-5.  Adding and Editing Variable Fields

Use the following to add and edit variable fields.

1. Click Record>New>Bibliographic and select a bibliographic template. See the 
example in Figure 2-20.

Result: The MARC tab of a new bibliographic record displays with the leaders 
and variable fields grid.

2. Click the Subfield Data cell to enter the ‡a information for the 245 tag.

Result: The content for ‡a is entered.

NOTE:
When you enter non-Roman characters for a language that is read right to left, the 
system dynamically adjusts for each subfield affected to flow the text in the proper 
direction. The Left / Right arrows on the keyboard adapt for movement through 
the text that is read right to left.

! IMPORTANT:
Hebrew and/or Arabic language support needs to be installed in the 
operating system for them to display in the correct order.
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NOTE:
Backspacing to erase diacritic characters may require you to press the backspace 
key twice. Diacritic characters are usually stored in the system as two separate 
components, the alphabetic character first and then the diacritic character. See 
Diacritics and Non-Roman Characters on page 6-1 and Voyager with Unicode 
Considerations on page C-1 for more information.

3. Click Edit>Insert Field Before (F3) or Edit>Insert Field After (F4) to add a tag to 
the grid. 

Result: This inserts a field before or after the current row.

4. Click the Tag cell and enter a tag number or press F2 to select a valid tag from the 
Valid Values dialog box. 

Result: The tag displays in the cell.

5. Click the indicator cell and type the indicator number or press F2 to select a valid 
indicator from the Valid Values dialog box. 

Result: A number representing the indicator displays in the indicator cell.

Figure 2-20. Bibliographic template selection

6. Click the bibliographic data cell labeled Subfield Data and press F9.
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Result: This inserts a subfield delimiter in the Subfield Data cell. 

NOTE:
The subfield delimiter may be automatically entered depending on the settings in 
your Session Defaults and Preferences (General tab). See Chapter 11, General 
Tab on page 11-2.

7. Type the subfield or press F2 to select a valid subfield.

Result: A valid subfield is entered.

8. Enter the subfield data.

Result: The bibliographic data is entered.

9. Click Save to DB.

Result: This stores the bibliographic record in the Voyager database.

NOTE:
In a 010 field, the leading signification spaces are not trimmed. To accurately have 
three leading spaces in a 010 field, you need four spaces between the subfield 
marker and the first digit of the LCCN. The space immediately after the subfield is 
added and removed by the Voyager Cataloging client to be consistent in its 
display of data.

Deleting Variable Fields (MARC Tab)

Use the Delete key to delete a row of variable information or individual characters 
within a row.

Entire Row

The procedure for deleting a row of variable field information is shown in 
Procedure 2-6, Deleting Row of Variable Field Information, on page 2-20.

Procedure  2-6.  Deleting Row of Variable Field Information

Use the following to delete an entire row of variable field information.

1. Click the cell in the Selection Column (see Figure 2-18) next to the row you want to 
delete.
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Result: This identifies via highlighting the material to be deleted.

2. Press the Delete key (or click Edit>Delete Field or right-click and select Delete 
this field).

Result: The system displays a warning dialog box.

3. Click Yes or No.

Result: Selecting Yes deletes the highlighted material or selecting No cancels the 
delete request.

4. Click Save to DB.

Result: This updates the record in the database with the deletion.

Individual Characters

The procedure for deleting individual characters of variable field information is 
shown in Procedure 2-7, Deleting Characters of Variable Field Information, on 
page 2-21.

Procedure  2-7.  Deleting Characters of Variable Field Information

Use the following to delete one or more characters of variable field information.

1. Click next to the character you want to delete.

Result: The insertion point is positioned to the left of the character you want to 
delete.

2. Press the Delete key.

Result: This deletes one character at a time of variable information.

3. Click Save to DB.

Result: This updates the record in the database with the deletions.
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Variable Fields (MARC Tab) Affecting the 
WebVoyáge OPAC Display

Voyager’s WebVoyáge module allows your institution to define what displays from 
your bibliographic, holdings, and item records. Certain information can be added 
to your bibliographic or holdings records which can be displayed in a special 
manner in WebVoyáge. 

To specify that certain documents, images, World Wide Web pages, or other 
resources are available in the WebVoyáge OPAC when a specific record is 
selected, you must use a link-capable field in a bibliographic record according to 
the MARC 21 standard (refer to www.loc.gov/marc/). 

See Table 2-2 for a list of link-capable fields/subfields. 

Links - Overview

Voyager handles the following types of links. See Table 2-3.

• URI (Uniform Resource Identifier) 

• URL (Unifrom Resource Locator) 

• URN (Uniform Resource Name)

• DOI (Digital Object Identifier) 

• Images on a server

Table 2-2. Link-Capable Fields in Bibliographic Records

URI Link Text

505 ‡u ‡a

506 ‡u ‡a

514 ‡u ‡a

520 ‡u ‡a

530 ‡u ‡a

540 ‡u ‡a

545 ‡u ‡a

552 ‡u ‡z or ‡a

555 ‡u ‡a

563 ‡u ‡a

583 ‡u ‡z or ‡a

856 ‡u ‡y or ‡z
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• DOS  

To include a World Wide Web resource or any other linked resource in a 
bibliographic record, use a link-capable field/subfield combination. There are 
many options for storing linked resources in MARC records. Your requirements 
will determine the options that best meet the needs of your institution.

The following examples are provided to assist you in thinking about some of the 
options available.

Links - URL Examples

The following is an example that uses the 856 variable field and ‡u in a MARC 
record to specify URLs. 

856  _ _ ‡u http://www.akc.org

856  4 _ ‡u http://www.whitehouse.gov

The following is an example that uses the 856 variable field, indicator 7, ‡3, ‡2, 
and ‡u in combination. 

856  7 _ ‡3 Table of Contents ‡2 HTTP ‡u http://
lcweb.loc.gov/cardir/toc/

This example causes the following to display in WebVoyáge as a hypertext link. 

Table of Contents

Table 2-3. Link Type

Link Type Description

URI/URL/URN/DOI 
Links

URLs, URNs, and DOIs are subsets of URI

If you click a URL link, it launches the Web browser 
and displays the specified file. 

In order for DOI and URN links to be verified and pro-
cessed, the addresses of the DOI and URN handler 
servers must be entered in the DOI and URN fields 
on the Validation tab of the Session Defaults and 
Preferences window. See Validation Tab on 
page 11-6 for more information about DOI and URN 
856 link servers.

Links to Images on a 
Server

Use either Image Server or a Web browser as deter-
mined by the name specified on the Validation tab in 
Cataloging’s Session Defaults and Preferences.

DOS Links DOS network links are determined by the operating 
system specified in the MARC record 856 field.
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The ‡2 and string HTTP indicates that the link is an http-type link when thumbnails 
are generated in the OPAC. If this is used, the thumbnail image displays in the 
OPAC in the thumbnails column. The 856 field containing the thumbnail must be 
the first 856 field listed in the MARC record.

Links - Link Text Examples

The following is a MARC record example that combines the URL and link text. 
The link text that displays in the OPAC accesses the URL specified.  

856  4 _ ‡u http://www.akc.org ‡z The American Kennel 
Club Web page

856  4 _ ‡u http://www.whitehouse.gov ‡z the White 
House Web page

These examples cause the following to display in WebVoyáge as hypertext links.

The American Kennel Club Web page

The White House Web page

Links - Files on a Server Examples

If you want to link to files stored on a server, you can use ‡d, ‡f, and ‡o. ‡o may 
contain the literals UNIX or DOS® identifying the type of server to which the link 
points.

The following is an example of a MARC record that specifies a link to a file on a 
server.

856  _ _ ‡d c:\word\winword ‡f schedule.doc ‡o dos 
‡z 1995 Fall Class Schedule 

NOTE:
When a record displays with a link to a file on a server, a thumbnail displays in the 
Titles Index in WebVoyáge.

Links - Image Server Link Examples

If your library uses Image Server and you want to specify a link to images stored 
in the Image Server database, 7 is the first indicator in the 856 variable field as in 
the following example.

856  7_ ‡2 sdc ‡f 10, 10, 4 ‡z Link Text

When a record with an Image Server link displays in the Title Index in 
WebVoyáge, a thumbnail displays.
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Image Server adds a link to both existing bibliographic records and existing 
holdings records. The 856 field is created automatically with a value of 7 in the 
first indicator. ‡2, ‡f, and ‡z are also filled in during the creation.

Links - DOI and URN Link Examples

If you want to link to a DOI or URN, you can use ‡g as in the following example.

856  _ _ ‡g DOI:87955754 ‡z DOI link to somewhere

For information about what needs to be set up in order for DOI or URN links to be 
successful in OPAC, see the WebVoyáge Architecture Overview and 
Configuration Models.

Links - Verify Hypertext Links for Bibliographic Records

You can verify the integrity of hypertext links in the current bibliographic record (or 
authority or holdings records ... see Verify Hypertext Links - Authority Records on 
page 2-36 and/or Verify Hypertext Links - Holdings Records on page 2-57) by 
selecting Record>Verify Hypertext links from the Cataloging main menu, or by 
using the Ctrl + K keystroke. This opens the Hypertext link dialog box. See 
Figure 2-21.

Figure 2-21. Hypertext links dialog box

NOTE:
If the record does not have any links, a message displays. See Figure 2-22.
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Figure 2-22. Missing Hypertext links message

See Table 2-4 that highlights the fields in bibliographic records validated when 
Record>Verify Hypertext links is selected.  

 See Table 2-5 for a description of valid and invalid links.    

Table 2-4. Verify Hypertext Links for Bibliographic Records

URI Link Text

505 ‡u ‡a

506 ‡u ‡a

514 ‡u ‡a

520 ‡u ‡a

530 ‡u ‡a

540 ‡u ‡a

545 ‡u ‡a

552 ‡u ‡z or ‡a

555 ‡u ‡a

563 ‡u ‡a

583 ‡u ‡z or ‡a

856 ‡u ‡y or ‡z

Table 2-5. Link Status

Link Status Description

Valid Links Display underlined and in blue.

Clicking a valid link (blue and underlined) initiates 
that connection.

Invalid Links Display in red with a diagnostic message. 

Invalid links can be corrected by editing the hypertext 
field in the MARC record. 
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Links - Table of Contents

To display a formatted Table of Contents in the OPAC, you must define the 505 
variable field in the bibliographic record. The OPAC displays the information 
stored in subfield ‡a and formats the information in one line that wraps to fit each 
screen and starts a new line at each double dash.

Links - Thumbnail Images

In order for thumbnail images to display in WebVoyáge for a particular link, you 
must have a separate link-capable field that refers to an image file that displays 
before any of the other link-capable fields in the MARC record. The only types of 
links that may cause thumbnails to display are links to server files, scandoc links, 
and HTTP links.  

A file only has a unique thumbnail image display in the OPAC if it is a still image 
file such as a .gif file, a .bmp file, or a scandoc document which is a still image. 
If the link leads to a .AVI, .MOV, .MPG, .PDF, .TXT, or .WAV file, or to a URL link, 
a generic thumbnail is supplied. 

System Tab

Press Alt + S from an open bibligraphic record to switch to the System tab.

The System tab contains the options to approve records for export and to 
suppress records from OPAC. In addition, the Owning Library for the record 
displays. See Figure 2-23. 
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Figure 2-23. Bibliographic Record - System Tab

All the information relating to OK to export is located on the System tab to 
include the following.

• Whether or not the record is OK to be exported (YES/NO)

• The date on which the OK to export option should take effect

• The date on which the OK to export option was last set

• The operator who set the record as OK to export

• The location at which OK to export was set

OK to Export Option

The OK to export option is used by libraries that export records. For instance, 
you may export records to a bibliographic utility on a regular basis to have 
holdings records attached. You can use Voyager’s Pmarcexport program to export 
records. See the Voyager Technical User’s Guide for details.

Checking the OK to export box confirms that the bibliographic record is 
acceptable for export. You must click the Save to Database button for it to take 
effect. If the OK to export box already contains a check mark, that indicates that 
an operator has either approved the record for export at an earlier date, or the 
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record was automatically authorized for export when it was imported. To 
automatically mark records as OK to export, see the "Bulk Export of MARC 
Records" section of the Voyager Technical User’s Guide.

When the OK to export box is checked, two radio buttons become active on the 
System tab, allowing you to either select the last date on which the OK to export 
option was set, or to select today’s date (Change to Today radio button). 
Selecting the Change to Today radio button and then clicking the Save to 
Database button will cause the OK to export date to change to today’s date. 

NOTE:
The OK to export option resets during the actual export process. The date, 
operator, and location at which the OK to export option was last set display below 
the OK to export check box and the two radio buttons indicating export dates, in 
the Last set for, By, and At textboxes.

History Tab

Press Alt + Y from an open bibliographic record to switch to the History tab.

The History tab includes a list of every change ever made to a bibliographic 
record (see Figure 2-24). These changes are described in Table 2-6.     

Table 2-6. History Tab Field Descriptions

Field Name Description

Date/Time The date and the time the change was made.

Operator The operator who made the change (actually the 
operator name as assigned in System Administra-
tion).

Cataloging Location The happening location (as defined in System 
Administration) at which the change was made.

Action The action performed on the record (UPDATE, CRE-
ATE, MERGE, REPLACE, or RELINK).

Encoding Level The encoding level as set in the Leader field of the 
record.

Suppress Action Whether or not the Suppress from OPAC check box 
was checked on the System tab.
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Figure 2-24. Bibliographic Record History Tab

Sorting the columns 

You can sort the History tab columns in ascending or descending order by 
clicking the column header.

Lag Time

In cases where a record has undergone massive amounts of changes such as 
1000 updates, you may find a small lag time when you click the History tab (or 
select Alt + Y). This is because the History tab is dynamically updated by your 
Voyager system. The lag time should not be more than a few seconds. 

Viewing and Editing Line Items from Bibliographic 
Records

It is possible to view and then manipulate a line item in the Acquisitions module 
from the associated bibliographic or holdings record in the Cataloging module. 
This feature is known as Acquisitions in Cataloging or Acq in the Cat. 
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Acq in the Cat is the second half of the two-way communication between the 
Acquisitions and Cataloging modules. See the Voyager Acquisitions User’s Guide 
for details. Cat in the Acq allows you to view and then edit a MARC record in the 
Cataloging module from the associated line item in the Acquisitions module. 

For details and instructions on using the Acq in the Cat feature, see Viewing and 
Editing Line Items (Acquisitions in Cataloging) on page 3-121.

Authority Records

An Authority Record is created when you select an authority template from the 
Select Authority Template dialog box (see Creating Records on page 3-1) or 
when you click Create from the Authority Validation dialog (see Chapter 9, 
Introduction on page 9-1). 

The authority record contains three tabs.

• MARC tab

• System tab

• History tab

When you create a new authority record, only the MARC and System tabs 
display since the record has no history yet.

 

MARC Tab

The MARC tab of an authority record (see Figure 2-25) contains a Leader, an 008 
fixed field, and variable fields. All values correspond to the published MARC 
standard.
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Figure 2-25. Authority record - MARC tab

Authority Leader

The Authority Leader Information allows you to select the Record Status and the 
Encoding Level. The Authority Type has only one type, so it always displays a “z.” 

The Authority Leader field displays as a grid, which is completely configurable 
using Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details 
on the MARC tag tables.

The procedure for configuring the Authority leader is shown in Procedure 2-8, 
Configuring the Authority Leader, on page 2-32.

Procedure  2-8.  Configuring the Authority Leader

Use the following to configure the Authority leader.

1. Click the Leader button (see Figure 2-26) from an open Authority record. 

Figure 2-26. Leader Button
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Result: The Leader dialog box (see Figure 2-27) opens as a grid.

Figure 2-27. Leader dialog box for authority information

2. Choose a record status and an encoding level from the appropriate drop-down 
menus by clicking the cell and then the down arrow to display the drop-down menu 
selections.

To display and browse drop-down menu selections, click the down arrow or press 
F4 or the space bar. Use the up and down arrows on your keyboard to navigate 
within the drop-down menu. From within a drop-down menu, you can enter the 
letter or number that precedes a particular selection. For instance, if you want to 
jump from subfield z within the drop-down menu to subfield a, you can simply 
press the letter a.

3. Click OK to exit and save your work; click Cancel or Esc to exit without saving.

Authority 008 Fixed Field

The 008 is a header in the main record used to describe the main format in the 
Leader. The 008 is required and non repeatable. 

The Authority 008 field displays as a grid which is completely configurable using 
Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details on the 
MARC tag tables.
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The procedure for configuring the Authority 008 Field is shown in Procedure 2-9, 
Configuring the Authority 008 Field, on page 2-34.

Procedure  2-9.  Configuring the Authority 008 Field

Use the following to configure the Authority 008 field.

1. Click the 008 button (see Figure 2-28) from an open authority record. 

Figure 2-28. 008 Button

Result: The 008 - General Description (Authority) dialog box (see Figure 2-29) 
opens as a grid.

Figure 2-29. 008 - General Description (Authority) dialog box

2. Select values from the grid by clicking a particular cell and then the down arrow to 
display drop-down menu selections.
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You must use either the mouse or the up and down arrows on your keyboard to 
move from cell to cell within the grid. To use the latter, first click in a particular cell 
and then use the up and down arrows to navigate from cell to cell. Do not click 
the down arrow. This causes you to browse the selections within a particular 
drop-down menu. Note that you cannot use the Tab key to move from cell to cell 
on the grid. This takes you outside the grid altogether. 

To display and browse drop-down menu selections, click the down arrow or press 
F4 or the space bar. Use the up and down arrows on your keyboard to navigate 
within the drop-down menu. From within a drop-down menu, you can enter the 
letter or number that precedes a particular selection. For instance, if you want to 
jump from subfield z within the drop-down menu to subfield a, you can simply 
press the letter a. 

NOTE:
In the 008 dialog box, the Heading Use selections are made via drop-down 
menus. 

3. Once you make selections, click OK to exit and save your work; click Cancel or Esc 
to exit without saving.

Variable Fields (Authority Record)

The Variable Fields grid allows you to add Tags, with First and Second Indicators, 
and Subfield Data. 

In order to add or edit information in the Variable Fields grid, you must first place 
your cursor in that grid. To do this, position and click your mouse in the Variable 
Fields portion of the record.

The procedure for adding a tag to the grid is shown in Procedure 2-10, Adding a 
Tag to the Grid, on page 2-35.

Procedure  2-10.  Adding a Tag to the Grid

Use the following to add a tag to the grid.

1. Select Edit>Insert Field Before (F3), or Edit>Insert Field After (F4).

2. Select the Tag cell by clicking in the cell under Tag heading. Type the tag or press F2 
to select a valid tag from the Cataloging Tips scroll box. The tag displays in the cell.
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3. Select an indicator by clicking in the indicator cell. Type the indicator or press F2 to 
select a valid indicator from the Cataloging Tips scroll box. A number representing 
the indicator displays in the indicator cell.

4. Select the Subfield Data cell. Press F9 to insert a subfield delimiter in the cell. Type 
the subfield or press F2 to select a valid subfield from the Cataloging Tips scroll box. 
Enter the subfield data. If necessary, click the ellipse box to expand the data cell.

The procedure for deleting a tag is shown in Procedure 2-11, Deleting a Tag, on 
page 2-36.

Procedure  2-11.  Deleting a Tag

Use the following to delete a tag.

1. Click the row label (the grey, left column). 

2. Press the Delete key on the keyboard.

3. Respond to the confirmation message.  

Verify Hypertext Links - Authority Records

You can verify the integrity of hypertext links in the current authority record (or 
bibliographic or holdings records ... see Links - Verify Hypertext Links for 
Bibliographic Records on page 2-25 and/or Verify Hypertext Links - Holdings 
Records on page 2-57) by selecting Record>Verify Hypertext links from the 
Cataloging main menu, or by using the Ctrl + K keystroke. This opens the 
Hypertext link dialog box. See Figure 2-30.
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Figure 2-30. Hypertext links dialog box

NOTE:
If the record does not have any links, a message displays. See Figure 2-31.

Figure 2-31. Missing Hypertext links message

See Table 2-7 that highlights examples of fields in authority records that are 
validated when Record>Verify Hypertext links is selected.  

Table 2-7. Verify Hypertext Links - Authority Records

URI Link Text

670 ‡u ‡a

678 ‡u ‡a

856 ‡u ‡z or ‡a
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See Table 2-8 for a description of valid and invalid links.    

System Tab

Pressing Alt + S from an open authority record switches you to the System tab. 
See Figure 2-32.

Figure 2-32. Authority Record : System Tab

Table 2-8. Link Status

Link Status Description

Valid Links Display underlined and in blue.

Clicking a valid link (blue and underlined) initiates 
that connection.

Invalid Links Display in red with a diagnostic message. 

Invalid links can be corrected by editing the hypertext 
field in the MARC record. 
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The System tab contains the option to approve records for export. All the 
information relating to OK to export is located on the System tab, including 
whether or not the record is OK to be exported (YES/NO), the date on which OK 
to export should take effect, the date on which OK to export was last set, the 
operator who set the record as OK to export, and the location at which OK to 
export was set.

OK to Export Option

The OK to export check box is for libraries that export records. You can confirm 
that the record is acceptable for export by checking the box. You must click the 
Save to Database button for changes to take effect. If the OK to export box is 
already checked, that indicates that an operator has either approved the record 
for export at an earlier date, or the record was automatically authorized for export 
when it was imported it. To automatically mark records as OK to export, see the 
"Bulk Export of MARC Records" section of the Voyager Technical User’s Guide. 

When the OK to export box is checked, two radio buttons become active on the 
System tab, allowing you to either select the last date on which the OK to export 
option was set, or to select today’s date (Change to Today radio button). If you 
select Change to Today and then click the Save to Database button, the OK to 
export date will change to today’s date. 

NOTE:
The OK to export option resets during the actual export process. The date, 
operator, and location at which the OK to export option was last set display below 
the OK to export check box and the two radio buttons indicating export dates, in 
the Last set for, By, and At textboxes.

History Tab

Press Alt + Y from an open authority record to switch to the History tab.

The History tab includes a list of every change ever made to an authority record 
(see Figure 2-33). These changes are described in Table 2-9.   

Table 2-9. History Tab Field Descriptions

Field Name Description

Date/Time The date and the time the change was made.

Operator The operator who made the change (actually the 
operator name as assigned in System Administra-
tion).
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Figure 2-33. Authority Record History Tab

Sorting the columns 

You can sort each of the History tab columns in ascending or descending order 
by clicking the column header.

Lag Time

In cases where a record has undergone massive amounts of changes such as 
1000, you may find a small lag time when you click the History tab (or select Alt + 
Y). This is because the History tab is dynamically updated by your Voyager 
system each time you click it. The lag time should not be more than a few 
seconds.

Cataloging Location The happening location (as defined in System 
Administration) at which the change was made.

Action The action performed on the record (UPDATE, CRE-
ATE, MERGE, REPLACE, or RELINK).

Encoding Level The encoding level as set in the Leader field of the 
record.

Suppress Action Whether or not the Suppress from OPAC check box 
was checked on the System tab.

Table 2-9. History Tab Field Descriptions

Field Name Description
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Holdings Records

Holdings Records (MFHDs) contain all the holdings information for bibliographic 
records. A holdings record can be created by selecting Record>Create 
Holdings, or by clicking the Create Holdings button when a bibliographic record 
is the active record. Before you can save a holdings record to the database, you 
must define field 852 subfield b with a valid location code (as defined in System 
Administration). 

The Holdings Record window (see Figure 2-34) consists of four tabs.

• MARC tab

• System tab

• Bib Title(s) tab

• History tab

Figure 2-34. Holdings Record - MARC Tab

MARC Tab

The MARC tab of a holdings record contains the Suppress from OPAC options, a 
Leader, an 008 fixed field, and variable fields. It also contains only one 007 fixed 
field. All values correspond to the published MARC standard.

Once a holdings record is saved to the database (see Saving a Record on page 4-
10) the title of the associated bibliographic record is displayed on the title bar of 
the holdings record, and on the BibTitle(s) tab. 
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Suppress from OPAC Option

To prevent a holdings record from displaying in the OPAC, mark the Suppress 
from OPAC check box. This does not prevent the display in OPAC of information 
from the bibliographic record. However, this prevents information from attached 
item records from displaying in the OPAC. If the Suppress from OPAC check box 
for a location is checked in the System Administration module, you cannot 
uncheck the Suppress from OPAC check box in Cataloging. See the "Locations" 
section of the Voyager System Administration User’s Guide for details.

Parentheses surrounding the ID number for bibliographic and holdings records 
are used throughout the Voyager application to indicate that a record is 
suppressed. The book icon in the record title bar also changes color as an 
indication that a record is suppressed. See the figures below for examples.

Figure 2-35. Suppressed bibliographic record

Figure 2-36. Suppressed holdings and bibliographic records
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Figure 2-37. Hierarchy view with suppressed bibliographic and holdings records

Figure 2-38. Display of suppressed bibliographic record in the Acquisitions client

Holdings Leader

The Holdings Leader field allows you to select the Record Status, Type of 
Record, and Encoding Level.

The Holdings Leader field displays as a grid which is completely configurable 
using Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details 
on the MARC tag tables.

The procedure for configuring the holdings leader is shown in Procedure 2-12, 
Configuring the Holdings Leader, on page 2-44.
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Procedure  2-12.  Configuring the Holdings Leader

Use the following to configure the holdings leader.

1. Click the Leader button from the MARC tab of an open holdings record. The Leader 
dialog box (see Figure 2-39) for holdings information displays as a grid.

Figure 2-39. Leader dialog box for holdings information

2. Select values from the grid by clicking a particular cell and then the down arrow to 
display drop-down menu selections.

You must use either the mouse or the up and down arrows on your keyboard to 
move from cell to cell within the grid. To use the latter, first click in a particular cell 
and then use the up and down arrows to navigate from cell to cell. Do not click 
the down arrow. This causes you to browse the selections within a particular 
drop-down menu. Note that you cannot use the Tab key to move from cell to cell 
on the grid. This takes you outside the grid altogether. 

To display and browse drop-down menu selections, click the down arrow or press 
F4 or the space bar. Use the up and down arrows on your keyboard to navigate 
within the drop-down menu. From within a drop-down menu, you can enter the 
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letter or number that precedes a particular selection. For instance, if you want to 
jump from subfield z within the drop-down menu to subfield a, you can simply 
press the letter a. 

3. Click OK to exit and save your work; click Cancel or Esc to exit without saving.  

Holdings 007 Fixed Field

The 007 field is a non-repeatable field that allows you to define a material 
category. 

The Holdings 007 field displays as a grid which is completely configurable using 
Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details on the 
MARC tag tables.

The procedure for configuring the holdings 007 fixed field is shown in 
Procedure 2-13, Configuring the Holdings 007 Fixed Field, on page 2-45.

Procedure  2-13.  Configuring the Holdings 007 Fixed Field

Use the following to configure the holdings 007 fixed field.

1. Click the 007 button (see Figure 2-40) from the MARC tab of an open holdings 
record. 

Figure 2-40. 007 Button

Result: The 007 field displays a tabbed dialog box (see Figure 2-41). 
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Figure 2-41. 007 - Physical Description dialog box for holdings information

2. Select a tab on which you want to enter values. 

NOTE:
You can use keyboard shortcuts to access tabs without the use of the mouse by 
holding down the Alt key and the key that is underlined on the tab name. For 
example, from the 007 dialog box in Figure 2-42, you can use the Alt+m 
keystroke to access the Maps tab without using the mouse. See MARC Tag 
Tables on page A-1 for details on how to define your own keyboard access keys.

3. Click the New button at the bottom of the dialog box to add a category. A grid 
displays with various drop-down menus (Figure 2-42). Select values from the grid by 
clicking a particular cell, and then the down arrow to display drop-down menu 
selections. 

After you make your selections, click Apply. Notice that a check displays in the 
check box indicating that values have been selected for that tab such as in Figure 
2-42 values have been added and applied on the Map tab).

You must use either the mouse or the up and down arrows on your keyboard to 
move from cell to cell within the grid. To use the latter, first click in a particular cell 
and then use the up and down arrows to navigate from cell to cell. Do not click 
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the down arrow. This causes you to browse the selections within a particular 
drop-down menu. Note that you cannot use the Tab key to move from cell to cell 
on the grid. This takes you outside the grid altogether. 

To display and browse drop-down menu selections, click the down arrow or press 
F4 or the space bar. Use the up and down arrows on your keyboard to navigate 
within the drop-down menu. From within a drop-down menu, you can enter the 
letter or number that precedes a particular selection. For instance, if you want to 
jump from subfield z within the drop-down menu to subfield a, you can simply 
press the letter a.

Figure 2-42. 007 - Physical Description dialog with grid displayed

NOTE:
Provided you have entered and applied values for the tab, you do not have to click 
the New button the next time you select that particular tab. Rather, the tab 
displays in grid format with the values you selected.  

4. Update a category: Complete the fields and click the Apply button. This will make 
the change(s) to the current display.

5. Delete a category: Click the Delete button.

6. Exit the 007 Field display: Click the Close or Esc buttons. Any changes you have 
made will not be saved unless the Apply or Delete buttons were clicked.
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Holdings 008 Fixed Field

The 008 is a header in the main record used to describe the main format in the 
Leader. The 008 is required and nonrepeatable. 

The Holdings 008 field displays as a grid which is completely configurable using 
Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details on the 
MARC tag tables.

The procedure for configuring the holdings 008 fixed field is shown in 
Procedure 2-14, Configuring the Holdings 008 Fixed Field, on page 2-48.

Procedure  2-14.  Configuring the Holdings 008 Fixed Field

Use the following to configure the holdings 008 fixed field.

1. Click the 008 button (see Figure 2-43) from the MARC tab of an open holdings 
record. 

Figure 2-43. 008 Button

Result: The 008 dialog box (see Figure 2-44) opens in a grid format.
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Figure 2-44. 008 - General Description (Holding) dialog box

2. In the Cancellation Date, Number of Copies, and Date of Report fields, enter values 
if applicable.

3. Select other values from the grid by clicking a particular cell, and then the down 
arrow to display drop-down menu selections.

You must use either the mouse or the up and down arrows on your keyboard to 
move from cell to cell within the grid. To use the latter, first click in a particular cell 
and then use the up and down arrows to navigate from cell to cell. Do not click 
the down arrow. This causes you to browse the selections within a particular 
drop-down menu. Note that you cannot use the Tab key to move from cell to cell 
on the grid. This takes you outside the grid altogether. 

To display and browse drop-down menu selections, click the down arrow or press 
F4 or the space bar. Use the up and down arrows on your keyboard to navigate 
within the drop-down menu. From within a drop-down menu, you can enter the 
letter or number that precedes a particular selection. For instance, if you want to 
jump from subfield z within the drop-down menu to subfield a, you can simply 
press the letter a.

NOTE:
For a Holdings record created in the Cataloging module, the default Method of 
Acquisition is u (for unknown). 
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4. After you make your selections, click OK to exit and save your work; click Cancel or 
Esc to exit without saving.  

Variable Fields (MARC Tab)

The Variable Fields grid allows you to add Tags (with First and Second Indicators), 
and Bibliographic Data (subfields). The system grid template provides the 
required Location/Call Number (852 tag) row with the subfield b entered with the 
location specified in Session Defaults (see 11-1).

NOTE:
Voyager accepts Dewey call numbers that have more than one decimal point, as 
well as call numbers that only have a decimal point after the Dewey root/Cutter 
combination such as D255.2F K88 v.3; B985 DUN.B. 

In order to add or edit in the Variable Fields grid, you must first place your cursor 
in that grid. To do this, position and click your mouse in the Variable Fields portion 
of the record. 

The procedure for adding variable fields is shown in Procedure 2-15, Adding 
Variable Fields, on page 2-50.

Procedure  2-15.  Adding Variable Fields

Use the following to add variable fields.

1. Select Edit>Insert Field Before (F3) or Edit>Insert Field After (F4) to add a tag to 
the grid.

2. Select the Tag cell by clicking in the cell under Tag heading. Type the tag or press F2 
to select a valid tag from the Cataloging Tips scroll box. The tag displays in the cell.

3. Select an indicator by clicking in the indicator cell. Type the indicator or press F2 to 
select a valid indicator from the Cataloging Tips scroll box. A number representing 
the indicator displays in the indicator cell.

4. Select the Bibliographic Data cell. Press F9 to insert a subfield delimiter in the cell. 
Enter the subfield or press F2 to select a valid subfield from the Cataloging Tips 
scroll box. Enter the subfield data. If necessary, click the ellipse box to expand the 
data cell.
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To delete a tag, click the row label (the grey, left column). Press the Delete key 
and respond to the confirmation message.

NOTE:
A function has been added to the Cataloging module allowing you to automatically 
add a bibliographic record call number 852 h and 852 i into a holdings record. 
This function is discussed in Get Call Number from Bib Record on page 2-51.

Get Call Number from Bib Record 

The get call number from bib record function improves material processing by 
automatically adding a call number to an existing MFHD. This MFHD can either 
lack a call number or contain an existing call number that needs to be replaced.   

Workflow Examples

Below are two instances in which the get call number from bib record function 
would be useful.

• The get call number from bib record function would be useful when a 
MFHD is created without a call number (e.g., in Acquisitions). Holdings 
records do not, as a rule, include a call number when they are created in 
Acquisitions. Usually, they contain only a location (852|b field). 

• Get call number from bib record would also be useful when an existing 
MFHD has a call number that is being replaced. Perhaps your library is 
engaging in a retrospective conversion or a re-classification project in 
which call numbers are being reviewed and/or replaced.  

In either of these instances, using the get call number from bib record function 
would simplify the insertion of the call number into the MFHD (852|h and 852|i 
fields). Rather than having to type in the call number or copy and paste the call 
number from the MFHD’s associated bibliographic record, the call number could 
be automatically inserted into the MFHD (via the appropriate menu option). This 
minimizes keystrokes and associated errors. It also eliminates the overall 
awkwardness of copying the call number from an open bib record and pasting it 
into the appropriate MFHD field.

NOTE:
If a bibliographic record contains multiple instances of call number information as 
specified in the call number hierarchy such as more than one 090 ‡a, the system 
adds the last instance of the call number information, 090 ‡a, to subfield h and 
subfield i of the MFHD.
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Setting Up to Use Get Call Number from Bib Record

You must select a call number hierarchy in Cataloging’s Session Defaults and 
Preferences in order to use get call number from bib record. The call number 
hierarchy indicates the type of call number such as LC or Dewey placed in the 
MFHD. For instance, if you want an LC call number to be placed in the MFHD, you 
would select the LC call number hierarchy. If you do not select a call number 
hierarchy in Cataloging’s Session Defaults and Preferences, you are not able to 
use the get call number from bib record function.

! IMPORTANT:
The fields of the bibliographic record in which the system checks for call 
numbers such as 050, 082, 090, and so on differ for each call number type. 
You must define these fields for each call number type in the System 
Administration module, and then select the call number type as part of the 
appropriate Cataloging Policy Group. See the Voyager System 
Administration User’s Guide for details.

The procedure for setting the call number hierarchy is shown in Procedure 2-16, 
Setting the Call Number Hierarchy, on page 2-52.

Procedure  2-16.  Setting the Call Number Hierarchy

Use the following to set the call number hierarchy.

1. Select Options>Preferences from the Cataloging toolbar.

Result: The Session Defaults and Preferences dialog box opens.

2. From the General tab, click the arrow at the far right of the Call Number 
Hierarchies drop-down menu. 

Result: A list with hierarchy names, codes, and call number classes displays (see 
Figure 2-45).

3. Select from the list the call number hierarchy you want to input in the MFHD, and 
click the OK button. 

Example: If you want to have an LC call number placed in the MFHD, select the 
LC call number hierarchy.
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Figure 2-45. Selecting a call number hierarchy

NOTE:
Each call number hierarchy is associated with a holdings/item default location 
(defined in Voyager’s System Administration module for the appropriate 
Cataloging Policy Definition to which the holdings/item default location belongs). If 
you select a call number hierarchy in Cataloging’s Session Defaults and 
Preferences that is not associated with the specified holdings/item default 
location, you get a warning message (see Figure 2-46). 

If you select Yes, the classification scheme for the call number hierarchy is 
changed in Cataloging. If you select No, the classification scheme for the call 
number hierarchy is not changed. You get the same message when you log into 
the Cataloging module if the hierarchy selected still does not match the holdings/
item default location.
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Figure 2-46. Setting call number hierarchy to a non-corresponding default 
holdings/item location

Using Get Call Number from Bib Record 

Once setup is complete, you are ready to use the following procedure to get the 
call number from the bibliographic record. 

The procedure for getting a call number from a bibliographic record is shown in 
Procedure 2-17, Getting Call Number from Bibliographic Record, on page 2-54.

Procedure  2-17.  Getting Call Number from Bibliographic Record

Use the following to get a call number from a bibliographic record.

1. Retrieve an existing MFHD using standard Cataloging functions. 

! IMPORTANT:
It is not required to have the MFHD’s corresponding bib record open to use 
the get call number from bib record function. However, you can have the 
bib record open if you wish. The system will know which bib record 
corresponds to the MFHD because bib records and MFHDs are linked in 
Voyager.

2. When you are ready to insert the call number, select Record>Get call number from 
bib record from the Cataloging toolbar (see Figure 2-47), or use the Ctrl+n 
keystroke. This causes the call number to be placed in the 852|h and 852|i field of 
the MFHD. The call number is automatically placed in the appropriate field 
regardless of where your cursor is positioned in the MFHD fields.
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NOTE:
If you only have a bib record open but not a MFHD, the Record>Get call number 
from bib record menu option is grayed out, and the Ctrl+n keystroke does not do 
anything.

Figure 2-47. Get call number from bib record menu option

NOTE:
If the associated bib record does not include the call number fields defined in the 
call number hierarchy you selected such as the fields are deleted, get call number 
from bib record does not work. You still see the function on the Record menu of 
the Cataloging toolbar (it is not grayed out), but selecting the function does not 
cause an effect in the MFHD 852 field. For example, if you have selected an LC 
call number hierarchy based on the 050 field, but the associated bibliographic 
record does not contain the 050 field, you are not able use the function.
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On the other hand, if the associated bib record includes call number fields that are 
empty of data, you receive two warning messages when using get call number 
from bib record. 

The first message informs you that the call number field is invalid, and that you 
need to check for the presence of subfield diameters and codes. Then, if you click 
OK, you receive a second message. 

The second message informs you that the system is unable to assemble the 
holdings record (or unable to assemble the bib record if the associated bib record 
is open). For example, if the MFHD’s associated bib record contains an 050 field 
that is empty of data but the field itself is not deleted, you receive the two warning 
messages.

3. Save your MFHD in standard Voyager Cataloging fashion.

NOTE:
In cases where you are replacing an existing call number with one from the same 
classification scheme or not, you receive a warning message before the call 
number is replaced. See Figure 2-48. If you click Yes, the existing call number will 
be replaced; if you click No, the call number will not be replaced.

Figure 2-48. Message for replacing an existing call number with a new one 

If you are replacing the call number with one from a different classification scheme 
such as LC to Dewey), you receive a second warning message. See Figure 2-49. 
This warning message ensures that you are aware that the existing call number is 
from a different classification scheme than the new one. If you click Yes, the call 
number is replaced. This also automatically changes the 852 field’s first indicator 
to the appropriate value. If you click No the call number is not replaced.  
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Figure 2-49. Message for replacing an existing call number with a new one from a 
different classification scheme

Verify Hypertext Links - Holdings Records

You can verify the integrity of hypertext links in the current holdings record (or 
bibliographic or authority records ... see Links - Verify Hypertext Links for 
Bibliographic Records on page 2-25 and/or Verify Hypertext Links - Authority 
Records on page 2-36) by selecting Record>Verify Hypertext links from the 
Cataloging main menu, or by using the Ctrl + K keystroke. This opens the 
Hypertext link dialog box. See Figure 2-50.

Figure 2-50. Hypertext links dialog box

NOTE:
If the record does not have any links, a message displays. See Figure 2-51.
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Figure 2-51. Missing Hypertext links message

See Table 2-10 that highlights examples of fields in holdings records that are 
validated when Record>Verify Hypertext links is selected.  

See Table 2-11 for a description of valid and invalid links.    

System Tab

Pressing Alt + S from an open holdings record switches you to the System tab.

The System tab contains the options to approve records for export and to 
suppress records from OPAC. In addition, the Owning Library for the record 
displays. See Figure 2-52. 

All the information relating to OK to export is located on the System tab to 
include the following.

• Whether or not the record is OK to be exported (YES/NO)

Table 2-10. Verify Hypertext Links - Holdings Records

URI Link Text

563 ‡u ‡a

583 ‡u ‡z or ‡a

856 ‡u ‡y or ‡z

Table 2-11. Link Status

Link Status Description

Valid Links Display underlined and in blue.

Clicking a valid link (blue and underlined) initiates 
that connection.

Invalid Links Display in red with a diagnostic message. 

Invalid links can be corrected by editing the hypertext 
field in the MARC record. 
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• The date on which the OK to export option should take effect

• The date on which the OK to export option was last set

• The operator who set the record as OK to export

• The location at which OK to export was set

Figure 2-52. Holdings Record: System Tab

OK to Export Option

The OK to export option is used by libraries that export records. See the "Bulk 
Export of MARC Records" section of the Voyager Technical User’s Guide for 
details on exporting records.

Checking the OK to export box confirms that the holdings record is acceptable 
for export. You must click the Save to Database button for it to take effect. If the 
OK to export box already contains a check mark, that indicates that an operator 
has either approved the record for export at an earlier date, or the record was 
automatically authorized for export when it was imported. To automatically mark 
records as OK to export, see the "Bulk Export of MARC Records" section of the 
Voyager Technical User’s Guide.

When OK to export is set and the record has been saved to the database, two 
radio buttons become active on the System tab. These radio buttons allow you to 
either select the last date on which the OK to export option was set, or to select 
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today’s date (Change to Today radio button). If you select Change to Today and 
then click the Save to Database button, the OK to export date will change to 
today’s date. 

NOTE:
The OK to export option resets during the actual export process. The date, 
operator, and location at which the OK to export option was last set display below 
the OK to export check box and the two radio buttons indicating export dates, in 
the Last set for:, By:, and At: textboxes.

Bib Title(s) Tab

The Bib Title(s) tab (see Figure 2-34) shows the associated bibliographic ID and 
title for the holding. Double-click the title to display the bibliographic record.

Figure 2-53. Holdings Record Bib Title(s) Tab

Typically, only one title displays. If the holding record is bound with, multiple titles 
display, one title for each bibliographic record within the bound holding.

History Tab

Press Alt + Y from an open holdings record to switch to the History tab.
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The History tab includes a list of every change ever made to a holdings record. 
See Figure 2-54. These changes are described in Table 2-12.    

Figure 2-54. Holdings Record: History Tab

Table 2-12. History Tab Field Descriptions

Field Name Description

Date/Time The date and the time the change was made.

Operator The operator who made the change (actually the 
operator name as assigned in System Administra-
tion).

Cataloging Location The happening location (as defined in System 
Administration) at which the change was made.

Action The action performed on the record (UPDATE, CRE-
ATE, MERGE, REPLACE, or RELINK).

Encoding Level The encoding level as set in the Leader field of the 
record.

Suppress Action Whether or not the Suppress from OPAC check box 
was checked on the System tab.
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Sorting the columns 

You can sort each of the History tab columns in ascending or descending order 
by clicking the column header.

Lag Time

In cases where a record has undergone massive amounts of changes such as 
1000, you may find a small lag time when you click the History tab (or select Alt + 
Y). This is because the History tab is dynamically updated by your Voyager 
system each time you click it. The lag time should not be more than a few 
seconds.

Viewing and Editing Line Items from Holdings 
Records

It is possible to view (and then manipulate) a line item in the Acquisitions module 
from the associated bibliographic or holdings record in the Cataloging module. 
This feature is known as Acquisitions in Cataloging or Acq in the Cat. 

Acq in the Cat is the second half of the two-way communication between the 
Acquisitions and Cataloging modules. See the "Viewing and Editing MARC 
Records" section of the Voyager Acquisitions User’s Guide for details. Cat in the 
Acq allows you to view and then edit a MARC record in the Cataloging module 
from the associated line item in the Acquisitions module. 

For details and instructions on using the Acq in the Cat feature, see Viewing and 
Editing Line Items (Acquisitions in Cataloging) on page 3-121.

Item Records

An Item Record (see Figure 2-55) describes a single item owned by your 
institution. An item record can be created by selecting Record>Create Items, or 
by clicking the Create Items button when a bibliographic or holdings record is the 
active record.



 Ex Libris Confidential 2-63

Chapter 2: Record Types and Creating

Figure 2-55. Example of an Item Record

Checking for Duplicate Barcodes - Item Records

Any time an item barcode is being created or edited, Voyager tests for the 
existence of duplicate barcodes in the database. When the barcode you are 
attempting to attach to an item is already in use elsewhere, you will be advised of 
this fact with a dialog box and asked if the barcode should be used anyway. 

You may enable or disable this feature by clicking the Check for Duplicate Item 
Barcodes check box on the Work Flow tab in Cataloging’s Session Defaults and 
Preferences (see Figure 2-56).
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Figure 2-56. Enabling/Disabling the Check for Duplicate Barcodes option

Header Information

You cannot add to or change the item record information described in Table 2-13.    

Table 2-13. Item Record Header Information

Field Name Description

Title(s) Lists the title of the item. If more than one bib-
liographic record is attached to that item record such 
as two books in one binding, this section displays a 
drop-down list with all associated titles.

Location The location's name from the holdings record.

Call # The call number, as specified in the 852 field of the 
holdings record.
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Location and Type

You can add to or change the information described in Table 2-14 by selecting 
from the appropriate drop-down list(s). However, if a location is assigned to an 
item, and that location does not belong to a Circulation Group as defined in 
System Administration, then that item cannot be charged to any patron.    

Item/Holdings

You can add to or change the information described in Table 2-15 by entering the 
appropriate text.   

Table 2-14. Item Record Location Options

Field Name Description

Perm. Loc The item's permanent location.

Item Type The item's permanent type.

Temp. Loc. The item's temporary location (if any).

Temp. Type The item's temporary assigned type (if any).

Media Type The item’s media type (if any).

Table 2-15. Item Record Holdings Options

Field Name Description

Enumeration The item's enumeration such as the volume number.

Chronology The item's chronology such as April.

Year The enumeration year (if serially published) or the 
publication year (if an individual item).

Caption Any additional title information.

Free Text Any additional item information.

Spine Any additional item information that displays on the 
spine label.
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Figure 2-57. Item record Note icon

Note Use/click the Note icon (see Figure 2-57) to access 
the Note dialog box (see Figure 2-58).

You may create the following types of notes:

• Regular

• Charge

• Discharge

The charge/discharge notes display for the circulation 
clerk when the item is being charged or discharged.

Table 2-15. Item Record Holdings Options

Field Name Description



 Ex Libris Confidential 2-67

Chapter 2: Record Types and Creating

Figure 2-58. Note Dialog Box
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Item Details

Table 2-16 describes the item record detail options. 

Self Check

The Magnetic Media and Sensitize check box options (see Figure 2-59) set item 
record level flags for interfacing with third-party self-check machines for item 
check in, check out, and renewal transactions. These are used for magnetic 
media and sensitize alerts.

Figure 2-59. Item record Self Check options

Table 2-16. Item Record Detail Options

Field Name Description

Barcode This is the barcode for the item. There can be one 
active and possibly several inactive barcodes in a 
drop-down list.

NOTE:
Pressing either F4 or the ellipses button brings up the 
Barcodes dialog box from which you can add or 
delete barcodes. The F4 button does not bring up the 
Barcodes dialog box if the item record is new and has 
not yet been saved to the database. Likewise, the 
ellipses button is disabled if the record is new and has 
not yet been saved to the database. If you click inside 
another field before pressing F4, the Barcodes dialog 
box does not display.

Copy The copy number.

Pieces The number of pieces that go with the item.

Price The item price. If no price is assigned, and replace-
ment costs are designated to be calculated for lost 
items, the default replacement for the item type is 
used.



 Ex Libris Confidential 2-69

Chapter 2: Record Types and Creating

Click the Magnetic Media and Sensitize check boxes per your item record 
requirements for self-check processing. The default settings for these check 
boxes are identified in Chapter 11, Session Defaults and Menu Options. See Item 
Defaults Tab on page 11-13 for more information.

Also refer to the Voyager Interface to Self Check Modules Using 3M SIP User’s 
Guide.

Statuses

Each item record has a status field that describes the item's state of being such as 
checked out or damaged. The Status button is shown in Figure 2-60.

Figure 2-60. Status Button

When you click the Status button, the Item Status dialog box displays, the 
following:

• Status that has been manually applied by an operator (Status)

• Date the status was applied (Date Applied)

• ID of the operator that applied the status (Applied By)

• List of available statuses to apply to the item (Status List)
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Figure 2-61. Item Status Dialog Box

NOTE:
You can only view item statuses when an item record is the active record. 

Table 2-17 contains a complete list of possible statuses. Statuses are listed 
according to rank. A status is only viewed in the module if all of the other statuses 
currently applied to the item are below it in rank. Thus, a status higher on the list 
takes precedence over a status lower on the list. 
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Table 2-17. Possible Statuses Listed According to Rank

Scheduled Assigned automatically when the item has 
been scheduled by the Media Scheduling 
module.

In Process Assigned manually when the item’s record 
is being reviewed, or some similar activity 
is being performed.

Lost (system) The status is automatically assigned to 
overdue items that have not been returned 
within an interval defined by the library. 
The system will not calculate additional 
late fees once this status is given.

Lost (library) The status is manually assigned to over-
due items that have not been returned 
within an interval defined by the library. 
The system will not calculate additional 
late fees once this status is given.

Missing The item has been labeled missing accord-
ing to library policies. May be manually 
assigned.

At bindery The item has been sent to the bindery. This 
status can only be assigned manually.

Charged Currently charged to a patron with a future 
due date. Automatically assigned.

Renewed Currently charged to a patron for an addi-
tional period with a future due date. Auto-
matically assigned.

Overdue Currently charged to a patron with a past 
due date, but not yet lost or stolen. Auto-
matically assigned.

On Hold An item is on a hold shelf waiting for the 
patron who placed a recall/hold request for 
the item. Automatically assigned.

In Transit An item is en route from one location to 
another. May be manually assigned.

In Transit (Dis-
charged)

A courtesy discharge has taken place and 
the item is now on its way home. Automati-
cally assigned.
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In Transit (On Hold) An item is en route to a hold shelf at a loca-
tion selected by the requesting patron. 
Automatically assigned.

Recall Request One or more patrons have placed a 
request for an item currently charged to 
another patron; a recall request can 
shorten the loan interval in effect. Automat-
ically assigned.

Hold Request One or more patrons have placed a 
request for an item that may or may not be 
currently charged to another patron. A hold 
request never affects the loan interval if the 
item is currently charged. Automatically 
assigned.

Short Loan Request One or more patrons have placed a short 
loan request for an item.

Remote Storage 
Request

One or more patrons have placed a 
request for an item that is in a remote stor-
age area.

Call Slip Request One or more patrons have placed a 
request for an item in a closed stacks area.

Discharged An item has been discharged and is cur-
rently on the shelf or in its way there and is 
in effect until the expiration of the circula-
tion policy group shelving interval. Auto-
matically assigned.

Not Charged Should be on the shelf and is assigned 
after discharge and expiration of shelving 
interval for the applicable circulation policy 
group. Automatically assigned.

Catalog Review The item has been marked for Catalog 
review. May be manually assigned.

Circulation Review The item has been marked for Circulation 
review. May be manually assigned.

Table 2-17. Possible Statuses Listed According to Rank
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The procedure for assigning a status is shown in Procedure 2-18, Assigning a 
Status, on page 2-73.

Procedure  2-18.  Assigning a Status

Use the following to assign a status to an item.

1. Select Item>View Status. The Item Status dialog box opens (see Figure 2-62). 

Claims returned A patron reports an item as having been 
returned, but there is no record of dis-
charge. Usually such an item is also over-
due and possibly missing or lost. May be 
manually assigned. This status only exists 
with other statuses and takes on the rank 
of the other status. 

Damaged The item has been damaged according to 
library policies. May be manually assigned. 
This status only exists with other statuses 
and takes on the rank of the other status.

Withdrawn The item has been withdrawn from the cir-
culating collection. May be manually 
assigned. This status only exists with other 
statuses and takes on the rank of the other 
status.

Table 2-17. Possible Statuses Listed According to Rank
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Figure 2-62. Item Status dialog box

There are two areas displayed for the status information, the actual applied Status 
box, and the Status List that contains the possible statuses. The number, if any, 
which displays at the top of the dialog box is the barcode assigned to the current 
item.

2. To apply a status, select the appropriate status from the Status List drop-down list 
and click the blue up arrow (see Figure 2-63). The status displays in the Status box. 
Once a status is applied to an item, it is no longer available in the Status List. 

To delete the status, highlight the appropriate status in Status box and click the 
red down arrow (see Figure 2-63). The status returns to the Status List drop-
down list.
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Figure 2-63. Blue Up and Red Down Buttons

3. Click the OK button to save the item statuses you’ve added or deleted and close the 
Item Status dialog box.

Statistical Categories

For statistical purposes, a site can define types of item characteristics that are not 
needed for cataloging but are useful for statistical compilations. The statistical 
categories are not associated with any one item type and there is no limit on the 
number created. When an operator creates a item record and assigns the item 
type an operator can select one or more statistical categories from the list. The 
Statistical Categories button is shown in Figure 2-64.

Figure 2-64. Statistical Categories Button

Item Statistical Categories are defined from System Administration and can only 
be assigned manually.

NOTE:
You can only view item statistical categories when an item record is the active 
record. 

The procedure for assigning Statistical Categories is shown in Procedure 2-19, 
Assigning Statistical Categories, on page 2-75.

Procedure  2-19.  Assigning Statistical Categories

Use the following to assign a statistical category to an item.

1. Select Item>View Statistics. The Item Statistical Categories dialog box opens 
(see Figure 2-65).
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Figure 2-65. Item Statistical Categories dialog box

There are two areas displayed for category information, the actual applied 
Statistical Category box, and the Statistical Categories List which contain the 
possible categories. The number which displays at the top of the dialog box is the 
barcode assigned to the current item.

2. To apply a statistical category, select the appropriate category from the Statistical 
Categories List and click the blue up arrow (see Figure 2-66). The category 
displays in the Statistical Categories box. Once a category is applied to an item, it is 
no longer available in the Statistical Categories List. 

Figure 2-66. Blue Up and Red Down Buttons

To delete the category, highlight the appropriate category in Statistical Categories 
box and click the red down arrow (see Figure 2-66). The status returns to the 
Statistical Categories List.

3. Click the OK button to save the statistical categories that you have added or deleted 
and close the Item Statistical Categories dialog box. 
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Creating Records

Before you can create a record, there must be at least one template for the type of 
record that you want to create in the Cataloging folder of the Voyager directory. 
The Cataloging client comes installed with the following templates.

• bib.tem

• auth.tem

• hldg.tem. 

For information on creating your own templates, see Creating a New Template on 
page 8-2.  

This section describe how to create new records for the following.

• Authority/Bibliographic entries. See Procedure 3-1, Creating a New 
Record, on page 3-2.

• Holdings when a bibliographic record is open. See Procedure 3-2, Creating 
a Holdings Record When a Bibliographic Record is Open, on page 3-5.

• Item entries from an active Holdings record. See Procedure 3-3, Creating 
an Item Record from an Active Holdings Record, on page 3-8.

The procedure for creating a new record is shown in Procedure 3-1, Creating a 
New Record, on page 3-2.
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Procedure  3-1.  Creating a New Record

Use the following to create a new record.

1. Select from the toolbar Record>New>Authority or Record>New>Bibliographic 
(Or click the arrow next to the Create a new record from a template button, and 
select Authority or Bibliographic. See Figure 3-1.) 

Figure 3-1. New Record Button

NOTE:
You can only choose between creating a new Authority or Bibliographic record 
here because Holdings records can only be created when a Bibliographic record 
is the active record, and Item records can only be created when a Holdings record 
is the active record.

Result: The Select Bibliographic Template dialog box opens (see Figure 3-2) if 
you have not specified a particular template in your Session Defaults and 
Preferences. Session Defaults and Preferences allows you to specify a file path 
for the Authority/Bibliographic templates. Your result may differ depending on what 
Session Defaults and Preferences have been set.
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Figure 3-2. Selecting a template for a new record 

2. Select the template you want to use, and click Open. (If you have specified a 
template in your Session Defaults and Preferences, this dialog box does not open.)

Result: The new record displays (see Figure 3-3) with a minimal template that 
contains a Leader, fixed fields, and variable fields.
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Figure 3-3. New bibliographic record template example

NOTE:
You must select a template from the Select Bibliographic Template or Select 
Authority Template dialog box that corresponds with the type of record you 
elected to create. For example, if you elected to create an Authority record, you 
can only choose a template for Authority records. Otherwise, you get the following 
error message (see Figure 3-4).

Figure 3-4. Error message for selecting an inappropriate template
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3. Complete the appropriate fields in the record and click Save.  

The fields entered are different for each record type. For more information, see 
Bibliographic Records on page 2-3, see Authority Records on page 2-31, see 
Holdings Records on page 2-41, or see Item Records on page 2-62.

Result: A New Record is saved to the database. 

NOTE:
When adding a Bibliographic record, it is important to remember that the assigned 
Owning Library is the Owning Library of the Cataloging location the user logs in 
with. For more details on Owning Libraries, see the Voyager System 
Administration User’s Guide. 

The procedure for creating a holdings record when a bibliographic record is open 
is shown in Procedure 3-2, Creating a Holdings Record When a Bibliographic 
Record is Open, on page 3-5.

Procedure  3-2.  Creating a Holdings Record When a Bibliographic Record is Open

Use the following to create a holdings record when a bibliographic record is open.

1. Select Record>Create Holdings or click the Create Holdings button (see Figure 3-
6). 

Result: A new holdings record displays for the active bibliographic record (see 
Figure 3-7) if you have selected a default template in Cataloging’s Session 
Defaults and Preferences (Folders/Files Tab on page 11-15).  

If you have not selected a default template, the Create Holdings button opens 
the Select Holdings Template dialog box allowing you to navigate to the 
appropriate template.   If you select a template from the Select Holdings 
Template dialog box that is not a holdings record template, you get the following 
error message (see Figure 3-5).
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Figure 3-5. Error message for selecting an inappropriate template

Figure 3-6. Create Holdings Button

NOTE:
If the bibliographic record contains more than one instance of the field that 
contains the call number, the last one listed in the bibliographic record is used in 
the new holdings record.
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Figure 3-7. Dialog box for creating a Holdings record from an open Bibliographic 
record when one already exists

2. Complete the appropriate fields in the record and click Save.

Result: A New Holdings Record is saved to the database. 

NOTE:
If the active bibliographic record already has a holdings record associated with it, 
Voyager opens a dialog box that warns you of the existing holdings record (Figure 
3-7). This dialog box only opens if you have not selected Always create a 
holding when adding holdings to a bib on the Workflow tab in Cataloging’s 
Session Defaults and Preferences (Work Flow Tab on page 11-10).  

From this dialog box you can do the following.

• Retrieve the existing holdings record by clicking the Retrieve button

• Create a new one by clicking the New button

• Cancel by clicking the Cancel button. 

! IMPORTANT:
If the Cataloging user is not allowed to attach a Holdings record to an 
Owning Library, the Owning Library of the location in the 852|b field is 
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checked against the Owning Library of the linked Bibliographic record.  
Then, if the Owning Libraries are different, a message is displayed in 
Cataloging, and the user is barred from saving the Holdings record.  This 
check is only performed if the Location is a valid Location for the user’s 
login. For more details on Owning Libraries, see the Voyager System 
Administration User’s Guide. 

The procedure for creating an item record from an active holdings record is shown 
in Procedure 3-3, Creating an Item Record from an Active Holdings Record, on 
page 3-8.

Procedure  3-3.  Creating an Item Record from an Active Holdings Record

Use the following to create an item record from an active holdings record.

1. Select Record>Create Items, or click the Create Item button (see Figure 3-8). 

Result: A default Item record opens. 

Figure 3-8. Create Item Button

2. Complete the appropriate fields, and click Save.

Result: A New Item Record is saved to the database. 

Opening Records

This section describes opening a record from a work folder and from the OPAC.
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Opening Records from a Work Folder  

Voyager Cataloging allows you to create, edit, and save records in work folders, 
as well as in the database. Records that are saved in work folders are called, work 
records. These records operate in the same way as other records except they are 
not validated against the MARC tag tables or authority records (until the records 
are saved to the database). The Open Record from Work Folder button is 
shown in Figure 3-9.

Figure 3-9. Open Record from Work Folder Button

TIP:
If you are copying records between internal databases, it is recommended 
that you use the import function instead of saving records to work folders 
and opening them in the new database. This is because work records keep 
the 001 field, and no duplication checking occurs between a work record 
and the database. 

The procedure for opening a work record is shown in Procedure 3-4, Opening a 
Work Record, on page 3-9.

Procedure  3-4.  Opening a Work Record

Use the following to open a work record.

1. Select File>Work Record>Open. 

Result: The Select Work File  dialog box opens. 

You can specify a folder to which this dialog box defaults in Cataloging’s Session 
Defaults and Preferences. See Folders/Files Tab on page 11-15 for details.

NOTE:
If Voyager does not find a folder called work, one will be created for you. 
However, you can open (or save) records to any directory.
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2. Click the appropriate record name from the work folder. The suffix of the record file 
indicates what type of record it is. 

Result: The record name is highlighted.

3. Click Open to open the record, or click Cancel to close the dialog box without 
opening a record.

Result: Open displays the Select work records dialog box.  Cancel returns you 
to the main Cataloging display.

NOTE:
Because the Suppress from OPAC check box is not a part of the MARC 21 
record, that information is not saved when the record is saved as a work record. 
Each time that you retrieve a work record in order to save it to the database, the 
Suppress from OPAC check box must be marked appropriately.

Opening Records from the OPAC

To retrieve and open a record from the Online Public Access Catalog (OPAC), you 
must use Record>Search to find the record. For more information, see Search 
Dialog Box on page 3-31.

Your search results are presented in the Titles Index dialog box from which you 
can select one or more titles. Your selection of one or more titles opens the 
bibliographic record(s) in the Cataloging client. You may use the following icons to 
open and view additional information attached to the bibliographic record(s):

• Get Hldgs

• Get Items

• Hierarchy (refer to Bibliographic Tree on page 3-11 for more information)
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Bibliographic Tree

When you click the Hierarchy button (see Figure 3-10) from an open record (or 
select Record>Show Associated Records from the Cataloging toolbar), the 
bibliographic, holdings, items, and bound with information displays in a 
hierarchically-formatted dialog box. 

Figure 3-10. Hierarchy Button

Figure 3-11. Hierarchical Display of Holdings and Items for Bibliographic Records

The hierarchical tree displays in colors that you can set in the Cataloging 
session’s Options > Preferences (see Session Defaults and Preferences on 
page 11-1). The Hierarchy dialog box (Holdings and Items for bib <number>) 
can be resized and placed anywhere on your display. That is, it is not restricted to 
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displaying within the Voyager Cataloging module window. The Hierarchy dialog 
box remains open in the background until you close it. As a result, the Hierarchy 
dialog box may remain open throughout your workflow while editing one or more 
bibliographic, holdings, or item records.

To view the details of each level of the hierarchy (for holdings, item, or bound with 
records), click the plus sign (+) to the left of the record ID number or click the 
Expand button to open all levels of the hierarchy. 

The hierarchy displays the following information:

• Bibliographic record

This level contains the bibliographic record ID, title, and owning library.

• Holdings record

This level contains the MFHD ID, location, call number, and order status 
(with any associated on-order information).

• Item record

This level contains the item ID, location, item type, enum/chron/year, copy, 
item status, and item barcode.

The Hierarchy dialog box provides the following button actions:

• Expand/Collapse

Expand opens all levels in the hierarchy.

When more than one level of the hierarchy is open, the Expand button 
dynamically changes to the Collapse button. Collapse closes all levels of 
the hierarchy except for the top (bibliographic) level.

• Print

Print prints the information that is currently displayed in the Hierarchy 
dialog box.

• Retrieve

Retrieve opens the records that you have highlighted in the Hierarchy 
dialog box.

With the Retain hierarchy selections workflow preference (Options > 
Preferences), you can set the preference to retain record selections or to 
remove record selections in the Hierarchy dialog box after the records are 
retrieved. Retaining record selections is the default. For more information, 
refer to Work Flow Tab on page 11-10.
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• Close

• Refresh

The Refresh button enables you to refresh the display when you open a 
different bibliographic, holdings, or item record and want its Cataloging 
hierarchy.

When this button is clicked, the contents of the record hierarchy display are 
updated to reflect the associated records for the record that had focus last 
before the Refresh button was clicked. If the Retain hierarchy selections 
option (Options > Preferences > Workflow tab) is selected, the record 
that caused the hierarchy to be refreshed is preselected in the hierarchy.

Importing Records

You can import MARC-formatted bibliographic and authority records into Voyager 
using Cataloging’s importing features. Any MARC 21 record can be imported, 
including records you download from a cataloging utility such as OCLC or RLIN. 
You can specify the character set to which you want imported records mapped 
such as the following in Cataloging’s Session Defaults and Preferences.

• Latin1 (non-Unicode)

• MARC 21 MARC8 (non-Unicode)

• MARC21 UTF-8

• OCLC (non-Unicode)

• RLIN legacy (non-Unicode)

• Voyager legacy (non-Unicode)  

See Mapping Tab on page 11-17 for more information.

Depending on the Import/Replace profile you have established in the System 
Administration module, imported records can either replace existing records, 
merge with existing records, be added to the database, or not be added to the 
database. See the Voyager System Administration User’s Guide for details on 
Import/Replace profiles. The Import/Replace profile you establish in System 
Administration is defined in Cataloging’s Session Defaults and Preferences. See 
Session Defaults and Preferences on page 11-1 for more information.

Records can be imported in the following ways through the Voyager Cataloging 
module. 

• From a file, a new file, or one you previously accessed (see Procedure 3-5, 
Importing Records From a File, on page 3-15)
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• From another database (Procedure 3-6, Importing Records From Another 
Database, on page 3-18)

NOTE:
Records can also be imported in batch mode which is a method of processing 
many records as a group versus one at a time. This method utilizes the Voyager 
BulkImport and Prebulk programs.  For more information about utilizing this 
method for importing, see the Voyager Technical User’s Guide.

Building the 035

When you import bibliographic and authority records, Voyager creates an 035$a 
field and adds it to the records. The 035$a field identifies records from other 
systems. By creating a new field, Voyager preserves the source of the record. The 
system creates this field regardless of the method you use, bulk import or online 
import in the Cataloging module (see also the Voyager Acquisitions User’s 
Guides).

The following are the steps the system uses to create the 035$a field when you 
import records:

1. The system first looks for the 003 field (source library’s code name).

2. If there are no parentheses around the 003 field, the procedure adds 
parentheses.

3. The system looks for the 001 field (source’s system ID number).

4. The system combines the 003 and 001 fields to create the 035$a field, thus 
preserving the original source of the records.

For example:

• Source 003 = OCoLC

• Source 001  = ocm 12345678

• 035$a field = (OCoLC)12345678

NOTE:
If the record has no 003 field, it creates the 035$a field using only the 001 field. If 
the record has no 001 field, the system cannot create the 035$a field.

OCLC Control Number Expansion

The OCLC control number format is changing to accommodate control numbers 
that are 10 digits or longer. A new prefix of on is being added to the 001 field to 
indicate a control number that is 10 or more digits in length. Refer to www.oclc.org 
for additional information.
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Voyager provides support for OCLC imported records that contain control 
numbers of 10 or more digits in length. Voyager imports OCLC data and 
processes it in the following manner:

10-digit control-number example:

• Source 003 = OCoLC

• Source 001 = on 1234567890

• 035$a field = (OCoLC)1234567890

More than 10-digits control-number example:

• Source 003 = OCoLC

• Source 001 = on 1234567890123

• 035$a field = (OCoLC)1234567891230

Voyager continues to support the previous OCLC control-number lengths such as 
the 9-digit and 8-digit control-number lengths for records that contain this 
information.

9-digit control-number example:

• Source 003 = OCoLC

• Source 001  = ocn 123456789

• 035$a field = (OCoLC)123456789

8-digit control-number example:

• Source 003 = OCoLC

• Source 001  = ocm 12345678

• 035$a field = (OCoLC)12345678

Importing Records From a File

The procedure for importing records from a file is shown in Procedure 3-1, 
Creating a New Record, on page 3-2.

Procedure  3-5.  Importing Records From a File

Use the following to import records from a file.

1. Select Record>Import>From new file or Record>Import>From previous file. 
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You can specify a default folder from which you want to import records in 
Cataloging’s Session Defaults and Preferences (see 11-15).

Result: The Select Import File dialog box opens (see Figure 3-12). 

NOTE:
For the Record>Import>From previous file command to be enabled, you must 
first select a new file (via the Record>Import>From new file command).  If you 
have not selected a new file, or if you exit Cataloging and log back in, the 
Record>Import>From previous file command will be grayed out.  

Figure 3-12. Select Import File dialog box

2. Select the file you want to import and click Open. 

Result: A dialog box opens, allowing you to select the specific record you want to 
import (Figure 3-13). 
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Figure 3-13. Selecting a record to import

The dialog box that opens when you select a file from which you want to import 
records includes the four columns described in Table 3-1. See Figure 3-13.   

NOTE:
The number of valid records and the number of invalid records in the file are 
displayed in the Status bar of the Cataloging module. Invalid records are not 
displayed in the dialog box listing records to import, and cannot be imported. For 
resolving problems with invalid records, see Invalid Recordson 3-27. 

3.  Highlight the record(s) you want to import. The number of records you can import at 
one time depends on your machine’s available memory.  

Result: The records are highlighted for import.

Table 3-1. Description of Column Headings for Import Record List

Column Name Description

Seq # Sequential count of the order in which the record 
was added to the import file.  For example, if the 
record was added to the import file fourth, the Seq # 
would be 4). 

ID Record ID assigned by the database or utility of 
origin.

Type Record type and bibliographic level from bytes 6 and 
7 of the Leader field.

Title/Heading The 245 field (if a bibliographic record), or the 1XX 
field (if an authority record).
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4. Click OK to import the selected record(s), or click Cancel to close the dialog box 
without importing the selected record(s).

Result: An imported record is displayed with a new 035 field which contains the 
old 003, followed by the 001. 

5. Save the records as work files, or save them to the database. 

Result: Duplication checking occurs when a record is saved to the database. For 
more information, see Save to Database on page 4-12. 

Importing Records From Another Database

In addition to importing records from a new or previously used file, it is also 
possible to import records from another database.  You can import records from a 
remote database directly from the Search dialog box, as well as perform a 
simultaneous search of many databases at once. 

In order to search for and import records from other databases, you must define 
the databases to which you want to connect.  This is done in the Database 
Definitions portion of the System Administration module. See the Voyager System 
Administration User’s Guide for details.

The procedure for importing records from another database is shown in 
Procedure 3-6, Importing Records From Another Database, on page 3-18.

Procedure  3-6.  Importing Records From Another Database

Use the following to import records from another database.

1. Click the Search button from the Cataloging toolbar, or select Record>Search.... 

Result: The Search dialog box opens.

2. Click Remote, or press Alt + R. 

Result: The Voyager Connection Options dialog box displays. See Figure 3-14. 

From this dialog box, you can choose the database(s) to which you want to 
connect, simultaneously search, and import records. 
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! IMPORTANT:
For the Remote... button to display on the Search dialog box, you must 
establish and define the databases you want to search and import records 
from in Voyager’s System Administration module. For details on this 
process, see the Voyager System Administration User’s Guide. 

Figure 3-14. Voyager Connection Options dialog box

From this dialog box, you can choose the database(s) to which you want to 
connect, simultaneously search, and import records. 

The Voyager Connection Options dialog box is divided into three sections.

• Available Locations

• Selected Locations

• Information About

Available Locations

This section contains a list of all the databases (as you have defined in System 
Administration), to which you are able to connect and search. You can navigate 
through this list, by clicking a particular database and using the up and down 
arrows on your keyboard. 

The list is divided into four columns.
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• The first column contains a check box indicating whether or not the 
database is selected as one to connect to and search.

• The Database Name column indicates the name of the database to which 
you are connecting.

• The Connection column indicates the type of connection for the database 
such as Voyager or Z39.50.

• The Type column indicates the type of database like Bibliographic or 
Citation. 

Remember, the database name, connection, type, and so on for each database is 
established and defined in the Database Definitions portion of Voyager’s System 
Administration module. See the Voyager System Administration User’s Guide for 
details.

Selected Locations

This section includes one column, listing the databases by database name you 
have selected. 

Information About

This section contains the description of the database highlighted in the list of 
Available Locations. The database does not have to be listed in Selected 
Locations for the description to display. This description is established in a free 
text field in the Database Definitions portion of Voyager’s System Administration 
module, and may or may not contain the name of the database or the associated 
institution’s online catalog. See the Voyager System Administration User’s Guide 
for details.

3. You can add and remove databases from the list of Available Locations.

Selecting a Database

From the list of Available Locations, highlight one by one the database(s) to 
which you want to connect, and click the Add>> button (or Alt + A). This moves 
the database name over to the list of Selected Locations (Figure 3-15). You can 
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also double-click the database in the list of Available Locations to select it. You 
can select as many databases as you want.  If you select more than one, they are 
searched simultaneously.  

TIP:
When a database is selected, a check mark displays in the check box 
located directly to the left of the database name in the list of Available 
Locations.

Removing a Database

To remove a database from the list of Selected Locations, highlight the database 
and click the Delete>> button (or Alt + D). You can also double-click the database 
in the list of Available Locations to remove it. To remove all the databases from 
the list of Selected Locations at once, click the Clear button.

Exiting the Voyager Connection Options Dialog Box

Click the Cancel button to exit the dialog box without connecting to a database(s), 
or press Alt + N. 

! IMPORTANT:
The default database searched during Cataloging’s staff-side searching is 
your local database. However, if you want to search your local database at 
the same time as another database(s), you must select Local Database 
from the list of Available Locations in addition to the other database(s) to 
which you want to connect and search. If you do not select Local 
Database, only the other database(s) you select are searched. 
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Figure 3-15. Selecting databases to search

4. Click the Connect button (or press Alt + C) to connect to the database(s) you have 
selected. If you are connecting to one database, the Remote Search dialog box 
opens, with the name of the database to which you are connected displayed after the 
colon (Figure 3-16). If you are connecting to more than one database, the 
Simultaneous Search dialog box opens. 

Figure 3-16. Remote Search dialog box
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5. Enter the criteria by which you want to search. For detailed information on searching 
for records in the Cataloging module, see the Search Dialog Box on page 3-31.

NOTE:
Searching for records in other databases, especially if they are non-Voyager 
databases, may be different from searching for records your local database. For 
instance, if you are performing a simultaneous search of your local database and 
a non-Voyager database, only the attributes that the databases have in common 
as defined in System Administration’s Database Definitions display in the Search 
by section of the Search dialog box. 

Thus, if you are searching a remote database and your local database 
simultaneously, and the only attribute the two databases have in common is the 
author attribute, you will only be able to perform a search by author. Additional 
searching rules apply if you are searching other databases such as connecting to 
multiple databases disables heading searches.   

Z39.50 databases do not support search limits. For more information on 
simultaneous searching, including setting up search attributes, see the Voyager 
System Administration User’s Guide.

6. After you enter your search criteria, click the Do Search button (or Alt + S). What 
displays next depends on whether or not you are searching multiple databases or a 
single database. 

NOTE:
If you receive an error message, such as Malformed Query or Search Failed, 
check your Database Definitions in System Administration module.

The Search Status dialog box opens if you are searching more than one 
database at once.  It displays the database name as defined in System 
Administration and the status of the search such as Searching, Receiving, or 
Done. See Figure 3-18. The Stop Search button allows you to stop the search at 
any time, if the status of the search is Searching or Receiving. 
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Figure 3-17. Search Status dialog box

To display the search results from the Search Status dialog box, click the Show 
Results button. This causes the Titles Index dialog box to open with the results 
for the databases you selected. See Figure 3-18. 

If you are searching your local database as well as a remote database(s), the 
Titles Index will display records in the sort order you specify in System 
Administration, depending on the type of search you performed. See the Voyager 
System Administration User’s Guide for details on sort order. If you are searching 
only remote databases and not your local database as well, the Titles Index 
displays in the sort order specified for the first database you selected in the 
Voyager Connection Options dialog box.

NOTE:
If you are searching more than one database, the Titles Index dialog box 
contains a Status button and a Database column. Click the Status button to bring 
up the Search Status dialog box. The Database column lists the name of the 
database name as established in System Administration. 

The Titles Index dialog box opens immediately if you are searching only one 
database. The Search Status dialog box does not display at all.
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Figure 3-18. Titles Index dialog box

For detailed information on the Titles Index dialog box, see Titles Index Dialog 
Box on page 3-48. 

7. Highlight the record you want to import on the Titles Index dialog box (or use the 
Ctrl or Shift keys to select more than one), and click OK (or double-click the record). 
The bibliographic record displays (Figure 3-19). 

Click Cancel to exit the Titles Index. 
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Figure 3-19. Record imported from another database

For details on bibliographic records, see the Bibliographic Recordssection on 2-3. 

8. Once the record is imported into your database, you can manipulate it as necessary 
and save it to your database or to a work file. For detailed information on saving 
records, see Saving and Printing Information on page 4-10. 

NOTE:
The title bar of the bibliographic record indicates that it has been imported.  See 
Figure 3-19. However, once the record is saved to your database, the title bar 
displays the bibliographic record ID.

After you have searched a remote database, the last search settings defined on 
the Voyager Connection Options dialog box applies until you either change the 
remote search settings or exit the Cataloging module. Thus, if you want to perform 
a standard staff-side search of your local database, you must reset your search 
settings so that only your local database is searched. 



 Ex Libris Confidential 3-27

Chapter 3: Creating, Opening, and Viewing Records

To do so, open the Search dialog box and click Remote.... Press the Clear button 
located toward the center of the dialog box, and then click Connect. This 
connects you only to your local database. In this case, it is not necessary for your 
local database in the list of Available Locations to be selected as a Selected 
Location for this to work. This is because your local database is the default 
database searched. 

Invalid Records

You cannot import records that are invalid from either a file or from a remote 
database. This is because the system cannot import a record that it cannot read. 
Generally speaking, the system cannot read a MARC record if its length as 
defined in the record’s first five bytes is incorrect, or if there is a critical element 
missing in the record such as a field tag displays without a subfield delimiter. If 
you encounter this situation, you can opt to either fix the record’s error such as in 
the file or manually key the record into the Cataloging module. 

RECOMMENDED:
If you attempt to fix the error in the file, we recommend that you re-export the 
record from your utility and then try the import again. 

Alternatively, provided you can associate the import record file with an appropriate 
application such as Notepad, you can display the record outside of Voyager, 
diagnose the problem (most likely there are missing field tags, subfield delimiters, 
end of field marks, and so on), make the necessary corrections, and then import 
the record. However, unless you are very familiar with MARC and have the 
available time, it is unlikely that this will be your preferred method. Keying the 
record into Voyager is generally the easiest and quickest solution for dealing with 
invalid records. 

TIP:
When it comes to invalid records, you should follow your utility’s 
procedures for reporting problems. 

Accessing Replaced or Deleted Files

In order to access deleted and discarded files, you must have permission to 
access the server. Every MARC record imported into Voyager that is either 
overlaid or deleted gets written to a deleted file; every incoming MARC record that 
is not added such as a duplicate or canceled is put into a discard file. 
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Using standard commands for your server, you can access and view the following 
files (created during the import and delete functions in the Cataloging module). 
You can FTP these files to the Cataloging client (actually your PC) using standard 
FTP procedures.

deleted.bib.marc

deleted.mfhd.marc

deleted.auth.marc

discard.bib.marc

discard.auth.marc

NOTE:
The files produced when you import records through Voyager’s Bulk Import batch 
job have the same names as the files listed above with the exception that .marc 
in the filename is replaced by .yyyymmdd.hhmm. For details on Bulk Import, see 
the Voyager Technical User’s Guide.

Creating New Bibliographic Records 
from Image Server

If your library has installed Image Server, you can create a new bibliographic 
record in Cataloging with a link to images. You can specify certain bibliographic 
information (such as Name, Title, and so on) on the File Documents folder and it 
will be transferred to a new bibliographic record in Cataloging. Bibliographic 
information is mapped into appropriate MARC fields to images displaying in the 
856 fields. From the File Documents dialog box in Image Server (Figure 3-20), 
you can create a new bibliographic record that contains the specified bibliographic 
information as well as the image link by pressing function keys. See Table 3-2.  

Table 3-2. Function Key Options for Creating Bibliographic Records

Function Key Description

F8 Creates an 856 tag(s) in a open bibliographic record in Cata-
loging for selected documents.

F9 Creates 856 tags in a open bibliographic record in Cataloging 
for all documents.

Alt-F8 Creates new bibliographic record in Cataloging for the values 
in Folder Name and creates 856 tags(s) for the selected docu-
ment(s).

Alt-F9 Creates a new bibliographic record in Cataloging for the val-
ues in Folder Name and creates 856 tags for all the docu-
ments in the folder.
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Figure 3-20. File Documents dialog box in ImageServer

When the bibliographic record is created in Cataloging (Figure 3-21), the 
information from the bibliographic template specified in Session Defaults is 
combined with the information from ImageServer to create the bibliographic 
record.  All of the information from both sources is entered into the record.  If there 
is no bibliographic template specified in Session Defaults, Cataloging supplies 
dummy information in the Leader and the 008 fields.  This information must then 
be edited before the record is saved to the database.  
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Figure 3-21. New Bibliographic Record in Cataloging

NOTE:
The Title field in ImageServer is required.  This information is placed into a new 
245 field in the new record during the transfer.  If the bibliographic template you 
are using already has a 245 field defined, delete one of the 245 fields before 
saving the record. You find duplicate fields in your new record if you have certain 
fields defined in the template and also specify the same information in the File 
Documents dialog box.

Generally, you will have a bibliographic template that is for the purpose of creating 
records with ImageServer links. Typically, you will want to define a template for 
the purpose of creating bibliographic records from ImageServer.  You would then 
select this template in your Session Defaults prior to adding any record.

Duplicate fields will only be detected if you have MARC validation on in Session 
Defaults and Preferences when you save the record.  If MARC Validation is off, 
be sure to check the record yourself for any duplications or other errors.

Viewing Information

This section discusses the different methods for viewing information through the 
Cataloging module such as the following.
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• Search dialog box

• Web server http POST

• Line items (Acquisitions in Cataloging)

• Holdings locations

• Linking and Unlinking Records

Search Dialog Box

The Search dialog box (Figure 3-22), available in all of the Voyager staff modules, 
provides a way to search your library’s catalog. It contains the following tabs.

• Keyword tab (see Keyword Tab and Keyword Searching on page 3-32)

• Index Selection tab (see Index Selection Tab on page 3-37)

• Builder tab (see Builder Tab and Builder Searching on page 3-44) 

• History tab (see History Tab on page 3-47)

Figure 3-22. Search dialog box

NOTE:
By default, the Index Selection tab displays when the Search dialog box opens. 
To navigate between search tabs, you can either click the appropriate tab or press 
the Alt key plus the letter underlined in the tab name.
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If configured, there can be two other features available on each tab regardless of 
the type of search. These features are remote searching and a user-defined 
search. See Remote Searching on page 3-74 and User-Defined Alternate Search 
Button on page 3-82.

User-defined limits can be applied to some searches. See Search Limits on 
page 3-84.

Keyword Tab and Keyword Searching

The Keyword tab (Figure 3-23) of the Search dialog box allows you to conduct 
keyword searches of all MARC fields and subfields in the bibliographic and 
holdings records. Users can specify the tag/subfields to search or specify an index 
to search by including the tag/subfield or index code before the search term.

NOTE:
The Holdings Boolean radio button is an optional feature which your site may or 
may not have chosen to implement.

Figure 3-23. Keyword tab of the Search dialog box

Limits can be applied to the Boolean and Free Text Keyword searches. However, 
they cannot be applied to the Holdings Boolean search. See Search Limits on 
page 3-84.
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Users must select a search type radio button and enter search criteria in the 
Search for field to enable the Do Search button. See Table 3-3 for a description 
of the options available on the Keyword tab to invoke a keyword search. 

NOTE:
An (R) in the first column of the table designates a required entry. Unless 
otherwise specified, characters can be alphabetic or numeric, uppercase and/or 
lowercase, and may include punctuation and spaces.

Table 3-3. Description of the Keyword tab

Option Description

Boolean Performs a keyword search of the bibliographic record 
using Boolean terms (and, or, not) without using 
relevance.

When you select Boolean, remember to insert Boolean 
terms. Otherwise, you receive a Malformed Query 
error message.

Free Text Performs a keyword search of the bibliographic record 
using relevance without Boolean operators.

Holdings Boolean

(optional feature)

Performs a keyword search, without using relevance, of 
holdings records in your local database.

Provides the flexibility to locate coded data, for example, 
inside the call number of MARC holdings records.

Must use Boolean operators if using more than one 
search term.

The default index searched is HKEY.

NOTE:
This search is not available for remote searching.
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Search for

(R)

Enter search criteria in this field. Search criteria 
separated by spaces may require quotation marks to 
achieve the intended result. Example:

“world war”

“41051654 //r944”

Wildcard characters are as follows.

• ? (question mark)

Use the question mark for multiple-character, 
wildcard searches at the beginning, middle, or end 
of your search terms.

• % (percent sign)

Use the percent sign for single-character wildcard 
searches.

NOTE:
Wildcard characters can be used in Free Text searches, 
Builder searches, and command line searches (that do 
not use a subfield-limited keyword index). Wildcard 
characters are not available for use with Z39.50 
searches.

Add one of the following operators before the search 
term (in a Free Text search) to specify additional 
characteristics.

• + (plus sign) 

The term must display in the record.

• ! (exclamation point) 

Records with the term are to be excluded.

• * (asterisk) 

The term is important.

You can also do command line searching. See Command 
Line Searching on page 3-35.

Table 3-3. Description of the Keyword tab

Option Description
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Results of Boolean and Free Text searches are displayed in a Titles Index dialog 
box, and results of Holdings Boolean searches are displayed in a Holdings Index 
dialog box. See Titles Index Dialog Box on page 3-48.

Command Line Searching

Users can do command line searching by specifying MARC record tags/subfields 
to search or an index to search and the existing rules for Boolean searching.

Default Tab Identifies which tab displays as the default when the 
Search function is initiated.

This button is inactive on the tab selected as the default.

At installation, the Index Selection tab is the default.

This option is available on the following tabs:  Keyword, 
Index Selection, and Builder.

NOTE:
This button does not display when Retain Last Search is 
selected.

Do Search Executes the search.

Cancel Cancels the search and closes the Search dialog box.

Clear Deletes the search term(s) in the Search for text box.

Limit Opens the Search Limits dialog box, where you can limit 
your search by language, location, date, or other 
variables you’ve configured.

NOTE:
Limits cannot be applied to holdings keyword searching.

See Search Limits on page 3-84.

Remote The Remote button, if configured, allows users to search 
remote databases.

See Remote Databases on page 3-74

URI Search If configured, this button invokes a user-defined URI 
(Uniform Resource Identifier) to search outside the 
Voyager database. 

See User-Defined Alternate Search Button on page 3-82.

Table 3-3. Description of the Keyword tab

Option Description
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• To search keyword composite indexes use the 4 letter code (see the 
Voyager System Administration User’s Guide). For example, the search 
code NKEY (author name) searches by tags 100 aqd, 110 abcdefgl, and so 
forth. Another command line search example using GKEY as the keyword 
index code is as follows.

GKEY pinnochio and GKEY disney 

• To search tags, use the three-numeric character of the tag followed by the 
single subfield (245b, 010a, 035a, 650x). The search is keyword except for 
number fields such as LCCN, ISBN, and ISSN which are left-anchored.

Truncation as well as boolean operators and quotation marks for phrase 
searching may be used (245a text? AND commentary) for the keyword 
indexed searches. You may also search for more than one tag at a time 
(650a "middle eastern literature" AND 100a pritchard). 

Other Keyword Search Considerations/Options

Optionally, your system administrator may implement dynamic noise word 
reduction to improve performance of keyword searches. This option eliminates 
common words from a user’s query for the purpose of searching but retains them 
for the purpose of relevance ranking.

The following is a list of stop words used with this feature.

• AND

• OR

• NOT

• OF

• IN

• THE

• WITH

• TO

• FOR

The dynamic noise word reduction capability is set with NOISEWORDFILTER in 
the server-side voyager.ini file. Refer to the Voyager Technical User’s Guide or 
see your system administrator for more information.
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Index Selection Tab

Headings/Index Selection searching allows users to perform left-anchored 
bibliographic searches, holdings searches, authorities searches, and headings 
searches. In addition to system defined searches, your institution can define 
additional searches. Search types are created in System Administration. See the 
Voyager System Administration User’s Guide for details.

Limits can be applied to those Index Selection searches conducted on left-
anchored indexes. However, they cannot be applied to headings searches. See 
Search Limits on page 3-84.

Figure 3-24 displays the Index Selection tab of the Search dialog box.

Figure 3-24. Index Selection tab of the Search dialog box

Table 3-4 describes the Index Selection tab. When a heading search is selected 
from the drop-down menu, the user must select either the Find or Browse radio 
button to govern the search. See Find and Browse Searches on page 3-41.
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NOTE:
An (R) in the first column of the table designates a required entry. Unless 
otherwise specified, characters can be alphabetic or numeric, uppercase and/or 
lowercase, and may include punctuation and spaces.

Table 3-4. Description of the Index Selection tab

Name Description

Find Find searches match specific records of the Search by type 
to the terms entered in the Search for field.

The result is a finite number of records.

See Find and Browse Searches on page 3-41 for more 
information.

Browse Displays an index of headings that can be browsed based on 
the Search by selection, any corresponding filter selections, 
and a Search for value.

Available with headings or call number searches.

See Find and Browse Searches on page 3-41 for more 
information.

Keyword Displays a headings list from which to select when exact 
word order or the initial words are unknown.

See Headings Keyword Searches on page 3-42 for more 
information.

Search type 
drop-down list

(R)

Unlabeled field containing a drop-down menu of searches 
available.

The list is determined by search usage with the most used 
search at the top of the drop-down.

The types of searches are system defined and user defined 
in the System Administration module. See the Voyager 
System Administration User’s Guide.

NOTE:
OPAC headings searches and Staff headings searches are 
available in the Cataloging module. However, only OPAC 
headings searches are available in the Acquisitions and 
Circulation modules.
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Heading Types
Filter

Users can select a Heading Type filter to further limit a 
heading or a headings keyword search. Resulting records 
must contain the heading type selected and match the search 
criteria.

The types of searches are system defined.

NOTE:
These filters may be suppressed in the System 
Administration module.

Locations Filter Users can select a Locations filter to further limit a search 
when doing call number searches. 

Locations are defined locally in the System Administration 
module. See the Voyager System Administration User’s 
Guide.

TIP:
By limiting a call number search by location, you can 
get an online shelf list.

Search for

(R)

Enter your search term(s) or phrase(s) in the Search for field 
(1-149 characters).

Use Boolean operators (and, or, not) to achieve the best 
match with your search string.

Use quotation marks to identify phrases.

Use a question mark (?) to truncate the search term if not 
automatically truncated. See Automatic Truncation for Index 
Selection Searches on page 3-84 for more information.

Default Tab Identifies which tab displays as the default when the Search 
function is initiated.

This button is inactive on the tab selected as the default.

At installation, the Index Selection tab is the default.

This option is available on the following tabs:  Keyword, 
Index Selection, and Builder.

NOTE:
This button does not display when Retain Last Search is 
selected.

Table 3-4. Description of the Index Selection tab

Name Description
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Save Settings Saves values on the current search tab.

The search code for the index is saved.

The saved settings display each subsequent time this tab is 
accessed.

To change settings, enter new values on the tab and click 
Save Settings.

NOTE:
When the index is deleted, the index code is changed, or it is 
suppressed, a standard error message is displayed. When 
the user responds by clicking OK, the default setting is 
cleared and the first index in the list and the first connector 
display.

This option is available on the following tabs:  Index 
Selection and Builder.

NOTE:
This button does not display when Retain Last Search is 
selected.

Do Search Executes the search.

Cancel Cancels the search.

Clear Deletes the search term(s) in the Search for field.

Remote The Remote... button, if configured, allows users to search 
remote databases.

See Remote Databases on page 3-74.

Limit Opens the Search Limits dialog box, where you can limit 
your search by language, location, date, or other variables 
you’ve configured.

NOTE:
The Limits button is not available for Headings or Holdings 
Keyword searches.

See Search Limits on page 3-84.

URI Search If configured, this button invokes a user-defined URI (Uniform 
Resource Identifier) to search outside the Voyager database.

See User-Defined Alternate Search Button on page 3-82.

Table 3-4. Description of the Index Selection tab

Name Description
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Results of searches from the Index Selection tab display in either the Titles 
Index dialog box or Headings List dialog box. See Titles Index Dialog Box on 
page 3-48 and Headings List Dialog Box on page 3-57.

Find and Browse Searches

The radio buttons of either Find or Browse are available if you are performing a 
heading or call number search. Selecting Find or Browse affects the search results 
received. 

A Find search returns specific, finite results that match the search criteria. For 
example, a Find subject heading search (OPAC Subject Headings Search) for 
war? returns the results shown in Figure 3-25. 

Figure 3-25. Search results after doing a find subject heading search for war?

The Browse search allows users to scroll through an institution’s list of headings. 
For example, a Browse subject heading search (OPAC Subject Headings Search) 
for war? returns the results shown in Figure 3-26.
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Figure 3-26. Search results after doing a browse subject heading search for war?

In this example, the system displays the Browse Headings List that users can 
scroll through using the arrow buttons (Table 3-10) to find the wanted heading.

Heading Searches by Call Number

When doing an Index Selection search by call number, Voyager accepts Dewey 
call numbers that have more than one decimal point as well as call numbers that 
only have a decimal point after the Dewey root/Cutter combination such as 305.1 
M887 no.2 and 506 N56 v.8. Also, normalization of Dewey call numbers including 
dates was adjusted to ensure proper sorting in call number indexes such as 321 
A65 1998.

Regarding the display of call numbers with 852‡k and 852‡m (call number prefix 
and suffix) fields, you can include prefixes and suffixes in all of Voyager’s call 
number displays.

When you perform a Browse search for a call number with a prefix or a suffix, you 
see the prefix or suffix in the results list as well as in the actual record itself.

Headings Keyword Searches

The Keyword radio button is active on the Index Selection tab when the 
following indexes are selected from the drop-down list.

• Staff Name Headings Search

• Staff Title Headings Search

• Staff Name/Title Headings Search



 Ex Libris Confidential 3-43

Chapter 3: Creating, Opening, and Viewing Records

• Staff Subject Search

• OPAC Name Headings Search

• OPAC Title Headings Search

• OPAC Name/Title Search

• OPAC Subject Search

Consistent with all headings searches, the Limit button is disabled when a 
headings index is selected from the drop-down list.

Command line syntax may be used with headings keyword searches. Boolean 
operators such as and, or, or not should be used to combine search strings.

Search terms in quotation marks are searched as a phrase. For example, “civil 
war” is not the same search as civil AND war.

Search results display in the Headings List dialog box without relevance ranking. 
See Figure 3-27. The headings are ordered alphabetically by normal heading.

Figure 3-27. Headings List for Headings Keyword Search

NOTE:
Authority record access is available via the Authority button.

Headings Keyword Searches are not available on the Builder tab.
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Builder Tab and Builder Searching

The Builder tab of the Search dialog box allows you to build complex searches 
using multiple fields, search terms, and Boolean operators.

Builder searches are Keyword searches. Therefore, limits can be applied. See 
Search Limits on page 3-84.

Figure 3-28 shows the Builder tab of the Search dialog box.

Figure 3-28. Builder tab of the Search dialog box

Table 3-5 describes the Builder tab.
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NOTE:
An (R) in the first column of the table designates a required entry. Unless 
otherwise specified, characters can be alphabetic or numeric, uppercase and/or 
lowercase, and may include punctuation and spaces.

Table 3-5. Description of the Builder tab

Name Description

Search for

(R)

Enter your search term(s) or phrase in the Search for field (1-
149 characters).

Wildcard characters are as follows.

• ? (question mark)

Use the question mark for multiple-character, wildcard 
searches at the beginning, middle, or end of your 
search terms.

• % (percent sign)

Use the percent sign for single-character wildcard 
searches.

NOTE:
Wildcard characters are not available for use with Z39.50 
searches.

Search term 
options drop-
down list

Unlabeled drop-down menu allowing the operator to determine 
how to search. Values are preset by the system.

• Any of these places an implied or between the search 
terms.

• All of these places an implied and between terms.

• As a phrase searches an if the terms are placed in 
quotes.

Search in Drop-down menu of keyword search types.

Values are preset by the system and user-defined Keyword 
indexes.

NOTE:
MFHD keyword index searching and Journal index searching 
are not available in builder searching because they cannot be 
combined with bibliographic keyword indexes. The Journal 
index is a title keyword search with a journal type limit applied 
to it.

Boolean
buttons

Use the And, Or, or Not buttons to conduct a
boolean search with additional search criteria.
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Search terms Unlabeled box containing your search terms and, if used, 
accompanying Boolean operators.

Edit Allows you to edit any search term or phrase you select from 
the unlabeled search term box.

Delete Deletes any selected search term from the
unlabeled search term box.

Default Tab Identifies which tab displays as the default when the Search 
function is initiated.

This button is inactive on the tab selected as the default.

At installation, the Index Selection tab is the default.

This option is available on the following tabs:  Keyword, Index 
Selection, and Builder.

NOTE:
This button does not display when Retain Last Search is 
selected.

Save Settings Saves values on the current search tab.

The search code for the index is saved.

The saved settings display each subsequent time this tab is 
accessed.

To change settings, enter new values on the tab and click 
Save Settings.

NOTE:
When the index is deleted, the index code is changed, or it is 
suppressed, a standard error message is displayed. When the 
user responds by clicking OK, the default setting is cleared 
and the first index in the list and the first connector display.

This option is available on the following tabs:  Index Selection 
and Builder.

NOTE:
This button does not display when Retain Last Search is 
selected.

Do Search Executes the search.

Cancel Cancels the search.

Table 3-5. Description of the Builder tab

Name Description
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Results from Builder searches display in the Titles Index dialog box, see Titles 
Index Dialog Box on page 3-48.

History Tab

The History tab (Figure 3-29) gives you access to all searches you performed 
during the current session. For each search you performed, it lists the search 
parameters and the number of records returned (#Hits).

Clear Deletes the search term(s) in the Search for field.

Limit Opens the Search Limits dialog box.

NOTE:
The Limits button is not available for Heading searches.

See Search Limits on page 3-84.

Remote The Remote... button, if configured, allows users to search 
remote databases.

See Remote Databases on page 3-74.

URI Search If configured, this button invokes a user-defined URI (Uniform 
Resource Identifier) to search outside the Voyager database.

See User-Defined Alternate Search Button on page 3-82.

Table 3-5. Description of the Builder tab

Name Description



3-48  Ex Libris Confidential

Cataloging User’s Guide

Figure 3-29. History tab of the Search dialog box

From the History tab, you can re-execute searches previously performed or edit 
previous search statements.

! IMPORTANT:
The History tab does not retain information about search limits. If you re-
execute or edit a search from the History tab, any current limits in effect 
are used instead of any limits you previously specified.

Titles Index Dialog Box

The Titles Index dialog box (Figure 3-30) displays the results of Keyword 
searches, whether conducted from the Keyword tab (a Boolean or Free Text 
search) or the Builder tab, and the results of left-anchored searches conducted 
from the Index Selection tab.

NOTE:
The maximum number of records returned is 10,000.
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Figure 3-30. Titles Index dialog box

TIP:
Click the Titles Index button (Figure 3-31) or Display>Title Index to re-
access the results of the most recent Keyword search when the Titles 
Index dialog box is closed.

Figure 3-31. Titles Index Button

By default the Titles Index dialog box displays the following. (See Search Results 
List Re-Sort Options on page 3-51 for a description of sort options for displaying 
Titles Index results.)

• Relevance column (for free text searches)

• Title

• Author

• Date
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The title, author, and date columns can be reconfigured to display other 
bibliographic data. These columns are configured on the Search Results tab 
when defining indexes in the System Administration module. See the Voyager 
System Administration User’s Guide for more information.

NOTE:
If your search retrieves more than 100 titles, a Stop button becomes active. You 
can then click the Stop button to cancel the retrieval of more records (Figure 3-
32).

Figure 3-32. Stop button seen with more than 100 search results

See Table 3-6 for a description of the Titles Index dialog box.

Table 3-6. Description of the Titles Index dialog box

Name Description

Font Select the font used to display text in the Titles Index 
dialog box.

NOTE:
These boxes display the Unicode character set in all 
Voyager modules.

Sort By Displays drop-down list of options to re-sort search 
results.  See Search Results List Re-Sort Options on 
page 3-51.

Relevance 
Column

Displays relevance bars for Free Text searches.

Bibliographic 
Information 
Column(s)

Columns containing bibliographic information (for 
example, full title, author, and format).

These are specified when defining searches in the 
System Administration module.
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Search Results List Re-Sort Options

The following options are available for re-sorting a search results list.

• Author

• Publish Date

• Publish Date Descending

• Relevance (if used for the search)

• Title

• Search results column headers such as Format, for example

(depending on the [Global Log] settings in the Voyager.ini file; see 
Re-Sort Configuration Options on page 3-52 for more information)

See Figure 3-33.

These options display when a non-headings search is performed against the local 
database or a single remote Voyager database.

Click one of the options from the Sort By drop-down list to execute a new sort.

Optionally, you may click a column heading to invoke a Quick Sort of the search 
results list using the column data.  See Re-Sort Configuration Options on page 3-
52 for more details of configurable options.

OK After clicking the OK button, the response of the sys-
tem varies depending on the type of search con-
ducted.

See Keyword Search in the Cataloging Module on 
page 3-106.

Cancel Closes the Titles Index dialog box.

Search Returns to the Search dialog box cleared of previous 
entries unless the Retain Last Search check box is 
selected in session preferences.

Select All Opens all of the returned records.

Clear All Clears all selected records.

Table 3-6. Description of the Titles Index dialog box

Name Description
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Selecting a Quick Sort value once re-sorts the list in ascending order based on the 
value selected. Selecting the same Quick Sort value a second time re-sorts the 
list in descending order. This applies to the Quick Sort capability selectable from 
both the Sort By drop-down list and by clicking a column heading when 
configured for sort options use.  See Re-Sort Configuration Options on page 3-52 
for more information.

Figure 3-33. Search results sort options

Re-Sort Configuration Options

The Sort By options that display in the Titles Index dialog box are determined by 
sort options configured in the [Global Log] stanza in the Voyager.ini file. 
The configurable sort options are as follows.

• ServerSortList=Y/N

• ASCIISortList=Y/N

• ASCIISortColumn=Y/N

See the Voyager Technical User’s Guide for more information regarding 
configuring the [Global Log] stanza in the Voyager.ini file.

See Table 3-7 for the system default when no options are configured in the 
[Global Log] stanza.  

Table 3-7. Default Re-Sorting Options (when none are configured)

Option Variable

ServerSortList Y
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ServerSortList

When ServerSortList=Y is implemented, the sort function utilizes Voyager 
indexes that follow certain rules to handle punctuation and other non-
alphanumeric characters that exist in a MARC record. For example, O’Connor 
becomes OConnor.

When one of the following Sort By options is selected from the drop-down list 
(see Figure 3-33), the system automatically executes a Voyager search on the 
server and displays new search results based on the sort order selected.

• Author

• Publish Date

• Publish Date Descending

• Relevance (if used for the search)

• Title

ASCIISortList

When ASCIISortList=Y is implemented, the system does an alphabetic sort 
with diacritics removed using Visual Basic on the client to process the existing 
search results list into the new sort order determined by the selection of one of the 
following Sort By options (below the line).

• Relevance (Quick Sort)

• Title (Quick Sort)

• “Column Heading Name” (Quick Sort)

such as Format (Quick Sort)

This method is faster because it does not re-execute the search query against 
Voyager indexed data on the server. Instead, it uses facilities on the client to 
process the sort. As a result, for example, leading articles are considered part of 
the data to sort versus ignored data as in a Voyager server sort.

ASCIISortList N

ASCIISortColumn N

Table 3-7. Default Re-Sorting Options (when none are configured)

Option Variable
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ASCIISortColumn

When ASCIISortColumn=Y is implemented, the system does an alphabetic sort 
with diacritics removed using Visual Basic on the client to process the existing 
search results list into the new sort order determined by the selection (mouse 
click) of one of the column headings.

This method is faster because it does not re-execute the search query against 
Voyager indexed data on the server. Instead, it uses facilities on the client to 
process the sort. As a result, for example, leading articles are considered part of 
the data to sort versus ignored data as in a Voyager server sort.

NOTE:
The Quick Sort facility may be accessed through either of the following methods 
when the appropriate configuration is implemented in the [Global Log] stanza.

• Click the column heading for the desired sort

• Select one of the Quick Sort (below the line) options from the Sort By drop-
down list

Considerations for Re-sorting Search Results

The following list highlights some considerations.

• When a re-sort is executed, the original sort order is lost except when 
relevance is used.

• If a search result is truncated to a maximum of 10,000 results, the re-sort 
option retrieves different results than the original set since the sort order by 
value is different.

The re-sort drop-down list options only display with bibliographic result sets that 
display a list of titles. The following are examples of types of searches that provide 
re-sort options.

• Keyword, Index Selection, or Builder searches

• Keyword searches with relevance and without relevance

• MFHD keyword searches

• Command line searches with relevance and without relevance

• Date searches

• Find searches

• Left-anchored, non-headings searches

• Selections on headings lists of headings with multiple titles
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The Sort By drop-down list does not display with bibliographic results sets 
meeting any of the following criteria.

• A list of headings

• Browse searches

• Remote Z39.50 connections

• Remote connections to non-Voyager catalogs

• Remote connections to multiple Voyager catalogs

Holdings Index Dialog Box

The Holdings Index dialog box (Figure 3-34) returns results of a Holdings 
Boolean search conducted from the Keyword tab.

NOTE:
The maximum number of records returned is 10,000.

Figure 3-34. Holdings Index dialog box

The Holdings Index dialog box displays the following:

• Holdings Record ID

• Title

• Author

• Date
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The title, author, and date columns can be re-configured to display other 
bibliographic data on the Holdings Index dialog box. These columns are 
configured on the Search Results tab when defining indexes in the System 
Administration module. See the Voyager System Administration User’s Guide for 
more information.

NOTE:
If your search retrieves more than 100 titles, a Stop button becomes active. You 
can then click the Stop button to cancel the retrieval of more records (Figure 3-
32).

Figure 3-35. Stop button seen with more than 100 search results

See Table 3-8 for a description of the Holdings Index dialog box.

Table 3-8. Description of the Holdings Index dialog box

Name Description

Font Select the font used to display text in the Holdings 
Index dialog box.

NOTE:
These boxes display the Unicode character set in all 
Voyager modules.

Holdings 
Record
Column

Displays the holdings record ID for holdings keyword 
searches.

Bibliographic 
Information 
Column(s)

Columns containing bibliographic information (for 
example, full title, author, and format).

These are specified when defining searches in the 
System Administration module.

OK After clicking the OK button, the response of the sys-
tem varies depending on the type of search con-
ducted.

See Keyword Search in the Cataloging Module on 
page 3-106.
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Headings List Dialog Box

Results of Index Selection headings searches display in a Headings List dialog 
box (Figure 3-36).  

NOTE:
A left-anchored or non-headings search from the Index Selection tab returns 
results in a Titles Index dialog box. See Titles Index Dialog Box on page 3-48. 

Figure 3-36. Headings List dialog box

In a Headings List dialog box, you can view the following.

• References

• Ref/Notes

• Notes/Scope Notes

Cancel Closes the Holdings Index dialog box.

Search Returns to the Search dialog box cleared of previous 
entries unless the Retain Last Search check box is 
selected in session preferences.

Select All Opens all of the returned records.

Clear All Clears all selected records.

Table 3-8. Description of the Holdings Index dialog box

Name Description
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• Narrower terms

• See and/or See Also reference(s) associated with the heading

See Table 3-9 for a description of associated Headings List information.

Optionally, headings with subdivisions display with dashes.  See Figure 3-37. To 
implement the display of dashes for headings with subdivisions, see the 
description of System>Miscellaneous options in the Voyager System 
Administration User’s Guide.

Table 3-9. Headings List Information

Type Description

Authorized This term displays if the heading is in the 1XX field of 
the authority record.

Reference This term displays if the heading is not an authorized 
heading but is a see from reference from the 4XX 
fields.

Auth/Ref This term displays if the heading is in the 1XX in an 
authority record and has references (5XX fields) in 
that same record and/or is itself a cross-reference in 
another authority record.

Note This term displays if the heading’s authority record 
contains scope notes. 
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Figure 3-37. Optional dashes for headings with subdivisions

TIP:
Access the Headings List dialog box by selecting Display>Headings List 
or by clicking the Headings List button (Figure 3-38). 

Figure 3-38. Headings List Button

NOTE:
If your search retrieves more than 100 headings, the Stop button becomes active. 
You can then click the Stop button to cancel the retrieval of more headings 
(Figure 3-39).

Figure 3-39. Stop button seen with more than 100 search results
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Table 3-10 describes the Headings List dialog box containing the search results.

Table 3-10. Description of the Headings List dialog box

Name Description

Font Drop-
down

Select the font used to display text in the Headings List
dialog box.

NOTE:
These dialog boxes display the Unicode character set in all 
Voyager modules.

[additional
references]

Unlabeled column identifying if there are References,
Ref/Notes, Notes as well as Scope Notes, Narrower terms, 
See and/or See Also reference(s).

Bibs Column Number of bibliographic records associated with this heading.

Heading
Column

Name of the Heading returned.

Heading Type 
Column

Type of heading returned.

OK Button Active once a heading is selected.

Opens the Titles Index dialog box if there are bibliographic 
records associated with the heading.

See Titles Index Dialog Box on page 3-48.

Cancel Button Closes the Headings List.

Search Button Opens the Search dialog box.

Authority
Button

Opens the Reference Information dialog box. Active if there 
is a Ref/Note, Reference, or Note, and so on.

See Reference Information Dialog Box on page 3-61.

Clear All
Button

Not active with a Browse search. Clears the selected head-
ings. 

Copy Button For browse searches only, clicking the Copy button copies 
the contents of the current heading into the clipboard, which 
may be pasted into the variable fields portion of a MARC 
record. It is also used when validating a heading. See the 
Voyager Cataloging User’s Guide.

Only available in the Cataloging module.
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Reference Information Dialog Box

Additional Reference Information can be displayed for titles that display the 
following in the Headings List dialog box.

• Authorized

• Reference

• Note

• Ref/Note

By clicking the Authority button or right clicking the row, the Reference 
Information dialog box opens (Figure 3-40).

Figure 3-40. Reference Information dialog box

This dialog box lists whether authority record information is available as well as 
Scope Notes, Narrower terms, See and/or See Also reference(s) for the selected 
heading. 

Navigation 
Buttons

After a browse search, use these buttons to navigate through 
the results.

Table 3-10. Description of the Headings List dialog box

Name Description
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NOTE:
Multiple Scope Notes display in the order in which they occur in the MARC record.

The Reference Information dialog box displays information in order by type of 
reference and then alphabetically by heading text. The reference types should be 
ordered as follows.

1. Authorized Record

2. Scope Note

3. See Reference

4. Earlier Heading

5. Acronym

6. Musical Composition

7. Broader Term

8. Narrower Term

9. See Also Reference

To retrieve information about one of the references, select the appropriate 
reference and click the Retrieve button. 

NOTE:
When the headings are retrieved from the server, they are normalized using the 
standard authority normalization rules to ensure that the alphabetic sort returns 
the headings in the proper order.

Scope Notes

Retrieve the scope notes for the heading by selecting it and clicking the Retrieve 
button (Figure 3-41).

Figure 3-41. Scope Notes for a heading
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Narrower Term

Find a narrower term by selecting it and clicking the Do Search button. See 
Figure 3-42.

Figure 3-42. Narrower term for a heading

The system does a new search for the narrower term. See Figure 3-43.

Figure 3-43. Search results from the narrower term

See Also

From the Reference Information dialog box, the operator can do a new search for 
the see also term by selecting it and clicking the Do Search button. See Figure 3-
44.
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Figure 3-44. See Also for a heading

The system then does a new search for the see also term. Figure 3-45 displays 
the search results of the See Also term.

Figure 3-45. See Also search results

Select one or more authority records Dialog Box

The Select one or more authority records dialog box displays when an 
Authorized record is selected from the Headings List dialog box or when an 
Authority Record is selected and you click Retrieve from the Reference 
Information dialog box. See Figure 3-46.
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Figure 3-46. Select one or more authority records dialog box

The records in the Select one or more authority records dialog box sort by 
tracing tag of the reference such as 4XX and 5XX and then alphabetically by 
heading within each tracing type.

NOTE:
Headings are  deduped prior to being displayed on the Select one or more 
authority records dialog box. Therefore, fewer entries display in this dialog box 
than the actual count of headings.

Perform a Keyword Search

The procedure for performing a keyword search in the Voyager modules is shown 
in Procedure 3-7, Performing a keyword search.

Procedure  3-7.  Performing a keyword search

Use the following to conduct a keyword search.

1. From the Search dialog box, click the Keyword tab.

Result: The Keyword tab opens (see Description of the Keyword tab on page 3-
33 for more information).

2. Select the wanted search option, either the Boolean radio button, the Free Text 
radio button, or the Holdings Boolean radio button.
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3. Enter your search term(s) or phrase(s).

Result: The search can now be executed (see Figure 3-47).

Figure 3-47. Completed Keyword tab

4. Select Do Search to execute the search, Cancel to cancel the search, Clear to 
delete the search terms, or Limit to set limits for this search. See Setting Search 
Limits on page 3-99.

Result: If the above search is performed, a Titles Index dialog box opens with 
the results (see Figure 3-48). 
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Figure 3-48. Titles Index dialog box after performing a free text keyword search

If a Holdings Boolean search has been conducted the Holdings Index dialog box 
shows the results (see Figure 3-49).

Figure 3-49. Holdings Index dialog box

5. Select the title or holdings record you want and select one of the option buttons. See 
Description of the Titles Index dialog box on page 3-50 for information.



3-68  Ex Libris Confidential

Cataloging User’s Guide

Result: If the OK button is clicked, the response of the system varies depending 
on the type of search conducted.

See Keyword Search in the Cataloging Module on page 3-106.

Perform an Index Selection Search

The procedure for performing an Index Selection search is shown in Procedure 3-
8, Index Selection Searching.

Procedure  3-8.  Index Selection Searching

Use the following to perform an Index Selection search.

1. Access the Search dialog box and click the Index Selection tab.

2. Select the type of search wanted from the drop-down menu (see Figure 3-50).

Figure 3-50. Type of search
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OPTIONAL:
3. Select an option button of either Find, or  Browse if you are performing a heading or 

call number search.

OPTIONAL:
4. Select a Heading Types Filter (if doing a heading or call number search). Hold the 

Ctrl key down to select more that one filter.

OPTIONAL:
5. Select a Locations Filter (if applicable) from the list box(es). Hold the Ctrl key down 

to select more that one filter.

OPTIONAL:
6. Click the Limits button to display the Search Limits dialog box and further limit your 

search. See Search Limits on page 3-84.

7. Enter your search term in the Search For field (see Figure 3-51).

Figure 3-51. Completed Index Selection tab

8. Click the Do Search button to perform the search.

Result: If you performed a Non-Heading search, the Titles Index dialog box 
shows matching titles.
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If you performed a Heading search, the Headings List dialog box shows all 
matching headings. Click the heading that most closely matches what your are 
searching for, then click the OK button (or double-click the heading.) The Titles 
Index dialog box then shows the matching titles. See Titles Index Dialog Box on 
page 3-48.

9. Click the item you want to select it in the Titles Index dialog box and click OK. 
Optionally, double-click the title to select it.

Result: If the OK button is clicked, the response of the system varies depending 
on the type of search conducted.

See Index Selection Search in the Cataloging Module on page 3-113.

Perform a Builder Search

The procedure for Performing a Builder search is shown in Procedure 3-9, 
Performing a Builder search.

Procedure  3-9.  Performing a Builder search

Use the following to perform a Builder search.

1.  Click the Builder tab from the Search dialog box.

Result: The Builder tab opens (see Figure 3-52).
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Figure 3-52. Builder search tab

2. Enter a search term(s) or phrase(s) in the Search for field.

3. Select the “any,” “all,” or “phrase” option from the drop-down list to the right of the 
Search for field. See Description of the Builder tab on page 3-45 for a description 
of the options.

4. Select a Search In field for matching the search terms.

OPTIONAL:
5. Click any of the Boolean operator buttons, And, Or, or Not, to use multiple search 

rows. Repeat steps 3 - 5.

Result: The row of search terms displays in the pane below the Search In field. 

NOTE:
The Boolean operator does not display in the row until you enter another search 
term and click an additional Boolean operator button (to be used with the next 
search term, if you enter another).

Figure 3-53 shows a search using multiple search terms in combination with the 
following.

• All three options for relationships between terms (any, all, phrase)
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• Various Search In fields (Title, the default Keyword Anywhere, Subject, 
and Author Name)

• Two Boolean operators (AND and OR)

Figure 3-53. Builder tab with multiple search terms and relationships

OPTIONAL:
6. Edit any row of search terms by clicking the row, then the Edit button, then repeating 

steps 3 - 5.

Delete any row of search terms by clicking the row, then clicking the Delete button. 
Delete the entire pane by clicking the Clear button.

OPTIONAL:
7. Click the Limits button to display the Search Limits dialog box and further limit your 

search. See Search Limits on page 3-84.

8. To search, click the Do Search button. (To cancel and close the Search dialog box, 
click the Cancel button.)

Result: The Titles Index or Headings List displays the results of the search.
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See Builder Search in the Cataloging Module on page 3-117.

Access/Review the History Tab

The procedure for accessing searches from the History tab is shown in 
Procedure 3-10, Accessing searches from the History tab.

Procedure  3-10.  Accessing searches from the History tab

Use the following to access a search from the History tab.

1. Click the History tab from the Search dialog box.

Result: The list of previous searches displays.

2. Click the row of the search you want to access.

Result: The row highlights.

OPTIONAL:
3. Click the Limits button. 

Result: The Search Limits dialog box displays. For information about setting 
limits. See Search Limits on page 3-84.

OPTIONAL:
4. Click the Edit button. 

Result: The correct tab opens on the Search dialog box and you can edit and
re-execute the search from there.

5. Click the Do Search button.

Result: This executes the previous search that you selected.
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Remote Searching

The Remote... button found on the Search dialog box enables you to select, 
connect to, search, and import records from other databases.

The Remote... button displays only if you have defined remote databases to 
which you can connect in System Administration. See the Voyager System 
Administration User’s Guide for details.

Remote Databases

If remote databases are defined in the Database Definitions workspace of the 
System Administration module, users can search these databases in the 
Acquisitions and Cataloging modules. See the Voyager System Administration 
User’s Guide for details on defining databases.

You can include your local database in the remote database search which creates 
a simultaneous search of local and remote databases.

If you have opened the Search dialog box and you have set up remote searches 
in the System Administration module, a Remote... button displays on the Search 
dialog box (Figure 3-54).

Figure 3-54. Remote... button on Search dialog box
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Voyager Connection Options Dialog Box

When the Remote... button is clicked the Voyager Connection Options dialog 
box opens (Figure 3-55).

Figure 3-55. Voyager Connection Options dialog box

Use the Remote... button to select the remote database(s) from which you want 
to do the following.

• Search (individually or simultaneously)

• Import records from

The Voyager Connection Options dialog box lists the databases you have 
access to as defined in the System Administration module. The name, 
connection, and type of databases are set in the Database Definition workspace 
of the Voyager System Administration module. 

NOTE:
Your local database lists.
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Table 3-11 describes the Voyager Connection Options dialog box. 

Searching Remote Databases

The procedure for searching remote databases is shown in Procedure 3-11, 
Searching remote databases.

Procedure  3-11.  Searching remote databases

Use the following to perform a bibliographic search of one or more remote 
databases.

1. Click the Remote... button at the bottom right of the Search dialog box or press
Alt + R on your keyboard from the Search dialog box.

Result: The Voyager Connection Options dialog box opens.

2. Click the database(s) to which you want to connect, then click the Add >> button. 
(Double-clicking the database name in the Available Locations also selects it.) from 
the list of Available Locations,.

Table 3-11. Description of the Voyager Connection Options dialog box

Section Field/Column Description

Available 
Locations

[Unnamed] Column of check boxes to the left of Database 
Name indicating whether or not the database has 
been added to Selected Locations.

Database Name The name of the database to which you can
connect.

Type The type of database such as Bibliographic or 
Citation.

Connection The connection type for the database such as
Voyager or Z39.50.

Selected 
Locations

Database Name Lists the databases (by name) that you have 
selected for searching.

Information 
about
[database 
name]

[not used] Describes the database selected in the list of 
Available Locations. Description is drawn from 
the Database Definition workspace in the
Voyager System Administration module.
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NOTE:
If you select more than one database, Voyager searches them simultaneously.

! IMPORTANT:
To search your local database along with remote database(s), select Local 
Database from the list of Available Locations.

Result: Selected locations/databases display in the Selected Locations list. A 
check mark displays in the box directly to the left of the selected database name in 
the list of Available Locations (see Figure 3-56).

OPTIONAL:
3. Select the database and click the << Delete button to remove a database from the 

list of Selected Locations. (You can also double-click the database name in either 
the list of Available Locations or Selected Locations.) To remove all the 
databases from the list of Selected Locations, click the Clear button.

Figure 3-56. Selected locations in the Voyager Connection Options dialog box

4. Click the Connect button or click the Cancel button.

Result: If you clicked the Connect button, one of the following dialog boxes 
opens.

• If you are connecting to one database, the Remote Search dialog box 
opens (see Figure 3-57) with the name of the database displayed in the 
title bar. If available from the remote server, the same search types are 
available as those in the regular local search display.
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Figure 3-57. Remote Search dialog box, Search by options

NOTE:
Default Tab and Save Settings functions are not available for remote searches.

• If you are connecting to more than one database, the Simultaneous 
Search dialog box opens (see Figure 3-58). The types of searches 
available are limited to those shared by all connected databases.
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Figure 3-58. Simultaneous Search dialog box

NOTE:
Default Tab and Save Settings functions are not available for remote searches.

If you clicked the Cancel button the Voyager Connection Options dialog box 
closes without connecting to a remote database.

! IMPORTANT:
Searches on remote and multiple databases are limited to search types 
available to all connected databases. Other limits may apply. For instance, 
connecting to multiple databases disables heading searches, and Z39.50 
databases do not support search limits.

For more information on simultaneous searching, including setting up search 
attributes, see the Voyager System Administration User’s Guide.

5. Enter your search criteria.

Table 3-12 lists the page numbers where you can find information about 
performing various searches.

Table 3-12. Page references for bibliographic search tabs

Tab Page

Keyword 3-32
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6. Click the Do Search button.

Result: One of the following occurs.

• If you are performing a single-database search (Z39.50), the Titles Index 
dialog box opens with results from the search.

• If you are performing a single-database search (Voyager-to-Voyager), 
either a Titles Index or Headings List dialog box displays the results.

• If you are performing a simultaneous search, the Search Status dialog box 
opens (see Figure 3-59), listing each database name and the status of 
each search. The Stop Search button displays if your search returned over 
100 hits. It allows you to interrupt the search if the status is Searching or 
Receiving.

Figure 3-59. Search Status dialog box

For simultaneous searches, click the Show Results button to view the 
results in the Titles Index dialog box (see Figure 3-60).

Index Selection 3-37

Builder 3-44

History 3-47

Table 3-12. Page references for bibliographic search tabs

Tab Page
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Figure 3-60. Titles Index following a simultaneous search

TIP:
For searches combining local and remote databases, the Titles Index 
dialog box displays records in the sort order specified in the System 
Administration module. If you are searching only remote databases, the 
Titles Index dialog box displays records in the sort order specified for the 
first database in the Voyager Connection Options dialog box. See the 
Voyager System Administration User’s Guide for details. 

NOTE:
For simultaneous searches, the Titles Index dialog box contains a Status button 
and a Database column. The Status button opens the Search Status dialog box 
of the last search. The Database column lists the name of the database as 
established in the System Administration module.

7. Click the row(s) containing the item(s) from the Titles Index dialog box to select one 
or more items.

8. Use one or more of the following buttons to continue and complete the search.
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Use... to...

OK add the item(s) you selected to the purchase order, 
close the Titles Index list box, and view the line 
item(s) in the Purchase Order dialog box.

Cancel end the search and close the Titles Index dialog box.

Search close the Titles Index dialog box and return to a new 
Search dialog box.

Status open the Search Status dialog box of the last search.

Refresh update the index in the event that records were 
updated in the Cataloging module.

Select All choose all of the records in the search results list.

Clear All de-select all selected records.

Click the Remote... button from the Search dialog box and de-select/select new 
databases to change the selected databases.

NOTE:
The connections you select in the Voyager Connection Options dialog box 
remain throughout the session unless you change them. 

User-Defined Alternate Search Button

Users can add another button on the Search dialog box, providing the capability 
to invoke a URI (Uniform Resource Identifier) to search outside the Voyager 
database.

An example of this user-defined feature is shown in Figure 3-61. The button 
labeled Google has been set up as a URI search option to access the GoogleTM 
search page.
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Figure 3-61. Search dialog box with user-defined alternate search button

This alternate search function can be configured to do either of the following:

• Take the text string entered in the Search for field and pass it to the 
alternate search facility to execute when you click this uniquely-defined 
alternate search button

• Access the search facility without including the text string

The URI search option is defined in the voyager.ini file. For more information, 
about the setup for this feature, see the description of the [SearchURI] stanza 
in the Voyager Technical User’s Guide.

Setting Search Preferences

Users can create session searching defaults to increase their searching efficiency.

Retain Last Search

Selecting the Retain Last Search check box causes the search information from 
your last search to be saved until the current Voyager session is exited. That way, 
if you want to perform the same search again, you do not have to redefine your 
search type and text. This check box is found in Cataloging’s  Session Defaults 
and Preferences workspace on the Work Flow tab. 
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Automatic Truncation for Index Selection Searches

Selecting the Automatic Truncation for Index Selection Searches check box 
causes an Index Selection search to be automatically truncated without requiring 
the question mark for a truncation character. This check box is found in 
Cataloging’s Session Defaults and Preferences workspace on the Work Flow 
tab.

Display Bibliographic Record Directly If Search 
Results In Only One Title

Selecting the Display Bibliographic Record Directly If Search Results in Only 
One Title check box causes a bibliographic record to display directly (if a search 
results in only one match), as opposed to having the Titles Index list box display 
from which you can select the bibliographic record.

Search Limits

Search limits can be applied to the following searches:

• Boolean and Free Text Keyword searches from the Keyword tab

• Left-anchored searches from the Index Selection tab

• Builder tab searches

! IMPORTANT:
Limits cannot be applied to the Holdings Boolean (MFHD Keyword), 
Subject headings, Author headings, or Call Number headings searches.

Users access the Search Limits dialog box to limit searches. Searches can be 
limited by Language, Location, Date, Medium, Type, Place, or Status.

In a limited search, the system compares the limit criteria selected to the code or 
value in the corresponding field of the bibliographic record. For example, if a 
search is limited to the publication date of 1960, the system checks the 008 
control field in the MARC bibliographic record, date of publication field (Figure 3-
62) and returns the matching results.
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Figure 3-62. Bibliographic record

User’s can configure the limits available in the Search Limits dialog box by 
configuring the limits.ini file. See Limits.ini File on page 3-86.

Search Limits Dialog Box

Figure 3-63 shows the Search Limits dialog box.

Figure 3-63. Search Limits dialog box
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Table 3-13 describes the Search Limits dialog box.

Limits.ini File

Search limits are configured in the limits.ini file located in the 
c:\Voyager\Misc. directory on the user’s computer. This file contains various 
stanzas which govern the type of limits available ([Limits] stanza), and the 
limiting criteria (search limits stanzas) seen in the Search Limits dialog box. 
Figure 3-64 provides an example of the limits.ini file. 

NOTE:
Use a text editor to edit the limits.ini file such as Notepad or Wordpad.

Table 3-13. Description of the Search Limits dialog box

Name Description

List of Limits Types of limits that can be imposed.

Limit Type
Column

Type of limit selected.

Value Value of the limit selected. 

For example, if a language limit is applied, English is a 
possible value.

Add Button Applies the limit selected in the top portion of the dialog 
box and displays in the bottom portion of the dialog box.

Delete Button Deletes the selected limit from the bottom half of the dia-
log box.

Clear Button Clears the selected limit from the top half of the dialog 
box.

Retain search
limits between 
searches

Applies the limit(s) to the current search and all future 
searches.

OK Button When clicked the system returns to the Search dialog box 
and the search limits defined are in effect.
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Figure 3-64. Sample limits.ini file

Limits Stanza

The [Limits] stanza defines the type and order of limits available in the Search 
Limits dialog box. It lists a three letter code for each type of limit:

• Language (LAN)

• Location (LOC)

• Date (DAT)

• Medium (MED)

• Type (TYP)

• Place (PLA)

• Status (STA)
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• Content (CON)

• Media (MDA)

• Carrier (CAR)

If any codes are misspelled or not present, that limit type is not available. Also, the 
order in which the codes are listed in the stanza is the order in which the limits are 
listed in the Search Limits dialog box.

Figure 3-65 shows a [Limits] stanza and the corresponding Search Limits 
dialog box list of limits.

Figure 3-65. [Limits] stanza and the list of limits in the Search Limits dialog box

Also, for each type of limit except the location limit, there is an associated search 
limit stanza defining the limit criteria. For example, users wanting to limit by 
medium would include MED in the [Limits] stanza, and include a [Medium] 
stanza in the limits.ini file.

Search Limits Stanzas

The search limit stanzas in the limits.ini file correspond to the types of limits 
listed in the [Limits] stanza. These provide the limiting criteria for each limit 
type. The search limits stanzas are as follows:

• [Language]

• [Date]

• [Medium]

• [Type]

• [Place]

• [Status]

• [Content]  

• [Media]  

• [Carrier]  
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NOTE:
Operators may limit by location if LOC is listed in the [Limits] stanza. However 
since locations are locally defined there is no locations stanza, the list of locations 
to choose from is derived from the locations defined in the System Administration 
module, see the Voyager System Administration User’s Guide.

Rules for Search Limit Stanzas

• Stanzas can be in any order in the limits.ini file, they do not have to be 
in the same order as in the [Limits] stanza.

• Users can delete criteria by deleting the line. Using the hash mark (#) 
before the criteria does not work.

• Removing a search limit stanza prevents those limits from being available.

• The [Date] stanza cannot be edited.

! IMPORTANT:
See the MARC standards for information regarding the MARC Leader, 007, 
and 008 fields, as well as, the available codes used for languages, status, 
medium, and places of publication, http://www.loc.gov/marc/.

[Language] Stanza

Users can limit searches to items published in a particular language by 
configuring this stanza. Any language you want to limit by must be listed in this 
stanza.

Figure 3-66 shows an example of part of the [Language] stanza. This stanza is 
editable and additional languages may be added.

Figure 3-66. Language stanza example

http://www.loc.gov/marc/
http://www.loc.gov/marc/
http://www.loc.gov/marc/
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Figure 3-67 shows some of the language limits that correspond to the 
[Language] stanza (Figure 3-66) as they display in the Search Limits dialog 
box.

Figure 3-67. Language limits

When a language limit is applied, the system compares the language code in the 
008 control field (positions 35-37) of the MARC record with the language 
selected in the Search Limits dialog box to find matching records.

[Date] Stanza

Users can limit searches to items published in a particular year, range of years, or 
before or after a particular year.

Figure 3-68 shows the [Date] stanza. This stanza is not editable.

Figure 3-68. Date stanza example

Figure 3-69 shows the date limits that correspond to the [Date] stanza 
(Figure 3-68) as they display in the Search Limits dialog box.
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Figure 3-69. Date limits

When a date limit is applied, the system compares the date in the 008 control 
field (positions 07-10) of the MARC record with the date provided in the Search 
Limits dialog box to find matching records.

[Medium] Stanza

Users can limit searches to the medium in which the item is published by 
configuring this stanza. Any medium you want to limit by must be listed in this 
stanza.

Figure 3-70 shows an example of the [Medium] stanza. This stanza is editable 
and additional medium limit codes may be added.

Figure 3-70. Medium stanza example

Figure 3-71 shows some of the medium limits that correspond to the [Medium] 
stanza (Figure 3-70) as they display in the Search Limits dialog box.
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Figure 3-71. Medium limits

When a medium limit is applied, the system compares the medium code in the 
first position in the 007 control field of the MARC record with the medium 
selected in the Search Limits dialog box to find matching records.

[Type] Stanza

Users can limit searches to the type of item by configuring this stanza. In Voyager, 
types are a combination of the type of record and the bibliographic level. Any type 
you want to limit by must be listed in this stanza.

Figure 3-72 shows an example of the [Type] stanza. This stanza is editable and 
additional type limit codes can be added.

Figure 3-72. Type stanza example

Figure 3-73 shows some type limits that correspond to the [Type] stanza 
(Figure 3-72) as they display in the Search Limits dialog box.
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Figure 3-73. Type limits

When a type limit is applied, the system creates a 2-letter code using the type of 
record code in the Leader control field (position 06) and bibliographic level code 
in the Leader control field (position 07) of the MARC record. This code is then 
compared to the type selected in the Search Limits dialog box to find matching 
records.

[Place] Stanza

Users can limit searches to items published in a particular place by configuring 
this stanza. Any place you want to limit by must be listed in this stanza.

Figure 3-74 shows an example of part of the [Place] stanza. This stanza is 
editable and additional places can be added.

Figure 3-74. Place stanza example
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Figure 3-75 shows some of the place limits that correspond to the [Place] 
stanza (Figure 3-74) as they display in the Search Limits dialog box.

Figure 3-75. Place limits

When a place limit is applied, the system compares the place code in the 008 
control field (positions 15-17) of the MARC record to the place selected in the 
Search Limits dialog box to find matching records.

[Status] Stanza

Users can limit searches of serial records by the publication status by configuring 
this stanza. Any status you want to limit by must be listed in this stanza.

Figure 3-76 shows the [Status] stanza. This stanza is editable and additional 
status limit types may be added.

Figure 3-76. Status stanza example

Figure 3-77 shows the status limits that correspond to the [Status] stanza 
(Figure 3-76) as they display in the Search Limits dialog box.
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Figure 3-77. Status limits

When a status limit is applied, the system compares the status code in the 008 
control field (position 06) of the MARC record with the status selected in the 
Search Limits dialog box to find matching records.

[Content] Stanza

The [Content] stanza provides filters on values in the 336‡b. See Table 3-14. 
This list contains Resource Description and Access (RDA) terms and 
corresponding three-character, lowercase alphabetic codes for RDA Content 
types.  

NOTE:
In addition to checking 336‡b, Voyager also checks 336‡a using the phrase/value 
provided for <code>= in the limits.ini file.  

Table 3-14. Content Filters

Code Description

crd cartographic dataset

cri cartographic image

crm cartographic moving image

crt cartographic tactile image

crn cartographic tactile three-dimensional form

crf cartographic three-dimensional form

cod computer dataset

cop computer program

ntv notated movement

ntm notated music
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[Media] Stanza

The [Media] stanza provides filters on values in the 337‡b. See Table 3-15. This 
list contains Resource Description and Access (RDA) terms and corresponding 
one-character, lowercase alphabetic codes for RDA Media types.  

NOTE:
In addition to checking 337‡b, Voyager also checks 337‡a using the phrase/value 
provided for <code>= in the limits.ini file. 

prm performed music

snd sounds

spw spoken word

sti still image

tci tactile image

tcm tactile notated music

tcn tactile notated movement

tct tactile text

tcf tactile three-dimensional form

txt text

tdf three-dimensional form

tdm three-dimensional moving image

tdi two-dimensional moving image

xxx other

zzz unspecified

Table 3-15. Media Filters

Code Description

s audio

c computer

h microform

p microscopic

g projected

Table 3-14. Content Filters

Code Description
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[Carrier] Stanza

The [Carrier] stanza provides filters on values in the 338‡b. See Table 3-16. 
This list contains Resource Description and Access (RDA) terms and 
corresponding two-character, lowercase alphabetic codes for RDA Carrier types. 

NOTE:
In addition to checking 338‡b, Voyager also checks 338‡a using the phrase/value 
provided for <code>= in the limits.ini file.

e stereographic

n unmediated

v video

x other

z unspecified

Table 3-16. Carrier Filters

Code Description

sg audio cartridge

se audio cylinder

sd audio disc

si sound track reel

sq audio roll

ss audiocassette

st audiotape reel

sz other audio carrier

ck computer card

cb computer chip cartridge

cd computer disc

ce computer disc cartridge

ca computer tape cartridge

cf computer tape cassette

ch computer tape reel

Table 3-15. Media Filters

Code Description
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cr online resource

cz other computer carrier

ha aperture card

he microfiche

hf microfiche cassette

hb microfilm cartridge

hc microfilm cassette

hd microfilm reel

hj microfilm roll

hh microfilm slip

hg microopaque

hz other microfilm carrier

pp microscope slide

pz other microscopic carrier

mc film cartridge

mf film cassette

mr film reel

mo film roll

gd filmslip

gf filmstrip

gc filmstrip cartridge

gt overhead transparency

gs slide

mz other projected carrier

eh stereograph card

es stereograph disc

ez other stereographic carrier

no card

nn flipchart

Table 3-16. Carrier Filters

Code Description
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Limiting a Search

The procedure for setting search limits is shown in Procedure 3-12, Setting 
Search Limits.

Procedure  3-12.  Setting Search Limits

Use the following to set search limits.

1. Click the Limit button to limit your search.

Result: The Search Limits dialog box opens (see Figure 3-78).

na roll

nb sheet

nc volume

nr object

nz other unmediated carrier

vc video cartridge

vf videocassette

vd videodisc

vr videotape reel

vz other video carrier

zu unspecified

Table 3-16. Carrier Filters

Code Description
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Figure 3-78. Search Limits dialog box

2. Click the plus sign ( + ) for the limit type you want to select. 

Result: This expands the list and displays the list of limit type values (see 
Figure 3-79).

Figure 3-79. Expanded list of limits

3. Select any values from the list you want to use as limits for your search. Figure 3-80 
shows the Medium limit of Computer File selected.

NOTE:
The Add button is not active until a specific limit is selected.
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Figure 3-80. Computer File selected as search limit

4. Click the Add button (or double-click the value) to add the limit to the list.

Result: The limit type value you selected displays in the Limit Type and Value 
columns (see Figure 3-81).

Figure 3-81. Selected search limits listed in the bottom portion of the dialog box

OPTIONAL:
5. Click the Retain search limits between searches check box.
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OPTIONAL:
6. To edit the limits you have chosen, select a limit type value from the Value column 

and click the Delete button to remove the value from the limits to be applied or click 
the Clear button to remove all limit type values from the Value column.

7. Click OK to accept the limiting criteria and return to the Search dialog box.

Result: The search limits are set.

MFHD-Bibliographic Combined 
Keyword Search (optional feature)

The MFHD-Bibliographic Combined Keyword Search provides the ability to 
combine holdings and bibliographic search criteria into one keyword search. This 
function is available through Voyager client and OPAC search facilities. (The 
focus of this user’s guide description is about the Voyager client capabilities.)

NOTE:
The MFHD-Bibliographic Combined Keyword Search is an optional feature that 
requires headings keyword indexes to be built. Contact Ex Libris Customer 
Support for more information.

In the Voyager client, the combined search may be performed as a command-line 
Boolean Keyword search or the Builder search function may be used.
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Example: The following is an example of a command-line search for “102 Dalmatians” or 
“African Queen” in the motion picture collection where SPAC is the Voyager code 
for the indexed 901 ‡a holdings field and MP is the code representing the motion 
picture collection stored in the 901 ‡a . See Figure 3-82 and Figure 3-83.

Figure 3-82. MFHD-Bibliographic Combined Keyword Search - command line 
example

Figure 3-83. Results of MFHD-Bibliographic Combined Keyword Search



3-104  Ex Libris Confidential

Cataloging User’s Guide

NOTE:
The 901 ‡a is used for local cataloging conventions and examples of MFHD-
Bibliographic Combined Keyword Search vary from institution to institution based 
on what is indexed.

Setup

Voyager provides the SPAC holdings keyword definition in Voyager System 
Administration for use with the MFHD-Bibliographic Combined Keyword Search. 
See Figure 3-84. The SPAC definition may be edited and/or additional definitions 
may be created depending on what you have indexed in your database.

Follow the normal procedures for defining holdings keyword definitions. See the 
Voyager System Administration User’s Guide for more information.

Figure 3-84. SPAC holdings keyword definition

The SPAC code may be used in a command-line search to identify the index to be 
searched. See Figure 3-82.
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Search Options

The MFHD-Bibliographic Combined Keyword Search incorporates the following 
functional search options/characteristics.

• Boolean operators to include parentheses for grouping and quotes for 
phrases

• And, or, or not boolean logic may be used to separate each index and term/
phrase combination in a command line search as in Figure 3-82

NOTE:
Free-text search syntax of the plus sign and asterisk is not 
available for command-line boolearn searches.

• Search limits

• Remote searching via a Voyager-to-Voyager connection is available

NOTE:
The MFHD-Bibliographic Combined Keyword Search 
feature must be installed on each remote Voyager server 
and the search codes (such as SPAC) must be compatible 
for remote Voyager searching to work. 

Search Results Display

The MFHD-Bibliographic Combined Keyword Search incorporates the following 
search results display characteristics.

• Search results sets display the associated bibliographic record for the 
MHFD-bibliographic combined search

• Search results set limit continues to be 10,000

• Search results are de-duplicated by bibliographic ID

• Search results display in the Titles Index format

• Search results columns displayed are determined by the first index in the 
search when multiple indexes are combined in a search per pre-existing 
functionality

User Considerations

In utilitizing the MFHD-Bibliographic Combined Keyword Search function, be 
aware of the following considerations.
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• MFHD keyword indexes are not available to the Z39.50 server.  As a result, 
there is no way to incorporate a Z39.50 search into a combined MFHD-
bibliographic search.

• Holdings-only search criteria (without the combined bibliographic criteria) 
generate bibliographic results sets. See Search Results Display on page 3-
105 for more information. Use the optional Holdings Boolean Keyword 
search function to generate holdings results sets.

Searching in Cataloging Examples  

This section discusses and provides examples of searching in the Cataloging 
module.

In the Cataloging module, users access the Search dialog box by clicking the 
Search icon in the toolbar or by selecting Search from the Record menu.

Users search for and display bibliographic, holdings, or authority records and if 
authorized, can edit these records.

Keyword Search in the Cataloging Module

If the Keyword
search is Then the results display in...  and the selected record...

Boolean The Titles Index dialog box displays. Selecting a title and 
clicking the OK button displays the MARC tab of the 
bibliographic record. See the Boolean search example on 
page 3-106.

Free text The Titles Index dialog box displays with relevance bars. 
Selecting a title and clicking the OK button displays the 
MARC tab of the bibliographic record. See the Free Text 
search example on page 3-109.

Holdings 
Boolean
(optional 
feature)

The Holdings Index dialog box displays. Selecting a 
holdings record and clicking the OK button displays the 
MARC tab of the holdings record. See the Holdings Boolean 
search example on page 3-111.

Example: Boolean search

Conduct a Boolean search to access bibliographic records relating to women and 
equality (Figure 3-85).
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Figure 3-85. Boolean search for a MARC record

After the search is conducted, a Titles Index dialog box lists the results (Figure 3-
86).
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Figure 3-86. Titles Index dialog box listing the results of the Boolean search

After a title is selected and the user clicks OK, the MARC tab of the bibliographic 
record displays (Figure 3-87).

Figure 3-87. Selected bibliographic record displays 
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Example: Free Text search

Conduct a Free text search to find an item with the word zeitgeist in it 
(Figure 3-88).

Figure 3-88. Free text search for a bibliographic record 

After the search is conducted, a Titles Index dialog box lists the results (Figure 3-
89).
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Figure 3-89. Titles Index dialog box listing the results of the Free Text search

After a title is selected and the user clicks OK, the MARC tab of the bibliographic 
record displays (Figure 3-90).

Figure 3-90. Bibliographic record after conducting a Free Text search 
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Example: Holdings Boolean search

Conduct a Holdings Boolean search to find items belonging to the Murray 
collection (Figure 3-91). In this case, holdings records contain an additional 
tag with collection information.

Figure 3-91. Holdings Boolean search for items belonging to the Murray collection

After the search is conducted, a Holdings Index dialog box lists the results 
(Figure 3-92). 
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Figure 3-92. Holdings Index listing the results of the Holdings Boolean search

After a holdings record is selected and the user clicks OK, the MARC tab of the 
holdings record displays (Figure 3-93).

Figure 3-93. MARC tab of the selected holdings record displays
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Index Selection Search in the Cataloging Module

If the Index Selection
search is Then the results display in...  

Headings The Headings List dialog box displays. Select a heading 
and click the OK button. The Titles Index dialog box 
displays. Select a title and click OK. The MARC tab of the 
bibliographic record displays. See the Headings search 
example on page 3-113.

Left-
Anchored

The Titles Index dialog box displays with relevance bars. 
Select a title and click OK. The MARC tab of the 
bibliographic record displays. See the Left-anchored search 
example on page 3-116.

Example: Headings search

Conduct a headings search to find an authority record for civil rights 
(Figure 3-94).

Figure 3-94. Headings search

After the search is conducted, a Headings List dialog box lists the results 
(Figure 3-95).
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Figure 3-95. Headings List dialog box

After the wanted heading is selected and the user clicks the Authority button, the 
Reference Information dialog box displays (Figure 3-96).

Figure 3-96. Reference Information dialog box

To access the Authority record, the user clicks the Retrieve button. In this 
example, multiple authority records are found (Figure 3-97).
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Figure 3-97. Multiple authority records found

Select the wanted record and display it (Figure 3-98).

Figure 3-98. Authority record
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Example: Left-anchored search

Conduct a left-anchored search for the title, To The Lighthouse, published 
before the year 2000 (Figure 3-99).

Figure 3-99. Left anchored, limited search

After the search is conducted, a Titles Index dialog box lists the results (Figure 3-
100).

Figure 3-100. Titles Index dialog box
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After a title is selected, the MARC tab of the bibliographic record displays 
(Figure 3-101).

Figure 3-101. MARC tab of the bibliographic record 

Builder Search in the Cataloging Module

All Builder tab searches are Keyword searches. Therefore, the results are 
displayed in the Titles Index. Additionally, limits can be applied. See the Builder 
search example on page 3-117.

Example: Builder search

Conduct a remote builder search for the title, The Bell Jar, written by Lucas 
or Plath (Figure 3-102).
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Figure 3-102. Builder search

After the search is conducted, a Titles Index dialog box lists the results (Figure 3-
103).
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Figure 3-103. Titles Index dialog box

After a title is selected, the MARC tab of the bibliographic record displays 
(Figure 3-104).

Figure 3-104. MARC tab of the bibliographic record
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Additional Options for Displaying a 
Record - Web Server http POST

You can display an active bibliographic record from Cataloging in WebVoyáge for 
example using an http POST request to send a MARC record to a web server. 
This is an optional feature that is set in the voyager.ini file with the [MARC 
POSTing] stanza. For more information regarding setup, see the Voyager 
Technical User’s Guide.

See Procedure 3-13, Display Record in WebVoyáge - Example, on page 3-120 for 
an example of displaying active bibliographic records from the Cataloging module 
in WebVoyáge.

NOTE:
If you are posting to WebVoyage, only bibliographic records can be posted.

Procedure  3-13.  Display Record in WebVoyáge - Example

Use the following to display an active bibiliographic record in WebVoyáge.

1. Search and open a bibliographic record in the Cataloging module.

Result: This makes the bibliographic record active.

2. Click Record > Send Record To > WebVoyáge.  See Figure 3-105.

Result: This displays the active record in WebVoyáge.

NOTE:
The active record can be determined by the highlighted Title Bar.
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Figure 3-105. Send Record To WebVoyáge

Viewing and Editing Line Items 
(Acquisitions in Cataloging)

The Cataloging in Acquisitions or Cat in the Acq feature allows you to view and 
edit a bibliographic record in the Cataloging module from a line item in the 
Acquisitions module.  See the Voyager Acquisitions User’s Guide for details on 
Cat in the Acq.  

In order to improve workflow even further, the Acquisitions in Cataloging or Acq in 
the Cat feature provides the second half of the two-way communication between 
the Acquisitions and Cataloging modules.  Acq in the Cat allows you to pull up and 
edit a line item in the Acquisitions module from the associated bibliographic or 
holdings record in the Cataloging module.  In this way, you can view all of the 
information related to a specific title without performing any additional searching, 
thereby saving valuable time and effort.   
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System Administration Setup

In order to use the Acq in the Cat feature, there is only one System Administration 
configuration you need to set. This configuration pertains to Acquisitions security 
permissions. Specifically, the operator(s) established in System Administration 
that you want to use the Acq in the Cat feature, must have at least view-only 
access to line items in Acquisitions. If the operator(s) does not have at least view-
only access to line items in Acquisitions, they will not be able to use the Acq in the 
Cat feature. In fact, the menu option in the Cataloging module that facilitates Acq 
in the Cat functionality is grayed out. See 3-123 for more details on the Acq in the 
Cat feature.

You establish view-only access (or add/update and/or delete access) to line items 
in Acquisitions on the Profile Values tab of the appropriate Acquisitions/Serials 
Profile Definition in the System Administration module. See Figure 3-106. To 
access the Profile Values tab of an Acquisitions/Serials Profile Definition, select 
Applications>Security from the System Administration main menu, or click the 
Security button. The Voyager Security Configuration dialog box opens. Click 
the Acq/Serials Profiles button, select the profile for which you want to set 
permissions, and click the Profile Values tab. 

For detailed information about setting permissions in  Acquisitons/Serials Profile 
Definitions, see the "Securing Your System>Acquisitions/Serials Profile 
Definitions" section of the Voyager System Administration User’s Guide.
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Figure 3-106. Establishing at least view-only access to line items in Acquisitions

The procedure for using the Acq in the Cat function is shown in Procedure 3-14, 
Using the Acq in the Cat Function, on page 3-123.

Procedure  3-14.  Using the Acq in the Cat Function

Use the following steps to work with the Acq in the Cat function.

1. Log into both the Cataloging and the Acquisitions modules using the same User ID 
and Password.  

If you are not logged into both modules, an error message displays.  See Figure 
3-107.
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Figure 3-107. Error message if not logged into both modules

If you are logged into Cataloging and Acquisitions with different User IDs and 
Passwords, an error message opens.  See Figure 3-108.

Figure 3-108. Error message if logged into modules with different User IDs and 
Passwords

2. Open a bibliographic or holdings record In the Cataloging module.   See Opening 
Records on page 3-8 for details on opening records. 

Result: The record opens. 

3. Select Record>View Line Items in Acquisitions, or use the Ctrl + M keystroke.  
Depending on whether the number of line items associated with the record, the 
result will be different.

Result: Line items open through Acq in the Cat function. See Figure 3-109.

Once the line item is up in the Acquisitions module, you can view and manipulate 
it in standard Acquisitions fashion. See the Voyager Acquisitions User’s Guide for 
details on line items.

NOTE:
If you have not established at least view-only access to line items in Acquisitions 
(in the System Administration module) for the operator(s) using the Acq in the Cat 
function, the View Line Items in Acquisitions menu option will be grayed out. See 
System Administration Setup on page 3-122 for more information on setting at 
least view-only access to line items in Acquisitions.
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A Single Line Item

If there is one line item associated with the record you opened, selecting 
Record>View Line Items in Acquisitons (or Ctrl + M) causes the Acquisitions 
client to display with the record’s associated line item.

NOTE:
Line items are directly associated with bibliographic records, as opposed to 
holdings records, in Voyager. Thus, using Acq in the Cat from a holdings record 
will cause the line item to display that is associated with the holdings record’s 
related bibliographic record. This is because holdings and bibliographic records 
are linked in the Voyager system.

Figure 3-109. Line item that displays in the Acquisitons module

Multiple Line Items

If more than one line item is associated with the record such as the same title has 
multiple purchase orders or if one line item was created per copy,  selecting 
Record>View Line Items in Acquisitons (or Ctrl + M) causes a dialog box to 
display in Acquisitions, summarizing all of the line items associated with the 
bibliographic record (see Figure 3-110). This summary is broken down into the 
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following 8 pieces: Line #/Status, Title, # Copies, Location(s), Funds, Line 
Item Type, Notes, and PO #.  From this dialog box, you can view (and edit) the 
line item of your choice by highlighting it and clicking the Details... button.

TIP:
To save you time and effort, the dialog box summarizing the line items will 
not close (even if you pull up a line item) until you press the Close button. 
That way, you do not have to go back into Cataloging and repeat the steps 
for viewing line items in Acquisitions.

Figure 3-110. Dialog box for multiple line item matches in Acquisitions

No Line Items

If the record you opened does not have any associated line items, selecting 
Record>View Line Items in Acquisitions (or Ctrl + M) will cause the following 
error message to display in Cataloging (see Figure 3-111). 

Figure 3-111. Message associated line items do not exist 
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4. Save your changes or exit when you are finished viewing the item in Acquisitions.

Retrieving Records Associated with 
Other Records

You can retrieve records that are related to other records. Depending on what 
type of record is the active record, you can retrieve records by selecting the 
appropriate command from the Record menu. See Table 3-17.

You can also retrieve records by clicking the appropriate toolbar button.    

You can also view all of the associated records by selecting Record>Show 
Associated Records (or click the Hierarchy button). From the Holdings and 
Items for dialog box you can select which associated record you want to retrieve.

• The procedure for retrieving holdings is shown in Procedure 3-15, Retrieve 
Holdings, on page 3-127.

• The procedure for retrieving authorities is shown in Procedure 3-16, 
Retrieve Authority, on page 3-129.

• The procedure for retrieving items is shown in Procedure 3-17, Retrieve 
Items, on page 3-130.

Retrieve Holdings

The procedure for retrieving holdings is shown in Procedure 3-15, Retrieve 
Holdings, on page 3-127.

Procedure  3-15.  Retrieve Holdings

Use the following to retrieve holdings.

Table 3-17. Retrieve Options Using Record Menu

Record Type Able to Retrieve

Authority None

Bibliographic Authority, Holdings, or Item

Holdings Items, Bibliographic

Items Holdings, Bibliographic
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1. Select Record>Retrieve Holdings or click the Retrieve Holdings button (Figure 3-
112).

Figure 3-112. Retrieve Holdings Button

Result: If there is only one holdings record associated with the active 
bibliographic record, the holdings record opens. 

If the bibliographic record has more than one holdings record associated with it, 
the Retrieve Holdings dialog box opens (Figure 3-113).

Figure 3-113. Retrieve Holdings dialog box

This dialog box lists the ID, Location, and Call Number for all the holdings 
records attached to the active bibliographic record.

2. Click New, Retrieve (after selecting record to retrieve), or Cancel.

Result: You can enter a new record, view (retrieve) a selected record, or exit from 
this dialog box.   
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Retrieve Authority

The procedure for retrieving authority records is shown in Procedure 3-16, 
Retrieve Authority, on page 3-129.

Procedure  3-16.  Retrieve Authority

Use the following to retrieve authority records.

1. Select Record>Retrieve Authorities. 

Result: The Select one or more authority records dialog box opens (Figure 3-
114), listing record numbers and names for all the authority records attached to 
the active bibliographic record.

Figure 3-114. Select one or more authority records dialog box

2. Select the record(s) that you want to view and click OK. Click Cancel to close the 
dialog box without retrieving any records.

Retrieve Items

The procedure for retrieving items is shown in Procedure 3-17, Retrieve Items, on 
page 3-130.
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Procedure  3-17.  Retrieve Items   

Use the following to retrieve items.

1. Select Record>Retrieve Items or click the Retrieve Items button (Figure 3-115).

Figure 3-115. Retrieve Items Button

Result:  The Retrieve Items dialog box opens (Figure 3-116).

Figure 3-116. Retrieve Items dialog box

From this dialog box you can open the item record(s), open the respective 
holdings record, or resequence the items if there are more than one. For any of 
the following activities, click the Clear button to unselect all of the selected items.

Each item’s location is designated as a permanent location or a temporary 
location. A permanent location is indicated by a capital P in parentheses (P) after 
the location name.  A temporary location is indicated by a capital T in parentheses 
(T) after the location name.

2. To open the item record(s, highlight the Item record(s) that you want to view (or 
double-click an Item record) and click OK. Click Cancel to close the dialog box 
without retrieving any records.
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3. To open the holdings record, highlight the appropriate Item record and click the View 
Holdings button.

4. To resequence the items, perform the following steps.  Resequencing items allows 
you to determine in which order items display in other modules.

a. Highlight the item(s) you want to resequence.

b. Click the Move Before button (cursor changes to an up arrow) or the Move 
After button (cursor changes to a down arrow), depending on where you 
want to move the item. Click Cancel Move to cancel the move without 
resequencing the items.

c. Point to and click the item you want to move the other item(s) before or 
after. The items are resequenced.

d. If you want this order to display every time this list is displayed, click the 
Save button then click the Cancel button to close the Retrieve Items 
dialog box.

e. Click the Cancel button before clicking the save button to close the dialog 
box without saving the new sequencing order of the items. 

Retrieve Bibliographic Record (Shortcut)

When the holdings and/or item record displays, use Retrieve Bibliographic 
Record to quickly view the associated bibliographic record.

To access this capability, click Record>Retrieve Bibliographic Record, click Get 
Bib from the toolbar, or use Ctrl+J. See Figure 3-17.
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Figure 3-117. Retrieve Bibliographic Record (Ctrl+J)

Viewing Holdings Locations 

To list all locations for which you are authorized, select Edit>Show Holdings 
Locations (or press Ctrl-L). The Holdings Locations dialog box opens (Figure 
3-118).

Figure 3-118. Show holdings Valid MARC Values dialog box

You must be in the subfield data field of a Holdings record to access this dialog 
box. This command displays all holdings locations and their abbreviations for your 
security access level. You can use this dialog box to change or add a location to a 
holdings record. Place your cursor after the subfield b marker, display the valid 
values (Ctrl + L), highlight a location and click OK (or double-click a location).   
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Linking and Unlinking Records

With the Cataloging module, you can link an item to multiple bibliographic records 
in order to accommodate a bound-with situation. The ability to link bibliographic 
records and item records depends upon which type of record is the active record.

NOTE:
If one or more bibliographic records (identified for relinking) are linked to any 
purchase order line items, the request to relink the holdings record is blocked and 
a message displays that identifies which bibiliograhic record(s) caused the block. 

Refer to the remainder of this section for the procedures that describe the linking, 
relinking, and unlinking steps.

Link Item to Bib

The procedure for linking items to bibliographic records is shown in Procedure 3-
18, Linking Items to Bibliographic Records, on page 3-133.

Procedure  3-18.  Linking Items to Bibliographic Records

Use the following to link items to bibliographic records.

1. Select Record>Link to bibliographic. 

Result: The Link the item to a bibliographic record dialog box opens (Figure 3-
119).

 

Figure 3-119. Link the item to a bibliographic record dialog box

2. Type the appropriate bibliographic ID in the text box. The bibliographic ID is 
displayed in the title bar of the bibliographic record.
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3. Click OK to link the item record to the bibliographic record; click Cancel to close the 
Link an item to bibliographic record dialog box without linking the records.

NOTE:
The ability to link bibliographic and item records in the Record menu is disabled if 
the system focus is not on a bibliographic or item record from the database. It also 
doesn’t work if the focus is on a bibliographic record from the database but the 
bibliographic record has existing holdings. In such a case, linking an item to the 
bibliographic record is not allowed because an existing item would already be 
linked to a holdings record either for this bibliographic record or another one.

Relink an Item to a Different Holdings

If an item record is the active record, you can specify a specific holdings record to 
relink the current item record to. 

NOTE:
Relinking an item to a different holdings will remove the link between the current 
item and the original holdings. 

The procedure for relinking an item to a different holdings is shown in 
Procedure 3-19, Relink an Item to a Different Holdings, on page 3-134.

Procedure  3-19.  Relink an Item to a Different Holdings

Use the following to relink an item to a different holdings.

1. Select Record>Relink to a different holding. 

Result: The Relink the item to a holding record dialog box opens (Figure 3-
120). 
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Figure 3-120. Relink the item to a holding record dialog box

2. Type the appropriate holdings ID in the text box. The holdings ID is displayed in the 
title bar of the item record.

3. Click OK to link the item record to the specified holdings record. Click Cancel to 
close the Relink the item to a holding record dialog box without linking the 
records.

NOTE:
The ability to relink an item to a different holdings in the Record menu is disabled 
if the system focus is not on a item record from the database. 

Unlinking Holdings and Bib Records

With the Cataloging module, you can unlink a holdings record from multiple 
bibliographic records in order to eliminate a bound-with situation. This capability is 
only available when a holdings (MFHD) record that is attached to multiple 
bibliographic records is the active record. 

The procedure for unlinking holdings and bibliographic records is shown in 
Procedure 3-20, Unlinking Holdings and Bib Records, on page 3-135.

Procedure  3-20.  Unlinking Holdings and Bib Records

Use the following to unlink holdings and bibliographic records.

1. Select Record>Unlink holding from bibliographic. 
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Result: The Linked Bib Records dialog box opens. 

2. Select the bibliographic ID that you want to unlink the holdings record from. 

Result: The bibliographic ID is displayed in the title bar of the bibliographic record.

3. Click OK, or click Cancel.

Result: This unlinks the bibliographic record from the holdings record or closes 
the dialog box without unlinking the records.  

NOTE:
The ability to unlink an item from a holdings in the Record menu is disabled if the 
system focus is not on a item record from the database.    

Copying an Item Record from an Existing Item 
Record

You can copy an item record from an existing item record as long as the item 
record is in the database (like copying MARC records). However, the barcode and 
template information are not copied to the record. In Session Preferences, the 
Item Defaults tab allows you to complete a template-like preference so that when 
you copy item records, information is already entered for your record.
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Changing Information

This section describes the following.

• How to edit existing records in the Cataloging module

• Alternatives for saving a record

• Printing options

Editing a Record

Before you can edit a record, you must first open the record. For more 
information, see Opening Records on page 3-8. 

The procedure for editing a record is shown in Procedure 4-1, Editing a Record, 
on page 4-1.

Procedure  4-1.  Editing a Record

Use the following to edit a record.

1. Display the record that you want to edit.  (See Opening Records on page 3-8 for 
more information.)
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2. Edit the record by changing the following.

• Leader

• Fixed fields

• Variable fields

For more information on these fields, see the section about that particular record 
type in Bibliographic Records on page 2-3, Authority Records on page 2-31, and 
Holdings Records on page 2-41.

To edit a record, you can use the same commands as you use for editing a 
template.  See Table 11-13 on page 11-32 for more information.

3. Save the record with one of the following commands: Save, Save As..., or Save to 
Database.  (See Saving a Record on page 4-10 for more information. )

NOTE:
If you cut and paste information from a different application (such as Microsoft 
Word), the following characters are stripped out.  See Table 4-1.  

Bibliographic Records

When you edit the bibliographic level and/or type of record in the Bibliographic 
Leader, a dialog box opens warning you about the incompatibility of the 008 to 
this changed record. If you click No or Cancel, the changes you made to the 
Bibliographic Leader will not be saved. If you click Yes, the changes will be 
saved and the incompatible portion of the 008 field displays. You can then make 
the changes to the 008 field. 

Deleting a Record

You can delete a record from the database by selecting Record>Delete.

Table 4-1. Character Changes

Character ASCII Code

tab ASCII 09

carriage return ASCII 0D

line feed ASCII 0A

subfield delimiter ASCII 1F

end of field character ASCII 1E

end of record character ASCII 1D
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The procedure for deleting a record is shown in Procedure 4-2, Deleting a Record, 
on page 4-3.

Procedure  4-2.  Deleting a Record

Use the following to delete a record.

1. Display the record from the database that you want to delete.  (See Search Dialog 
Box on page 3-31 for more information.)

2. Select Record>Delete.

3. Click OK, or click Cancel.

Result: This deletes the record or closes the confirmation dialog box without 
deleting the record.

NOTE:
You cannot delete a bibliographic record that has holdings records attached to it, 
and you cannot delete a holdings record that has item records attached to it. You 
also cannot delete a record that has other transactions pending against it. This 
includes records that are checked out to patrons in the Circulation module or 
purchase orders in the Acquisitions module. 

When you delete a record, it is saved on the server in a file called 
delete.<recordtype>.marc, where <recordtype>  is the type of record 
being deleted (either bib, mfhd, or auth). For example, if you delete a bibliographic 
record, it is saved in the file delete.bib.marc. To access the deleted files on 
the server, contact your system administrator.

When item records are deleted, key pieces of item information are automatically 
archived in a log file called delete.item. This file is intended for audit and 
statistical purposes. If necessary, this file may be used to manually recreate items 
in Voyager.

Adding a URL to an 856 Field

You can automatically insert an 856 field with a URL in it into your record. Voyager 
automatically adds the URL on view in your web browser into a new 856 field in 
the record currently open in Cataloging. If you do not run Netscape or Explorer, 
this function may not work properly.  
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The procedure for adding a URL to an 856 field is shown in Procedure 4-3, Adding 
a URL to an 856 Field, on page 4-4.

Procedure  4-3.  Adding a URL to an 856 Field

Use the following to add a URL to an 856 field.

1. Open up your web browser and pull up the Web site whose URL you want to add.

2. Open the record (or create a new record) into which you want to insert the URL.

3. Select Edit>Insert URL from Browser or click Ctrl + U.  

Result: The URL will be added to a new 856 field in the record. You can then edit 
the new 856 field if necessary.

Change Owning Library

Owning libraries are assigned to locations in System Administration. Institutions 
must specify that bibliographic records belong to an owning library. When a user 
logs into Cataloging, they must select a cataloging location, which is associated 
with an owning library, from a list determined by their security clearance. 
Depending on the security clearance and on the cataloging location selected, the 
user will (or will not) be able to view, update, add, or delete records from various 
owing libraries.

The procedure for changing the owning library is shown in Procedure 4-4, 
Changing Owning Library, on page 4-4.

NOTE:
This assumes that you have the appropriate security clearance to perform this 
change.

Procedure  4-4.  Changing Owning Library

Use the following to change the owning library.

1. Display the bibliographic record that you want to change the owning library for.



 Ex Libris Confidential 4-5

Chapter 4: Changing, Saving, and Printing Information

2. Select Record>Change Owning Library from the Cataloging toolbar.

3. Select the appropriate owning library and click OK. Click Cancel to close the Select 
an Owning Library dialog box without changing the owning library.

If a Cataloging Location is selected that has no associated owning library, the user 
will be unable to add, edit, or delete any bibliographic record.

Changing Records with Bibliographic 
Overlay/Merge in Cataloging

This section describes the overlay/merge function, procedure, and considerations 
for bibliographic records in the Cataloging module.

The Overlay/Merge function in Cataloging involves two bibliographic records that 
already exist in the database. The two bibliographic records involved in this 
procedure are identified as a target bibliographic record and a source 
bibliographic record. These are specifically defined as explained in Table 4-2.    

With Overlay (see Overlay Record in Figure 4-5), one bibliographic record is 
copied into another. The target bibliographic record’s contents are completely 
replaced.

Table 4-2. Target/Source Record Definitions for Bibliographic Merge

Type Description

Target This is the record whose contents are replaced or supple-
mented.

This records always remains in the database.

The overlay/merge procedure starts with this record in the Cat-
aloging module.

Source This is the record whose contents, MFHDs, and items are 
moved to the target record.

Optionally, this record may be deleted from the database when 
the overlay/merge is executed.

Associated MFHDs and items may be relinked to the target bib-
liographic record. 
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With Merge, one bibliographic record is merged with another utilizing the existing 
merge profiles as defined in Voyager System Administration such as the one 
highlighted in Figure 4-1. Specifically, the fields in the target record that are 
identified in the merge profile are preserved when the source record’s fields are 
copied to the target record.

The default merge profile called Overlay Record (see the drop-down list in 
Figure 4-5 on page 4-9) is system supplied. You cannot view this profile in 
Voyager System Administration. It is not one of the Cataloging - Bibliographic 
Duplicate Detection Profiles. This system-supplied profile is set to Merge but does 
not have any merge fields defined. As a result, the entire record is overlayed.

The other Cataloging - Bibliographic Duplicate Detection Profiles that display in 
the drop-down list shown in Figure 4-5 are those that are set to Merge. These 
merge options retain the tags defined in the merge fields as defined in the 
Cataloging - Bibliographic Duplicate Detection Profiles.

Figure 4-1. System Administration merge profile example

NOTE:
The quality hierarchy component of the merge profiles is ignored for this function 
given the personal review of records prior to executing this procedure.
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The distinction with the overlay/merge procedure in Cataloging versus bulk import 
is that you may use two existing bibliographic records in the database versus 
importing external records.

The procedure for overlaying/merging bibliographic records is shown in 
Procedure 4-5, Overlaying and Merging Bibliographic Records, on page 4-7.

Procedure  4-5.  Overlaying and Merging Bibliographic Records

Use the following to overlay/merge bibliographic records.

1. Identify/select the target bibliographic record (as defined in Table 4-2 on page 5) 
from available active bibliographic records in Cataloging.

2. Click Record > Overlay Bibliographic Records.

Result: The Overlay Bibliographic Records options display. See Figure 4-2.

Figure 4-2. Overlay Bibliographic Records options

3. Select the source record (defined in Table 4-2 on page 5) using one of the following 
methods.

a. Select one of the active bibliographic records displayed with the Open 
option.

b. Retrieve a non-active bibliographic record by record ID using the 
Bibliographic ID option. See Figure 4-3.
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Figure 4-3. Retrieve a Record dialog box

c.  Search for a record by using the Search option.

Result: The Overlaying and Merging Bibliographic Records dialog box 
displays. See Figure 4-4.

Figure 4-4. Overlaying and Merging Bibliographic Records dialog box

4. Select the Merge Profile you prefer from the drop-down list (see Figure 4-5) and 
check Relink Mfhds and Items and/or Delete Source Bib per your requirements.



 Ex Libris Confidential 4-9

Chapter 4: Changing, Saving, and Printing Information

Figure 4-5. Merge Profile dropdown list options

5. If you want to view the overlay/merge results before committing them to the 
database, click Preview to process your overlay/merge request and display it in the 
preview area of the Overlaying and Merging Bibliographic Records dialog box. 
If the overlay/merge results are not acceptable, click Cancel.

6. Click Save to store the overlay/merge changes to the database.

! CAUTION:
There is no way to undo this operation.

7. Optionally, make note or respond to messages provided in the following situations.

a. For Relink Mfhds and Items requests where the source bibliographic 
record is participating in any Acquistions module transactions such as a 
line item entry, the system displays a message indicating that you need to 
use the Acquisitions module to manually make the necessary adjustments.

b. For Relink Mfhds and Items requests where the source bibliographic 
record is participating in any Circulation module transactions, a warning 
message is displayed indicating that the transactions will be relinked to the 
target bibliographic record with Yes/No options to indicated how to 
proceed.

c. For Delete Source Bib, normal deletion rules apply. The system sends a 
message if it is unable to perform the deletion. For example, you must 
relink any MFHDs and items if you also try to delete the bibliographic 
record (presuming, of course, that the bibliographic record has MFHDs and 
items).

Record History - Overlay/Merge

The system keeps track in the bibliographic record history of overlay/merge 
activity between records. There is an action type of overlay that displays on the 
History tab of the bibliographic record.
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Source records that are deleted are added to the deleted.bib.marc file in the 
rpt folder on the server. The ID of the deleted source bibliographic record may be 
retained in the database in the archive tables.

Saving and Printing Information

This section describes the process for saving and printing information.

Saving a Record   

To save a record, you can select from the following toolbar options.

• File>Save

• File>Save As

• Record>Save to Database

• Record>Save to Database and Close

• Record>Save to Database and to Local File

• Record>Save to Database and to Local File and Close

Because Cataloging works with records in two locations, the database and work 
folders, it is important to understand where records are saved. You can always 
determine in which work folder a record is saved by using File>Save As. 

NOTE:
Records saved to the databased are validated based on the options chosen on 
the Validation tab of Session Defaults and Preferences.  See Validation Tab on 
page 11-6 for more information.

Save

You can save an active record or a template to a file in a work folder by selecting 
File>Save or click the Save button (Figure 4-6). This command tries to save the 
current record or template to the same work folder from which the record was 
opened. If the record was opened from a work folder, it is saved to the same work 
folder.  However, if the record was retrieved from the OPAC, Voyager asks you to 
name the record or template and save it in a work folder. To save a record to a 
different location, use the Save As command. 



 Ex Libris Confidential 4-11

Chapter 4: Changing, Saving, and Printing Information

Figure 4-6. Save Button

When a record is saved to a work folder, it is not validated against authority 
records or the MARC tag table. Also, because the Suppress From OPAC check 
box is not a part of the MARC 21 record, that information is not saved when the 
record is saved as a work record. Each time that you retrieve a work record in 
order to save it to the database, the Suppress From OPAC check box must be 
marked appropriately. 

In addition, if a record is saved to a work folder and then opened in another 
Cataloging session for a different database, the record overlays any existing 
record without any duplicate checking. This is because Voyager automatically 
overlays any record with an identical 001. The correct procedure is to Import the 
record into another database.

Update Record Alert

If you modify a record and save it and Voyager discovers that the record has been 
modified by another user while you had the record open, Voyager displays an 
Update Record Alert message (Figure 4-7). This alert is activated for changes 
made to any record types.

Figure 4-7. Update record alert dialog box

If there have been changes made, the following three options are available.

• To save your changes and overlay the previous changes in the database 
(the No button).

• To cancel your changes and preserve what is already in the database (the 
Cancel button). 
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• To view the record in the database (the Yes button). In that case, you will 
be able to view the current database version of the record and combine the 
information into your record to your satisfaction, and then save the final 
version of your record back to the database.

Save As...

You can save a record to a work folder (a file) at a different location by selecting 
File>Save As.... When you select Save As..., Voyager saves the record to a new 
location and/or with a new name. If the record was opened from a work folder, you 
can use Save As to save the record in the following ways: 

• Appended to an existing work record

• To the same work folder as a new record

• To a different work folder

If the record was retrieved from the database, use Save As to save the record to 
a work folder. 

In addition, if a record is saved to a work folder and then opened in another 
Cataloging session for a different database, the record will overlay any existing 
record without any duplicate checking. This is because Voyager automatically 
overlays any record with an identical 001. The correct procedure is to Import the 
record into another database.

Save to Database

You can save a record to the database in the following ways.

• Select Record>Save to Database.

• Click the Save to Database button (Figure 4-8).

• Press Ctrl+B on your keyboard.

Figure 4-8. Save to Database button

In addition, you can save a record to the database and then have the record 
automatically close by selecting Record>Save to Database and Close, or by 
pressing Ctrl+Q on your keyboard. If you are saving a record to the database via 
the Save to Database and Close function and a different process interrupts the 
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save and close such as Authority Validation or Duplicate Detection, the record is 
closed once you elect to continue with the save, provided that the save is 
successful.

Save and Security

In order to save a record to the database, you need the proper security level. 
When saving a record to the database, Cataloging first validates the record 
against the MARC tag tables (see MARC Tag Tables on page A-1) and the 
Authority records, (see Authority Control on page 9-1). 

Save and ISBN/ISSN Validation

Validation of the ISBN and/or ISSN fields may occur automatically when you save 
bibliographic records to the database.  This is determined by the setting selected 
in Session Defaults and Preferences. See Table 11-2 on page 11-7 for a 
description of your options.

If validation should fail, you are given the option to continue and select Save to 
save the record to the database or to select Cancel and the record is not saved to 
the database.

You may also dynamically validate the ISBN or ISSN fields by selecting either of 
the following options from the Record menu without saving the record to the 
database. See Figure 4-9.

• Validate ISBNs

• Validate ISSNs

Selecting these options from the Record menu takes precedence over whatever 
settings are chosen in Session Defaults and Preferences.
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Figure 4-9. Record menu dynamic ISBN/ISSN validation options

Save and Duplicate Records

Cataloging then checks for duplicate records. A confirmation message displays 
upon the successful saving of the record. If you want to save the records in your 
current session to the database without running MARC or Authority Control 
Validation, you can change the settings on the Validation tab in your Session 
Defaults and Preferences (see Validation Tab on page 11-6).

Save and Confirmation Message

If you do not want a confirmation message to display upon the successful saving 
of a record to the database, you can change the Suppress confirmation 
message upon successful save option on the Work Flow tab in your Session 
Defaults and Preferences (see Work Flow Tab on page 11-10). 
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Save Considerations

Before you can save a holdings record to the database, you must define the 852 
subfield b with a valid location code as defined in System Administration and 
assigned to the appropriate Cataloging Policy and Cataloging Security Profile. 

Once a holdings record is saved to the database, the title of the associated 
bibliographic record is displayed on the title bar of the holdings record, and on the 
BibTitle(s) tab.

When an existing record with a record status of new, such as when the 
Bibliographic Leader is set to n, is edited and saved to the database, the record 
status is automatically changed to corrected or c.

When a record retrieved from an existing work file is saved to the database and it 
has an 001, it is treated as an existing record. Cataloging updates the record with 
a matching 001 in the database.  When a record does not have an 001, it is 
treated as a new record.

Save and Bibliographic Dedupe Detection

When a newly-copied, newly-imported, or newly-created record is saved to the 
database, Voyager checks for any duplicates in the database and if any are 
detected, the Bibliographic Dedupe Detection dialog box opens (Figure 4-10). 
This lists all of the records that are found to be duplicates according to the rules in 
the System Administration module.  For information on duplicate matching, see 
the "Bibliographic Duplicate Detection Profile" section of the Voyager System 
Administration User’s Guide.

NOTE:
If any single index in the duplicate detection hierarchy is matched to more than 
1000 records, all duplicate detection stops.  Only the first 100 records above the 
matching threshold are returned to the client.
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Figure 4-10. Bibliographic Dedupe Detection dialog box

• You can view the MARC record of any of the duplicates by selecting a 
record from the list and clicking Retrieve.  Click Clear All to deselect all of 
the selected records in the list.

• To add the record to the database as a new record overriding the existence 
of duplicates, click Add As New Record.  

• If you want the incoming record to replace or be merged with one of the 
records in the list, use Procedure 4-6, Replace/Merge Incoming Record, on 
page 4-16.

The procedure for replacing or merging an incoming record with a record from the 
Bibliographic Dedupe Detection dialog box is shown in Procedure 4-6, Replace/
Merge Incoming Record, on page 4-16.

Procedure  4-6.   Replace/Merge Incoming Record

Use the following to replace or merge incoming records.

1. Make sure that the target record in the list and only the target record is highlighted.

2. Click the drop-down arrow to select with which replace or merge profile you want 
to import.  This list only includes Replace or Merge profiles.
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3. Click the Replace/Merge using profile: button. No more duplicate checking is 
performed, and the record is replaced or merged according to the profile selected.

When you save a record to the database for the first time, a number is assigned to 
that record by the system. This record ID displays in the title bar of that record.

If you do merge or replace one of the records in the database with the incoming 
record, the old record is written to a replace file called replace.<record 
type>.marc, which is located in the /rpt directory. 

When you save a bibliographic record to the database from a work folder, the 
record in the work folder is automatically deleted, unless you have Delete 
records from work files once saved to database unselected in Session 
Defaults.

Voyager checks for duplicate records according to the Authority and 
Bibliographic Import/Replace profile menus set in Session Defaults. For more 
information, see General Tab on page 11-2. 

Anytime the system is performing tasks that update the bibliographic tables, you 
are unable to update or delete records until the system is finished processing. 
While processing, the system displays "The Catalog is in read-only mode. You are 
not allowed to update/delete any bibliographic records at this time."

Saving to the Database and to a File Simultaneously

You can also save a record to the database and to a file simultaneously.  This 
allows you to avoid having to do a regular Save and then a Save to Database as 
well. You can choose to save to the database and to a file and keep the record 
open onscreen by selecting Record>Save to Database and to Local File. You 
can also choose to save to the database and to a file and then to close the record 
once it has been saved by selecting Record>Save to Database and to Local 
File and Close.

When Save to Database and to Local File is selected, the bib is first saved to 
the database according to all of the rules regarding saving to the database (see 
above for more information).  Then, if the save is successful, it is converted to the 
character set format specified for that file and then saved to a local file.

If there is no filename entered in Session Preferences, the Save to Database and 
to Local File option will be disabled. For more information, see Folders/Files Tab 
on page 11-15. 



4-18  Ex Libris Confidential

Cataloging User’s Guide

NOTE:
If the record is saved to the database but is not successfully saved to the local file, 
a warning message will be displayed, but the record in the database will remain in 
its updated form.

Validating  a Bibliographic Heading

You can validate a heading manually. A validated heading is one that matches an 
authority heading in the database. Any row that contains a tag that is under 
Authority Control can be checked to see if it matches an Authority Heading. You 
can select Record>Validate Heading to check whether it is valid. This will 
validate the heading in the selected row. 

You can also access Heading Validation by performing a right click of the mouse 
in the selection column of the grid in the MARC view form.  From the menu that 
displays, click Validate Heading in this Field.  

The procedure for validating a heading is shown in Procedure 4-7, Validating a 
Heading, on page 4-18.

NOTE:
While Validate Heading is only performed on a single row, performing Cut, Copy, 
and Delete from this menu operates on all selected rows. When a menu option 
does not apply, it is not displayed.

Procedure  4-7.  Validating a Heading

Use the following to validate a heading.

1. From an open bibliographic record, select the row you want to check by clicking in 
the fixed column (the empty box to the left of the Tag row).  

Result: This highlights the row and displays the arrow in the fixed column.

2. Select Record>Validate Heading from the main menu or right-click in the fixed 
column and select Validate Heading in this Field.

Result: If the field is a valid Authority heading, a dialog box opens with "This 
heading is valid."  

3. Click OK to return to the Bibliographic record.
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Result: If the field is not a valid Authority heading, the Headings Index displays.

4. Browse through the Headings Index until you find the appropriate heading.  Select 
the heading and click Replace.  

Result: This copies the selected heading into the bib record in place of the invalid 
heading and returns you to the bib record.

NOTE:
If the subject heading selected from the index is of a different index type or a 
different thesaurus type, the following changes may also occur:

Subject Headings

Subject headings may have their indicator 2 changed if the heading selected from 
the browse index is of a different type from the one being validated. Furthermore, 
if indicator 2, that is, the second ind changes to a 7 which indicates that the 
heading type is in subfield 2, the new heading may contain a subfield 2 specifying 
the heading type.

Non-Subject Headings

If a non-subject heading is selected from the index, upon selecting a valid heading 
from the list of valid headings and clicking Replace, the original tag of the bib 
heading being replaced may change depending on the new heading. For 
instance, if a personal name heading is being validated (100 tag) and a corporate 
heading is selected to replace it, the bib tag will change to 110 to reflect the type of 
the new name heading.

A record will not be given a new indicator 2 and a new tag simultaneously.

5. Right-click the mouse in the selection column of the grid in the MARC view form to 
display a pop-up menu with the following selections.

• Copy this field

• Cut this field

• Paste before this field

• Delete this field

• Validate the heading of this field

• Move this field up by one (moves the focus row up by one row)

• Move this field down by one (moves the focus row down by one row)



4-20  Ex Libris Confidential

Cataloging User’s Guide

NOTE:
While Validate Heading is only performed on a single row, performing Cut, Copy, 
and Delete from the menu bar operates on all selected rows. When a menu option 
does not apply, it is not displayed.

Make a Copy of a Record

You can make a copy of a record retrieved from the database by selecting 
Record>Make a Copy. 

The procedure for copying a record is shown in Procedure 4-8, Copy a Record, on 
page 4-20.

Procedure  4-8.  Copy a Record

Use the following to copy a record.

1. Display the record from the database that you want to copy. (See Search Dialog Box 
on page 3-31 for more information.)

2. When the record is displayed, select Record>Make a Copy. 

Result: A copy of the record displays. The 001 field is stripped out of the new 
copy. You can save this as a new record in the database and the Date of Creation 
is updated in the 008 fixed field, byte 00 through 05. 

NOTE:
Voyager checks for duplicate records according to the preference set in Session 
Defaults. For more information, see General Tab on page 11-2. 

You can also make a copy of records that do not come from the database by using 
the Save As command. For more information, see Save As... on page 4-12.   

Printing a Record    

You can print bibliographic, holdings, item, or authority records. To print a record, 
select File>Print Record. For some fixed fields that do not display the 
information, the printout contains a printed description of that field. 
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Printing Item Records

Item-record printing is controlled by:

• Print Setup (Figure 4-11)

• catalog.ini (located in the Catalog folder with the Voyager client)

NOTE:
The catalog.ini file contents are read when the Cataloging client is opened. As a 
result, any changes made to the catalog.ini file while the Cataloging client is 
running do not take effect until Cataloging is restarted.

Figure 4-11. Print setup dialog box
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[ITEM_RECORD] Stanza

The [ITEM_RECORD] stanza (see Figure 4-12) in the catalog.ini file formats 
printing for a single item record. 

[ITEM_RECORD]

Heading=Item Record for Item ID

HeadingFont=Times New Roman

HeadingFontSize=12

HeadingFontBold=True

HeadingFontItalic=False

HeadingFontUnderline=True

HeadingJustified=C

LabelFont=Times New Roman

LabelFontSize=12

LabelFontBold=True

LabelFontItalic=False

LabelFontUnderline=False

TextFont=Times New Roman

TextFontSize=12

BarcodeFont=Barcode 3 of 9

BarcodeFontSize=12

StartStopChar=*

PrintStartStopChar=Y

TitleLabel=Title:

MFHDIDLabel=MFHD Id:

LocationLabel=MFHD Location:

CallNumberLabel=Call Number: 

SummaryHoldings866Label=Summary Holdings:

SummaryHoldings867Label=Supplements:

SummaryHoldings868Label=Indexes:

BarcodesLabel=Barcodes:

PermLocLabel=Perm Location:

Figure 4-12. [ITEM_RECORD] stanza
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Many of the keys in the catalog.ini file [ITEM_RECORD] stanza define the 
label text for a field. If there is no value entered for a key, the field data is still 
printed (if there is any data); but no label is printed. 

If the key is removed from the [ITEM_RECORD] stanza, the data for that field 
does not print. If, for example, you do not want to print summary holdings 
information, remove the SummaryHoldings8xxLabel= statements from the 
catalog.ini file.

Values are required for the following keys or, otherwise, printing fails:

• HeadingFont=Times New Roman

• HeadingFontSize=12

• HeadingFontBold=True

• HeadingFontItalic=False

TempLocLabel=Temp Location:

ItemTypeLabel=Item Type:

TempTypeLabel=Temp Item Type:

MediaTypeLabel=Media Type:

EnumLabel=Enum:

ChronLabel=Chron:

YearLabel=Year:

CaptionLabel=Caption:

FreeTextLabel=Free Text:

SpineLabelLabel=Spine Label:

ItemStatusesLabel=Item Statuses:

StatisticalCategoriesLabel=Statistical Categories:

NotesLabel=Notes:

CopyLabel=Copy:

PiecesLabel=Pieces:

PriceLabel=Price:

MagMediaLabel=Magnetic Media:

SensitizeLabel=Sensitize:

PageMargins=1

BlankLinesBetweenSections=2

Figure 4-12. [ITEM_RECORD] stanza (Continued)
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• HeadingFontUnderline=True

• HeadingJustified=C

• LabelFont=Times New Roman

• LabelFontSize=12

• LabelFontBold=True

• LabelFontItalic=False

• LabelFontUnderline=False

• TextFont=Times New Roman

• TextFontSize=12

• PageMargins=1

• BlankLinesBetweenSections=2

When present in the catalog.ini file, the MFHDIDLabel= key prints the 
following:

• Text specified (MFHD Id: is the default text)

• Voyager MFHD ID for the item

When present in the [ITEM_RECORD] stanza of the catalog.ini file, the 
BarcodeFont= key prints the barcode field using the font specified (Barcode 3 of 
9 is the default). If this is not included in the [ITEM_RECORD] stanza of the 
catalog.ini file, the TEXTFONT= is used. When the BarcodeFont= key is 
included (and a value specified), only the active barcode is printed. To include a 
start and stop character before and after the barcode, you need to specify Y (yes) 
for PrintStartStopChar= and specify the character to print using 
StartStopChar=.

If the following are not present, the Print Record option does not display in the File 
menu for printing item records:

• catalog.ini file

• [ITEM_RECORD] stanza

• Data field keys

[MFHD_ITEM_LIST] Stanza

The [MFHD_ITEM_LIST] stanza (see Figure 4-14) in the catalog.ini file 
formats printing of item records from a MFHD list (see Figure 4-13). 
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Figure 4-13. Print Selected button

[MFHD_ITEM_LIST]

Heading=Item Records for MFHD ID

HeadingFont=Times New Roman

HeadingFontSize=12

HeadingFontBold=True

HeadingFontItalic=False

HeadingFontUnderline=True

HeadingJustified=C

LabelFont=Times New Roman

LabelFontSize=12

LabelFontBold=True

LabelFontItalic=False

LabelFontUnderline=False

TextFont=Times New Roman

TextFontSize=12

BarcodeFont=Barcode 3 of 9

Figure 4-14. [MFHD_ITEM_LIST] stanza
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BarcodeFontSize=12

StartStopChar=*

PrintStartStopChar=Y

TitleLabel=Title:

ItemIDLabel=Item Id:

LocationLabel=MFHD Location:

CallNumberLabel=Call Number: 

SummaryHoldings866Label=Summary Holdings:

SummaryHoldings867Label=Supplements:

SummaryHoldings868Label=Indexes:

BarcodesLabel=Barcodes:

PermLocLabel=Perm Location:

TempLocLabel=Temp Location:

ItemTypeLabel=Item Type:

TempTypeLabel=Temp Item Type:

MediaTypeLabel=Media Type:

EnumLabel=Enum:

ChronLabel=Chron:

YearLabel=Year:

CaptionLabel=Caption:

FreeTextLabel=Free Text:

SpineLabelLabel=Spine Label:

ItemStatusesLabel=Item Statuses:

StatisticalCategoriesLabel=Statistical Categories:

NotesLabel=Notes:

CopyLabel=Copy:

PiecesLabel=Pieces:

PriceLabel=Price:

MagMediaLabel=Magnetic Media:

Figure 4-14. [MFHD_ITEM_LIST] stanza (Continued)
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Many of the keys in the catalog.ini file [MFHD_ITEM_LIST] stanza define 
the label text for a field. If there is no value entered for a key, the field data is still 
printed (if there is any data); but no label is printed. 

If the key is removed from the [MFHD_ITEM_LISTD] stanza, the data for that 
field does not print. If, for example, you do not want to print summary holdings 
information, remove the SummaryHoldings8xxLabel= statements from the 
cataloging.ini file.

Values are required for the following keys or, otherwise, printing fails:

• HeadingFont=Times New Roman

• HeadingFontSize=12

• HeadingFontBold=True

• HeadingFontItalic=False

• HeadingFontUnderline=True

• HeadingJustified=C

• LabelFont=Times New Roman

• LabelFontSize=12

• LabelFontBold=True

• LabelFontItalic=False

• LabelFontUnderline=False

• TextFont=Times New Roman

• TextFontSize=12

• PageMargins=1

• BlankLinesBetweenSections=1

• BlankLinesBetweenItems=2

• HorizontalBarBetweenItems=True

SensitizeLabel=Sensitize:

PageMargins=1

BlankLinesBetweenSections=1

BlankLinesBetweenItems=2

HorizontalBarBetweenItems=True

Figure 4-14. [MFHD_ITEM_LIST] stanza (Continued)



4-28  Ex Libris Confidential

Cataloging User’s Guide

When present in the catalog.ini file, the ITEMIDLabel= key prints the 
following:

• Text specified (Item Id: is the default text)

• Voyager item ID

When present in the [MFHD_ITEM_LIST] stanza of the catalog.ini file, the 
BarcodeFont= key prints the barcode field using the font specified (Barcode 3 of 
9 is the default). If this is not included in the [MFHD_ITEM_LIST] stanza of the 
catalog.ini file, the TEXTFONT= is used. When the BarcodeFont= key is 
included (and a value specified), only the active barcode is printed. To include a 
start and stop character before and after the barcode, you need to specify Y (yes) 
for PrintStartStopChar= and specify the character to print using 
StartStopChar=.

If the following are not present, the Print Selected button does not display:

• catalog.ini file

• [MFHD_ITEM_LIST] stanza

• Data field keys

Printing Labels  

You can print spine and piece labels by selecting File>Print Label. A spine label 
can be an attachment on an item for shelving purposes. A piece label can be an 
attachment to an item for general identification purposes. 

Spine and piece labels can be customized. You can create separate spine and 
piece templates from bibliographic, holding, item and serial records. The 
templates are defined in the file spinelabel.cfg which is located in the /Misc 
subdirectory.

The default settings are as follows: the size of a spine label is 1 5/8" high by 9/10" 
wide. The size of a piece label is 1 5/8" high by 2 9/10" wide.  However, this may 
be changed by your institution.  See the section, Spine and Piece Label Print 
Template on page 4-31, for information on customizing labels.

The procedure for printing spine and piece labels is shown in Procedure 4-9, Print 
Spine and Piece Labels, on page 4-28.

Procedure  4-9.  Print Spine and Piece Labels

Use the following to print spine and piece labels.
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1. Select File>Print Label. 

Result: Depending on the location of the cursor prior to selecting the Print Label 
command, different information automatically displays in the Print Labels dialog 
box (Figure 4-15). See the sections Bibliographic Recordsand Holdings 
Recordsfor more information.

Figure 4-15. Print Labels dialog box

2. Mark the check box next to the type of label you want to print: Spine Label or Piece 
Label. Mark both check boxes to print both spine labels and piece labels.

3. Add or edit information in the spine and piece label sections.

NOTE:
The system automatically adjusts the text on the screen to fit the information on 
the appropriate label.

4. Enter the number of copies to be printed in the Number of Copies box. You can 
select any number from 1 to 9999.
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5. Click the Print button to print the labels on the printer to which Windows is set to 
print.   Click the Clear button to remove all information from the spine and piece label 
sections.  Click the Close button to close the dialog box without printing the 
information.

NOTE:
Print Label does not send anything to the printer, unless some data is typed in the 
dialog box (in either section). 

Bibliographic Records

If the active record is a bibliographic record, the following is the default information 
that will display in the Print Labels dialog box. See Table 4-3. You can change 
this information at any time before you print.  

Holdings Records

If the active record is a holdings record, the following is the default information that 
will automatically display. See Table 4-4. You can change this information at any 
time before you print.  

Table 4-3. Default Text in Print Labels Dialog Box - Bibliographic Record

Field Default

Spine Label Spine Label Name (as defined for the Location in 
System Administration), Address and Bib ID

Piece Label Spine Label Name (as defined for the Location in 
System Administration), Address, Bib ID, Title, and 
Title Brief

Table 4-4. Default Text in Print Labels Dialog Box - Holdings

Field Default

Spine Label MFHD ID and Call Number

Piece Label MFHD ID and Call Number
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Item Records

If you select Print Label and the active record is an item record, the following 
information automatically displays. See Table 4-5. You can change this 
information at any time before you print.  

Spine and Piece Label Print Template

The spine and piece label print template allows you to customize the appearances 
of spine and piece labels from bibliographic, holdings, item, and serial records. 
You can also create a template for a label with solely general information. You can 
define what kind of information displays on each label. You can customize its 
layout and appearance, and you can specify the number of copies that are to be 
printed. This information is contained in a file called spinelabel.cfg which is 
located in the /Misc directory on the client workstation.

For each type of information that can be printed, there are three stanzas in the 
template. 

• [Print Options XXX] stanza

• [Print Template Spine XXX] stanza

• [Print Template Piece XXX] stanza

XXX  represents the type of record or the specific names of the stanzas.  For 
example, the bibliographic record stanzas are called [Print Options 
Bibliographic], [Print Template Spine Bibliographic], and 
[Print Template Piece Bibliographic].

NOTE:
These names cannot be changed. Altering the names causes label printing to fail.

The [Print Options XXX] stanza contains the formatting and general 
information regarding the label. The [Print Template Spine XXX] stanza 
contains the information and the layout for printing the spine label. The [Print 
Template Piece XXX] stanza contains the information and the layout for 
printing the piece label.  

Table 4-5. Default Text in Print Labels Dialog Box - Item Record

Field Default

Spine Label Spine Label Name (as defined for the Location in 
System Administration). Address and Bib ID

Piece Label Spine Label Name (as defined for the Location in 
System Administration), Address, Bib ID, Item ID, 
Copy Number, and Item Barcode
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There is also a single [Templates] stanza at the beginning of the file.

Templates Stanza

The [Templates] stanza contains the list of the different types of templates that 
can be customized.  The [Templates] stanza cannot be changed.  Editing the 
[Templates] stanza in any way causes label printing to become unpredictable.

[Print Options XXX] Stanza

The [Print Options XXX] stanza contains formatting and other information 
on each type of record for which a label can be created. See Figure 4-16 for a 
description of the options available in the [Print Options XXX] stanza.   

Line#

1 [Print Options Bibliographic]

2 StandardFont=The name of the default font

3 StandardFontSize=The size of the default font

4 AlternateFont=The name of the alternate font

5 AlternateFontSize=The size of the alternate font

6 Copies= The number of copies that are to be 
printed

7 TabWidth= The width in inches that the tab code 
(\T) represents

8 Margin= The label’s left margin, in inches

9 SpineLabelHeight=The height of the spine label, in 
inches

10 SpineLabelWidth=The width of the spine label, in 
inches

11 PieceLabelHeight=The height of the piece label, in 
inches

12 PieceLabelWidth=The width of the piece label, in 
inches

Figure 4-16. Description of options in the [Print Options 
Bibliographic] stanza
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Print Template Spine/Print Template Piece Stanza

The [Print Template Spine XXX] and [Print Template Piece XXX] 
stanzas can be completely customized. Any type of information can be entered 
into the stanza as well as any additional text or field labels. See Figure 4-17 and 
Figure 4-18.  

Whatever you enter in the [Print Template Spine XXX] or [Print 
Template Piece XXX] stanzas prints on the label.  The text that you enter 
displays onscreen. To get specific information such as the Title from the database, 
you can enter Action Codes.

If you want nothing to display in the field for a particular label in the dialog box 
onscreen, simply enter nothing after the stanza name. If nothing is entered in a 
particular [Print Template Spine XXX] or [Print Template Piece 
XXX] stanza, nothing displays for that label or piece onscreen. However, you may 
still enter anything into the label or piece field in the Print Labels dialog box and 
print that information.

Line#

1 [Print Template Spine Serial Issue]

2 Name: \B\F102\b

3 Addr1: \U\F510\u

4 Component Name: \F600

5 Enum Chron: \F601

6 Receipt Date: \F602

Figure 4-17. Sample [Print Template Spine XXX] stanza

Line#

1 [Print Template Piece Serial Issue]

2 Name: \B\F102\b

3 Addr1: \U\F510\u

4 Component Name: \F600

5 Enum Chron: \F601

6 Receipt Date: \F602

Figure 4-18. Sample [Print Template Piece XXX] stanza
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Action codes are used in these stanzas to change how the information displays on 
the label, and field codes are used after the \F action code to specify the 
information that is to be printed.

The information you enter in the [Print Template Spine XXX] and [Print 
Template Piece XXX] stanzas prints with the font and font size specified in the 
StandardFont and StandardFontSize variables in the [Print Options XXX] 
stanza for that type of record, unless you specify otherwise. See "Printing in the 
Alternate Font" and "Changing Font Size". For example, if you want the caption 
Item Barcode: to print, simply enter Item Barcode:.

Action Codes

Table 4-6 contains a list of action codes that you can use to change how the 
information displays on the labels.  

 Initiating and Ending Action Codes

The \A and \a, \B and \b, \I and \i, \U and \u, and \S and \s action codes 
are initiated and ended in the same way.  Enter the uppercase action code before 
the information it is to effect, and enter the lowercase action code after the 
information it is to effect. For example, if you want the caption Item Barcode: to 
print in bold, enter:

Table 4-6. Action codes descriptions

Action Codes Description

\ prints a blank line

\A starts alternate font

\a ends alternate font

\B starts bold

\b ends bold

\I starts italic

\i ends italic

\U starts underline

\u ends underline

\S starts new font size (a two digit size must follow \S)

\s ends new font size

\T inserts a tab

\F inserts field data (a three digit field code must follow \F)
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\BItem Barcode:\b

Printing Field Information

To print field information, you must enter a field code after the \F action code. For 
example, if you entered Item Barcode: as a caption and wanted the item barcode 
information to be retrieved from the server and printed after the Item Barcode: 
caption, you enter:

Item Barcode: \F401 

Printing in the Alternate Font

To have the item barcode information print in the alternate font and font size, you 
would enter the \A action code when the alternate font is to start and the \a 
action code when the alternate font is to end:

Item Barcode= \A\F401\a

The alternate font is specified after the AlternateFont variable, and the 
alternate font size is specified after the AlternateFontSize variable.  Both of 
these display in the [Print Options XXX] stanza for that type of record. 

If you have chosen your alternate font as a barcode font, you may need to print a 
few lines of blank space beneath the information that is to be printed with the 
barcode font to ensure that the barcode does not overlap with the information 
beneath it. Enter the \ (backslash) action code on a line by itself to print a blank 
line.

NOTE:
The barcode font that is included with Voyager is called Barcode 3 of 9. If you 
use this font as your alternate font and your scanning device requires start/stop 
characters, you must put an * (asterisk) on both sides of the field that is to be 
printed with the alternate font in order for your scanner to read the barcode after it 
is printed. 

For example, if you want to print the item barcode field in the alternate font, and 
you have selected as your alternate font Barcode 3 of 9, you enter: 

\A*\F401*\a

NOTE:
If you are using this barcode font, and you make it print bold 
(\B\A*\F401*\a\b), the barcode height will print taller and the digits normally 
beneath the barcode will not be visible; if you are using the barcode font and you 
make it print italic (\I\A*\F401*\a\i), the barcode height will print shorter. If 
you chose to use a different barcode font, you should read the documentation on 
the barcode font to determine what start/stop character must be used.
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Changing Font Size

To change the size of the font that the information is printing in, you would enter 
the \S## action code (where ## stands for the 2-digit size of the font) before the 
information, and the \s action code after the information (\S24\F401\s). If you 
do not enter the \s action code after the information, all subsequent information is 
printed with this new font size.

Inserting a Blank Line

To insert an extra line of space between different lines of information on a printout, 
you would enter the \ (backslash) action code on a line by itself between the 
different lines of information. 

Inserting a Tab

To tab a piece of information over from the left margin, you enter the \T action 
code before the information. The tab width that applies to this action code is 
specified after the TabWidth variable in the [Print Options XXX] stanza for 
that type of record.

Spine Label Field Codes

Table 4-7 contains the list of Generic Field Codes (100 Series).  The data for the 
100 Series field codes is defined through the Voyager System Administration 
client application.  

Table 4-8 contains the list of Bibliographic Field Codes (200 Series).  A detailed 
definition of the data retrieved for the 200 Series field codes can be found in the 
Voyager System Administration User’s Guide.  

Table 4-7. Generic Field Codes - 100 Series

Data Displayed Code

Current Date & Time 100

Library Display Name 101

Library Name 102

Nuc Code 103

Table 4-8. Bibliographic Field Codes  - 200 Series

Data Displayed Code

Bib_Id 200

Title_Brief 201
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Table 4-9 contains the list of Holdings Field Codes (300 Series). The 300 Series 
field codes pull the content to print from the MFHD.  

Table 4-10 contains the list of Item Field Codes (400 Series).  The 400 Series field 
codes use the data stored in the item record for printing the spine label.  

Title (see also Title long) 202

Author 203

Imprint 204

Table 4-9. Holdings Field Codes - 300 Series

Data Displayed Code

Mfhd_Id 300

Call Number - Display Format 301

Table 4-10. Item Field Codes - 400 Series

Data Displayed Code

Item_Id 400

Item Barcode 401

Enumeration 402

Chronology 403

Year 404

Caption 405

Free Text 406

Copy Number 407

Item Type Code 411

Item Type Name 412

Item Type Display 413

Item Location Code (prints the tem-
porary location if there is one; other-
wise prints the permanent location)

414

Item Location Name 415

Item Location Display Name 416

Table 4-8. Bibliographic Field Codes  - 200 Series

Data Displayed Code
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Table 4-11 contains the list of Library Address Field Codes (500 Series).  The data 
for the 500 Series field codes is defined through the Voyager System 
Administration client application.  

Table 4-12 on page 38 contains the list of Received Serial Issue (600 Series).  
The data for the 600 Series field codes is defined through the serials retrieval 
process.  See the Voyager Acquisitions User’s Guide for more information.  

Sample Template File

Figure 4-19 is a sample label print template file.

Item Location Spine Label 417

Pieces 418

Price 419

Spine Label 420

Table 4-11. Library Address Field Codes - 500 Series

Data Displayed Code

Address Line 1 510

Address Line 2 511

Address Line 3 512

Address Line 4 513

Address Line 5 514

City 515

State/Province 516

Zip/Postal Code 517

Country 518

Table 4-12. Received Serial Issue Field Codes - 600 Series

Data Displayed Code

Component Name 600

Enum Chron 601

Receipt Date 602

Table 4-10. Item Field Codes - 400 Series

Data Displayed Code
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Line#

1 [Templates]

2 Blank

3 Bibliographic

4 Holdings

5 Item

6 Serial Issue

7

8 [Print Options Blank]

9 StandardFont=Times New Roman

10 StandardFontSize=12

11 AlternateFont=Arial

12 AlternateFontSize=12

13 Copies=3

14 TabWidth=1

15 Margin=0.05

16 SpineLabelHeight=1.625

17 SpineLabelWidth=.9

18 PieceLabelHeight=1.625

19 PieceLabelWidth=2.9

20

21 [Print Template Spine Blank]

22 Name: \B\F102\b

23 Addr1: \U\F510\u

24 Addr2: \F511

25 Addr3: \F512

26 Addr4: \F513

27 Addr5: \F514

28 City: \F515

29 St: \F516

30 Zip: \F517

31 Country: \F518

32

Figure 4-19. Sample label print template file
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33 [Print Template Piece Blank]

34 Name: \B\F102\b

35 Addr1: \U\F510\u

36 Addr2: \F511

37 Addr3: \F512

38 Addr4: \F513

39 Addr5: \F514

40 City: \F515

41 St: \F516

42 Zip: \F517

43 Country: \F518

44

45 [Print Options Bibliographic]

46 StandardFont=Times New Roman

47 StandardFontSize=12

48 AlternateFont=Arial

49 AlternateFontSize=12

50 Copies=1

51 TabWidth=1

52 Margin=0.05

53 SpineLabelHeight=1.625

54 SpineLabelWidth=.9

55 PieceLabelHeight=1.625

56 PieceLabelWidth=2.9

57

58 [Print Template Spine Bibliographic]

59 Name: \B\F102\b

60 Addr1: \U\F510\u

61 Bib Id: \F200

62 Author: \F203

63 Imprint:

64 Title: \F202

65 Title - Brief: \F201

Line#

Figure 4-19. Sample label print template file
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66

67 [Print Template Piece Bibliographic]

68 Name: \B\F102\b

69 Addr1: \U\F510\u

70 Bib Id: \F200

71 Author: \F203

72 Imprint:

73 Title: \F202

74 Title - Brief: \F201

75

76 [Print Options Holdings]

77 StandardFont=Times New Roman

78 StandardFontSize=12

79 AlternateFont=Arial

80 AlternateFontSize=12

81 Copies=1

82 TabWidth=1

83 Margin=0.05

84 SpineLabelHeight=1.625

85 SpineLabelWidth=.9

86 PieceLabelHeight=1.625

87 PieceLabelWidth=2.9

88

89 [Print Template Spine Holdings]

90 Mfhd Id: \F300

91 Call Number: \F301

92

93 [Print Template Piece Holdings]

94 Mfhd Id: \F300

95 Call Number: \F301

96

97 [Print Options Item]

98 StandardFont=Times New Roman

Line#

Figure 4-19. Sample label print template file
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99 StandardFontSize=12

100 AlternateFont=Arial

101 AlternateFontSize=12

102 Copies=1

103 TabWidth=1

104 Margin=0.05

105 SpineLabelHeight=1.625

106 SpineLabelWidth=.9

107 PieceLabelHeight=1.625

108 PieceLabelWidth=2.9

109

110 [Print Template Spine Item]

111 Name: \B\F102\b

112 Addr1: \U\F510\u

113 Bib Id: \F200

114 Author: \F203

115 Chron: \F403

116 Caption: \F405

117 Free Text: \F406

118 Enumeration: \F402

119 Item Id: \F400

120 Year: \F404

121 Copy Number: \F407

122 Pieces:

123 Price:

124 Spine Label:

125 Item Barcode: \F401

126 Item Type Code:

127 Item Type:

128 Item Type Display:

129 Item Location Code:

130 Item Location Display Name:

131 Item Location:

Line#

Figure 4-19. Sample label print template file
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132 Media Type:

133 Media Type Code:

134

135 [Print Template Piece Item]

136 Name: \B\F102\b

137 Addr1: \U\F510\u

138 Bib Id: \F200

139 Author: \F203

140 Chron: \F403

141 Caption: \F405

142 Free Text: \F406

143 Enumeration: \F402

144 Item Id: \F400

145 Year: \F404

146 Copy Number: \F407

147 Pieces:

148 Price:

149 Spine Label:

150 Item Barcode: \F401

151 Item Type Code:

152 Item Type:

153 Item Type Display:

154 Item Location Code:

155 Item Location Display Name:

156 Item Location:

157 Media Type:

158 Media Type Code:

159

160 [Print Options Serial Issue]

161 StandardFont=Times New Roman

162 StandardFontSize=12

163 AlternateFont=Arial

164 AlternateFontSize=12

Line#

Figure 4-19. Sample label print template file
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Closing a Record

You can close the active record by selecting File>Close. This command closes 
the current record. If changes have been made to the record since it was last 
saved, you are asked to save the changes or close without saving them. You can 
also close all of the records that you have open by selecting File>Close All.

165 Copies=1

166 TabWidth=1

167 Margin=0.05

168 SpineLabelHeight=1.625

169 SpineLabelWidth=.9

170 PieceLabelHeight=1.625

171 PieceLabelWidth=2.9

172

173 [Print Template Spine Serial Issue]

174 Name: \B\F102\b

175 Addr1: \U\F510\u

176 Component Name: \F600

177 Enum Chron: \F601

178 Receipt Date: \F602

179

180 [Print Template Piece Serial Issue]

181 Name: \B\F102\b

182 Addr1: \U\F510\u

183 Component Name: \F600

184 Enum Chron: \F601

185 Receipt Date: \F602

186

Line#

Figure 4-19. Sample label print template file
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Cataloging & Bibliographic Record 
Linking

Introduction

Once you have added at least one bibliographic record linking profile in System 
Administration, you can search for, review, and edit related records in the 
Cataloging module.

Configuration information for bibliographic record linking is located in the Voyager 
System Administration User’s Guide and in WebVoyáge Architecture Overview 
and Configuration Models.

For more information about searching for records in the Cataloging module, see  
Search Dialog Box on page 3-31.

For more information about editing or deleting records in the Cataloging module, 
see Changing Information on page 4-1.

Displaying Related Records

Related Records displays on the menu bar whenever a linked source record is 
the active record in Cataloging. Clicking Related Records displays one or more 
bibliographic linking profiles. If you select one of the profiles, the system retrieves 
any records related to the source record based on the profile. 

It is the presence of the tag/subfield override in a profile and the existence of 
those tags/subfields in the active record that determines whether or not any profile 
names display from Related Records.
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Before Related Records displays on the menu bar, you must have at least one 
bibliographic linking profile created in the Voyager System Administration module.

NOTE:
For the purpose of this discussion, assume that three linking profiles have been 
added to System Administration.  

If the source record currently active in Cataloging contains any of the tag/subfields 
listed in Table 5-1, Related Records displays on the menu bar.

• If the source record contained only a 776 ‡x, 776Host would be the only 
profile listed when Related Records is clicked.

• If the source record contained a 776 ‡x and a 780 ‡x, 776Host and 
780Preceding displays in the list.

• If the source record contained all three tag/subfields, all three profile names 
display in the list.

Figure 5-1. Related Records listing applicable profiles for “Cinema Journal”

Table 5-1. Example of profile names and overrides

Profile Name Tag/Subfield Override

776Host 776 ‡x

780Preceding 780 ‡x

785Succeding 785 ‡x
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Figure 5-1 shows a partial display of a MARC record in the Cataloging module. 
Three bibliographic linking profiles are listed for the title Cinema Journal.

• 776Host

• 780Preceding

• Child Records

Selecting one of the profiles from the list retrieves any related records, based on 
the profile. For example, if you selected the 780Preceding profile, the system 
looks at the data in the 022 ‡a of the source record if that is the index defined in 
the profile and retrieves any records that contain the same data in the 780 ‡x.

Figure 5-2. Preceding title for “Cinema Journal” and applicable profiles

Figure 5-2 shows the result of selecting the 780Preceding profile from the Related 
Records menu. It also shows the profiles which apply to the preceding title, 
Journal of the Society of Cinematologists. The Related Records menu lists both 
the 780Preceding and 785Succeeding profiles. Selecting the 785Succeeding 
profile would re-display the MARC record for Cinema Journal.

The Related Records menu for both Cinema Journal and Journal of the Society of 
Cinematologists lists a profile name Child Records. Selecting that profile would 
result in an error message. 
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Figure 5-3. No related records message

Neither title is related to any child records at this point. However, both records 
contain an 035 ‡a which are the tag/subfield overrides for that profile.

If the system finds only one related record, it displays the record. (This depends 
on whether or not the “Display bibliographic record directly if search results in only 
one title” option is set in Options>Preferences.) If the system finds more that one 
related record, a dialog box opens listing all related records. You can choose one 
or more titles from the list to display.

In the Cataloging module, you can quickly create new related records from a 
source record using templates. New functionality has been added to traditional 
templates in order to map tag/subfield information from a source record into a 
target record.

See Templates for general template information. If you are already familiar with 
creating and editing templates, see MARC Record Derivation Using Cataloging 
Templates on page 5-8.

Templates

A cataloging template allows you to use a pre-defined MARC record to easily 
create new records. Before you can create a record, there must be at least one 
template in the template folder of the Voyager directory. Voyager provides you 
with three templates: bib.tem, auth.tem, and hold.tem (typically located in 
c:\voyager\catalog\templates). These templates should not be deleted.

NOTE:
Templates cannot be retroactively applied to an existing record.

You must have at least one template for each type of record that you want to 
create (for example, bib.tem, auth.tem, hold.tem).
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The procedure for creating a new template is shown in Procedure 5-1, Creating a 
New Template, on page 5-5.

Procedure  5-1.  Creating a New Template

Use the following to create a new template.

1. Select File>Template>New from the menu.

Result: The Create a New Record dialog box opens. See Figure 5-4.

Figure 5-4. Create a New Record dialog box

2. Select the record type (Bibliographic, Authority, or Holdings) from the drop-down 
menu and click OK.

Result: The system template for the record type you selected displays.

3. Create the new template by completing the leader, fixed fields, and variable fields.

For more information about the leader, fixed, and variable fields, see the Voyager 
Cataloging User’s Guide.

4. Select File>Save As.... from the menu.

5. Enter the name you want for your template.

The extension for the file must be .tem. For example, thesis.tem.
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NOTE:
When a template is saved, it is not validated against authority records or the 
MARC tag table.

The procedure for editing a template is shown in Procedure 5-2, Editing a 
Template, on page 5-6.

Procedure  5-2.  Editing a Template

Use the following to edit a template.

1. Select File>Template>Edit from the menu.

Result: The Open Template File dialog box opens.  See Figure 5-5.

Figure 5-5. Open Template File dialog box

2. Select the template file you want to edit and click Open (or double-click the file).

Result: The selected template opens.

3. Edit the template by changing the leader, fixed fields, and variable fields. You can 
use the same commands as you use for editing a record.
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For more information about editing and the leader, fixed, and variable fields, see 
the Voyager Cataloging User’s Guide.

4. Select File>Save from the menu to save the template with the same name. Select 
File>Save As... to save the template with a different name. If you use Save As..., 
the extension for the file must be .tem.

NOTE:
When a template is saved, it is not validated against authority records or the 
MARC tag table.

The procedure for deleting a new template is shown in Procedure 5-3, Deleting a 
Template, on page 5-7.

Procedure  5-3.  Deleting a Template

Use the following to delete a template.

1. Select File>Template>Edit from the menu.

2. Select the template you want to delete and click Open (or double-click the template).

Result: The selected template displays.

3. Select File>Template>Delete from the menu.

Result: The message “Are you sure you want to delete [the selected template]?” 
prompts you. See Figure 5-6.

 

Figure 5-6. Verify delete template message
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4. Click Yes to delete the selected template, or click No to close the dialog box without 
deleting the selected template.

MARC Record Derivation Using 
Cataloging Templates

In the section, Templates on page 5-4, you learned how to create, edit, and delete 
templates for use in the Cataloging module. You can use the functionality of 
templates to quickly create related records.

Related records are linked to each other by coordinated subfield values. For 
example, the 773 ‡x in the target or child record is linked to the 022 ‡a in the 
source or parent record. Another example of related records is the 780 ‡x in a 
successor serial title is related to the 022 ‡a of the predecessor serial title.

MARC record derivation allows you to use existing template functionality to create 
new, related MARC records whether they are bibliographic, holdings, or authority 
records. The new records can include static data from the template as well as 
dynamically mapped subfield data from the existing source record. You can also 
map subfields from one type of MARC record to a different type of MARC record.

This functionality can be used with Bibliographic Record Linking, or it can be used 
independently.   

Derivation fields provide the link when you create related records in Cataloging. 
These fields specify the tag and subfield data in the active (source) MARC record 
that is mapped into a new MARC record. The derivation fields also determine the 
subfield in the new record to which the data is mapped.

You can add derivation fields to an existing template or create new templates. 
Templates containing derivation fields are created and maintained in the same 
manner as standard templates.

There are two basic formats for a derivation field. See Figure 5-7.

Line#

1 ‡< 022a>

2 ‡< ‡x 022a>

Figure 5-7. Examples of  derivation fields
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See Table 5-2 and Table 5-3 for a description of the elements contained in the 
examples in Figure 5-7.   

! IMPORTANT:
The delimiter symbol must always be immediately followed by the left 
(opening) angle bracket at the beginning of a derivation field.

Other than that one exception, spacing for derivation fields is irrelevant.  

Table 5-2. Description of the first example in line 1 of Figure 5-7

Component Description

‡ delimiter symbol (hex 1f)

< left (opening) angle bracket

022 tag in source record

a subfield in source record

> right (closing) angle bracket

Table 5-3. Description of the first example in line 2 of Figure 5-7

Component Description

‡ delimiter symbol (hex 1f)

< left (opening) angle bracket

‡ delimiter symbol (hex 1f)

x subfield in target record

022 tag in source record

a subfield in source record

> right (closing) angle bracket

Table 5-4. Examples of spacing in derivation fields

Correct Format Incorrect Format

‡<_022a> ‡_<_022a>

‡<_‡x_022a> ‡_<_‡x_022a>
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NOTE:
In Table 5-4, the underscore ( _ ) character in the incorrect formats indicates a 
space. The system automatically adds spacing in the Voyager Cataloging module. 
However, this spacing applies only to the display in the module. It does not 
translate into spacing for the WebVoyáge display of records.

So how does the system decipher this derivation field? It depends on which 
format has been used for the derivation fields.

If an operator wants to create a new record using a template which includes the 
tag, subfield, and derivation field 773 nn ‡x ‡< 022a>, the system creates the new 
record in the following manner:

• Reads the derivation field ( ‡< 022a> ) in the template .

• Checks the active “source” record for an 022 tag, subfield a.

If an 022 tag is present in the source record and subfield a contains data, 
the systems adds a 773 tag to the new target record and maps the data in 
the 022 ‡a to the 773 ‡x.

If an 022 tag is present in the source record but subfield a is not present, or 
the 022 tag is not present in the source record, the system does not 
consider this a match. When a derivation field using this format does not 
match anything in the source record, the system adds a 773 ‡x to the new 
record but leaves the subfield empty.

For example, if the number 1234-5678 appears in the 022 ‡a of the source 
record, the system maps that number into the 773 ‡x of the new target 
record. That is, 773 nn ‡x 1234-5678.

The system acts differently if the second derivation field format is used. For 
example, if the tag, subfield, and derivation field 773 nn ‡< ‡x 022a> is added to a 
template, the system creates a new record in the following manner.

• Reads the derivation field ( ‡< ‡x 022a>) in the template.

• Checks the active source record for an 022 tag, subfield a.

If an 022 tag is present in the source record and subfield a contains data, 
the systems adds a 773 tag to the new target record and maps the data in 
the 022 ‡a to the 773 ‡x.

If an 022 tag is present in the source record but subfield a is not present, or 
the 022 tag is not present in the source record, the system does not 
consider this a match. When a derivation field using this format does not 
match anything in the source record, the system adds a 773 to the new 
record but does not add a subfield or any subfield data.
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Again, if the number 1234-5678 appears in the 022 ‡a of the source 
record, the system maps that number into the 773 ‡x of the new target 
record. The difference in format determines how missing information is 
handled.

NOTE:
If the chosen template does not contain any derivation fields, the system treats the 
template as a standard template (see Templates on page 5-4).

Multiple Subfields

You can add extra characters to derivation fields in order to accommodate tags 
which are allowed to have repeating subfields. For example, if your source record 
includes:

022 ‡a 1234-5678 ‡a 2234-5467 ‡a 3234-5467

and you want to map each of those subfields to separate subfields in your new 
record, then the derivation field displays as follows.

773 nn ‡< ‡x 022a>

The addition of the ‡x on the inside of the angle brackets maps all the 022 
subfield data to separate 773 subfields as follows.

773 nn ‡x 1234-5678 ‡x 2234-5467 ‡x 3234-5467

Non-Matching Subfields

You can use this same format to determine how the system should handle non-
matching subfields. You can decide whether or not the tags and indicators 
specified in the derivation field are added to the new record if there are no 
matching subfields in the source record. 

For example, if the source record contains the following data:

022 nn ‡y 1234-5678

and you define a template with a derivation field like this:

773 nn ‡< ‡x 022a>

the new record includes only the 773 nn without any subfield data.
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Rules and Examples for Derivation Fields

Depending on the data in the source record, and the format of the derivation fields 
in the template, you could have many different results. The tables beginning with 
Table 5-5 through Table 5-12 describe specific rules for derivation fields. 

! IMPORTANT:
You can map a tag/subfield combination from the source record into the 
same tag/subfield combination or a different tag/subfield combination in the 
new record. In the tables below, the examples are mapping information 
from the tag/subfield combination in the source record to another, different 
tag/subfield combination in the target record.  

Table 5-5. Example 1 - Derivation field

Rule If the derivation field has the format ‡< ###c> (no space 
between ‡ and <) where the first three characters (represented 
by “#”) are numeric and the last character (represented by “c”) is 
alphanumeric, map the data from the corresponding tag/subfield 
combination (contained within the angle brackets < >) in the 
active bibliographic record into the new record, replacing the 
derivation tag.

If the active source 
record contains:

022 nn ‡a 1234-5678

And the cataloging 
template contains:

773 nn ‡x ‡< 022a>

Then the new record 
contains:

773 nn ‡x 1234-5678

Table 5-6. Example 2 - Derivation field

Rule If the derivation field has the format ‡< ‡c ##c> (no space 
between ‡ and <), map the data from the corresponding tag/sub-
field combination in the active bibliographic record to the new 
record only if the tag/subfield combination exists in the active 
bibliographic record.

If the active source 
record contains:

022 nn ‡a 1234-5678

And the cataloging 
template contains:

773 nn ‡< ‡x 022a>
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Then the new 
record contains:

773 nn ‡x 1234-5678

Table 5-7. Example 3 - Derivation field

Rule If the derivation field has the format ‡< ###c>, and the corre-
sponding tag exists in the active record but the subfields do not 
match, or the corresponding tag does not exist in the active 
record, add only the tag and subfield.

If the active source 
record contains:

022 nn ‡y 1234-5678 or the 022 tag does not exist in the active 
record

And the cataloging 
template contains:

773 nn ‡x ‡< 022a>

Then the new record 
contains:

773 nn ‡x (subfield data empty)

Table 5-8. Example 4 - Derivation field

Rule If the derivation field has the format ‡< ‡c ##c>, and the corre-
sponding tag exists in the active record but the subfields do not 
match, or the corresponding tag does not exist in the active 
record, add only the tag.

If the active source 
record contains:

022 nn ‡y 1234-5678 or the 022 tag does not exist in the active 
record

And the cataloging 
template contains:

773 nn ‡< ‡x 022a>

Then the new record 
contains:

773 nn (no subfield or subfield data)

Table 5-6. Example 2 - Derivation field
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Table 5-9. Example 5 - Derivation field

Rule If the format of the derivation field is ‡< ###c> and a subfield is 
repeated in the active bibliographic record, map all occurrences 
of the subfield into the new record in the order in which they 
appear.

NOTE:
This format adds one new tag followed by the subfield data 
separated by spaces.

If the active source 
record contains:

022 nn ‡a 1234-5678   022 nn ‡a 2234-5678   022 nn ‡a 3334-
5678

And the cataloging 
template contains:

773 nn ‡x ‡< 022a>

Then the new record 
contains:

773 nn ‡x 1234-5678 2234-5678 3334-5678

Table 5-10. Example 6 - Derivation field

Rule If the format of the derivation field is ‡< ‡c ###c> and a subfield 
is repeated in the active bibliographic record, map each occur-
rence of the subfield into the new record in the order in which 
they appear.

NOTE:
This format adds one new tag followed by the subfield data 
separated by the subfield specified in the derivation field.

If the active source 
record contains:

022 nn ‡a 1234-5678   022 nn ‡a 2234-5678   022 nn ‡a 3334-
5678

And the cataloging 
template contains:

773 nn ‡< ‡x 022a>

Then the new record 
contains:

773 nn ‡x 1234-5678 ‡x 2234-5678 ‡x 3334-5678

Table 5-11. Example 7 - Derivation field

Rule If the derivation field has the format ‡< VRID> or ‡< ‡c VRID>, 
map the Voyager record ID from the active record into the new 
record. 
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NOTE:
If a template containing derivation fields is used to create a new record without an 
active source record, the system considers the derivation fields as non-matching 
and output information to the new record as described in Table 5-7 and Table 5-8. 

Template Example

There is no limit to the number of templates you can create. They can be short 
templates, containing only a few tags and subfields, or very long. They can 
contain derivation fields or not. And, you can include derivation fields into 
standard templates. With the addition of derivation fields, template functionality 
has been expanded to now include:

• Tags and subfields with static text. You could use static text when you 
create multiple records using the same subject headings.

Example: 650 nn ‡a Geography ‡b United States

• Tags with subfields used as place markers. Use the place markers as 
reminders to always complete those particular subfields.

Example: 300 ‡a ‡b ‡c

If the active source 
record contains:

001  60349

And the cataloging 
template contains:

773 nn ‡x ‡< VRID> or 773 nn ‡< ‡x VRID>

Then the new record 
contains:

773 nn ‡x 60349

Table 5-12. Example 9 - Derivation field

Rule In all cases, if the format of the derivation field is not valid, output 
it to the destination record as is.

If the active source 
record contains:

022 nn ‡a 1234-5678

And the cataloging 
template contains:

773 nn ‡x < ‡x 022a> (should be either 773 nn ‡x ‡< 022a> or
773 nn ‡< ‡x 022a> )

Then the new record 
contains:

773 nn ‡x < ‡x 022a> (copies the characters exactly)

Table 5-11. Example 7 - Derivation field
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• Tags with subfields using characters as place markers. Use these place 
markers as reminders to complete those subfields using a particular 
format.

Example: 260 ‡a ‡b ‡c yyyy

• Tags with derivation fields. See the examples beginning with Table 5-5.

• Combinations of all of the above.

Example: 300 nn ‡a ### p. : ‡b ill. ‡c ## cm.

Example: 650 nn ‡a Geography ‡< ‡z 650z> ‡< ‡y 650y>

Example: 100 nn ‡a Syria, Derrell, ‡e lyricist. ‡< ‡a 505r>

To illustrate the functionality of templates, consider this template created to link 
bibliographic records for individual songs to the bibliographic record for the CD 
recording.

Table 5-13. Example of a template using standard and derivation fields

Tag Subfield Data

028 ‡< ‡a 028a>

035 ‡< ‡a 035a>

090 ‡< ‡a 090a> ‡< ‡b 090b>

100 ‡< ‡a 700a> ‡< ‡d 700d>

245 ‡< ‡a 505a> ‡< ‡a 505t> ‡< ‡h 245h>

260 ‡< ‡a 260c> ‡< ‡b 260b> ‡< ‡c 260c>

300 ‡< ‡a 300a> ‡< ‡b 300b> ‡< ‡c 300c>

500 ‡< ‡a 500a>

505 ‡a Concertos for Harp and Orchestra

505 ‡< ‡a 505a>

508 ‡a ‡< 508a>

650 ‡< ‡a 650a> ‡< ‡z 650z> ‡< ‡y 650y>

700 ‡< ‡a 700a>

773 ‡< ‡a 110a> ‡t ‡< 245a> ‡< 245b> ‡d ‡< 260a> ‡< 260b> ‡< 260c> ‡< ‡w 035a>

773 ‡< ‡6 VRID>
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Many of the tags in Table 5-13 use only derivation fields. Others use 
combinations, such as Tag 100 and 245. Tag 505 contains static text that is copied 
directly into the new record. Notice Tag 773 contains derivation fields in both the 
‡< ###c> and ‡< ‡c ###c> formats for the same subfield.

! IMPORTANT:
When you are creating new records using a template containing derivation 
fields, the system includes any information that has been added to the 
source record, even if the record has not been saved. For example, if you 
edited a source record by adding subject information (650abc), then 
created a new record using the template in Table 5-13, the new record 
would include the subject information from the source record even though 
you have not yet saved the source record to the database. 

Session Defaults and Preferences

You can access the Session Defaults and Preferences dialog box by selecting 
Options>Preferences. From this dialog box, you can change a number of 
defaults which are presented on seven tabs.

• General

• Validation

• Work Flow

• Item Defaults

• Folders

• Mapping

• Colors and Fonts

The defaults you choose are saved when you exit the Cataloging module. Anyone 
who uses the Cataloging module on that machine begins with the same defaults 
that you selected unless they change them.

For more information about Session Defaults and Preferences for the Cataloging 
module, see Chapter 11, Session Defaults and Menu Options.

Folders/Files Tab

Setting defaults on the Folders/Files tab is especially useful for MARC derivation 
of records. 
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If you want to use one particular template to create new MARC records, you can 
specify the template as a default in Session Options and Preferences in the 
Cataloging module.

You can enter the entire path for a default template in the appropriate box 
(Bibliographic, Authority, or Holdings). The filename must refer to an existing file. 
You can also click the ellipses button to select the template you want from the 
appropriate directory. 

The procedure for defining a default template is shown in Procedure 5-4, Defining 
a Default Template, on page 5-18.

Procedure  5-4.  Defining a Default Template

Use the following to define a default template.

1. Open the Cataloging module.

2. Select Options>Preferences from the menu bar. Figure 5-8.

Figure 5-8. Menu bar in the Cataloging module

Result: The Session Defaults and Preferences dialog box opens. See Figure 5-
9.
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Figure 5-9. Session Defaults and Preferences dialog box

3. Click the Folders/Files tab.

Result: The dialog box displays the Folders and Files options. See Figure 5-10.

Figure 5-10. Folders/Files tab for Session Defaults and Preferences
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4. Enter the entire path to the desired template for the appropriate record type 
(bibliographic, authority, or holdings) in the Templates section. For example, 
c:\voyager\catalog\template\bib.tem.

You can also click the ellipsis button. 

Result: The Select Bibliographic Template dialog box opens.

If you have not defined a Template folder on the Folders/Files tab (see 
Procedure 5-5, Defining a Default Folder, on page 5-22), the dialog box defaults to 
the Voyager directory.

Figure 5-11. Select Bibliographic Template dialog box - no default Template folder

5. Select the Catalog folder and click the Open button (or double-click the Catalog 
folder).

There are three standard folders within the Catalog folder. They are 
MARCTemplate, Tag Tables, and Template.

NOTE:
The default bibliographic, holdings, and authority templates are located in the 
Template folder. You can save any new templates that you create to that folder, 
but it is not required. If you are sharing templates among coworkers, you could 
create a Template folder on a network that everyone can access.

6. Select the Template folder and click the Open button (or double-click the Template 
folder).
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Result: The Select Bibliographic Template dialog box displays a list of template 
files. If you have defined a Template folder on the Folders/Files tab, and you click 
the ellipsis button for a template, the Select Bibliographic Template dialog box 
defaults directly to that folder.

Figure 5-12. Template files in the Template folder

7. Select the template file you want to use and click the Open button (or double-click 
the template file).

Result: The path to the file automatically displays in the Bib field in the Templates 
section.

Figure 5-13. Bib template selected on Folders/Files tab

8. Click the OK button to close the Session Defaults and Preferences dialog box and 
save your changes.
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NOTE:
A file path can only be specified in the Templates section if there is one template 
(as opposed to multiple templates) defined for each record type. 

See Procedure 5-6, Creating New Records Using Templates, on page 5-24 to 
learn how to use default templates when creating new MARC records.

In the Folders section, you can enter or select a default Template folder so when 
you want to edit an existing template, the Open Template File dialog box defaults 
to the specified folder. Also, if you specify a default Template folder, any new 
templates that you create are saved to that folder.

The procedure for defining a default folder is shown in Procedure 5-5, Defining a 
Default Folder, on page 5-22.

Procedure  5-5.  Defining a Default Folder

Use the following to define a default folder.

1. Open the Cataloging module.

2. Select Options>Preferences from the menu bar.

Figure 5-14. Menu bar in the Cataloging module

Result: The Session Default and Preferences dialog box opens. See Figure 5-
9.

3. Click the Folders/Files tab.
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Result: The dialog box displays the Folders and Files options. See Figure 5-10.

4. In the Folders section, enter the entire path to the desired folder in the Template 
field. For example, c:\voyager\catalog\template\.

You can also click the ellipsis button. 

Result: The Select Directory dialog box opens. See Figure 5-15.

Figure 5-15. Select Directory dialog box

The Select Directory dialog box should default to the Voyager directory. If not, you 
can browse your PCs hard drive by double-clicking the C:\ in the Directory drop-
down list. 

Use the Drives drop-down list to change drives if your default folder resides on a 
drive other than C:\

5. Double-click the Catalog folder in the Voyager directory to expand it and display the 
contents.

There are three standard folders within the Catalog folder. They are 
MARCTemplate, Tag Tables, and Template.

NOTE:
The default bibliographic, holdings, and authority templates are located in the 
Template folder. You can save any new templates that you create to that folder, 
but it is not required. If you are sharing templates among coworkers, you could 
create a Template folder on a network that everyone can access.



5-24  Ex Libris Confidential

Cataloging User’s Guide

6. Double-click the Template folder.

7. Click the OK button in the Select Directory dialog box to save your selection to the 
Folders/Files tab and close the dialog box.

Figure 5-16. Default Template folder selected on Folders/Files tab

8. Click the OK button to close the Session Defaults and Preferences dialog box and 
save your changes.

See Procedure 5-7, Creating New Records Using a Default Folder, on page 5-25 
to learn how to use a default folder when creating new MARC records.

Once you have created a template using derivation fields, you can begin creating 
new records. For more information about creating and editing MARC records in 
the Cataloging module, see the Voyager Cataloging User’s Guide. 

If you need to create many new related records from one source record, selecting 
a default template is the quickest method of record creation. You can change your 
default template at any time.

The procedure for creating new records using templates is shown in Procedure 5-
6, Creating New Records Using Templates, on page 5-24.

Procedure  5-6.  Creating New Records Using Templates

Use the following to create new records using templates.

1. Search for and display the source bibliographic record.
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For more information about searching in the Cataloging module, see the Voyager 
Cataloging User’s Guide.

2. Click the New button on the Cataloging toolbar.

Result: The system automatically uses the default template defined in the Bib 
field on the Folders/Files tab of Session Defaults and Preferences to create the 
new record.

3. Edit the new record as necessary.

If you are using a template containing derivation fields, make sure the information 
is mapped correctly. If a derivation field displays in the new record, it may be 
because the source record did not contain the tag specified. 

4. Save the new record to the database.

For more information about Saving options in the Cataloging module, see the 
“Saving and Printing Information” section of the Voyager Cataloging User’s Guide.

5. Close the new record so the source record is again active.

6. Repeat steps 2 through 5 until you have created all the necessary related records.

If you are creating many new related records but need to use more than one of 
your templates, do not define a default template in the Templates block. Instead, 
define the folder in the Template field on the Folders/Files tab of Session 
Defaults and Preferences.

This causes the Open File dialog box to open when you click the New button. At 
that point, you can choose the appropriate template for the current source record.

The procedure for creating a new records using a default folder is shown in 
Procedure 5-7, Creating New Records Using a Default Folder, on page 5-25.

Procedure  5-7.  Creating New Records Using a Default Folder

Use the following to create new records using a default folder.

1. Search for and display the source bibliographic record.

2. Click the New button.
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Result: The Select Bibliographic Template dialog box opens.

3. Select the appropriate template file and click Open (or double-click the template file).

The system automatically uses the template you selected to create the new 
record.

4. Edit the new record as necessary.

If you are using a template containing derivation fields, make sure the information 
a mapped correctly. If a derivation field displays in the new record, it may be 
because the source record did not contain the tag specified. 

5. Save the new record to the database.

For more information about Saving options in the Cataloging module, see the 
“Saving and Printing Information” section of the Voyager Cataloging User’s Guide.

6. Close the new record so the source record is again active.

7. Repeat steps 2 through 6 until you have created all the necessary related records.  
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Introduction

Voyager supports UnicodeTM in the Cataloging client.  This provides the capability 
to enter diacritic and non-Roman characters in MARC records.

There are several methods for entering diacritic and non-Roman characters in 
Voyager MARC records such as the following.

• Special Character Entry

• Special Character Mode

• Cut & Paste from another program such as the Microsoft Character Map

• Customize Regional Options to input non-Roman characters from a 
different language

• Import MARC records with diacritic and non-Roman characters

Special Character Entry

The procedure for entering diacritic or non-Roman characters using Special 
Character Entry is shown in Procedure 6-1, Special Character Entry, on 
page 6-2.
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Procedure  6-1.  Special Character Entry

Use the following to enter a diacritic or non-Roman character with Special 
Character Entry.

1. Select Special Character Entry (Ctrl+E) from the Edit menu. 

Result: The Special Character Entry dialog box opens. See Figure 6-1.

Figure 6-1. Special Character Entry

2. Select the diacritic character and click Insert or Insert/Close.

Result: This inserts the character in the MARC record and leaves the Special 
Character Entry dialog box open or closed, respectively.
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Special Character Mode

The procedure for entering a diacritic or non-Roman character using Special 
Character Mode is shown in Procedure 6-2, Special Character Mode, on 
page 6-3.

Procedure  6-2.  Special Character Mode

Use the following to enter a diacritic or non-Roman character with Special 
Character Mode.

1. Select Special Character Mode from the Edit menu. 

Result: Special Character displays in the status bar of the Cataloging module.

2. Type the character that maps to the character you want to enter into the MARC 
record.  See Table 6-1.

Result: This enters the diacritic or non-Roman character into the MARC record.

3. Select Special Character Mode from the Edit menu.

Result: This turns off Special Character Mode and returns you to your normal 
mode of entry.

Special Character Mode Mapping

The keyboard equivalents for entering diacritic and non-Roman characters in 
Special Character Mode is shown in Table 6-1. 

NOTE:
The file of Special Character Mode characters can be customized to match your 
institution’s preferences and may not exactly match the list shown in Table 6-1. 
See Special Characters.cfg on page 6-7 for more information. 

Table 6-1. Special Character Mode Mapping - Diacritic & Non-Roman Characters

Description
Diacritic / Non-Roman 

Character Keyboard Equivalent

Script l <space>

Polish L ¡ !
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Scandinavian O ¢ "

D with Crossbar £ #

Icelandic Thorn ¤ $

AE Digraph ¥ %

OE Digraph ¦ &

Miagkii Znak § ’

Dot at Midline ¨ (

Musical Flat © )

Patent Mark ª *

Plus or Minus « +

O Hook ¬ ’

U Hook - -

Alif ® .

alpha ¯ /

Ayn ° 0

Polish l ± 1

Scandinavian o ² 2

d with Crossbar ³ 3

Icelandic thorn ´ 4

ae Digraph µ 5

oe Digraph ¶ 6

Tverdii Znak · 7

Turkish i ¸ 8

British Pound ¹ 9

eth º :

Dagger » ;

o Hook ¼ <

u Hook ½ =

Beta ¾ >

Table 6-1. Special Character Mode Mapping - Diacritic & Non-Roman Characters

Description
Diacritic / Non-Roman 

Character
Keyboard Equivalent



 Ex Libris Confidential 6-5

Chapter 6: Diacritics and Non-Roman Characters

Gamma ¿ ?

Superscript 0 À @

Superscript 1 Á  A

Superscript 2 Â B

Superscript 3 Ã C

Superscript 4 Ä D

Superscript 5 Å E

Superscript 6 Æ F

Superscript 7 Ç G

Superscript 8 È H

Superscript 9 É I

Superscript + Ê J

Superscript - Ë K

Superscript ( Ì L

Superscript ) Í M

Subscript 0 Ð P

Subscript 1 Ñ Q

Subscript 2 Ò R

Subscript 3 Ó S

Subscript 4 Ô T

Subscript 5 Õ U

Subscript 6 Ö V

Subscript 7 × W

Subscript 8 Ø X

Subscript 9 Ù Y

Subscript + Ú Z

Subscript - Û [

Subscript ( Ü \

Subscript ) Ý ]

Table 6-1. Special Character Mode Mapping - Diacritic & Non-Roman Characters

Description
Diacritic / Non-Roman 

Character
Keyboard Equivalent
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Pseudo Question Mark à ‘

Grave á a

Acute § b

Circumflex ã c

Tilde ä d

Macron å e

Breve æ f

Dot Above ç g

Umlaut è h

Hacek é i

Angstrom ê j

Ligature left ë k

Ligature right ì l

High Comma off center þ m

Double Acute î n

Candrabindu ï o

Cedilla ð p

Hook Right ñ q

Dot Below ò r

Double Dot Below ó s

Circle Below ô t

Double Underscore õ u

Underscore _ v

Hook Left ÷ w

Right Cedilla ø x

Upadhmaniya ù y

Double Tilde first half ú z

Double Tilde second half û {

High Comma Centered í ~

Table 6-1. Special Character Mode Mapping - Diacritic & Non-Roman Characters

Description
Diacritic / Non-Roman 

Character
Keyboard Equivalent
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Special Characters.cfg

The Special Characters.cfg file located in the Catalog folder in the Cataloging 
module installation directory may be customized to contain character mappings 
that can be used with the Special Character Mode in the Cataloging module. By 
default, the file is installed with the mappings identified in Table 6-1.

This file is encoded in Latin-1.  Any characters outside the Latin-1 character set 
may be referenced in the Special Characters.cfg file using XML entity references.

An XML entity reference is in the format &#x1234 where 1234 is the hexidecimal 
representation of the Unicode (UTF-8) character.

! IMPORTANT:
Literal commas in any field in this file must be encoded using the XML 
entity reference form.  The XML entity reference for the comma is &#x2C;. 
Entity references may appear in either hexadecimal or decimal notation.

File Contents

The Special Characters.cfg file is a list of comma separated values.  Each entry 
contains three comma separated fields.  This file may contain tabs for readabiltiy.

First Field

The first field contains the value of the keyboard key that accesses the entry.  

If this field is empty, the entry is only available using the Special Characters Entry 
form.

Degree ê Shift-F1

Phonocopyright ’ Shift-F3

Copyright “ Shift-F4

Sharp ” Shift-F5

Inverted ? • Shift-F6

Inverted ! – Shift-F7

Table 6-1. Special Character Mode Mapping - Diacritic & Non-Roman Characters

Description
Diacritic / Non-Roman 

Character
Keyboard Equivalent
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The first field may only contain ASCII graphic characters with code points from 32 
through 127 decimal.

This field may only contain a single character.

Second Field

The second field contains the text to insert into the field of the MARC record.

This field may contain characters from Latin-1.  Any characters from outside the 
Latin-1 character set must be encoded in XML entity reference format.

This field may contain an arbitrary amount of text.  It is possible for this field to 
contain a lengthy block of text (approximately 80 characters).  Although, the 
default file contains single-character entries.

Third Field

The third field contains a description of the entry. This field is optional.

It may contain Latin-1 characters and entity references.

This field may be 80 characters in length.

Microsoft Character Map

The Microsoft Character Map can be used to cut and paste non-Roman 
characters needed for Cataloging input.

Use the following path to access the Microsoft Character Map.

Start>Programs>Accessories>System Tools>Character Map

For more information about the Microsoft Character Map use the Microsoft Help 
and reference materials on this topic.

Regional Options for Non-Roman 
Characters

Microsoft provides operating-system-level regional language options that provide 
another alternative for entering non-Roman character.

Use the following path to access the Microsoft Regional Options.
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Start>Settings>Control Panel>Regional Options

For more information on this topic use the Microsoft Help and reference materials.

Importing Records with Non-Roman 
Characters

Information about considerations for importing Non-Roman characters can be 
found in BulkImport on page C-8 and also in the Voyager Technical User’s Guide.

Other Diacritic Considerations

Other diacritic considerations can be found in Diacritics and MARC21 Compliance 
Considerations on page C-3.
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Pick and Scan (Cataloging/Circulation)

Introduction

With Pick and Scan, authorized users can make changes to one or more item, 
holdings, and/or bibliographic records in a single process. The records you want 
to change can be identified by item barcode or Voyager record ID (item, holdings, 
or bibliographic record IDs). When processing changes, a single identifier 
(barcode or record ID) can be entered on the Records to Change tab or a file 
containing multiple barcodes or record IDs can be specified.

Refer to the following sections for additional information:

• Security

• Pick and Scan Workspace

• Using Pick and Scan

Security

Similar to manually making changes to Voyager records, Pick and Scan requires 
that operators have the appropriate security authorization in the following profiles 
to process the requested changes:

• Voyager System Administration > Security > Cataloging Profiles 

• Voyager System Administration > Security > Circulation Profiles
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For Cataloging Profiles, the options are located on the Profile Values tab (see 
Figure 7-1). 

Figure 7-1. Cataloging Profile Operator Security Options/Authorizations

The authorizations in the Circulation Profiles related to Pick and Scan are located 
on the Profile 2 tab (see Figure 7-2).
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Figure 7-2. Circulation Profile Operator Security Options/Authorizations Related to Pick and 
Scan

Refer to the Voyager System Administration User’s Guide for more information 
regarding these profile options.

Pick and Scan Workspace

The Pick and Scan workspace is comprised of the following tabs:

• Changes to Make

• Records to Change

• Logs
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Changes to Make

Many of the options on the Changes to Make tab (see Figure 7-3) are directly 
related to the information captured in the item record dialog box in Cataloging 
(see Figure 7-4, Figure 7-5, and Figure 7-6). 

Figure 7-3. Changes to Make Tab
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Figure 7-4. Cataloging Item Record Dialog Box

Figure 7-5. Item Record - Item Status
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Figure 7-6. Item Record - Item Statistical Categories

Refer to Table 7-1 for a description of the options available on the Changes to 
Make tab. The Reset button on the Changes to Make tab enables you to reset all 
of the options that you have changed on this tab back to the default settings. 

Table 7-1. Changes to Make Tab

Option Description

Locations

Permanent Select from the drop-down menu of available locations.

TIP:
When making changes to the Permanent Location, you 
may also want to simultaneously change the Holdings 
Location of the linked holdings record.

Temporary Select from the drop-down menu of available locations.

The default option in all cases is No Change.

Clear is provided as an option for non-required fields in the item 
record. Select Clear to remove any data that exists in the field. 
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Types

Permanent Select from the drop-down menu of available item types defined 
in Voyager System Administration.

The default option in all cases is No Change.

Temporary Select from the drop-down menu of available item types defined 
in Voyager System Administration.

The default option in all cases is No Change.

Clear is provided as an option for non-required fields in the item 
record. Select Clear to remove any data that exists in the field. 

Media Select from the drop-down menu of available item types stored 
in Voyager Media System Administration.

The default option in all cases is No Change.

Clear is provided as an option for non-required fields in the item 
record. Select Clear to remove any data that exists in the field. 

Self Check

Magnetic Media Select Yes or No for the Magnetic Media flag per your item 
record requirements for self-check processing. 

The Magnetic Media option sets item record-level flags for 
interfacing with third-party self-check machines for item check in, 
check out, and renewal transactions. This is used for magnetic 
media alerts.

When viewing the item record, the Magnetic Media check box is 
checked if Yes has been chosen.

Refer to the Voyager Interface to Self Check Modules Using 3M 
SIP User’s Guide for more information.

Sensitize Select Yes or No for the Sensitize flag per your item record 
requirements for self-check processing. 

The Sensitize option sets item record-level flags for interfacing 
with third-party self-check machines for item check in, check out, 
and renewal transactions. This is used for sensitize alerts.

When viewing the item record, the Sensitize check box is 
checked if Yes has been chosen.

Refer to the Voyager Interface to Self Check Modules Using 3M 
SIP User’s Guide for more information.

Table 7-1. Changes to Make Tab

Option Description
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Item Free Text Select Clear to remove any content in the Free text field in the 
item record.

Select Append (and enter text in the space provided) to add text 
to the existing content in the Free text field in the item record.

Select Replace with (and enter text in the space provided) to 
replace the existing content in the Free text field in the item 
record. 

Copy Number Use the options provided to:

• Reset the copy number to zero

• Replace the existing copy number with the copy number 
you specify in the space provided

Pieces Use the options provided to:

• Reset the pieces number to one

• Replace the existing pieces number with the pieces 
number you specify in the space provided

Item Price Use the options provided to:

• Reset the item price to zero ($0)

• Replace the existing price with the amount you specify in 
the space provided

Table 7-1. Changes to Make Tab

Option Description
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Item Status Use the options provided to:

• Add the statuses you select from the list provided

• Remove the statuses you select from the list provided

• Delete the existing statuses (for the record/records 
specified on the Records to Change tab) and replace 
them (add) with the tatuses you select from the list 
provided

The list provided contains the following non-system-applied 
statuses:

• At Bindery

• Cataloging Review

• Circulation Review

• Claims Returned

• Damaged

• In Process

• In Transit

• Lost--Library Applied

• Missing

• Withdrawn

The default option is No Change.

Clear is provided as an option to remove any selections you 
have made.

Statistical Categories Use the options provided to:

• Add the statistical categories you select from the list 
provided

• Remove the statistical categories you select from the list 
provided

• Delete the existing statistical categories (for the record/
records specified on the Records to Change tab) and 
replace them (add) with the statistical categories you 
select from the list provided

The list provided reflects the statistical categories defined in the 
Voyager System Administration module.

The default option is No Change.

Clear is provided as an option to remove any selections you 
have made.

Table 7-1. Changes to Make Tab

Option Description
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Delete Item Use this option to delete the record/records specified on the 
Records to Change tab.

You may also specify deleting the associated holdings record if 
there are no other item records attached to that holdings record. 
In addition, you may also indicate to delete the associated 
bibliographic record, if after deleting the holdings record, there 
are no other holdings records linked to the bibliographic record.

NOTE:
For bound-with items, selecting the option to delete the 
bibliographic record also deletes additional bibliographic records 
linked to the bound-with item record.

Suppress from OPAC

Bib Select one of the following options:

• Suppressed

• Unsuppressed

The default is No Change.

Choosing the Suppressed option causes the suppress flag to 
be set in the database for the bibliographic record linked to the 
item identified for Pick and Scan.

For the Unsuppressed option, the suppress flag in the database 
is turned off.

NOTE:
For bound-with items, this includes all bibliographic records 
linked to the bound-with item record.

To change the suppress flag, the user needs to be logged into 
the bibliographic record’s owning library and have Add/Update 
Item Records checked on the Profile 2 tab (Circulation Profile) 
in Voyager System Administration.

Table 7-1. Changes to Make Tab

Option Description
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MFHD Select one of the following options.

• Suppressed

• Unsuppressed

The default is No Change.

Choosing the Suppressed option causes the suppress flag to 
be set in the database for the MFHD record linked to the item 
identified for Pick and Scan.

For the Unsuppressed option, the suppress flag in the database 
is turned off.

NOTE:
The MFHD record cannot be unsuppressed if its location is 
marked as suppress.

To change the suppress flag, the record’s location must be in the 
security profile and Update Holding Record With Pick and 
Scan must be checked on the Profile 2 tab (Circulation Profile) 
in Voyager System Administration.

Holding Location Select from the drop-down menu of available locations stored in 
the operator’s security profile. 

Modifications to the Holding Location option change the linked 
MFHD 852 ‡b.

852 Subfield k Use this option to make the following call number prefix changes 
in the linked MFHD:

• Delete 852 ‡k

• Replace the existing 852 ‡k content with the call number 
prefix content you specify in the space provided

OK to Export Use this option to set a record flag to identify bibliographic and/or 
MFHD records for export. The drop-down list options are:

• No Change

• No (don’t export)

• Yes (export and leave the export date as it is stored; if no 
export date exists, it will be set to the current date)

• Yes, and change date (export and change the date for 
export to the current date)

Table 7-1. Changes to Make Tab

Option Description
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Records to Change

The Records to Change tab (see Figure 7-7) provides the Pick and Scan options 
that enable you to specify the records that you want to change. You can 
interactively specify the identifier information for making changes one record at a 
time using the Identifier field, or you can specify the file name of a file containing 
multiple records that you want to change in a single process. Pick and Scan 
processing information displays on the lower portion of this tab.

Figure 7-7. Records to Change Tab
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Refer to Table 7-2 for a description of the options available on the Records to 
Change tab. 

Table 7-2. Records to Change Tab

Option Description

Record Identifier Select one of the following options to indicate how the system is 
to identify the record(s) that you want to change:

• Item Barcode

• Item ID

• Holdings ID

• Bibliographic ID

This option works in combination with the Identifier field and the 
File field. As a result, you need to specify a record identifier for all 
Pick and Scan processing that you invoke.

Perform Changes 
Against

Select one of the following options to indicate how to process 
empty holdings or bibliographic records:

• This item only

• All items on this holdings record

• All items on all holdings records

What To Do Select the Update Database or Preview option to indicate the 
action your prefer. The Preview option is the default that enables 
you to process a preview of your requested changes before 
committing those changes to your Voyager database. Use the 
Update Database option to execute your changes in the Voyager 
database.

When processing a file of multiple records, you may also indicate 
that the system should stop processing upon the first error that it 
encounters.

Identifier Enter the barcode or the record ID for the record that you want to 
change (or delete). Click the check mark icon to process the 
change(s) that you specified on the Changes to Make tab.
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Logs

The Logs tab (see Figure 7-9) provides options for you to identify your local 
logging preferences and work with the logs on the server.

For Pick and Scan, the logging naming convention uses the following format:

“PASLog.” + Process ID + “.” + Timestamp 

The Process ID is the same for the same profile with multiple jobs run in the same 
open session. The Process ID changes with a new profile and a new open 
session. 

You can save local logs to your PC or network-attached drive.

File Enter the name of the file containing the barcodes or record IDs 
of the records that you want to change or delete.

Each barcode or record ID in the file must be on a separate line/
row (see Figure 7-8). 

Figure 7-8. Example File

Print List Click this button to print the processing information displayed on 
the Records to Change tab.

Save to File Click this button to save the processing information displayed on 
the Records to Change tab as a .txt file.

Table 7-2. Records to Change Tab

Option Description
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The Logs tab provides the following options for managing your server logs:

• Select All/Unselect All (from the server logs displayed on the Logs tab)

• Get log (stores selected log/logs locally)

NOTE:
When Encrypt= is set to Y in the Voyager.ini file, the Get Log button 
and the ability to retrieve the log to the client from the server is unavailable.

• Delete (selected log/logs)

Figure 7-9. Logs Tab

Using Pick and Scan

The procedure for using Pick and Scan is shown in Procedure 7-1, Making 
Changes with Pick and Scan, on page 7-16
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Procedure  7-1.  Making Changes with Pick and Scan

Use the following to make changes with Pick and Scan:

1. After logging in to the Cataloging or Circulation module, select Pick and Scan from 
the File or Functions menu, respectively.

2. Specify the changes you want to make on the Changes to Make tab. Refer to the 
section Changes to Make on page 7-4 for additional information regarding your 
options.

3. Optionally, click the Logs tab and specify your preferences if you plan to locally log 
any problems during processing. Refer to the section Logs on page 7-14 for 
additional information regarding your options.

4. Click the Records to Change tab.

5. Using the options provided, specify the following:

• What record identifier you plan to use

• How to perform item changes

• If you want to preview changes or make the changes to the Voyager 
database

• Enter the barcode or record ID for single record change or enter the name 
of the file containing multiple barcodes or record IDs for processing 
changes

6. Click the check mark to process a single record change or click the Process File 
button to process multiple records per the barcodes or record IDs that you have 
specified.

Result: The processing changes display in the space provided on the Records to 
Change tab.

7. Optionally, print or save the processing results on the Records to Change tab that 
display.

8. Click Close when Pick and Scan processing is complete.
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Introduction

A template allows you to use a pre-defined MARC record to create new records 
easily. Before you can create a record, there must be at least one template in the 
template directory in the Voyager directory. Voyager provides you with three 
templates.

• bib.tem

• auth.tem

• hold.tem

These templates should not be deleted. 

For information about setting template preferences, see Folders/Files Tab on 
page 11-15.

The procedure for creating a new template is shown in Procedure 8-1, Creating a 
New Template, on page 8-2.

The procedure for editing a template is shown in Procedure 8-2, Editing a 
Template, on page 8-4.

The procedure for deleting a template is shown in Procedure 8-3, Deleting a 
Template, on page 8-5.
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NOTE:
Templates cannot be retroactively applied to an existing record.

Creating, Editing, and Deleting 
Templates

The procedure for creating a new template is shown in Procedure 8-1, Creating a 
New Template, on page 8-2.

NOTE:
You must have at least one template for each type of record that you want to 
create such as bib.tem, auth.tem, or hold.tem.

Procedure  8-1.  Creating a New Template

Use the following to create a new template.

1. Select File>Template>New.

2. Select the record type (Authority, Bibliographic, or Holdings) and click OK. 

Result: The system template for the record type you selected is displayed.

3. Create the new template by entering the Leader, fixed fields, and variable fields.

For more information, see Bibliographic Records on page 2-3, Authority Records 
on page 2-31, and Holdings Records on page 2-41. 

For special considerations regarding authority templates, see Special 
Considerations - Authority Templates on page 8-3.

Result: A template matching your requirements is completed.

4. Select File>Save As. Enter the name you want for your template. The suffix for the 
file must be .tem such as thesis.tem.

NOTE:
When a template is saved, it is not validated against authority records or the 
MARC tag table. 
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Special Considerations - Authority Templates

To provide for the most flexibility in authority record creation, Voyager Cataloging 
provides the folllowing options with authority templates when validating authority 
records and using Create auth from the Authority Validation dialog box (see 
Figure 9-1).

• System generated fields

• Custom templates

• Default preferences setting

System Generated Fields

The system automatically populates the authority template with the following 
fields.

• 040

• 670 

See the Create auth description in Table 9-2 on page 9-4 and Figure 9-5 on 
page 9-7 for more information.

• 1XX and 4XX (depending on what is being validated in the authority record)

If a blank template (where no fields are specified) is created, saved, and specified 
as the default in Session Defaults and Preferences (see Figure 11-7 on 
page 11-16), the automatically generated fields display when using Create auth 
from the Authority Validation dialog box.

The system generated fields are based on a standard established by the Library 
of Congress. 

Custom Templates

You may also create your own unique templates that identify fields beyond the 
system generated ones as described in System Generated Fields on page 8-3. 
Follow the steps described in Procedure 8-1, Creating a New Template, on 
page 8-2 to create your custom templates.

! IMPORTANT:
System generated fields are also dynamically added to your template when 
you use Create auth from the Authority Validation dialog box. If, for 
example, you include an 040 field in your custom template, a duplicate 040 
is generated when the authority template displays.  Therefore, your custom 
templates do not need to include the system generated fields.
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Default Preferences Setting

To eliminate any extra steps in locating a commonly used authority template, use 
Session Defaults and Preferences to specify the name of the template to be used 
as the default.

See Folders/Files Tab on page 11-15 for more information about setting defaults.

The procedure for editing a template is shown in Procedure 8-2, Editing a 
Template, on page 8-4.

Procedure  8-2.  Editing a Template

Use the following to edit a template.

1. Select File>Template>Edit. 

2. Select the template you want to edit and click Open. 

Result: The template you selected opens. 

3. Edit the template by changing the Leader, fixed fields, and variable fields. For more 
information on these fields, see the section about that particular record type. For 
more information, see Bibliographic Records on page 2-3, Authority Records on 
page 2-31, and Holdings Records on page 2-41.

To edit the template, you can use the same commands as you use for editing a 
record. See Table 11-13 on page 11-32 for more information.

4. Select File>Save to save the template with the same name. Select File>Save As to 
save the template with a different name. If you use Save As, the suffix for the file 
must be .tem.

NOTE:
When a template is saved, it is not validated against authority records or the 
MARC tag table.

The procedure for deleting a template is shown in Procedure 8-3, Deleting a 
Template, on page 8-5.
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Procedure  8-3.  Deleting a Template

Use the following to delete a template.

1. Select File>Template>Edit.

Result: The Open Template File dialog box displays.

2. Select the template you want to delete and click Open. 

Result: The template you selected displays.

3. Select File>Template>Delete. 

Result: A warning message displays regarding your delete request.

4. Click OK to delete the selected template, or click Cancel to close the dialog box 
without deleting the selected template.

Result: The templated is deleted or canceled per your selection.

Templated Input

Optionally, you may want to consider using Templated Input for entering and 
editing MARC records. This alternative provides the capability to use common-
language terms to prompt the enduser for input fields.

For a detailed explanation of using Templated Input, see Appendix D.
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Introduction

When you select Record>Save to Database, Voyager's Cataloging module can 
automatically validate the current record against the appropriate authority record. 
Fields that are subject to authority control (such as authors, series, and subjects), 
are checked against authority records in your database. 

Depending on what option is selected on the Validation tab in Session Defaults 
and Preferences (see Session Defaults and Preferences on page 11-1), one of 
the following occurs.

• If all headings are valid or if Bypass Authority Control is selected, the 
record is saved to the database. 

• If there are invalid headings and you have not selected Display all the 
headings, the Authority Validation dialog box opens and lists only the 
headings without an authority record.

• If there are invalid headings and Display all the headings is selected, the 
Authority Validation dialog box opens and lists all of the headings 
whether they are valid or not such as no authority record. 

NOTE:
If you want to save bibliographic records in your current session to the database 
without running Authority Control Validation, you can check the Bypass Authority 
Control Validation option in Options>Session Defaults. Otherwise, all invalid 
headings must be resolved or overridden by clicking the Continue button on the 
Authority Validation dialog box (Figure 9-1) before the record is saved to the 
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database. However, the database requires that in all variable length fields each 
subfield indicator is followed by text even if this option is selected. A single space 
following the indicator is a sufficient amount of text.

Figure 9-1. Authority Validation dialog box

Columns on the Authority Validation 
Dialog Box

The following columns (see Table 9-1) display in the Authority Validation dialog 
box.  

Table 9-1. Authority Validation Dialog Box

Column Description

Heading Name, Title, Name/Title, or Subject.

Tag(s) MARC record tags being validated.
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Validation Displays the results for validation of each tag in the 
record.

• Heading Validated - an exact match was made

• Cosmetic Differences - the record matches except 
for differences in punctuation

• Partial Heading Validation - some of the subfields 
(but not all) match a heading

• No Heading Validated - a match could not be 
found to validate the heading

NOTE:
Partial Validation works by trying to make an exact match 
of the subfields of the record. If it does not, it removes the 
rightmost subfield and performs a match based on that 
information. It repeats this until it makes a match or it 
runs out of fields, at which point it returns No Heading 
Validated. 

 Partial Validation does not match based on close 
matches of a subfield.  For example if you validate "‡a 
Mississippi River," a partial match never identifies "‡a 
Mississippi River Authority" as a candidate. For that type 
of matching, you must highlight the heading and click 
Search to perform a browse headings search which will 
list all the headings that closely but not exactly match that 
heading.

Bib Heading The bibliographic heading with subfield diameters.

Near Heading The bibliographic heading in the database that most 
closely matches the heading under validation. The follow-
ing may display in the Near Heading column.

• The column may be blank indicating that the 
heading does not match

• The heading may display in a normalized form 
(and matches the authority heading)

• The headings do not match partially, or they are 
from another index

Table 9-1. Authority Validation Dialog Box

Column Description
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Buttons on the Authority Validation 
Dialog Box

The following buttons (see Table 9-2) display on the Authority Validation dialog 
box.    

Table 9-2. Authority Validation Dialog Box Buttons

Button Description

Create auth Use to generate a new Authority record. 

The NUC code in the 040 comes from the Cataloging 
location’s Owning Libraries NUC code. The Authority 
record’s location must correspond to the Owning 
Libraries Location. 

To activate the Create auth button, you must first select 
the error in the Authority Validation dialog by clicking 
the row label. 

Clicking Create auth displays the AuthDll32 dialog box. 
See Figure 9-2.

Clicking Create auth displays an authority template if 
one has been selected as a default in Session Defaults 
and Preferences (see Table 11-5 on page 11-16) or the 
Select Authority Template dialog box (see Figure 9-3) 
displays from which you can select a template.

See Procedure 8-1, Creating a New Template, on 
page 8-2 for more information about creating templates.

If you click Cancel from the Select Authority Template 
dialog box, the system generated template displays (a 
standard established by the Library of Congress).  See 
Figure 9-4.

If you click Cancel from the Select Authority Template 
dialog box and there is not enough information available 
to create a 670‡b, the Building 670b dialog box 
displays. See Figure 9-5. Optionally, you may select 
Don’t Generate any 4XX fields in the new authority 
record that gets automatically created.

Retrieve auth Use to retrieve an authority record when one exists.

This button is disabled if the heading selected has no 
associated authority record. 
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Figure 9-2. Example of the AuthDll32 dialog box

Copy Copies the selected Heading text to the clipboard. To 
activate the Copy button, you must first select the error in 
the Authority Validation dialog by clicking the row label 
(the grey, left column).You can then paste the Heading 
into the new authority record using Edit>Paste or the 
Ctrl+v function.

Search This button allows you to search for authority headings 
using the standard Search dialog. A browse search is 
launched with the search argument being the selected 
heading. If you select a heading from the browse list and 
click Copy, the heading is copied to the clipboard. You 
can then return to the record and add the heading 
information by selecting a point in the variable field and 
clicking Paste. 

NOTE:
If the heading selected is a subdivision, the search 
performed is a regular find search rather than a browse.

Continue This overrides all of the authority validation errors and 
allows Voyager to save the record to the database. This 
button does not create authority records for the 
unauthorized headings.

Close This button closes the Authority Validation dialog box.

Table 9-2. Authority Validation Dialog Box Buttons

Button Description



9-6  Ex Libris Confidential

Cataloging User’s Guide

Figure 9-3. Select Authority Template dialog box

Figure 9-4. New Auth Record example
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Figure 9-5. Building 670b dialog box example

Global Headings Change and Preview 
Queue

An authority record, the 100-185 fields, contains an established name, title, name/
title subdivision, or subject. Voyager’s Global Headings Change process is a 
combination of client interface and batch jobs on the server that process the 
changes you make to an authority heading. When a change is made and saved to 
the database, you can view all of the affected heading changes in the Global 
Headings Change Queue activity of the Voyager Cataloging module (select from 
the File menu in the Cataloging main menu).  You must have the proper security 
profile in System Administration to make these changes.

When a change to an authority heading or subdivision type (initial subfield 
delimiter or 18x tag of the subdivision) is made, the Global Headings Change 
Queue expands to a hierarchical tree, displaying all of the changes to the 
Authority heading as well as the associated authority fields or records. You can 
view the proposed changes, see the other information that is affected, and finally 
mark the changes that you want implemented.
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NOTE:
Traced and untraced reference authority headings may be changed by the Global 
Headings Change Queue.

Each of the three branches of the tree (see Table 9-3 for a description) represents 
a different aspect of the authority heading information.   

The levels of the tree are shown in Figure 9-6.

Table 9-3. Tree Descriptions

Tree Level Description

First level Displays the original authority record prior to changes, 
the 1xx or 18x.

Second level Displays the modified 1xx or 18x heading, the affected 
headings in bibliographic records, and the bib record 
affected by the change.

Third level Displays all authority headings affected by the changed 
1xx or 18x heading in level one. Those headings affected 
include the 1xx, 4xx, or 5xx fields.

NOTE:
If a 4xx displays in the third level and its level one 
heading is not a subdivision (for example, you have a 4xx 
pointing to a 1xx that is the same as the 4xx), it is a sign 
of a conflicting authority record.
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Figure 9-6. Global Headings Change Queue Tree Levels

In order for Global Headings Changes to be completed, three batch processing 
jobs must be run.  They must be run in the following order.

1. Job 11

2. Job 12

3. Job 13

For more information, see the Voyager Technical User’s Guide.  

Each job only processes records that have had the previous job run on them.  If 
you run the same job consecutively, it is ignored the second time. 

The Bibs column (bibliographic count) that displays in level two of the Global 
Headings Change Queue tree indicates the number of times the authority 
heading occurs in a bibliographic record. The bibliographic count that displays in 
the preview queue displays the number of bibliographic records to be processed 
with the new heading. See Figure 9-7.

! IMPORTANT:
Any records to be processed through the Global Headings Change Queue 
must not be manually changed between each step of the batch job.  If 
changes are made manually, the records in which changes were made are 
removed from the queue.



9-10  Ex Libris Confidential

Cataloging User’s Guide

Figure 9-7. Global Heading Change & Preview Queues

If you have a bibliographic record with a name/title heading that, for example, 
contains both a 1xx and a 240, 243, or 245 or it contains a 400, 410, 411, 700, 
710, 711, 800, 810, or 811, it is only changed if an authority record which contains 
a name/title heading is changed.  If a non-name/title authority record such as a 
name authority heading with a matching 1xx heading is changed, this has no 
effect on a name/title bibliographic record.

For example, suppose you have a bibliographic record that contains the following.

100  ‡a Adams, John Q.

243  ‡a My life with Abigail : a biography

You also have authority record #1 that has the name but not the title in the 1xx, as 
in the following example.

100  ‡a Adams, John Q.

If you change the 100 ‡a of authority record #1 to Adams, John Quincy, the above 
bibliographic record is not changed.

Assume you have an authority record #2 that contains a name/title heading, such 
as the following example.

100  ‡a Adams, John Q.  ‡t My life with Abigail : a 
biography

If you changed the 100 ‡a of authority record #2 to Adams, John Quincy, that 
change is reflected in your bibliographic record.
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Global Headings Change Work Flow

The following is a Global Headings Change workflow example:

1. A change is made to an authority heading by an online edit, online replace, import, 
or Bulk Import and saved to the database. The change is automatically queued up to 
the Global Headings Change Queue. 

2. Open the queue by pressing Ctrl + G or by selecting File > Global Headings 
Change from the main menu. The heading that is visible is the old authority heading, 
before it was changed. The Authority record can be viewed by clicking the heading 
and then clicking the Auth... button.

3. The first batch/server process (batch job 11) is run. 

NOTE:
Refer to the Voyager Technical User’s Guide for more information regarding 
Cataloging batch jobs 11,12, and 13. 

4. The first stage of change displays in the Global Headings Change Queue. You can 
view the heading changes that were made to the original Authority record.

5. Run the second batch job (batch job 12) and view the Global Headings Change 
Queue again. 

6. This allows you to view changes that are to be made to authority and bibliographic 
records that have that heading. To see a list of bibliographic records associated with 
the new heading, highlight the new heading and click the Preview button. The bib 
records display in the lower portion of the Global Headings Change dialog box.

7. Check the Process? check box (or highlight the new heading and click the Process 
button). The process flag marks the change to be executed by the batch job and 
identifies those check boxes to initiate the change.
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Figure 9-8. Process? Check Box

8. Running the third batch job (batch job 13) completes the changes that have been 
checked and saves them to the database.

Global Headings Change Work Flow - Alternative 1 
Process All

If you choose to bypass the step to preview/review the global headings changes, 
you can use the Process All option to flag all the records for change and skip 
batch job 12. In this scenario, the alternative work flow is as follows:

1. Run the first batch/server process, batch job 11 (Catjob 11). The first stage of change 
is available in the Global Headings Change Queue. That is, the old authority heading 
before it was changed and new authority heading with the changes that were made 
to the original authority record are now available. 

2. Open the Global Headings Change queue by pressing Ctrl + G or by selecting File > 
Global Headings Change from the main menu.
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Figure 9-9. Global Headings Change Queue

3. Click Process All. By selecting Process All, the system automatically marks the 
Process? check box for all authority records in the queue. If you change your mind, 
you can select Clear All to remove the check mark from the Process? check box for 
all the authority records in the queue.

If you forget to run batch job 11 before selecting Process All, the system will 
prompt you with an informational message reminding you that you need to run this 
batch job.

4. Run batch job 13 (Catjob 13) to complete the changes that have been checked by 
the Process All option and save them to the database.

Global Headings Change Work Flow - Alternative 2 
Manually Process

An alternative method of making these changes without the Global Headings 
Change Queue is to change the records directly. You can bring up the 
bibliographic records that have the old authority heading and update all of the 
references manually. This removes the heading from the queue.
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Global Change Process

For more information on batch jobs 11-13, see the Voyager Technical User’s 
Guide.

When a change is made to an authority record and saved to the database, the 
record with the change displays in the Global Headings Change Queue as it 
used to be before the changes were made. Refer to Figure 9-10. This is the first 
level of headings changes in the tree structure. 

Figure 9-10. Global Heading Preview: Intial State

You can view the full Authority record in MARC format by highlighting the record 
and clicking the Auth button. Refer to Figure 9-11.
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Figure 9-11. Global Change Preview:  Authorities Records

Running the first batch job causes Voyager to add the second level of heading 
changes to the tree structure. These are the changes that are intended to be 
made.  The Process flag displays at this level. This flag allows you to select which 
changes you want to have processed by the third batch job.

Running the second batch job causes Voyager to add the third level of headings 
changes to the tree structure. These are the authority record headings that would 
be affected by the change. This batch job creates the entries in the preview 
queue, displaying any Authority records with 5XX fields.

When you view the Global Headings Queue, you are able to select which 
changes are to be processed.  Each change and its corresponding updates are 
the result of an authority heading change.

After running the second batch job you can also view any bibs associated with this 
heading by highlighting the heading and clicking the Preview button. This 
displays the changed heading, and enables the Bib button which displays the 
complete record. The top section of the Global Headings Change Queue only 
displays the old heading and the heading change. 

Before you run the third batch job, you must specify which changes you want to 
make by checking the Process? box.

Running the third batch job makes all of the changes to the bibliographic and/or 
authority records that had the Process flag turned on in the Global Headings 
Queue dialog box.
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Original Heading

The first thing displayed when you open the global headings screen is the original 
heading. See Figure 9-12 and Table 9-4.

Figure 9-12. Level One of Tree: Original Heading, outlined

 

Proposed New Heading

The next thing that displays below the old heading is the new heading. See Figure 
9-13 and Table 9-5.  This displays the complete new heading as it will look after 
the changes have been made. You must check the box to the left of the new 
heading in order to make the change. There may be more than one proposed new 
heading, such as when a subdivision is changed.

Table 9-4. Original Heading Information Displayed

Column Description

Auth ID The authority record ID of the changed heading.

Heading (old) The original heading for the record.

Operator The operator who made the change.

Date The date the change was made.

Index Type The type of heading index.
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Figure 9-13. Level Two of Tree: Proposed New Heading, outlined

 

Affected Authority Headings

Any rows that display below the new heading are the other affected authority 
headings (see Figure 9-14 and Table 9-6) such as a 5XX or, in the case of a 
subdivision change, a 1XX.  Depending on the changes being made, there may or 
may not be any affected authority headings to be changed. That is, no affected 
authority headings may display in the dialog box.

Figure 9-14. Level Three of Tree: Authority Headings outlined

Table 9-5. Proposed New Heading Information Displayed

Column Description

Process? You can instruct the batch job to process the change by 
either clicking the check box or selecting the heading and 
clicking the Process button.

Heading (new) The proposed new heading.

Bibs The number of bibliographic records containing the old 
heading.

Authorized? States whether the heading is an authorized Heading.
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Splitting a Heading

You may want to split a heading such as vaccine and vaccination. If 90 percent of 
the records will be vaccine, it might be a good idea to complete Global Change for 
100 percent of the records and change the 10 percent that will go under 
vaccination manually. 

Heading Merge

In order to merge headings, you can create a brief or provisional authority record 
to attach to the old headings and then change the heading and leave the old 
authority record there until after the Global Change. After the Global Change, you 
can delete the dummy authority record.

Name/Title Heading Change

If you have a bibliographic record with a name/title heading that, for example, 
contains both a 1xx and a 240, 243, or 245 or it contains a 400, 410, 411, 700, 
710, 711, 800, 810, or 811, it is only changed if an authority record which contains 
a name/title heading is changed.  If a non-name/title authority record with a 
matching 1xx heading is changed, there is no effect on the bibliographic record.

Behavior of the Dialog Box

In order to display the Preview Change Queue, you must highlight a new 
heading in the upper portion of the dialog box. Click the Preview button and any 
bib records affected by the change display in the lower portion of the dialog box. If 
more than 250 bib records are affected by the change, the first 250 records 
display. Click the Next button to retrieve the remainder of the bib records. If you 
make any changes such as deleting a record, the count only reflects the number 
displayed compared to the number remaining that you have not retrieved. Only 
when you have retrieved all of the records does the count reflect the real total in 
the queue.

Table 9-6. Authority Headings Information Displayed

Column Description

Hdg Type Specifies the type of heading that contains the heading 
being changed.

Auth ID The authority record ID.

1XX  Heading Specifies the authorized heading.
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Buttons 

The following (Table 9-7) describes the different button options.   

When bib records are displayed after clicking the Preview button, the following 
buttons (see Table 9-8) display with the bib records in the lower portion of the 
dialog box.   

Table 9-7. Button Descriptions

Button Description

Process Highlight the new heading by clicking it and click the Pro-
cess button to flag the row to save changes to the data-
base in a batch job.

Clear Highlight the heading by clicking it and then click the 
Clear button to prevent the batch program from process-
ing the heading such as remove the Process flag.

Search Performs a browse search on the original heading or old 
heading.  Saving a record to the database allows you to 
search it.

NOTE:
If the heading selected is a subdivision, the search 
performed is a regular find search rather than a browse.

Preview Display any heading change by selecting it and clicking 
Preview.

Auth Displays the authority record.

Delete Deletes the selected changes from the Global Headings 
Change Queue.

Table 9-8. Button Description for Preview Display

Button Description

Next Retrieves more bib records if more than 250 records are 
affected by the heading change.

Bib Displays the bibliographic record.

Delete Removes a bib record from the preview list. It will not be 
included in the heading change.
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Global Headings Batch Job

See the Voyager Technical User’s Guide for a description of how to run each of 
the Global Headings batch jobs.  Refer to jobs 11, 12, and 13 of the Cataloging 
batch job.   
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Introduction

With the Authority Load Reviewer, you can review and process additional 
changes related to Auth Load Match jobs that have been run in Global Data 
Change (GDC). After selecting an Auth Load Match job to review, you can review 
individual records and perform the following actions:

• Import Record

• Find Related Bibs

• Retrieve Matches

• Claim Ownership

• Do Not Process

• Mark As Done

• Clear Status

To open the Authority Load Review dialog box, select Authority Load Reviewer 
from the Cataloging file menu. 
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Figure 10-1. Authority Load Review file menu option

The Authority Load Reviewer dialog box has the following components:

• Select Job

• Select Result Type

• Filters (for viewing records)

• Record selecting/viewing area

• Action buttons
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Figure 10-2. Authority Load Review dialog box

Select Job Area

The Select Job area provides a drop-down list from which to select the Auth Load 
Match job that you have run. The ellipsis button, when clicked, opens the Job 
Details dialog box that displays the GDC Auth Load Match job details (for the job 
that you’ve selected in the drop-down list) enabling you to confirm that you are 
selecting the correct job. 
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Figure 10-3. Authority Load Review Job Details dialog box (in Cataloging)

Similarly, the job details can be viewed from the GDC client with the View 
Running/Completed option. Refer to Figure 10-4.
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Figure 10-4. GDC job results view

When you have located the Auth Match Job for which you want to do further 
processing, click Get Job Results.

Select Result Type Area

After you have clicked Get Job Results for a specific Auth Match Job, the Select 
Result Type area becomes active and displays the number of records for the 
following types upon which some action can be taken:

• No Match

• Multi-Match
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• Split

• Delete

• Reject

Select one of the result types to have those records display in the Select Record 
area.

Filters

Depending on the results of the Auth Load Match job in GDC, there may be 
several records that display in the Select Record area when you choose a 
particular result type. As a result, the following filters have been provided to aid 
you in managing the Select Record list of records:

• Filter by Bulk

• Filter by Status (Refer to Table 10-1 for additional information)

• Filter by Owner

Table 10-1. Record Statuses

Status Description

New Identifies the initial state of a record after the Auth 
Load Match job.

Open Indicates that a Cataloging user is currently viewing 
this record in the Authority Load Reviewer. 

Other users may view the record but may not take any 
action until the owner releases it. 

While any record that can be reviewed is in this state, 
the GDC client is prevented from deleting a job or its 
result files.
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In Progress Indicates that a Cataloging user is taking some action 
based on this record in the Authority Load Reviewer 
even though the record may not be open at the 
moment. Other users may view the record, but may 
not take any action until the owner releases it.

A record is set to the In Progress status when a user 
has selected the Claim Ownership action for that 
record.

While any record that can be reviewed is in this state, 
the GDC client is prevented from deleting a job or its 
result files.

Done Indicates that a Cataloging user has viewed or taken 
some action based on the record and no further action 
is needed.

This status is informational and does not affect 
processing by Auth Load Merge.

This status does not prevent another user from 
working with the record

A user may undo this status by using the Clear Status 
action.

Do Not Process Indicates that the record is one that should not be 
processed by an Auth Load Merge job for any reason.

This status does not prevent another user from 
working with the record.

A user may undo this status by using the Clear Status 
action.

Imported Indicates that the record has been manually imported 
into the database via the Cataloging client and should 
not be processed by an Auth Load Merge job.

This status does not prevent another user from 
viewing the record, but all other actions are prohibited.

Another user may undo this status.

Table 10-1. Record Statuses

Status Description
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Record Selecting/Viewing Area

Use the Select Record list to identify a specific record to view for processing by 
clicking the row of the record in the list. 

Figure 10-5. Selected record opens in the viewing area

To view a different record, click a different record in the Select Record list.

In addition to the record opening in the viewing area, the system also displays:

• Record Status

If a different user has claimed ownership of the open record in the viewing 
area, the record will have a status of In Progress. To reset the status to 
Open, the user that claimed ownership of the record needs to click the 
Clear Status action button.

• Record Owner

If the open record in the viewing area is being viewed by a different user, 
the name of the other user appears in Record Owner.

If a different user has claimed ownership of the open record in the viewing 
area, the name of the other user appears in Record Owner.

• Actions available for the record that is open (refer to Action Buttons on 
page 10-9)
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Action Buttons

The actions that display for any given record that is open in the viewing area is 
dependent on: 

• Result type selected

• Current status of the record (New, Open, In Progress, Done, Do Not 
Process, or Imported)

• Permissions in the user’s operator Cataloging profile in Voyager System 
Administration

The following permissions are required in Voyager System Administration 
(see Figure 10-6 and Figure 10-7) for the actions provided in Authority 
Load Reviewer:

• Import Record - Authority Record/Add

• Find Related Bibs - Bibliographic Record/View

• Retrieve Matches - Authority Record/View

• Claim Ownership - Authority Record/Update

• Do Not Process - Authority Record/Update

• Mark As Done - Authority Record/Update

• Clear Status - Authority Record/Update

Figure 10-6. Operator Security for Authority Load Reviewer - Authority Record
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Figure 10-7. Operator Security for Authority Load Reviewer - Bibliographic Record

The following figure illustrates an example of an open record in the viewing area 
and the active action buttons for that record.

Figure 10-8. Action Buttons
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Refer to Table 10-2 for a list of available actions for each result type. 

Table 10-2. Available Actions for Each Result Type

Result Type Available Actions

No Match • Import Record

• Claim Ownership (marks record with a status of In 
Progress)

• Do Not Process

• Mark As Done

Multi-Match • Import Record

• Retrieve Matches (retrieves all authority records 
whose IDs are listed in the 935 field)

• Claim Ownership (marks record with a status of In 
Progress)

• Do Not Process

• Mark As Done

Split • Find Related Bibs (searches for any bibliographic 
records linked to the headings records that are 
linked to this open authority record)

When related bibliographic records are found, a 
dialog box opens where you can select Open to 
see a MARC record view or Search for a Headings 
Browse search. Refer to Figure 10-9.

• Claim Ownership (marks record with a status of In 
Progress)

• Mark As Done

Delete • Import Record

• Find Related Bibs (searches for any bibliographic 
records linked to the headings records that are 
linked to this open authority record)

When related bibliographic records are found, a 
dialog box opens where you can select Open to 
see a MARC record view or Search for a Headings 
Browse search. Refer to Figure 10-9.

• Claim Ownership (marks record with a status of In 
Progress)

• Do Not Process

• Mark As Done
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Figure 10-9. Viewing Find Related Bibs

Reject • Mark As Done

Rejected records can only be viewed along with the 
message that indicates why the record was rejected. 
Refer to Figure 10-10 for an example.

Reject result type records are records identified in and 
Auth Load Merge job that had one or more matches in 
the database and that satisfied a Do Not Merge If... 
rule included in an Auth Load Merge configuration.

By viewing these records in the Authority Load 
Reviewer, you are able to learn why these records 
were rejected.

Table 10-2. Available Actions for Each Result Type

Result Type Available Actions
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Figure 10-10. Reject message display area example
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Session Defaults and Preferences

You can access the Session Defaults and Preferences dialog box by selecting 
Options>Preferences. From this dialog box, you can change a number of 
defaults which are presented on several tabs.

• General

• Validation

• Work Flow

• Item Defaults

• Folders

• Mapping

• Colors/Fonts

• Bib MARC Tag Colors

After you select your defaults, click OK to accept them or click Cancel to close the 
dialog without applying any of your selections.

The defaults you choose are saved when you exit the Cataloging module. 
Preferences are machine specific. If more than one person uses the same 
workstation, each person uses the same defaults. 
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General Tab

Customize the options on the General tab (see Figure 11-1) to match your 
preferences using Table 11-1 for a description of each option.

Figure 11-1. Cataloging Session Defaults and Preferences: General tab
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Table 11-1. General tab options for Session Defaults and Preferences

Options Description

Holdings/Item default 
location

Select the default location for all holdings and item records that 
you create by clicking the drop-down arrow.

Call Number 
Hierarchies

Select the call number hierarchy which is used to pull call 
number information from a bib record into a holdings record.  
You can also select None from the list of options.

Bibliographic Import/
Replace Profile

Select the appropriate Import/Replace profile from this drop-
down menu. These profiles are defined by your system 
administrator and specify what actions are taken when 
duplicate records are found during an import. 

If your profile removes records that are currently in the 
database and replaces them with the imported record, or 
merges the existing record with a new record, the old records 
are archived on the server in the file 
replace.<recordtype>.marc. If your profile does not 
replace records that are currently in the database, the imported 
duplicate records are archived on the server in the file 
discard.<recordtype>.marc. Records rejected because 
they don’t match are archived in the file 
reject.<recordtype>.marc. 

To access the deleted and discarded files on the server, or for 
more information on specific profiles, refer to "Bibliographic 
Duplicate Detection Profiles" in the Voyager System 
Administration User’s Guide.
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Bib Overlay Import/
Replace Profile

Select the Overlay Record profile or None from the drop-down 
menu. Selecting the Overlay Record option causes the 
Overlay Record profile to be the default (see Figure 11-2 
below). 

NOTE:
The cataloging operator performing this function needs to be 
linked to an operator profile that permits the ability to overlay/
merge bibliographic records. Refer to the Security section of the 
Voyager System Administration User’s Guide that describes the 
options on the Profile Values tab for Cataloging Profiles for 
more information. 

Figure 11-2. Overlaying and Merging Bibliographic Records

Table 11-1. General tab options for Session Defaults and Preferences

Options Description
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Authority Import/
Replace Profile

Select the appropriate Import/Replace profile from this drop-
down menu. These profiles are defined by your system 
administrator and specify what actions are taken when 
duplicate records are found during an import. 

If your profile removes records that are currently in the 
database and replaces them with the imported record, or 
merges the existing record with a new record, the old records 
are archived on the server in the file 
replace.<recordtype>.marc. If your profile does not 
replace records that are currently in the database, the imported 
duplicate records are archived on the server in the file 
discard.<recordtype>.marc. Records rejected because 
they don’t match are archived in the file 
reject.<recordtype>.marc. 

To access the deleted and discarded files on the server, or for 
more information on specific profiles, refer to Authority 
Duplicate Detection Profiles in the Voyager System 
Administration User’s Guide.

Default Field Order 
Configurations

Select the MARC Field Ordering Rule from the drop-down lists 
for the Authority, Bibliographic, and Holdings parameters 
that contains the field sorting rule(s) that you want to apply to 
these records in Cataloging. 

If you want these field sorting rules to be applied automatically 
when you save records in Cataloging, select the Sort 
automatically on save option.

Refer to the MARC Field Ordering Rules section in the Voyager 
System Administration User’s Guide for more information.

Delete records from 
work files once saved 
to database

Select this check box to automatically delete a record(s) from 
your work files, once you save that record to the database.

Delete records from 
import file once saved 
to database

Select this check box to automatically delete the record(s) you 
import from an import file, once you save that record to the 
database.

NOTE:
This preference does not apply to authority records imported via 
the Authority Load Reviewer (refer to Authority Load Reviewer 
on page 10-1 for additional information).

Table 11-1. General tab options for Session Defaults and Preferences

Options Description
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Validation Tab

Customize the options on the Validation tab (see Figure 11-3) to match your 
preferences using Table 11-2 for a description of each option.

Figure 11-3. Session Defaults:  Validation tab

Add a subfield ‘a’ to a 
new field

Select this option to add a subfield ‘a’ automatically to the field 
when a new field is added to a record using the Insert field 
before (F3) and Insert field after (F4) commands.

Display MARC Views 
maximized

Select this option to open a record in its maximized form 
automatically.

NOTE:
If this option is selected and you have more than one record 
open at one time, you only see the top record. The other 
records open behind the top record. You can use the Window > 
Cascade command to minimize and view all open records. This 
is important to remember if you select the Close All command 
from the File menu.

Table 11-1. General tab options for Session Defaults and Preferences

Options Description
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Table 11-2. Validation tab options for Session Defaults and Preferences

Options Description

Cataloging formats Select one of the Cataloging formats.

• Marc21

• Oclc

• Rlin

See Tag Tables and MARC Validation on page A-4 for more 
information.

Bypass MARC 
Validation

Select this option to stop the validation of records against the 
MARC tag tables when you save to the database. More 
information regarding tag tables is available in MARC Tag 
Tables on page A-1.

See Figure 11-4 for an example of the message window that 
displays when this option is not selected and invalid characters 
are found when attempting to store a record in the database.

Bypass MARC21 
Character set validation

Select this option to prevent the validation of records against 
the MARC21 character set when you save to the database.

When this option is not selected, the MARC21 Repertoire.cfg 
file stored in the Catalog folder of the Voyager software on each 
PC is used for character set validation.

List all the errors Select this option to display a list of all the errors resulting from 
the MARC validation. This option is used in combination with 
Bypass MARC Validation.

Show errors one at a 
time

Select this option to display each error individually that results 
from the MARC validation. This option is used in combination 
with Bypass MARC Validation.

Bypass                   
Authority Control 
Validation

Selected this option to stop the validation of records against the 
authority records when you save to the database. 

When this option is not selected, only the heading types 
selected in the Heading Types group box undergo authority 
validation.
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Bypass Decomposition 
of accented characters 
for MARC21

Select this option to prevent the decomposition of characters for 
MARC21.  Leave this option unchecked for MARC21 
compliance.

Some non-Voyager data entry methods may utilize composed 
characters, characters that store two component parts (diacritic 
and alphabetic character) as a single character with its own 
unique internal value such as when using a non-U.S. keyboard.

For MARC21 compliance, characters with diacritics must be 
stored as two separate component pieces. (See Diacritics and 
MARC21 Compliance Considerations on page C-3 for more 
information.) This feature addresses this issue.

Display all the headings Select this option to have any of the heading types display in 
the Authority Validation dialog box along with the validated 
headings.

Only the headings in error display when this option is not 
selected.

Bypass ISBN validation Select this option to prevent the validation of the following fields 
when a bibliographic record is saved to the database:

• 020‡a

• 024‡a with first indicator of 3

If this option is not selected, validation occurs to insure compli-
ance with the ISBN format.

Bypass ISSN validation Select this option to prevent the validation of the 022‡a when a 
bibliographic record is saved to the database.

If this option is not selected, validation occurs to insure compli-
ance with the ISSN format.

Table 11-2. Validation tab options for Session Defaults and Preferences

Options Description
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856 link servers Use these options to specify the location of the server(s) that 
resolves the URN, DOI, and/or Image Server links.

URN/DOI:

URN (Uniform Resource Name) and DOI (Digital Object 
Identifier) work different from the URL (Uniform Resource 
Locator) addresses. 

The URN or DOI links in the link-capable fields of the MARC 
record do not point directly to the item. Instead, the URN or DOI 
link specification is first routed through a handler server which 
then maps the URN or DOI to the physical location of the digital 
item. 

You must specify the URL addresses of your URN and DOI 
handler servers in the URN and DOI fields on the Validation 
tab of the Session Defaults and Preferences window. 

When you verify the integrity of a URN or DOI link by selecting 
Verify Hypertext links from the Record menu (see Links - 
Verify Hypertext Links for Bibliographic Records on page 2-25), 
the URN or DOI link in a link-capable field is appended to the 
address of the URN or DOI handler server. 

For information about entering URN or DOI links in the link-
capable fields of a MARC record, see Links - DOI and URN Link 
Examples on page 2-25; and for information about set up in 
WebVoyáge, see WebVoyáge Architecture Overview and 
Configuration Models.

Image Server:

The Image Server field designates which viewer to use to bring 
up an Image Server link. 

You may specify the location of the Voyager Image Server exe-
cutable (the full path must be given such as c:\sym-
trix\iadms.exe), or the location of a browser interface 
program (such as http://XXX/cgi-bin/scandoc.cgi, 
where XXX is the machine on which the program is located). 
Scandoc.cgi is the interface which, when used with Image-
Server, uses a browser instead of Scandoc to view the images. 

The default value for this field is blank.

Heading Types - Name Select this option to have Name heading types validated.

Heading Types -Title Select this option to have Title heading types validated.

Table 11-2. Validation tab options for Session Defaults and Preferences

Options Description
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Figure 11-4. Invalid MARC21 Characters message when storing record

Work Flow Tab

Customize the options on the Work Flow tab (see Figure 11-5) to match your 
preferences using Table 11-3 for a description of each option.

Heading Types - Name/
Title

Select this option to have Name/Title heading types validated.

Heading Types - 
Subject

Select this option to have Subject heading types validated.

Heading Types - 
Subdivision

Select this option to have Subdivision heading types validated.

Subdivision can only be selected if Subject is selected.

Table 11-2. Validation tab options for Session Defaults and Preferences

Options Description
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Figure 11-5. Session Defaults: Work Flow tab 

Table 11-3. Work Flow tab options for Session Defaults and Preferences

Options Description

Retain last search Select this check box to save the last search performed in the 
Search dialog box. The last search is saved until the current 
Cataloging session is exited.

The system retains this preference selection from Cataloging 
session to session based upon your operator ID.

NOTE:
Retain last search overrides the Default Tab and Save 
Settings functionality located on the Search dialog box. 
Therefore, you must clear the Retain Last Search checkbox in 
order to utilize the Default Tab and Save Settings functions. 
See Table 3-3 on page 3-33, Table 3-4 on page 3-38, and 
Table 3-5 on page 3-45 for more information. 



11-12  Ex Libris Confidential

Cataloging User’s Guide

Automatic truncation for 
non keyword searches

Select this check box to automatically truncate non-keyword 
searches (such as Headings searches) without requiring the 
question mark (?) as a truncation character.

Display bibliographic 
record directly if search 
results in only one title

Select this check box to automatically display a bibliographic 
record if only one record is available as a result of the search.

Always create a holding 
when adding holdings 
to a bib (that is, do not 
show existing holdings 
first)

Select this option to be placed in Add mode automatically when 
a bibliographic record already has holdings and a new one is to 
be added either by clicking the New Hldgs button on the menu 
bar or selecting Record>Create Holdings.

Display item record 
directly if item retrieve 
results in only one item

Select this check box to automatically display an item record 
directly when only one record is available as a result of your 
search.

Sequence new items at 
top

Use this option when creating a new item record to tell the 
server to add the new item at the top of the sequence instead of 
the bottom of the sequence.

Sequence new e-items 
at top

Use this option when creating a new e-item record to tell the 
server to add the new e-item at the top of the sequence instead 
of the bottom of the sequence.

Check for Duplicate 
Item Barcodes

Use this option to specify that when the user adds an item 
record or a barcode to an existing item the software checks if 
the barcode is already used in other items. If so, the user 
receives a warning and has the option to cancel the add item or 
the add barcode operation, or to save it anyway.

If this is unchecked, the software does not check for the 
presence of duplicate barcodes.

Suppress confirmation 
message upon 
successful save

Select this check box to suppress the confirmation message 
that displays after a record has been successfully saved to the 
database. 

Table 11-3. Work Flow tab options for Session Defaults and Preferences

Options Description
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Item Defaults Tab

Customize the options on the Item Defaults tab (see Figure 11-6) to match your 
preferences using Table 11-4 for a description of each option.  These default 
settings affect what is displayed when creating item records.  The initial item type 
default is determined by the default settings (see Cataloging - Policy Definitions in 
the Voyager System Administration User’s Guide) for the Cataloging location 
selected when you log in.

Update permanent 
location of attached 
items when MFHD is 
saved to the database

Select this option to have the system automatically update the 
item location to match the MFHD location when the MFHD 
record is updated. This applies to the permanent location (not 
temporary location) for all items attached to the MFHD record.

The successfully updated confirmation message displays the 
number of updated item records with an updated permanent 
location unless you have suppressed confirmation messages 
by selecting the Suppress confirmation message upon 
successful save option.

With this process, the item history information (modified-by 
operator, modify location, and modify date) is also updated.

Update item type of 
attached items when 
MFHD is saved to the 
database (based on 
item location 
definitions)

Select this option to have the system automatically update the 
permanent item type to match the Initial Default Item Type 
assigned to the location in Voyager System Administration 
(Cataloging > Policy Definitions > [policy group name] > 
Locations tab) when the MFHD record location is updated.

The successfully updated confirmation message displays the 
number of updated item records with an updated item type 
unless you have suppressed confirmation messages by 
selecting the Suppress confirmation message upon 
successful save option.

NOTE:
This option is enabled/available when you select the Update 
permanent location of attached items when MFHD is saved 
to the database option.

Retain hierarchy 
selections

Select this check box to retain the highlighted selections in the 
Hierarchy dialog box after clicking Retrieve to open the 
highlighted records.

Table 11-3. Work Flow tab options for Session Defaults and Preferences

Options Description
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Figure 11-6. Session Defaults:  Item Defaults tab

Table 11-4. Item Defaults tab options for Session Defaults and Preferences

Options Description

Item Type Select the default Item Type to display when creating item 
records.  This defaults to the selection made in Cataloging - 
Policy Definitions in Voyager System Administration for the 
location you selected when logging in to the Cataloging module.  
This is a required field.

Temp. Loc. Select the default Temp. Loc. to display when creating item 
records.  

Temp. Type Select the default Temp. Type to display when creating item 
records.

Status Select the default Status to display when creating item records.

Stat. category Select the default Stat. Category to display when creating item 
records.
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Folders/Files Tab

Customize the options on the Folders/Files tab (see Figure 11-7) to match your 
preferences using Table 11-5 for a description of each option.

Enum Enter the default Enum to display when creating item records.

Chron Enter the default Chron to display when creating item records.

Year Enter the default Year to display when creating item records.

Caption Enter the default Caption to display when creating item 
records.

Free text Enter the default Free text to display when creating item 
records.

Spine Enter the default Spine information to display when creating 
item records.

Copy Enter the default Copy number to display when creating item 
records.

Pieces Enter the default Pieces number to display when creating item 
records.

Self Check
   Magnetic Media
   Sensitize

Indicate your default preference for the Magnetic Media and 
Sensitize check boxes for item record creation and 
maintenance. When the check box is selected for these options,  
the flag is set to Y (Yes) in the database. When unselected, the 
value is set to N (No) in the database.

The Magnetic Media and Sensitize check box options set item 
record level flags for interfacing with third-party self-check 
machines for item check in, check out, and renewal 
transactions. These are used for magnetic media and sensitize 
alerts.

Table 11-4. Item Defaults tab options for Session Defaults and Preferences

Options Description
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Figure 11-7. Session Defaults: Folders/Files tab

Table 11-5. Folders/Files tab options for Session Defaults and Preferences

Options Description

Templates

• Bib

• Hldg

• Auth

Enter the template file name for each of the record types, bib-
liographic, holdings, and authority. This establishes a default 
template format that automatically displays when creating a 
new record.

Optionally, click the ellipses button to select a template. The file 
name must refer to an existing file.

NOTE:
A default template must be specified in the Auth field for an 
authority template to automatically display when creating a new 
authority record from the Authority Validation dialog box 
(Figure 9-1). See Table 9-2 on page 9-4 for more information.

Folders

• Work

• Template

• Import

In the Folders group box, you can enter or select a default 
folder so that when you open a work record and/or template and 
import a record, the Open dialog box defaults to the specified 
folder.
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Mapping Tab

Customize the options on the Mapping tab (see Figure 11-8) to match your 
preferences using Table 11-6 for a description of each option.

Voyager Cataloging allows you to import records from other formats.   Use the 
Mapping tab to identify the format of the records being imported (locally or 
remotely).

Saving records to the database affects validation and separate tag tables are 
available to save to based on the record format type you choose. See MARC Tag 
Tables on page A-1 for more information.

Work Files

• Bib

• Hldg

• Auth

In the Work Files group box, you can enter the names of the 
files to which you want your records automatically saved when 
you use the Save or Save As feature. If you enter a filename in 
a field, you will not be prompted for a filename when saving 
records of that type. You can specify a different file for bib-
liographic, holdings and item records. If you enter a filename, a 
record will be automatically saved to this file instead of prompt-
ing you for a filename. If the file does not exist it will be created 
the first time Cataloging attempts to save to the file.

Save to Local File

• File

• Character Set

In the Save to Local File group box, you can specify the file to 
which you want bibliographic records to be saved when you use 
the Save to Database and to Local File option (with or without 
Close). Enter the filename in the File field or click the ellipses to 
search for the file to which you want to save. Click the Charac-
ter Set drop-down arrow to select the character set format in 
which you want the records to be saved. 

NOTE:
If no filename is entered into the File field, the Save to 
Database and to Local File option is disabled. If the file is 
specified but does not currently exist, it is created at the next 
Save to Database and Local File.

Table 11-5. Folders/Files tab options for Session Defaults and Preferences

Options Description
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Figure 11-8. Session Defaults: Mapping tab

Table 11-6. Mapping tab options for Session Defaults and Preferences

Options Description

Expected Character 
Set of Imported 
Records

Local Import

Use the Local Import drop-down menu to select the character 
set of the records being imported locally.  Your choices include 
the following.

• Latin-1 (non-Unicode)

• MARC21 MARC-8 (non-Unicode)

• MARC21 UTF-8

• OCLC (non-Unicode)

• RLIN legacy (non-Unicode)

• Voyager legacy (non-Unicode)

This provides the information needed by the system to map the 
incoming records to Unicode UTF-8 encoding. 
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Colors/Fonts Tab

Using the options provided on the Colors/Fonts tab, you can change the:

• Text color

• Background color

• Font style, size, and weight

Colors

The text and background colors can be set for:

• Viewing MARC records using the MARC Views section of the Colors/Fonts 
tab

Additionally, you can select a specific row marker symbol from the drop-
down list of options for your MARC views of records.

• Viewing the record hierarchy

• Viewing the global headings change hierarchy

MARC Mapping for 
OCR Data

Tag

Indicator 1

Indicator 2

Subfield

This feature is used specifically in conjunction with Image 
Server. This feature applies to the sending of Full-Text OCR 
data (text read from a non-searchable image stored in Image 
Server) from the Image Server program to an active bib-
liographic record in Cataloging. Once the OCR data is inserted 
into an active bibliographic record, the data is then searchable 
through Voyager. 

Specify the Tag, Indicator 1, Indicator 2 and Subfield where 
OCR data should be inserted into an active bibliographic 
record. If you do not specify this information, the following 
defaults will be used: Tag: 500, Indicator 1: none, Indicator 2: 
none, Subfield: a.

NOTE:
A maximum of 1600 characters will fit into a single field of a 
MARC record. Each time a field reaches this limit, another 
identical field will be created into which the rest of the data will 
be inserted. In addition, it should be noted that the maximum 
record size for a MARC record in Voyager is 64K. 

Table 11-6. Mapping tab options for Session Defaults and Preferences

Options Description



11-20  Ex Libris Confidential

Cataloging User’s Guide

• Suppressed records search results

Search results are highlighted with the preference colors selected when a 
bibliographic or MFHD record is suppressed (including times when the 
bibliographic record is not suppressed but the MFHD record is 
suppressed). This applies to Find and Browse searches on the Index 
Selection tab of the Search dialog box and includes call number browse 
searches.

Figure 11-9. Session Defaults: Colors/Font tab

Fonts

The font name, size, and bold properties are applied to the bottom portion of the 
MARC record view. The top portion of the dialog box is not affected by the 
Preferences font settings. See Figure 11-10. 
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Figure 11-10. Font Settings Example

The font name, size, and bold properties are also applied to the Leader, 006, 007, 
and 008 dialog boxes. See Figure 11-11.
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Figure 11-11. Leader Dialog Box Example

The font name and size properties (but not the bold property) are applied to the 
Global Headings Change & Preview Queues dialog box. 

Figure 11-12. Font Displayed for Global Headings Change & Preview Queues

The procedure for changing colors and fonts is shown in Procedure 11-1, 
Changing Colors and Fonts, on page 11-23.
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Procedure  11-1.  Changing Colors and Fonts

Use the following to change colors and fonts.

1. Click the button for the type of record to which you want to change the color.

Your choices are the following (see Table 11-7).    

Result: A menu of options displays.

TIP:
Change the Conversion colors to highlight records that display in 
Cataloging but were not converted.  (These are the same records that are  
identified by nc in the Title Bar. See Non-Converted Records (nc) on 
page C-4 for more information.)

Table 11-7. Record types available for color change

Color/Fonts Tab Dialog Box Group Record Type

MARC views (variable fields) • Bibliographic

• Holdings

• Authority

• Conversion

Record Hierarchy • Bibliographic

• Holdings

• Item

• Bound With

Global Heading Change Hierarchy • Level 1: Old Heading

• Level 2: New Heading

• Level 3: Auth Heading

Search Result Colors Suppressed Records.

Use this option to display bib-
liographic and holdings records in a 
different color in the staff search 
results lists if these records have 
been suppressed in the database 
from the OPAC.
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2. Select Text Color, Back color, or Reset Color depending on the color you want to 
change. 

Result: The Color dialog box opens.

3. Select a color and click OK. 

Result: The color is displayed in the Sample box. 

NOTE:
To reset the colors for one type of record to the default, click the record type 
button and select Reset Color from the submenu.

4. Click the drop-down arrow for Row Marker Symbol to select the type of indicator 
used to identify the current row in MARC records.

Result: This sets the row marker symbol to your preference.

5. Click the drop-down arrow for font Name to select the font to be used.

Result: This changes the font to the one you prefer.

TIP:
The Lucida Sans Unicode (or if you have Microsoft Office fonts installed, 
Arial Unicode MS ) font provides a broad spectrum of characters for the 
Unicode environment.

6. Set the font size by typing the font size number in the field provided or select a font 
size from the drop-down list.

The font size that you enter can be in the range of 8 through 72. If you enter a 
number larger than 72, the system will save it as 72 since this is the maximum font 
size allowed.

7. Check the Font Bold check box to specify that the text displayed in the Variable 
Fields is bold.

Result: This changes the font weight preference to bold.

Bib MARC Tag Colors Tab

The options provided on the Bib MARC Tag Colors tab enable you to set the text 
and background colors that display for tag rows while cataloging records.
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Procedure  11-2.  Creating Bib MARC Tag Colors

Use the following to create bibliographic MARC tag colors to display while 
cataloging records.

1. Click Options > Preferences from the menu bar to open the Session Defaults and 
Preferences dialog box.

2. Select the Bib MARC Tag Colors tab. 

TIP:
Click the scrolling arrow to the right to access this tab.

3. Use the Insert key on your keyboard to open a new row in the grid.

4. Enter a tag number in the Tag column cell.

This can be a fully qualified MARC tag such as 245, or you can enter a MARC tag 
using a wildcard format such as 24X or 2XX. The wildcard format must start with a 
number, 0 through 9, and adhere to the following valid pattern:

nXX, nnX, or nnn where n is a number, 0 through 9, and the X represents the 
wildcard position

5. Click the Set Color for Selected Tags button.

6. Choose Text Color or Back Color from the pop-up window.

7. Select your color preference and click OK.

8. Repeat the color selection steps for each MARC tag that you want to identify with 
color.
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Figure 11-13. Colors Selected for Bibliographic MARC Tags

To delete a row, highlight the row and press the Delete key on your keyboard.

9. Click OK to save your bibliographic MARC tag color preferences.

RDA Toolkit

If the RDA Toolkit option has been enabled in Voyager System Administration and 
your institution is using user-level authorization to access the RDA Toolkit, the 
RDA Toolkit tab (see Figure 11-14) displays in Cataloging Session Defaults and 
Preferences. The RDA Toolkit tab provides a place for you to enter your user-level 
(versus institution-level) user name and password.

NOTE:
If an institution-level user name and password has been set in the RDA Toolkit 
configuration in Voyager System Administration, the RDA Toolkit tab does not 
display in Cataloging Session Defaults and Preferences. 

For more information regarding using RDA Toolkit from the Edit menu, see 
Table 11-13 on page 11-32.
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Figure 11-14. RDA Toolkit tab

Cataloging Menus

The Voyager Cataloging module provides you with the ability to create, update, 
and save MARC 21 records.

NOTE:
Some of the menus only display after you create or open a record or highlight text 
in an open record.

Main Workspace Menu Options

The following menu options are available after logging in to the main cataloging 
workspace.
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File Menu - Main Workspace

The contents of the File menu are shown in Table 11-8.  

Table 11-8. File Menu

Menu Description

Work Record Displays the option to open a work record.

Template Displays options for creating and editing, tem-
plates.

Login Info Displays your user name, operator ID, and loca-
tion.

Change Password Displays the dialog box for changing your pass-
word.

For information on how to configure password 
requirements, refer to the Voyager System 
Administration Guide.

Print Setup Displays the Print dialog box.

Print Label Displays the Print Labels dialog box for printing a 
spine label and/or a piece label.

Global Headings Change 
(Ctrl+G)

Displays the Global Headings Change Queue.

Pick and Scan (Ctrl+I) Displays the Pick and Scan dialog box to process 
mass changes (change, delete, clear, or sup-
press records) to item records and associated 
holdings and bibliographic records by authorized 
staff.

Authority Load Reviewer Displays the Authority Load Reviewer dialog box 
for reviewing the following types of results from 
the completed Auth Load Match jobs for further 
processing:

• No match

• Multi-Match

• Split

• Delete

• Reject

Exit Closes the Cataloging module.
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Record Menu - Main Workspace

The contents of the Record menu are shown in Table 11-9.  

Display Menu - Main Workspace

There are no active Display menu options until a record search has been 
completed. 

Options Menu - Main Workspace

The contents of the Options menu are shown in Table 11-10.  

Table 11-9. Record Menu

Menu Description

New Provides the options to create new authority or 
bibliographic records.

Search Displays the Search dialog box for retrieving 
records from the database. 

Retrieve by record id Provides the option to retrieve the record by its 
record ID number. 

Retrieve by barcode Provides the option to retrieve a record by its bar-
code number. 

Import Provides the option to import records into the 
Voyager database from a new file.

Table 11-10. Options Menu

Menu Description

Preferences Displays the Session Defaults and Preferences 
dialog box that provides options on the following 
tabs.

• General

• Validation

• Work Flow

• Item Defaults

• Folders/Files

• Mapping

• Colors/Fonts
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Help Menu

The contents of the Help menu are shown in Table 11-11.  

Menu Options After Working with Active Records

The menus dynamically display additional options after you begin to work with 
bibliographic, holdings, item, and authority records.

File Menu - Working with Active Records

The contents of the File menu are shown in Table 11-12.  

Toolbar Use this option to toggle the display of the tool-
bar on and off.

Toolbar Text Use this option to toggle on and off descriptive 
text that displays under the toolbar icons.

Toolbar Tips Use this option to toggle on and off the tips that 
display when you hover over a particular icon on 
the toolbar with your cursor.

Status Bar Use this option to toggle on and off the display of 
the status bar.

Table 11-11. Help Menu

Menu Description

Help Topics Displays a list of Cataloging help topics.

Ex Libris on the Web Provides links to Ex Libris Web content.

About Cataloging Displays the copyright notice and version num-
ber of your copy of Voyager Cataloging.

Table 11-12. File Menu

Menu Description

Work Record Displays options for opening and deleting work 
records.

Template Displays options for creating, editing, and delet-
ing templates.

Table 11-10. Options Menu

Menu Description
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Login Info Displays your user name, operator ID, and loca-
tion.

Save (Ctrl+S) Saves the active work record to the location from 
which it was opened.

Save As (Ctrl+A) Saves the active record in a new location such 
as a work file.

Close Closes the active record.

Close All Closes all of the active records such as bib-
liographic, holdings, item, and/or authority.

Print Setup Displays the Print dialog box.

Print Record (Ctrl+P) Prints the active record.

Print Label Displays the Print Labels dialog box for printing a 
spine label and/or a piece label.

Global Headings Change 
(Ctrl+G)

Displays the Global Headings Change Queue.

Pick and Scan (Ctrl+I) Displays the Pick and Scan dialog box to process 
mass changes (change, delete, clear, or sup-
press records) to item records and associated 
holdings and bibliographic records by authorized 
staff.

Exit Closes the Cataloging module.

Table 11-12. File Menu

Menu Description
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Edit Menu - Working with Active Records

The contents of the Edit menu are shown in Table 11-13.  

Table 11-13. Edit Menu

Menu Description

Cut (Ctrl+X) Cuts the highlighted text and places it on the 
clipboard.

Copy (Ctrl+C) Copies the highlighted text and places it on the 
clipboard.

Paste (Ctrl+V) Inserts the text stored on the clipboard and 
pastes the rows above the target row. 

All of the MARC view records contain a dummy 
row that displays at the end of the variable fields. 
The purpose of the dummy row is to allow you to 
paste into the last editable row since the action of 
paste will insert the information before the 
marked row. 

You cannot do anything to the dummy row except 
copy above it. You can paste the information, 
entire rows, that you have copied from an open 
or closed row.

Selecting multiple rows are achieved by holding 
down the Ctrl key and clicking the rows. 

NOTE:
If you cut and paste information from a different 
application such as Microsoft Word, some 
characters are stripped out. 

Insert Field Before (F3) Adds a blank MARC field before the active field.

Insert Field After (F4) Adds a blank MARC field after the active field.

Delete Field (Del) Deletes the active MARC field. This field or 
subfield cannot then be pasted elsewhere.

Unselect Text (F11) Unselects the currently selected text.

Insert Subfield (F9) Adds a blank MARC subfield with delimiter.

Edit Cell (F8) Positions cursor for editing.

Special Character Entry 
(Ctrl+E)

Displays the Special Character Entry dialog box 
and allows you to select a special character to 
enter in your record.
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Special Character Mode 
(Ctrl+D)

Allows you to change your keyboard to a special 
character mode.

Show Marc Values (F2) Displays a selection table with all valid MARC 
values for the active field or subfield.

Show RDA Toolkit 
(Shift+F2)

Displays RDA Toolkit information using the URL 
configured in Voyager System Administration 
(Cataloging > RDA Toolkit).

The RDA Toolkit information displays when a 
bibliographic or authority MARC record view 
window is open and:

• A row in the MARC record grid is selected

• The record is in edit mode and the cursor 
is positioned in either the tag indicator 1, 
indicator 2, or subfield data cell of any row 
in the MARC record.

For an example, see Figure 11-15 and Figure 11-
16.

Show Holdings Locations 
(Ctrl-L)

Displays all available holdings locations and 
abbreviations for your security access level. 

Insert URL from Browser 
(Ctrl+U)

Creates a new 856 field containing the URL of 
the page currently displayed in your Web 
browser.

Table 11-13. Edit Menu

Menu Description
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Figure 11-15. Highlighted grid row
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Figure 11-16. RDA Toolkit display

Record Menu - Working with Active Records

The contents of the Record menu are shown in Table 11-14.  

Table 11-14. Record Menu

Menu Description

New Provides the options to creates new authority or 
bibliographic records.

Search Displays the Search dialog box for retrieving 
records from the database. 

Make a Copy Copies the active record.  It must have been 
retrieved from the database. 

Change Owning Library Changes the owning library of the current bib-
liographic record.

Retrieve by record id Provides the option to retrieve the record by its 
record ID number. 

Retrieve by barcode Provides the option to retrieve a record by its bar-
code number. 

Unlink holding from bib-
liographic

Unlinks a holdings record from multiple bib-
liographic records. 
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Relink holding to bib-
liographic

Relinks the current item record to a different 
holdings record 

Show Associated Records Displays holdings, bibliographic and item records 
associated with the active record.

Find Related Bibs Searches for any bibliographic records linked to 
the headings records that are linked to the open 
authority record.

When related bibliographic records are found, a 
dialog box opens where you can select Open to 
see a MARC record view or Search for a Head-
ings Browse search. 

This functions like Find Related Bibs in the 
Authority Load Reviewer.

Retrieve Bibliographic 
Record

Retrieves the bibliographic record associated 
with the holdings or item record displayed.

Retrieve Holdings Retrieves the holdings records for the active 
record. 

Create Holdings Creates a new holdings record for the active 
record.

Retrieve Items Retrieves the item records for the active holdings 
record.

Create Items Creates a new item record for the active holdings 
record.

Retrieve Authorities Retrieves the authority records for the active 
record. 

View Line Items in Acquisi-
tions (Ctrl+M)

Allows you to automatically pull up and edit a 
purchase order line item in the Acquisitions mod-
ule from an open bibliographic or holdings record 
in the Cataloging module. 

Both the Cataloging and Acquisitions modules 
must be open and logged into with the same user 
ID and password. 

Table 11-14. Record Menu

Menu Description
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Get call number from bib 
record (Ctrl+N)

Causes a bibliographic record call number to be 
automatically inserted into the 852h and 852i 
fields of a holdings record. 

You do not need to have the bibliographic record 
to which the holdings record is associated open; 
only the holdings record. 

Verify Hypertext links 
(Ctrl+K)

Verifies hypertext links in the active record.

See Links - Verify Hypertext Links for Bib-
liographic Records on page 2-25, Verify Hyper-
text Links - Authority Records on page 2-36, and 
Verify Hypertext Links - Holdings Records on 
page 2-57 for more information.

Overlay Bibliographic 
Records

Select this option to identify the source record to 
be used in either a bibliographic overlay or 
merge procedure. 

NOTE:
The cataloging operator performing this function 
needs to be linked to an operator profile that 
permits the ability to overlay/merge bibliographic 
records. Refer to the Security section of the 
Voyager System Administration User’s Guide 
that describes the options on the Profile Values 
tab for Cataloging Profiles for more information. 

See Overlaying and Merging Bibliographic 
Records on page 4-7.

Validate ISBNs Select this option to dynamically validate ISBNs. 
For more information, see Save and ISBN/ISSN 
Validation on page 4-13 and Table 11-2 on 
page 11-7.

Validate ISSNs Select this option to dynamically validate ISSNs. 
For more information, see Save and ISBN/ISSN 
Validation on page 4-13 and Table 11-2 on 
page 11-7.

Validate heading Validates the current heading.

Table 11-14. Record Menu

Menu Description
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Related Records Menu - Working with Active 
Records (Bibliographic Records Only)

The Related Records menu only displays when a linked source record 
(bibliographic) is the active record.

This menu displays one or more bibliographic linking profiles.

Reorder Fields Select this option to display the Reorder Fields 
dialog box from which you can select the MARC 
Field Ordering Rule from the drop-down list that 
contains the field sorting rule(s) that you want to 
apply to the record with which you are working. 

If you set a default in Session Defaults and Pref-
erences, that default is the option that you see 
displayed in the Reorder Fields dialog box.

If you have set Sort automatically on save in 
Session Defaults and Preferences, the default 
MARC Field Ordering Rule setting that you 
selected in Session Defaults and Preferences 
will override any other setting when you save the 
record.

Refer to the MARC Field Ordering Rules section 
in the Voyager System Administration User’s 
Guide for more information.

Save to Database (Ctrl+B) Saves the active record to the database.

Save to Database and 
Close (Ctrl+Q)

Saves the active record to the database and then 
closes the record.

Delete Deletes the active record.

Send Record To Formats MARC record for an http POST on a 
web server such as WebVoyáge.

NOTE:
This optional feature requires setup in 
voyager.ini in the [MARC POSTing] stanza.

Import Provides the option to import records into the 
Voyager database from a new or previous file.

History Displays historical information such as creation 
date and location for an item record.

Table 11-14. Record Menu

Menu Description
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The system retrieves any records related to the source record based on the profile 
selected from the menu list.

For more information, see Displaying Related Records on page 5-1.

Item Menu - Working with Active Records (Item 
Records Only)

The contents of the Item menu are shown in Table 11-15. This menu is only 
available when an item record is the active record.  

Display Menu - Working with Active Records

The contents of the Display menu are shown in Table 11-16.  

Table 11-15. Item Menu

Menu Description

View Status (Ctrl + S) Displays status information that can be assigned 
to and/or removed from an item such as dam-
aged, missing, in transit, or withdrawn. 

View Statistics (Ctrl + T) Displays statistical category assignments for an 
item that can be added and/or removed. 

View Notes (Ctrl + N) Displays any note associated with the item 
record.

View Barcodes (Ctrl + A) Displays the Barcodes dialog box for adding or 
deleting barcodes from an item record.

Table 11-16. Display Menu

Menu Description

Headings List Displays the list of headings found in the most 
recent search.

Title Index Displays the list of titles found in the most recent 
search.
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Options Menu - Working with Active Records

The contents of the Options menu are shown in Table 11-17.  

Window Menu - Working with Active Records

The contents of the Window menu are shown in Table 11-18.  

Table 11-17. Options Menu

Menu Description

Preferences Displays the Session Defaults and Preferences 
dialog box that provides options on the following 
tabs.

• General

• Validation

• Work Flow

• Item Defaults

• Folders/Files

• Mapping

• Colors/Fonts

Hide Fixed Fields Hides the fixed fields of your records, so you can 
see more of the variable fields.

Toolbar Use this option to toggle the display of the tool-
bar on and off.

Toolbar Text Use this option to toggle on and off descriptive 
text that displays under the toolbar icons.

Toolbar Tips Use this option to toggle on and off the tips that 
display when you hover over a particular icon on 
the toolbar with your cursor.

Status Bar Use this option to toggle on and off the display of 
the status bar.

Table 11-18. Window Menu

Menu Description

Tile Arranges multiple windows so they do not over-
lap.

Cascade Arranges multiple windows so they overlap.

Arrange Icons Arranges icons for minimized windows at the bot-
tom of the main window.
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Help Menu - Working with Active Records

The contents of the Help menu are shown in Table 11-19.  

Window 
1, 2...

Lists currently open document windows. A check 
mark displays in front of the active document 
window. Select one to make that record 
active.The long number is the record ID.

Table 11-19. Help Menu

Menu Description

Help Topics Displays a list of Cataloging help topics.

Ex Libris on the Web Provides links to Ex Libris Web content.

About Cataloging Displays the copyright notice and version num-
ber of your copy of Voyager Cataloging.

Table 11-18. Window Menu

Menu Description
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MARC Tag Tables

Introduction

The MARC tag tables define various types of records, fields, and subfields for 
bibliographic and authority records. The tag tables are located in the 
\Voyager\Catalog\Tagtable directory on the client PC.  See Figure A-1. Tag 
tables are configuration files identified by the .cfg file extension.

The tag table configuration files can be modified to match your requirements.  
They can be edited using a program such as Notepad which is provided with the 
Windows operating system. 

NOTE:
Configuration files can be saved and edited using any word processor.  However, 
they must be saved in ASCII format. ASCII format supports alphabetic, numeric, 
and special characters represented by a 7-bit binary number for up to 128 
possible characters.

When you open the \Voyager\Catalog\Tagtable directory, you will see the 
following structure.
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Figure A-1. Files and directories in the Voyager/Catalog/Tagtable directory

The OCLC, RLIN, and MARC21 folders in the directory contain specific sets of tag 
tables used solely in the Cataloging module.  These tag tables are used for MARC 
validation.  If you open these directories, you see a long list of files as in Figure A-
2.

The Country.cfg and Lang.cfg files are tag tables that are used by the 
Cataloging module for country and language codes. (For the Circulation module, 
the country and language codes are stored in a file called circbib.cfg located in the 
circulation directory and the country and language codes for the Acquisitions 
module are stored in the acqbib.cfg located in the misc directory.)
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Figure A-2. Example of MARC21 Folder Contents

In the OCLC, RLIN, and MARC21 directories, all the files that begin with the letter A 
pertain to authority records, all the files that begin with the letter B pertain to 
bibliographic records, and all the files that begin with the letter H pertain to 
holdings records.  After the letters A, B, or H, each of the filenames includes the 
word marc followed by a number and an xx.  The number and xx indicate the 
field range to which the file pertains.  For example, Amarc3xx.cfg pertains to 
authority record fields in the 300 range, and Hmarc2xx.cfg pertains to holdings 
record fields in the 200 range.

Filenames that do not include a number but include the word fix pertain to the 
fixed fields including Leader fields for the particular record type.  For example, 
Bmarcfix.cfg pertains to bibliographic record fixed fields.
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In the OCLC, RLIN, and MARC21 directories there is a file called master.cfg.  
This file provides a high-level outline of the fields included in authority, 
bibliographic, and holdings records for each one’s tag table format.

NOTE:
When modifications are made to a specific configuration file, it may also be 
necessary to make a corresponding change in the master.cfg file in that folder. 

Tag Tables and MARC Validation

The tag tables are used in the Cataloging module to validate your MARC records 
as they are saved to the database.  The main configuration file, master.cfg, can 
be edited to include or exclude authority, bibliographic, holdings, or local files in 
the MARC validation process.  Certain fields can also be identified as mandatory 
validation checks for compliance with the OCLC, RLIN, and MARC21 formats.

The Cataloging module validates MARC records against one of three different tag 
tables formats, OCLC, RLIN, or MARC21.  These three formats display as options 
in Session Defaults and Preferences Cataloging formats.  See Figure A-3.  If 
you do not want one or more of these formats available as MARC validation 
choices, you can delete the directory from \Voyager\Catalog\Tagtable and 
the Cataloging module does not display them as options.

Figure A-3. Cataloging format choices for MARC validation
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If you save a record to the database in Cataloging with MARC validation turned on 
and an inconsistency or error is found against the tag tables, you receive an error 
report.  See Figure A-4.  This alerts you to the inconsistency or error discovered 
so that you can make the necessary changes to the record.  If you do not make 
the changes necessary to validate the record against the tag tables, you are not 
able to save the record to the database.

NOTE:
MARC validation can be bypassed if you check the Bypass MARC Validation or 
Bypass MARC21 Character set validation check box on the Validation tab of 
Session Defaults and Preferences.

Figure A-4. Sample report if MARC validation finds an error while saving a record 
to the database 

Structure of MARC Tag Tables Overview

All the MARC tag tables contain similar structural components.  For the most part, 
they all begin with comments (see Figure A-5) and subsequently, stanzas (see 
Stanzas in the MARC Tag Tables on page A-6) outlining fields and/or their 
contents and values.

TIP:
In order to keep track of the updates you make to the tag tables, record 
your additions, edits, and/or deletions at the beginning of each 
configuration file in the comment area.  In the Figure A-5 example, notice 
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that the initials of the tag table editor are included to keep track of who 
performed the modifications.

Stanzas in the MARC Tag Tables

MARC tag tables are divided into sections called stanzas. Stanzas are generally 
located after the comment area at the beginning of a configuration file.

Stanza Names

Each stanza begins with a name or a title enclosed in square brackets such as 
[410]. The stanza name is unique within each configuration file.

Stanzas are the main component of the tag tables. They define contents and 
values on both a high and a low level for each tag table format. For example in the 
Bmarcfix.cfg file of the RLIN directory, the [490] stanza provides details 
about the 490 field of bibliographic records including valid subfields and their 
values.

Stanzas That Reference Other Stanzas

Stanzas in the tag tables can also reference other stanzas, ones that provide 
more detail about particular fields, subfields, or templates.  For example in the 
Bmarcfix.cfg file of the MARC21 directory, the [007Code] stanza defines the 
possible values for the 007 fixed field of bibliographic records. This stanza 
includes the templates used for each possible value such as subfield a for Maps 
uses the 007_Map template. Since the [007Code] stanza references the 

# Built from http://www.loc.gov/marc/bibliographic/ecbdhome.html 6/29/2007 TGG

# Up-to-date through MARC21 Concise through update no.7 (October 2006)

# These tables include some obsolete elements marked with the qualifier 
(OBSOLETE)

# These tables include some locally defined elements marked with the qualifier 
(LOCAL)

# Updated with approved MARC proposals 2007-01 to 2008-03. 5/13/08 ASP

# Updated with approved MARC proposals 2008-04 to 2009-10, except 2009/6-1 9 Sept 
09 MEB

# Updated with approved MARC proposals 2010-01 to 2010-05, 24 June 2010 MEB

Figure A-5. Example of Tag Table Comment Area (.cfg File)
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007_Maps template and that template is not defined in the [007Code] stanza, 
there must be another stanza in the Bmarcfix.cfg file called [007_Map]. This 
stanza provides the details about that particular template type. 

NOTE:
Stanzas that are referenced by other stanzas can be located either directly after 
the stanza that references them or all together at the end of a configuration file.  

Stanza Components

In Figure A-6, there are three sample stanzas taken from the Hmarx0xx.cfg file 
of the MARC21 tag table format. These stanzas outline the 014 linkage number 
field of holdings records.

[014]

0=a 0A

1=b 0A

2=z 1A

3=9 0A

Subfa=Linkage number

Subfb=Source of number

Subfz=Cancelled/invalid linkage number

Subf9=Old holdings linkage number

[014Ind1]

0=0 

1=1 

Value0=Holdings record number

Value1=Bibliographic record number

[014Ind2]

0=_ 

Value_=Undefined

Figure A-6. Sample stanzas from the Hmarc0xx.cfg file for MARC21 format
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MARC tag field/ indicator field 

This is the name of the stanza.  In Figure A-6, this is [014], [014Ind1], and 
[014Ind2].

MARC subfield

In Figure A-6, there are four subfields defined as a, b, z, and 9.

Software order number

These numbers are only used by the software itself and are insignificant to the 
actual user.  In Figure A-6, there are four software order numbers 0, 1, 2, and 3. 

Subfield rule definition

The value 0 or 1 indicates if the field is repeatable. 0 means it is a non-repeatable 
field and 1 means it is a repeatable field. In Figure A-6, subfields a, b, and 9 are 
non-repeatable fields and subfield z is a repeatable field.

Subfield rule definition

The subfield rule value either A, M, or O indicates whether the field is applicable, 
mandatory, or optional. A means the field is applicable, M means it is mandatory, 
and O means it is optional. In Figure A-6, all the subfields are applicable with a 
value of A. None are mandatory or optional.

! IMPORTANT:
These values are used during MARC validation in the Cataloging module. 
The system gives particular attention to mandatory subfields, those with a 
value of M. If it is a mandatory subfield and no value is set for it in the 
Cataloging module, you get a warning message when you try to save the 
record indicating that you have left out a mandatory field.

Subfield and subfield definition

The subfield/subfield definition stanza component describes the values that you 
input to the subfield in the Cataloging module.  In the Cataloging module when 
you press F2 with your cursor in the appropriate subfield, the values entered in 
this component display.  In Figure A-6, subfield a is the linkage number, subfield b 
is the source of number, subfield z is the cancelled/invalid linkage number, and 
subfield 9 is the old holdings linkage number.
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Indicator value

Valid indicator values are specified in this component of the stanza.  In Figure A-6, 
the valid values for indicator 1 of the 014 field are 0 and 1 as defined in the 
second last stanza; and the valid value for indicator 2 of the 014 is 0 as defined in 
the last stanza.

Indicator and indicator definition

The indicator/indicator definition component specifies the indicator values for the 
indicators of MARC fields.  In Figure A-6, the definition for valid value 0 is holdings 
record number, and the definition for valid value 1 is bibliographic record number.  
The definition for valid value 0 is undefined for indicator 2 of the 014 field.  In the 
Cataloging module when you press F2 and your cursor is in the appropriate 
indicator field, the values entered in this component display.

Xmarcfix.cfg Tag Tables

There are three Xmarcfix.cfg tag tables.

• Amarcfix.cfg

• Bmarcfix.cfg

• Hmarcfix.cfg

These files define the valid values for the fixed fields of authority, bibliographic, 
and holdings records for each tag table format, OCLC, RLIN, and MARC21.
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Sample Xmarcfix.cfg Tag Table

Figure A-7 is an example of one the Xmarcfix.cfg tag tables.  Specifically, this 
is an example of a Bmarcfix.cfg tag table. 

! CAUTION:
One or more spaces must be used after a comma to separate the different 
components of information specified in the .cfg tag tables. Do not use tabs.

Grid Templates

In tag tables, you can define grid templates as per your preferences.  These 
templates determine how the grid for fixed fields displays in the Cataloging 
module. See Figure A-9. 

The templates used for a specific field/subfield have their own stanzas that can be 
defined immediately following the stanza that references them or all together at 
the end of the configuration file.  See Figure A-8 for a sample template for subfield 
a.

[006Code]

a=&Books, 006_Books

c=P&rinted Music, 006_Music

d=Manuscr&ipt Music, 006_Music

e=Prin&ted Map, 006_Maps

f=&Manuscript Map,  006_Maps

g=&Projected Medium, 006_Visual

i=&Nonmusical Sound, 006_Music

j=Musical S&ound, 006_Music

k=&2-D Nonprojectable, 006_Visual

m=Computer &File, 006_Computer

o=&Kit, 006_Visual

p=Mi&xed Material, 006_Mixed

r=&3-D Artifact, 006_Visual

s=&Serial Control, 006_Serials

t=Manuscript &Lang., 006_Books

Figure A-7. Sample Bmarcfix.cfg file stanza from the new MARC tag tables
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In the Cataloging module, the template in Figure A-8 displays the grid as 
illustrated in Figure A-9 for the 006 fixed field of bibliographic records.  

The procedure for accessing the 006 field grid is shown in Procedure A-1, 
Accessing the 006 Field Grid, on page A-11.

Procedure  A-1.  Accessing the 006 Field Grid

Use the following to access the 006 field grid.

1. Click the 006 button on the MARC tab.

2. Click the New button.

[006_Books]

Illustrations 1, 006/008BooksIllustrations, 1,  1, _

Illustrations 2, 006/008BooksIllustrations, 2,  1, _

Illustrations 3, 006/008BooksIllustrations, 3,  1, _

Illustrations 4, 006/008BooksIllustrations, 4,  1, _

Audience, 006/008BooksAudience, 5,  1, _

Form Of Item, 006/008BooksItem, 6,  1, _

Contents 1, 006/008BooksContents, 7,  1, _

Contents 2, 006/008BooksContents, 8,  1, _

Contents 3, 006/008BooksContents, 9,  1, _

Contents 4, 006/008BooksContents, 10,  1, _

Govt. Publications, 006/008BooksGovtPub, 11,  1, _

Conf. Publications, 006/008BooksConfPub, 12,  1, 0

Festschrift, 006/008BooksFestschrift, 13,  1, 0

Index, 006/008BooksIndex, 14,  1, 1

Literary Form, 006/008BooksLiteraryForm, 16,  1, 0

Biography, 006/008BooksBiography, 17,  1, _

Figure A-8.  Sample 006_Books stanza in a Bmarcfix.cfg file
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Result: The Additional Materials Characteristics dialog box opens. See 
Figure A-9.

Figure A-9. Grid for the 006 field of a bibliographic record

Defining Your Own Keyboard Shortcuts

In the stanzas of the new tag tables, you are able to specify keyboard access 
keys/shortcuts for each tab of the fixed field grid templates.  This allows you to use 
a keyboard shortcut as opposed to the mouse to access a certain tab.  

You define a keyboard shortcut via the ampersand (&) symbol in the stanzas 
defining the various tabs of a fixed field grid.  See Figure A-7.

The keyboard equivalents employ the Alt key plus a letter or number that you 
designate within the appropriate stanza.  The letter you designate as the keyboard 
equivalent is underlined in the Cataloging module on the corresponding tab.  

NOTE:
The & (ampersand) is stripped out of the string when it is displayed in the form title 
bar.
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For instance, instead of accessing the Books tab using the mouse, you may want 
to use the Alt+b keystroke.  To set this up, you place an & (ampersand) in front of 
the letter you want to use in combination with the Alt key in the appropriate 
Xmarcfix.cfg file such as a=&Books as in Figure A-7.  In the Cataloging 
module using this example, the Books tab displays with B in Books underlined.  
See Figure A-10.  

Figure A-10. Sample keyboard shortcut for the Books tab

NOTE:
You can only designate one keyboard equivalent at a time.  If you define more 
than one, only the last one will be used.

Stanzas in the Xmarcfix.cfg Tag Tables

There are three types of stanzas in each of the Xmarcfix.cfg tag tables.

• Code type or tab stanzas 

• Grid template stanzas 

• Drop-down menu selection stanzas 

NOTE:
The order and the structure of these stanzas is hierarchical.  The code type 
stanzas define what tabs display for fixed fields in the Cataloging module.  The 
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grid template stanzas define the grid that displays once you select a tab for a fixed 
field.  The drop-down menu stanzas define the selections you have on a particular 
grid.

Code Type/Tab Stanzas [00xCode]

Code types essentially define what tabs display in the Cataloging module for each 
fixed field.  To access these tabs, you click the Leader, 006, 007, or 008 buttons 
from the MARC tab of an authority, bibliographic, or holdings record.  Remember 
that holdings records do not have 006 field, and authority records do not have 006 
or 007 fields.  

For example if you click the 007 button on the MARC tab of a bibliographic record, 
the tab selections as illustrated in Figure A-11 display based on what is defined in 
the MARC tag tables in the Bmarcfix.cfg file.

Figure A-11. Code types/tabs that display in the Cataloging module for a 
bibliographic record

Once you select a tab from the Cataloging module, and click the New button, a 
grid displays with all the possible values for that particular tab/code type.  

Types of Code Type/Tab Stanzas

There are four stanzas for code types/tabs for each tag table format.
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• [006Code]

• [007Code]

• [008Code]

• [000Code]

Each stanza pertains to a particular fixed field.  For example, [000Code] pertains 
to the Leader field.  

! IMPORTANT:
Do not change the names of the four code type/tab stanzas [000Code], 
[006Code], [007Code], and [008Code].  These stanza headings are 
used by the program to look for the tab data for their respective 00x type.  
Altering these stanza names or adding additional stanzas with these 
names will cause unpredictable results.

The [00xCode] stanzas define the following.  

• The name of the tabs that display in the Cataloging module for each record 
type.

• The order of the tabs that display in the Cataloging module  for each record 
type.

• The template used for each tab in the Cataloging module for each record 
type.

Names of Tabs in the Cataloging Module

The [006Code], [007Code], [008Code], and [000Code] stanzas of the 
Xmarcfix.cfg tag tables define the names of the tabs that display in the 
Cataloging module for the fixed fields of each record type.  The names of the tabs 
are listed directly after the stanza name.  See Figure A-12.  The letter at the 
beginning of each line is called the code type.  This is an industry standard and 
should not be altered.  This value is also used by the program to reference other 
values in other stanzas. 
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The specifications in Figure A-12 display as shown in Figure A-13 when the 006 
button on the MARC tab of a bibliographic record using MARC21 format in the 
Cataloging module is selected.

[006Code]

a=&Books, 006_Books

c=P&rinted Music, 006_Music

d=Manuscr&ipt Music, 006_Music

e=Prin&ted Map,       006_Maps

f=&Manuscript Map, 006_Maps

g=&Projected Medium, 006_Visual

i=&Nonmusical Sound,  006_Music

j=Musical S&ound,       006_Music

k=&2-D Nonprojectable, 006_Visual

m=Computer &File,      006_Computer

o=&Kit,                006_Visual

p=Mi&xed Material,  006_Mixed

r=&3-D Artifact,      006_Visual

s=&Serial Control,     006_Serials

t=Manuscript &Lang., 006_Books

Figure A-12. Code type examples from the [006Code] stanza of a Bmarcfix.cfg 
file for MARC21 format
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Figure A-13. The result in the Cataloging module of the [006Code] stanza in the 
Bmarcfix.cfg file

Order of Tabs in the Cataloging Module

The order that the tabs are displayed in the Cataloging module depends on the 
order of the lines in the [00xCode] stanzas of the Xmarcfix.cfg files.  You can 
alter the tab layout as per your preferences as long as you cut and paste whole 
stanza rows.

For example, to display the Printed Music tab before the Books tab in the 
bibliographic record 006 grid, change the [006Code] stanza in the 
Bmarcfix.cfg file to the order highlighted in Figure A-14.  

[006Code]

c=P&rinted Music, 006_Music

a=&Books, 006_Books

...

Figure A-14. Arrangement of tabs
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Grid Templates in the Cataloging Module 

The grid template declaration indicates the template that the program uses for 
each tab of the fixed fields.  These templates are indicated on the far right column 
of each [00xCode] stanza in the Xmarcfix.cfg files.  

In the example in Figure A-14, the Printed Music tab uses a template called 
006_Music. Tabs can use either the same template or they can use different 
templates. The contents and structure of each template is defined in the 
[00x_???] template stanzas. See Template Stanzas [00x_???]for more 
information.

Template Stanzas [00x_???] 

[00x_???] stanzas in Xmarcfix.cfg files have five columns in which you 
define the following for each record type.

• The selections you have on the grid for each code type/tab  in the 
Cataloging module.

• Whether the grid includes drop-down menus or text boxes.  If drop-down 
menus are included, this stanza references the name of the drop-down 
menu stanza in which valid selections are outlined.

• The character position for values in the records, integer values.

• The length of the selection. 

• Default values for drop-down menus and masks for text boxes.

! IMPORTANT:
Template configuration stanzas must have five comma-delimited entries/
columns per line, or the program will not function properly.

See Figure A-15 for an example of a template configuration stanza from a 
Bmarcfix.cfg file using the MARC21 tag table format.
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! IMPORTANT:
You can only modify column 1 and column 5 in this particular stanza type, 
unless a new MARC standard is implemented or an error is discovered.  

[008_Books]

Publication Status, 008PublicationStatus,

Date 1 (yyyy), <<<TEXT>>>, 7, 4, aaaa

Date 2 (yyyy), <<<TEXT>>>, 11, 4, aaaa

Place of Publication, Country, 15 3, xx_

Illustrations 1, 006/008BooksIllustrations, 18, 1, _

Illustrations 2, 006/008BooksIllustrations, 19, 1,  _

Illustrations 3, 006/008BooksIllustrations, 20, 1, _

Illustrations 4, 006/008BooksIllustrations, 21, 1, _

Audience, 006/008BooksAudience, 22, 1, _

Form of Item, 006/008BooksItem, 23, 1, _

Contents 1, 006/008BooksContents, 24, 1, _

Contents 2, 006/008BooksContents, 25, 1, _

Contents 3, 006/008BooksContents, 26, 1, _

Contents 4, 006/008BooksContents, 27, 1, _ 

Govt. Publication, 006/008BooksGovtPub, 28, 1, _

Conf. Publication, 006/008BooksConfPub, 29, 1, _

Festschrift, 006/008BooksFestschrift, 30, 1, 0

Index, 006/008BooksIndex, 31, 1, 0

Literary Form, 006/008BooksLiteraryForm, 33, 1, 0

Biography, 006/008BooksBiography, 34, 1, _

Language, Language, 35, 3, eng

Modified Record, 008ModifiedRecord, 38, 1, _

Cataloging Source, 008CatalogingSource, 39, 1, d

Figure A-15. Sample template configuration stanza from a Bmarcfix.cfg file
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Column 1

The first column of the stanza is the description that is displayed for a particular 
tab in the Cataloging module.  See Figure A-17.  This column can be changed to 
match your preferences such as for internationalization purposes.  

Column 2

This column is used for two purposes.

• To define the name of the drop-down menu stanza name that will define the 
valid values for that particular drop-down menu.

• To define that field as a text box (non-drop-down menu box) at which point 
a stanza defining the textbox is not required.  

For the latter, the keyword <<<TEXT>>> is used.  

NOTE:
<<<TEXT>>> is a reserved term used to describe to the program that the grid cell 
has text entered into it from the user and not from a drop-down menu stanza.  
When using this value, a mask value has to be entered into the last column of the 
stanza.  See Column 5 on page A-20 for a description of mask values.  Any 
attempt to use this value for a drop-down menu stanza name will be ignored by 
the system, and it will automatically be made into a text box. 

Column 3

This column defines the character position of this value in the record (integer 
value) as defined in the MARC standard.

Column 4

This column defines the length of the selection.  This should match the length of 
the key of the drop-down menu selection (integer value).

Column 5

This column serves two purposes.

• Default value for the drop-down menu.

• Mask for the text box.  
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Although the default for this column is a value set to be appropriate for all users (_ 
for Unknown or not specified), you can change it.  If you do change it, make sure 
the value is valid or an unpredictable error may occur.

TIP:
Make a backup copy of every locally edited configuration file in a separate 
file location.  

If the default for the drop-down menu does not exist in the possible list of 
selections, nothing will be displayed as a default; and you can still make other 
selections as normal.  The text mask is defined to use the following characters. 
See Table A-1.

Thus, in Figure A-16, you can enter any combination of 4 digits or spaces for the 
Date 1 field. The number of characters in the mask must equal the fourth column 
entry.

 

The sample template configuration stanza in Figure A-16 results in the template in 
the Cataloging module as seen in Figure A-17.

Table A-1. Text Masking Options

Text Mask Description

0 any digit

9 any digit or space

# any digit or sign

L any letter

? any letter or space

A any letter or digit

a any letter, digit, or space

& any character

[008_Books]

Publication Status, 008PublicationStatus, 7, 1, _

Date 1 (yyyy), <<<TEXT>>>, 8, 4, 9999

Figure A-16. Using Text Mask Characters in [008_Books] Stanza
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Figure A-17. Result in Cataloging module of the sample template configuration 
stanza

Drop-Down Menu Selections Stanzas [xxx]

In these stanzas, you input all the selections you want available from the drop-
down menus for the fixed field grids in the Cataloging module.  A sample stanza 
indicating drop-down menu selections for books is highlighted in Figure A-18.  

[006/008BooksBiography]

_=No biographical material

a=Autobiography

b=Individual biography

c=Collective biography

d=Contains biographical information

|=No attempt to code

Figure A-18. Sample stanza defining drop-down menu options for the 006 and 
008 fields
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NOTE:
You can input drop-down menus for more than one field.  In Table A-18, the 
values for the drop-down menu pertain to both the 006 and the 008 fields.

The stanza in Figure A-18 generates the drop-down menu shown in Figure A-19 
to display in the Cataloging module.

Figure A-19. Result in the Cataloging module of the sample drop-down menu 
stanza

Shortcut for Entering Numerical Data

When working with numerical data and the program sees a ~ (tilde) to the left of 
the equal sign, it creates a list of values for these numbers and inserts them into 
the drop-down list.  The values on either side can be positive or negative, and can 
go in ascending or descending order.  However, they must be whole integer 
values (from -32,768 through 32,767).  The left side of the tilde gets displayed 
first and the right gets displayed last.  Input the numerical range of 001 to 999 for 
running time as 001~999=Running time.

NOTE:
The ~ (tilde) character is used in the key portion of the drop-down menu stanzas 
to expand a numerical range in the drop-down menu instead of typing out the 
entire range.  Using this value in the key of a drop-down menu stanza especially 
with non-numerical data can have unpredictable results.  Avoid using it in this way.   
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Call Number Indexing

In Voyager 2001.1, call number functionality is expanded to provide greater 
flexibility with different classification schemes, the rules used to determine how 
call numbers are indexed.  Voyager is enhanced to recognize and store 852 
information specified with a first indicator of 7 and an associated code in subfield 2 
(‡2).  This enhancement applies to both online and bulk call number entry and 
update for specific ‡2 codes.

Voyager uses 852 first indicator values 0 - 3, 7, and 8 as defined in the MARC 21 
Format for Holdings Data.  See Table B-1 for a detailed list of 852 first indicator 
values. 

Table B-1. 852 first indicator values

1st Indicator Value Description

blank No information provided.  (Blank also indicates not 
indexed.)

0 Library of Congress (LC) classification.

1 Dewey Decimal classification.

2 National Library of Medicine (NLM) classification.

3 Superintendent of Documents (SuDOC) classification.

7 Source specified in subfield 2

8 Other scheme
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Additionally, non-standard values "c" and "u" are used by Voyager.  See Table B-
2. 

Several subfield 2 codes used in combination with first indicator 7 are 
implemented in Voyager 2001.1.  These codes identify the rules for sorting and 
normalizing call numbers for different classification schemes.  See Table B-3 for a 
list of these codes. 

NOTE:
The CACODOCS classification and the UDC classification can be specified in two 
ways.  See Table B-4. 

Table B-2. 852 first indicator non-standard values

1st Indicator Value Description

c Canadian Commissioner of Documents (CACODOCS) 
classification

u Universal Decimal Classification (UDC)

Table B-3. Subfield 2 Codes

‡2 Codes Description

cacodoc Canadian documents.

oldyale Old Yale classification.

udc Universal Decimal Classification.

cammain Cambridge main library classification.

cammed Cambridge medical library classification.

camgen Cambridge generic library classification

dnal National Agricultural Library (NAL) classification

Table B-4. CACODOCS and UDC classifications

1st Indicator Value Subfield Value Description

7 ‡2 cacodoc Canadian Commissioner of 
Documents (CACODOCS) 
classification

c Canadian Commissioner of 
Documents (CACODOCS) 
classification

7 ‡2 udc Universal Decimal Classification 
(UDC)
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With these changes to Voyager 2001.1, creation of other non-standard 
classification codes is possible as a special request.  For other non-standard 
codes to be implemented, normalization rules need to be written and codes added 
to the Voyager schema as valid codes.  Use of any new non-standard code 
requires a call number index regen to index the existing records with this code.  To 
place a request for development of a non-standard classification code, contact 
Customer Support.

! IMPORTANT:
For libraries upgrading to Voyager 2001.1 and currently using the UDC, 
Old Yale, or Cambridge classification schemes, a call number index 
regeneration is required.

Call Number Sorting and Searching

There are two aspects to sorting and searching by call number that are of 
significance relative to Voyager’s processing logic.

• How the data is interpreted and stored when input to a Voyager database 
(How records are saved).

• How the search text is processed and results displayed for a call number 
search (how users search).

How the data is stored/normalized determines how it can be sorted and search 
results are affected not only by how the data is stored but also by how the search 
text is processed.

Call Number Input/Normalization Process (Records 
Saved)

When a call number is entered into the database, Voyager evaluates what type of 
call number it is such as LC, Dewey Decimal, National Library of Medicine, 
Cambridge Main, and so on. Once this type is determined Voyager uses a 
corresponding classification scheme (see Table B-1, Table B-2, and Table B-3) 
that contains the rules used for normalizing the call number. The process of 

u Universal Decimal Classification 
(UDC)

Table B-4. CACODOCS and UDC classifications

1st Indicator Value Subfield Value Description
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normalizing the call number formats the call number so that Voyager can more 
accurately search and sort call numbers. For example, alpha characters are 
stored in their uppercase format to insure consistency in sorting.

To identify a holdings record as using the Cambridge Main classification scheme, 
the following, for example, can be specified.

852 7_ ‡b CAT ‡h S250.c.200.16 ‡2 cammain

This example uses a combination of first indicator 7 and subfield 2 (‡2) to identify 
the classification scheme. The first indicator or the first indicator in combination 
with a subfield in the MARC 21 Format for Holdings Data (MFHD) identifies which 
classification scheme is to be used for formatting the call number for storage in 
Voyager.  

Call Number Searching and Display Results

Voyager normalizes the content of the search text entered for a call number index 
search.  Similar to the process used when storing call number information, 
Voyager evaluates the search content to determine if the call number fits the LC 
classification scheme, the Dewey Decimal classification scheme, and so on. It 
then processes the normalized search content against the normalized call number 
field to generate a list of results.

NOTE:
The classification schemes utilized by a library are identified and stored in the 
system at implementation time and, in general, are not changed.  Additionally, at 
implementation time, the processing order of the classifications schemes is 
specified. Typically, the LC classification scheme is identified as the first 
classification Voyager checks when processing a call number. However, for 
libraries using other classification schemes more commonly, the more commonly 
preferred classification scheme can be identified as the first to process against by 
Voyager.
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Voyager with Unicode Overview

The implementation of Unicode in the Voyager product set is scheduled in 
phases.

The first phase of the Unicode implementation includes the following.

• Cataloging

• WebVoyáge

• Search and MARC Display Functions in the Acquisitions, Circulation, and 
Media Scheduling modules

The remaining Voyager modules continue to support data in the Latin-1 format.

Function Enhanced in Cataloging for 
Font Options and Input of Non-Roman 
Text

Operators can search for, display, and edit the contents of all MARC records using 
Unicode whether or not the record contains non-Roman characters.

The font in the Cataloging module can be changed to support a variety of 
languages. See Procedure 11-1, Changing Colors and Fonts, on page 11-23 for 
more information.
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The Voyager with Unicode release supports all the standard Microsoft® 
WindowsTM keyboard and input methods allowing cataloging staff the ability to 
input non-Roman text using any standard keyboard.

With the flexibility of Voyager with Unicode, it is possible to input text that is not 
part of the MARC21 standard. Optionally, the Cataloging module provides a 
feature that can be selected to validate that a Unicode record contains only 
characters that conform to the MARC21 standard. See Validation Tab on page 11-
6 for more information.

Characteristics of a Unicode-Formatted 
Record in Voyager

Unicode-formatted records can be identified by the ninth position of the Leader. 
The ninth position contains the letter a. See Figure C-1.

Non-Unicode records contain a space in the ninth position.

Figure C-1. Leader Ninth Position

NOTE:
Tag tables do not allow anything to be specified for position 9 in the Leader since 
it is used to identify Unicode records.



 Ex Libris Confidential C-3

Appendix C: Voyager with Unicode Considerations

Diacritics and MARC21 Compliance 
Considerations

Diacritic characters have two components, the alphabetic character and the 
diacritic symbol. For example, ç is made up of c and ¸.

Non-Unicode databases store the diacritic symbol followed by the alphabetic 
character as two separate characters. For example, français is stored as 
fran¸cais. This practice of storing characters is influenced by the MARC21 
standard.

Unicode databases store the alphabetic character first and then the diacritic 
character as two separate characters. For example, français is stored as 
franc¸ais. Also, the diacritic character may be stored as a single entity such as ç.

It is possible that when using certain Windows-based programs, diacritic 
characters are generated with a different internal value that allows the two 
components to be stored as one character. This may occur in the Voyager 
environment when you copy a diacritic character from a Windows-based program 
and paste it into a Voyager record. Voyager has the flexibility to store the diacritic 
character in this alternative format as a single character.

NOTE:
Even though a diacritic character may be stored as two separate components, the 
system displays it as one character.

MARC21 Compliance Considerations

When exchanging records with MARC21 compliant systems, the standard 
dictates that in almost all cases the diacritic character be stored as two 
component pieces, the diacritic symbol first followed by the alphabetic character. 

When exporting from the Voyager with Unicode system, simply indicate MARC21 
MARC8 code M with the -a parameter (-aM) when running bulk export; and the 
system handles the order of the alphabetic character and the diacritic for the 
receiving MARC21 compliant system. See the Voyager Technical User’s Guide for 
more information regarding bulk export.

Additionally, you can use the decomposition feature selectable on the Validation 
tab in Session Defaults and Preferences in the Cataloging module (see Validation 
Tab on page 11-6 for more information) to translate single-entity, non-Roman 
characters into two components so that there is an alphacharacter and diacritic for 
MARC21 compliance.
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Considerations for Records Imported or 
Converted to Unicode

For existing Voyager systems, records in the database need to be converted to 
the Unicode UTF-8 encoding for the Voyager with Unicode release. This process 
is separate and distinct from importing non-Unicode records into an existing 
Voyager with Unicode database.

See Database Conversion on page C-4 and BulkImport on page C-8 for a 
description of the conversion and import processes and considerations.

(See the Voyager Technical User’s Guide for information about exporting records 
from a Voyager with Unicode database.)

Database Conversion

When a non-Unicode Voyager database is converted to a Voyager with Unicode 
database, the following record processing occurs.

• Each record is analyzed to determine if it is a Unicode encoded record. 
(The system checks the ninth position of the Leader. See Characteristics of 
a Unicode-Formatted Record in Voyager on page C-2.)

• Non-Unicode records are converted to the Unicode UTF-8 encoding 
format.

• Any non-recognizable characters are replaced with a Unicode substitution 
character

• Records that cannot be converted to Unicode are viewable in the 
Cataloging module with nc (not coverted) displayed in the Title Bar. See 
Non-Converted Records (nc) on page C-4 for more information.

Also, if appropriate options have been selected in Session Defaults and 
Preferences, non-converted records display in a different color. See 
Colors/Fonts Tab on page 11-19 for more information.

• Log files are generated as part of the conversion process. See Message 
Logs on page C-5 for more information. These log files can be used to 
diagnose records that do not convert successfully to Unicode UTF-8 
encoding.

Non-Converted Records (nc)

A non-converted record can be viewed and corrected in the Cataloging module 
and subsequently saved as a Unicode record.
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! IMPORTANT:
For a record to display in the Cataloging module, there must be an a in the 
9th position of the Leader. Therefore, you see both nc in the Title Bar and 
an a in the 9th position of the Leader. This may seem like a contradiction. 
However, the letter a in the 9th position of the Leader does not become a 
permanent component of the record until the record is saved to the 
database.

! CAUTION:
Be certain to make all corrections to the nc record before saving it to the 
database. When the nc record is saved to the database, the letter a is 
stored in the 9th position of the leader permanently identifying the record 
as Unicode formatted along with any remaining inaccuracies and 
substitiute characters.

Message Logs

The database conversion process produces a log file for bibliographic, holdings, 
and authority records. The log files are named as follows.

• log.#####.bib

• log.#####.mfhd

• log.#####.auth

(where ##### is the job/process ID number)

Records containing fields that fail to convert to Unicode are still visible in the 
Cataloging, WebVoyáge, Aquisitions, Circulation, and Media Scheduling modules 
subsequent to the conversion process. 

A review of the records with errors is necessary to make corrections not handled 
by the conversion process. The error (warning) logs provide a variety of useful 
information to assist with the reivew of records with errors. See Table C-1, 
Table C-2, Table C-3, and Table C-4 for a description of the information that is 
provided. 
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NOTE:
There are two levels of error and warning messages, record-level and field level.

Table C-1. Record-Level Warnings & Errors

Warning/Error Description

leader 9 is not space This is a warning. An attempt is made to convert from 
Voyager encoding to Unicode. This warning may indicate 
corrupt data or reflect a staff input error.

leader 9 is ‘a’ This is an error. There is not attempt made to reconvert a 
record that is already defined as a Unicode record.

066 Error This is an error. This indicates that the character sets in 
the 066 are not supported by the converter.

Table C-2. Log Information Provided for Field-Level Warnings & Errors

Warnings & Errors Information Provided

The record type and ID of the record.

The index within the record of the field that generated the error.

(This is the index within all the field of the record not within fields with the same tag.)

The tag of the field that generated the error.

The text c->8 indicates that the conversion was from Voyager encoding to Unicode.

The error type is specified as follows.

• Page= indicates to which code page (MARC character subset) the source 
character belongs. This is a number that corresponds to specific code pages. See 
Table C-3 for a list of the code pages.

• At indicates the position within the field of the source character that caused the 
problem.

• A hexidecimal dump of the source character and the following seven characters is 
provided.

• An ASCII dump of the source character and the following seven characters.

If the source character or any following characters are control characters or 
diacritics (their code point value is not between 32 and 127), they display as 
periods.
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Table C-3. Code Page Numbering

Code Page Number Description

0 Latin text with ALA diacritics

1 CJK characters (the EACC set)

2 Arabic

3 Cyrillic

4 Greek

5 Hebrew

6 MARC-8 Greek characters (alpha, beta, gamma)

(Logged as a loose translation)

7 MARC-8 superscript and subscript numbers

(Logged as a loose translation)

Table C-4. Specific Warnings & Errors

Warning/Error Description

loose char This is a warning.

This indicates that a character that is not strictly part of 
the Voyager encoding has been converted.

Carriage returns, line feeds, and MARC-8 superscript 
and subscript numbers are some examples of characters 
that are converted and raise this warning.

no char to combine to This is a warning.

This indicates that a Voyager encoding combining 
character was stored at the end of a subfield where it 
lacks a base character to combine to.

In this case, the conversion places a space preceding the 
combining character in the converted record.

undefined char This is an error.

This error occurs when the converter encounters data in 
the source record that cannot be mapped to Unicode. 
The specific characters that cannot be mapped differ 
from code page to code page.
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BulkImport

When importing records using BulkImport, the following record processing occurs.

• The system checks the Bulk Import Rule defined in the Voyager System 
Administration module to determine the character set mapping of the 
incoming records.

If MARC21 UTF-8 (the only Unicode encoding option) is selected, the 
system expects the letter a to be stored in position 9 of the Leader. See 
Characteristics of a Unicode-Formatted Record in Voyager on page C-2 for 
more information.

All the other options are non-Unicode, and the system expects a space to 
be stored in position 9 of the Leader.

• Position 9 of the Leader is analyzed to determine if it matches the Bulk 
Import Rule specified in Voyager System Administration. If the Leader 
position does not contain the expected value, the record is not imported 
and an error is logged in the standard BulkImport message logs.

For a summary of BulkImport processing and results, see Table C-5. 

• After a record passes the check on the 9th position of the Leader, the 
system converts the remaining fields according to the mapping information 
provided in the Bulk Import Rule.

If the record contains characters that cannot be converted, an error is 
logged in the standard BulkImport message logs; and the record is not 
imported. 

Table C-5. BulkImport Rules / Results

Mapping

(Expected Character Set of 
Imported Records)

Leader

Position 9 
Contents

Conversion 
Result Processing Result

MARC21 UTF-8 a No Conversion Load into Database

MARC21 UTF-8 Space Error Out & Log

OCLC (non-Unicode) a Error Out & Log

OCLC (non-Unicode) Space Successful Load into Database

OCLC (non-Unicode) Space Failure Error Out & Log

RLIN legacy (non-Unicode) a Error Out & Log

RLIN legacy (non-Unicode) Space Successful Load

RLIN legacy (non-Unicode) Space Failure Error Out & Log

Latin-1 (non-Unicode) a Error Out & Log
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Subfield Character

The subfield character (‡) continues to be recognized as a subfield delimiter 
character and cannot be used as content in a record. It is reserved for this 
purpose.

The subfield character (‡) can be entered using the following methods.

• Enter the character from the keyboard

• Click Edit > Insert Subfield (F9)

• Select Options > Preferences > Add a subfield ‘a’ to a new field

Cataloging Templates

Templates created in the Cataloging module starting with the Voyager with 
Unicode release must be created as Unicode templates. This implies that the 
ninth position of the Leader must be set to a. See Characteristics of a Unicode-
Formatted Record in Voyager on page C-2 for more information.

Analyzing Inconsistencies

There are different options for diagnosing inconsistencies in Unicode text.

Latin-1 (non-Unicode) Space Successful Load

Latin-1 (non-Unicode) Space Failure Error Out & Log

MARC21 MARC-8 (non-Unicode) a Error Out & Log

MARC21 MARC-8 (non-Unicode) Space Successful Load

MARC21 MARC-8 (non-Unicode) Space Failure Error Out & Log

Voyager legacy (non-Unicode) a Error Out & Log

Voyager legacy (non-Unicode) Space Successful Load

Voyager legacy (non-Unicode) Space Failure Error Out & Log

Table C-5. BulkImport Rules / Results

Mapping

(Expected Character Set of 
Imported Records)

Leader

Position 9 
Contents

Conversion 
Result Processing Result
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Hexadecimal Value

One method for determining the hexadecimal values of non-Roman and Roman 
characters is to copy the text into an editor such as Microsoft WordPad and use 
Alt+X to display the hexidecimal value.

Resources

For more information on a variety of topics related to Unicode, browse the 
following site.

www.unicode.org
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What is Templated Input?

Templated Input provides a common-language alternative for entering and editing 
MARC records. For example, the MARC 245 field can be labeled Title instead of 
245. (See Figure D-31 on page D-37.) With Templated Input, MARC record fields 
are mapped to their corresponding values through modifiable templates.

Templated Input may be used to create records for special collections.

Templated Input Requirements

A separate Voyager Cataloging user ID must be created specifically for use with 
Templated Input. More than one Templated Input user ID may be created.

Creating Templated Input User IDs

Templated Input requires that a user ID be created with specific options selected 
in Voyager System Administration. In particular, the Use Templated Forms check 
box must be selected. See Figure D-1. Optionally, you may decide what add, 
delete, and/or update authority you give to the Templated Input user ID.
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NOTE:
If the Use Templated Forms check box is inactive, Contact Customer Support for 
assistance.

For more information about setting up a Voyager Cataloging user ID, see the 
Voyager System Administration User’s Guide.

Figure D-1. Use Templated Forms check box (Voyager System Administration)

Login for Templated Input

Logging in to Voyager Cataloging for Templated Input follows the same procedure 
as for normal cataloging usage. The only difference is the special user ID and 
password created specifically for the purpose of Templated Input.

After successful login, the usual Voyager Cataloging dialog box displays. See 
Figure D-2. The normal Voyager Cataloging features are the same when using 
Templated Input except for working with templates.
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Figure D-2. Voyager Cataloging main screen

Creating Records with Templated Input

Procedure  D-1.  Creating Records with Templated Input

Use the following to create a new record in the Cataloging module using 
Templated Input.

1. Click the New button.

Result: The Select a MARC Template dialog box displays. See Figure D-3
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Figure D-3. Select a MARC Template Dialog Box

2. Select a template from the available list and click OK.

(The selected template uses the mapping values defined in the configuration files 
for MARC record fields. For more information about creating template configuration 
files, see Template Configuration Files on page D-5.) 

Result: The selected template displays. See Figure D-31 on page D-37.

Retrieving/Editing Records with 
Templated Input

Procedure  D-2.  Retrieving/Editing Records with Templated Input

Use the following to retrieve/edit a record in the Cataloging module using 
Templated Input.

1. Use Search to locate the record you want to edit.
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Result: The selected record displays using the appropriate Templated Input form.

The Voyager Cataloging module selects the appropriate Templated Input form 
based on the mapping for bytes 06 and 07 of the MARC leader field in the record. 
See Template.ini File on page D-5 for more details.

2. Click Save to DB to save your changes.

Result: The record is updated in the database.

Template Configuration Files

Two types of files are required for using templated input in the Cataloging module: 
one primary configuration file (template.ini), and one template definition file 
for each defined template. The template configuration files for Templated Input 
templates are in the MARCTemplate directory of the Cataloging folder on each 
PC on which Voyager Cataloging is installed.

The template.ini file contains basic information and definitions about the 
templates, while separate template definition files contain more specific 
information about each template. The template.ini file must reside in the 
\Voyager\Catalog\MarcTemplate directory on a local machine, while 
template definition files can reside on any drive. Both the template.ini file and 
the template definition files can be modified and customized to individual needs.

NOTE:
The template.ini and template definition files are not modifiable in the Cataloging 
module itself, but in any text editor application such as Microsoft Notepad®.

Template.ini File

The template.ini file is the primary configuration file for templated input, and 
defines templates to be used to create and edit records. The file can be modified 
as needed (for example, if a new template needs to be added). The 
template.ini file contains three stanzas: [New Templates], [Edit 
Templates], and [NonFiling]. 

Figure D-4 shows an example of a template.ini file.
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Line#

1 [New Templates]

2 NewSerial.cfg

3 NewBook.cfg

4

5 [Edit Templates]

6 as=EditSerial.cfg

7 am=EditBook.cfg

8

9 [NonFiling]

10 1=a

11 2=an

12 3=the

13 4=der

14 5=die

15 6=das__

16 7=le

17 8=la

18 9=les

19 10=l

20 11=il

21 12=la

22 13=lo

23 14=gli

24 15=gl

25 16=le

26 17=el

Figure D-4. Sample template.ini File
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[New Template] Stanza

This stanza includes the filenames and locations of the templates to be used for 
creating new bibliographic records. The files can have any name. Although 
examples shown here contain the file extension .cfg, this is not required.

Lines 1 through 3 of Figure D-4 on page D-6 show an example of a [New 
Templates] stanza indicating the file names and location of two templates for 
creating new bibliographic records.

NOTE:
It is not necessary to provide the full file path for the templates. Cataloging will 
look for the files in the C:\Catalog\MARCTemplate directory. It is only necessary to 
include the full file path if templates are not located in the directory mentioned 
above.

[EditTemplates] Stanza

This stanza details which template files should be used to edit existing 
bibliographic records. It contains the mapping of two characters, bytes 06 and 07 
of the MARC record leader, to the template required to edit the record (see lines 5 
through 7 of Figure D-4 on page D-6). 

The first character is matched to byte 06 of the leader field, and the second 
character is matched to byte 07 of the leader field. The first template, specified in 
the [Edit Templates] stanza, to match the leader character values of the 
record being opened will be used to edit that record. 

For example, if you open a file with a leader as in Figure D-5 (with an 06 of a and 
an 07 of s), and your [Edit Templates] stanza is as in Figure D-6, the record 
will be opened using the EditSerial.cfg template configuration file.

27 18=los

28 19=las

29 20=den

30 21=det

31 22=de

Line#

Figure D-4. Sample template.ini File (Continued)
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Figure D-5. Sample MARC record leader

Figure D-6. Sample [Edit Templates] stanza

NOTE:
If the leader information of the record you wish to edit does not contain the leader 
information specified in the [Edit Templates] stanza, the Cataloging client will 
prevent you from accessing the record.

[NonFiling] Stanza

This stanza contains a numbered list of valid non-filing articles which are used to 
automatically create non-filing indicators for appropriately templated fields.

Lines 9 through 31 of Figure D-4 on page D-6 is a sample [NonFiling] stanza 
outlining 21 non-filing articles.

Template Configuration (.cfg) Files

Template configuration files provide detailed information about templates listed in 
the template.ini file. They control the form and values of each template, and 
are modifiable using any text editor. As many template configuration files can be 
created as needed, and can be located either on a local machine (local PC), or on 
a network, as long as definitions in the template.ini file point to the correct file 
location. 

! IMPORTANT:
If using the configuration files on local PC’s, copy the files to the proper 
directory (\Catalog\MARCTemplate is the default) on each PC after editing 
them.

000 00425cas 22001337i450

[Edit Templates]

as=EditSerial.cfg

am=EditBook.cfg
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Template definition files contain three main stanzas. The remaining stanzas are 
control specification stanzas where you establish the formats and types of boxes 
used by the template operator, as well as the information used as the control 
values.

1. The [General] stanza defines the name of the template as displayed to 
the template operator

2. The [BibInitialization] stanza defines what fields will be pre-
defined for new bibliographic records. This information is not visible to the 
template operator, and gets placed into every record created with that 
template.

3. The [BibMarcMapping] stanza defines the fields of the bibliographic 
record which have values chosen by the template operator (as opposed to 
preset default values), and what controls those values are based on.

NOTE:
Having 008 character position specifications in both the [BibInitialization] and 
[BibMarcMapping] stanzas produces one 008 in the record, and any information 
for the same character position from the [BibMarcMapping] stanza overrides the 
information entered in the [BibInitialization] stanza. 

Placing information for other fields in both the [BibInitialization] and 
[BibMarcMapping] stanzas results in multiple fields in the record.

The following is an example of a template definition file for creating new 
bibliographic records for monographs.
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Line#

1 [General]

2 Caption=New Book

3

4 [BibInitialization]

5 000/06=a

6 000/07=m

7 000/17=u

8

9 [BibMarcMapping]

10 035:__:|a<accessionno.text>

11 040:__:|a<creator.text>

12 245:1<title.nonfiling>:|a<title.text>

13 500:__:|a<generalnote.text>

14 520:3_:|a<abstract.text>

15 538:__:|a<physicalformat.text>

16 650:_0:|a<subject1.text>

17 650:_0:|a<subject2.text>

18 650:_0:|a<subject3.text>

19 700:1_:|a<personalauthor1.text>

20 700:1_:|a<personalauthor2.text>

21 700:1_:|a<personalauthor3.text>

22 710:2_:|a<corporateauthor.text>

23

24

25 [accessionno]

26 Type=TextBox

27 Caption=Accession no.:

28

29 [creator]

30 Type=TextBox

Figure D-7. Sample Template Definition File
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31 Caption=Creator:

32 NoValue=Y

33 SameLine=Tovid

34

35 [title]

36 Type=TextBox

37 Caption=Title:

38 Width=wide

39 Scroll=0

40 Lines=2

41

42 [generalnote]

43 Type=TextBox

44 Caption=General Note

45 Width=wide

46 Scroll=1

47 Lines=2

48

49 [abstract]

50 Type=TextBox

51 Caption=Abstract:

52 Width=wide

53 Scroll=1

54 Lines=5

55

56 [physicalformat]

57 Type=TextBox

58 Caption=Physical Format:

59 SameLine=T

60

61 [subject1]

Line#

Figure D-7. Sample Template Definition File (Continued)
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62 Type=TextBox

63 Caption=Subject1:

64 Width=Medium

65

66 [subject2]

67 Type=TextBox

68 Caption=Subject2:

69 Width=Medium

70 SameLine=T

71

72 [subject3]

73 Type=TextBox

74 Caption=Subject3:

75 Width=Medium

76

77 [personalauthor1]

78 Type=TextBox

79 Caption=Personal Author1:

80

81 [personalauthor2]

82 Type=TextBox

83 Caption=Personal Author2:

84

85 [personalauthor3]

86 Type=TextBox

87 Caption=Personal Author3:

88

89 [corporateauthor]

90 Type=TextBox

91 Caption=Corporate Author:

92 Width=Wide

Line#

Figure D-7. Sample Template Definition File (Continued)
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[General] Stanza

This is a required stanza that contains one variable: Caption=. The Caption= 
variable defines the actual name (as opposed to the filename), of the template 
that the operator sees in the list of available templates as well as any other place 
it is necessary to refer to a template by name. The name for the template itself can 
be any combination of letters, numbers, and/or symbols. Choosing a descriptive 
template name facilitates easy identification for the operator (for example, 
choosing “New Book” for a template used to create new bibliographic records for 
books).

Figure D-8 (from Lines 1 and 2 of Figure D-7 on page D-10) is an example of a 
[General] stanza that defines the template name the operator sees in the 
Voyager Cataloging module (see Figure D-9).

Figure D-9. Result of New Book Caption variable in the [General] Stanza

[General]

Caption=New Book

Figure D-8. Sample [General] stanza
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[BibInitialization] Stanza

This optional stanza defines what fields will be pre-defined for new bibliographic 
records. It is optional because it pertains only to creating new bibliographic 
records, and will be ignored if the template is used to edit an existing record.

The [BibInitialization] stanza defines initial values for certain byte 
positions of the MARC leader field, as well as all byte positions for the MARC 006, 
007, and 008 fields. Remember, byte positions start with 0, so the first byte 
position is the 0 byte position. Also, as with all MARC records, there can only be 
one Leader (000) specification and one 008 field. However, there can be multiple 
006 and 007 fields.  

NOTE:
Remember that these values are constant in all records controlled by the 
template, and will be invisible to the operator. To set character position values 
based on user input, add them to the [BibMarcMapping] stanza (see Using 
Multiple Control Properties in a Single Stanza on page D-42).

Leader field

In the [BibInitialization] stanza, the byte positions that can be defined for 
the MARC leader field are as follows: 06, 07, 08, 17, 18, and 19. All others are 
fixed, or set by the program or database. Elements of the leader (000) 
specification (which is numeric notation for the leader in the template 
configuration files) can be initialized by creating a variable consisting of the field 
name, followed by a forward slash, followed by the byte position, an equals sign, 
and the value of the byte position. Only single byte positions can be defined.

Figure D-10 leader field elements in a [BibInitialization] stanza for 
creating a new serial record that indicates that the type of record (000/06) is a 
language material, the bibliographic level (000/07) is a monograph, and the 
encoding level (000/17) is unknown.
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006 and 007 Fields

Single or multiple 006 and 007 fields may be initialized by creating a variable that 
consists of the field name, followed by the equals sign, and the value for the entire 
field. Use vertical bars to represent MARC21 fill characters, and underscores to 
represent byte positions that are left blank.

! CAUTION:
The person creating the templates should be sure that the right number of 
byte positions are being used for 007 definitions. The program either cuts 
off or pads 007s if they are too long or short. 

Figure D-11 shows an example of a default value for a 007 field in the 
[BibInitialization] stanza.

Figure D-11. Sample 007 specification in the [BibInitialization] stanza

008 Field

For each new record created using templates, the program will automatically 
generate an 008 field. The [BibInitialization] stanza allows for the 
provision of overriding values for any chosen position in the 008 field. Elements of 
the 008 field may be initialized by creating variables that consist of field names, 
followed by a forward slash, followed by the byte position, and optionally by a 
dash and the byte range. Single bytes use only the byte position. Multiple byte 
definitions are defined by specifying the first byte position, a dash, and the end 
byte position. Use an underscore to signify blanks, and the vertical bar to 
represent MARC21 fill characters. For an example, see Figure D-12.

[BibInitialization]

000/06=a

000/07=m

000/17=u

Figure D-10. Sample [Bibinitialization] stanza

007=he|amb___buca
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The following is an example of override values for three positions in the 008 field, 
indicating that the form of item (008/23) is braille, the government publication 
(008/28) is federal/national, and the item is a festschrift (008/30).

Figure D-12. Sample 008 field

Variable Fields

This part of the [BibInitialization] stanza supplies default values for 
variable MARC record fields in the 010 to 999 range. To define default values for 
variable fields, provide the appropriate field tag, a colon, the first and second 
indicators, another colon, a subfield indicator, and the entire contents of the 
subfield. It is possible to specify as many subfields on a line as desired, but the 
definition of each variable field must all be on one line. Use a vertical bar to 
represent the MARC21 delimiter character, and spaces (as opposed to under-
scores) to specify indicators to be left blank. For an example of variable fields in 
the [BibInitialization] stanza, see Figure D-13.

Figure D-13 is an example of default values for two variable MARC fields, 
indicating the physical description (300 field) of the item as well as a language 
note (546 field).

Figure D-13. Sample variable MARC record fields

Overview of Templates Produced by 
Template Configuration Files

The control specification stanzas of the template configuration files (lines 13 
through 65 of Figure D-14) determine the layout of the template, and the values 
(information) associated with the combination box items available for selection by 
the template operator. These stanzas are named for the boxes which they define, 
but need not have the same name as that seen by the template operator.

008/23=f

008/28=f

008/30=1

300: :|al v.|c29 cm

546: :|aIn French, Latin, and Spanish
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The [BibMarcMapping] stanza (lines 1 through 11 of Figure D-14) determines 
how the information entered by the operator gets placed into the record being 
created.

Though the control specification stanzas must be placed further down in the 
template configuration files from the [BibMarcMapping] stanza, it is easier to 
understand the Templated Input process by explaining the control specification 
stanzas first.
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Line#

1 [BibMarcMapping]

2 035:--:|a<accessionno.text>

3 040:--:|a<creator.text>

4 245:1<title.nonfiling>:|a<title.text>

5 500:--:|a<generalnote.text>

6 538:--:|a<physicalformat.text>

7 650:-0:|a<subject1.text>

8 650:-0:|a<subject2.text>

9 650:-0:|a<subject3.text>

10 700:1-:|a<personalauthor.text>

11 710:2-:|a<corporateauthor.text>

12

13 [accessionno]

14 Type=TextBox

15 Caption=Accession no.:

16

17 [creator]

18 Type=TextBox

19 Caption=Creator:

20 NoValue=Y

21 SameLine=T

22

23 [title]

24 Type=TextBox

25 Caption=Title:

26 Width=wide

27 Scroll=0

28 Lines=2

29

30 [generalnote]

Figure D-14. Sample [BibMarcMapping] and control specification stanzas (Page 
1 of 3)



 Ex Libris Confidential D-19

Appendix D: Templated Input

31 Type=TextBox

32 Caption=General Note:

33 Width=wide

34 Scroll=1

35 Lines=2

36

37 [physicalformat]

38 Type=TextBox

39 Caption=Physical Format:

40 SameLine=T

41

42 [subject1]

43 Type=TextBox

44 Caption=Subject1:

45 Width=Medium

46

47 [subject2]

48 Type=TextBox

49 Caption=Subject2:

50 Width=Medium

51 SameLine=T

52

53 [subject3]

54 Type=TextBox

55 Caption=Subject3:

56 Width=Medium

57

58 [personalauthor]

59 Type=TextBox

60 Caption=Personal Author1:

Line#

Figure D-14. Sample [BibMarcMapping] and control specification stanzas (Page 
2 of 3)
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Combination Boxes and Text Boxes

In Templated Input, operator-modifiable data is input through the use of controls. 
There are two types of controls used in templated input: combination (or drop-
down) boxes and text boxes. Each box has a corresponding stanza associated 
with it where you define the parameters of the box, including the layout of it and 
the values associated with the items available for selection by the template 
operator.

Both combination (combo) boxes and text boxes share the elements shown in 
Figure D-1, some of which are required, some of which are optional.

61

62 [corporateauthor]

63 Type=TextBox

64 Caption=Corporate Author:

65 Width=Wide

Table D-1. Shared elements

Element Required 
or 
Optional

Description Possible Values

Type required Indicates the type of control, either 
combination box or text box.

ComboBox or 
TextBox

Caption required Name to be displayed to the operator just 
above the control on the template.

Any

Width optional Amount of horizontal space taken up by the 
control.

Narrow, Medium, 
or Wide.

Default=Narrow

Line#

Figure D-14. Sample [BibMarcMapping] and control specification stanzas (Page 
3 of 3)
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Combination Boxes

Combination boxes are useful if operators must be presented with a limited 
number of choices, (for example, if a field for a record is to have a value of either 
microfilm, or microfiche). These displayed choices can consist of very 
general information which does not require familiarity with MARC record formats. 
Using codes from Voyager tag table files, or values entered manually, you then 
can attach more specific MARC record information to the values displayed to the 
template operator. You can also attach multiple values to each option available to 
the template operator, so the same box can be used for multiple MARC record 
fields.

You can configure combination boxes to pull values out of another MARC 
configuration file (tag table file) or you can enter the values into the stanzas in the 
template configuration files themselves. The tag table files reside in the 
C:\Voyager\Catalog\TagTable directory on each PC on which the Voyager 
Cataloging Module is installed.

Combination Boxes Using Other Configuration Files

The control to specify a configuration file to pull values from is the source 
element.

Source= element

If the combination box will be filled by data pulled from a MARC configuration file 
(tag table file), the definition of the combination box must include the Source= 
element. This element indicates where data for the combination box is to be 
pulled from. Provide this information in the following format: 

SameLine optional Whether or not the control should display on 
the same horizontal line as the previous 
control. A value of True means the program 
will display the control on the same line to 
the right of the previous control (if there is 
room). A value of False (the default) will 
display the control on the left edge of the 
next line on the template.

True or False

Table D-1. Shared elements (Continued)

Element Required 
or 
Optional

Description Possible Values
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Source=Name of configuration file/name of stanza to extract 
information from in the source file.

NOTE:
Only a partial file path is needed because the program will automatically start 
looking in the \catalog subdirectory.

The example in Figure D-15 directs the program to look in the BookRegularity 
stanza in the Bmarcfix.cfg file.

Figure D-15. Sample Source= element line

If the contents of the combination box will be filled with the contents of Source=, 
then an optional Display= element may be set. The Display= element 
determines how the contents of the Source= information will display to the 
operator (in the combination box).

Display= Element

This element sets what displays in each line of the combination box. It has one of 
three possible values: v (default), c, cv, or vc. The value c represents display of 
the actual MARC code itself, while v represents display of the value of the 
contents. vc or cv represent combinations of MARC code and values of contents.

NOTE:
The Display= element in stanzas using the Source= element differs from the 
Display= element used in stanzas which do not draw information from tag table 
files.

Figure D-16 shows an example of the Source= element and the Display= 
element (in a [frequency] stanza). Figure D-17 shows the [006/
008SerialsFrequency] stanza (from the Bmarcfix.cfg file) which the 
Source= element in the [frequency] stanza draws the information from for the 
combination box. Figure D-18 shows the frequency combination box as created 
by the [frequency] stanza in Figure D-16. 

Figure D-19 shows what the box would look like if the Display= element were 
set to v (or left blank).

Source=Bmarcfix.cfg/BookRegularity
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Figure D-16. Sample stanza using the Source= and Display= elements

[frequency]

Type=combobox

Caption=frequency

Source=Bmarcfix.cfg/006/008SerialsFrequency

StartUpDefault=r

Display=cv

Width=Narrow
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[006/008SerialsFrequency]

_=No determinable frequency

a=Annual

b=Bimonthly

c=Semiweekly

d=Daily

e=Biweekly

f=Semiannual

g=Biennial

h=Triennial

i=Three times a week

j=Three times a month

m=Monthly

q=Quarterly

s=Semimonthly

t=Three times a year

u=Unknown

w=Weekly

z=Other

|=No attempt to code

Figure D-17. [006/008SerialsFrequency] stanza in the Bmarcfix.cfg file
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Figure D-18. Sample Frequency combination box using Display=cv

Figure D-19. Sample Frequency combination box using Display=v (the default)

Combination Box Values Set in Template 
Configuration Files

If the information for the combination box is not available in the Voyager tag table 
files, all of the items to present in the combination box must be listed in the 
corresponding stanza. Keep in mind, the program does not sort items listed for 
inclusion in combination boxes, rather it will list items in the order in which they 
display in the stanza for the combination box at hand.

There are up to four variables, or control properties, associated with each item in 
the combination box. Two of these properties, Code and Display, are required. 

• Display is the control property seen by the template operator. Set these 
values to something the template operator would recognize.

NOTE:
The Display= element in stanzas using the Source= element differs from this 
Display= control property.

• Code is the default property placed into the resulting MARC record.

The remaining two, Equivalent and Other, are optional. These two properties 
are extra variables which you can assign values to, to be placed into the record (if 
you have the same information, which needs to be placed into different MARC 
record fields in different formats, for example). For an example using these two 
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control properties, see Using Multiple Control Properties in a Single Stanza on 
page D-42. The values of the properties are set here, while their placement into 
the MARC records is detailed in the [BibMarcMapping] stanza.

Table D-2 shows the 4 control properties for combination boxes which do not draw 
information from tag table files. Lines 7 through 10 of Figure D-20 show an 
example set of control property value specifications.

Table D-2. Combination box control property types

Element Required or 
Optional

Description

Code required An abbreviation or other symbolic representation for the 
item. This element is required even if it is not used in a 
template. It must be the first element defining each of the 
items to be listed in the combination box. It is not displayed 
to the operator.

Display required The text to be presented to the operator in the combination 
box itself.

NOTE:
The exception to the above is when using the Source= 
element in a combination box control stanza. In that 
case, the Display control property tells the template 
whether to display the code and value, or just the 
code, from the tag table file. For more information, see 
Source= element on page D-21.

Equivalent optional A piece of information associated with the item which may 
be needed in a template definition. It is not displayed to the 
operator. 

Other optional An additional piece of information associated with the item 
which may be needed in a template definition. This 
element may have any name. This element is not 
displayed to the operator.
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Text Boxes

Text boxes are useful if operators must enter text for placement directly into a 
MARC record field.

You can configure text boxes to count the number of non-filing characters and 
enter that number into the MARC record. Text box configuration in the control 
specification stanzas is straightforward. Table D-3 lists the possible layout 
specifications for text boxes (all of which are optional).

Line#

1 [size]

2 Type=combobox

3 Caption=Size

4 Width=Narrow

5 SameLine=T

6

7 Code=21.6 X 27.94 cm.

8 Display=Letter size newsletter

9 Equivalent=8.5 X 11 in.

10 Other=Print copies of department newsletters avail. in 
dept. office.

Figure D-20. Sample control specification stanza

Table D-3. Text box layout variables

Element Description

DefaultValue Specifies text for display in the text box when creating a new 
bibliographic record, or when editing a bibliographic record 
that does not have any data for the field or subfield. If an 
existing record does have data for that field or subfield, then 
the data will fill the text box when the record is loaded.

Lines Specifies the number of vertical lines to be taken up by the 
text box. The default is 1 if this is not set.
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The stanza in Figure D-21 produces the display in Figure D-44.

Figure D-22. Sample Text Box Display

[BibMarcMapping] Stanza

You configure the MARC record placement of the information entered into the 
combination and text boxes in the [BibMarcMapping] stanza. This is where you 
establish what information to pull from which boxes and how the information gets 
placed into the MARC fields of the record.

For example, if you want the value of the Code property selected in the Size 
combination box to get placed into the 300c, and the value of the Other property 
into the 500a, in the resulting record, enter a line in the [BibMarcMapping] 
stanza as in Figure D-23.

Scroll Specifies whether or not a vertical scroll bar will display at the 
right edge of a text box. Valid values are True, in which case 
a scroll bar will display, and False, (default) in which case a 
scroll bar will not display.

[title]

Type=TextBox

Caption=Title:

Width=wide

Scroll=0

Lines=2

Figure D-21. Sample [title] stanza

Table D-3. Text box layout variables (Continued)

Element Description
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Figure D-23. Sample 300c and 500a specification in the [BibMarcMapping] stanza

For each MARC field, it is necessary to supply the field number, followed by a 
colon, both indicators (fixed values, spaces, or symbols), another colon, the 
subfield indicator (vertical bar with subfield character), and the control 
specification for that field/subfield. Enter control specifications in the following 
format:

<controlname.controlproperty>

Based on the [size] stanza in Figure D-24, if the template operator selected 
Letter size newsletter from the Size combination box, the resulting 300c and 500a 
fields in the MARC record would be as in Figure D-25 (once the record was 
saved).

Figure D-24. Sample [Size] stanza

300:--:|c<size.code>.

500:--:|a<size.other>

[size]

Type=combobox

Caption=Size

Width=Narrow

SameLine=T

Code=21.6 X 27.94 cm.

Display=Letter size newsletter

Equivalent=8.5 X 11 in.

Other=Print copies of department newsletters avail. in 
dept. office.

Code=21.6 X 35.56 cm.

Display=Newspaper

Equivalent=8.5 X 14 in.

Other=Print copies of school newspapers avail. in 
stacks.
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Figure D-25. Sample 300c and 500a created from Size combination box

For more information about combination boxes, see Combination Boxes on 
page D-21.

[BibMarcMapping] stanza elements

The following is an example of a [BibMarcMapping] stanza contained within a 
template definition file for editing serials. It outlines 10 MARC fields which 
contains operator-modifiable information, including the system control number 
field or accession number field (035), which must be further detailed in another 
stanza in the template entitled, [accessionno]. Likewise, the MARC field for 
cataloging source or creator (040), must be further detailed in a separate stanza 
entitled, [creator]. The last component contained in the angle bracket, .text, 
indicates that the component is a text box (as opposed to combination box) in 
which the operator can input free text data.
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Leader Elements

Elements of the Leader (designated in template configuration files as 000) can be 
mapped by creating a variable that consists of the field name, followed by a 
forward slash, followed by the byte position, followed by an equals sign, and then 
the object to be used to edit that particular element. Only byte positions 06, 07, 
08, 17, 18, and 19 can be edited. Do not attempt to specify other byte positions in 
the leader. Remember that byte positions start with a 0.

The following example of leader field 17 indicates that the encoding level element 
(000/17), takes its value from the code control property of the combination box 
created by the [enclvl] stanza.

000/17=<enclvl.code>

[BibMarcMapping]

035:__:|a<accessionno.text>

040:__:|a<creator.text>

245:1<title.nonfiling>:|a<title.text>

500:__:|a<generalnote.text>

538:__:|a<physicalformat.text>

650:_0:|a<subject1.text>

650:_0:|a<subject2.text>

650:_0:|a<subject3.text>

700:1_:|a<personalauthor.text>

710:2_:|a<corporateauthor.text>

Figure D-26. Sample [BibMarcMapping] Stanza
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006 and 007 Fields

Parts of one or more of these fields can be mapped to controls in the template by 
creating a variable consisting of the field name, followed by an equals sign, and 
the values and object names for the entire field. A vertical bar is used to represent 
MARC21 fill characters, and an underscore is used to represent byte positions to 
be left blank. One 006 or 007 is created for each line.

TIP:
If you are creating a template for multiple material forms (like video tapes, 
music and books) or for material forms which have more than one possible 
specification (like music), make sure that a control (template user input) 
rather than a fixed value is being specified for the first byte position (byte 
position zero). If your template is for one material form which only has one 
possible specification, put the 00 character positions of the 006 and 007 in 
the [BibInitialization] stanza.

The following is an example of a MARC 007 field in the [BibMarcMapping] 
stanza, indicating the position eleven (generation code) of the 007 field takes its 
value from a combination box called, generat.

007=hd|afb___ba<generat.code>a

008 Field

Elements in the 008 field can be mapped to controls in the template by creating 
variables consisting of the field name, followed by a forward slash, followed by the 
byte position, and optionally by a dash and the byte range. Single bytes use only 
the byte position, while multiple byte definitions are defined by specifying the first 
byte position, then a dash, and the end byte position. The variable is followed by 
the equals sign, and the name and property of the object that provides the data for 
these byte positions.

The following is an example of the 008 field in the [BibMarcMapping] stanza which 
indicates that the country of publication code (008/15-17), takes its value from the 
Code control property of the combination box called country.

008/15-17=<country.code>

Other Variable Fields17

For each variable field or part of each variable field available for user modification, 
it is necessary to supply the field name, followed by a colon, both indicators (fixed 
values, spaces, or objects), another colon, the subfield indicator (vertical bar with 
subfield character), and the contents of that subfield (may be fixed). You may 
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specify as many subfields on a line as you wish, but the definition of each variable 
field must all be on one line. As with the 006 and 007 fields, one field is created in 
the record for each variable field in the [BibMarcMapping] stanza.

Figure D-27 shows an example of MARC variable fields in [BibMarcMapping], 
indicating that the contents of the title (245a) field should be set from the text box 
called, title. The note (500a) field indicates that the contents of the field should 
be set from a text box called, note.

Figure D-27. Sample 245 and 500 field template specifications in the 
[BibMarcMapping] stanza

! IMPORTANT:
For each control property specified in the [BibMarcMapping] stanza, a 
corresponding control property value line must exist in each control group 
for the combination box stanza being referred to. For example, if you 
configure the template to enter the <agency.other> value into a MARC 
field, you must have an Other= line with information in it for each control 
property group in the [Agency] stanza. If you do not provide a property 
value for the control selected by the template operator in the drop-down 
box, nothing will be placed into that field (or subfield) in the record.

In setting up a combination box using content from either a MARC configuration 
file (tag table file), or content listed in the combination box itself, the optional 
elements in Table D-4 can be set.

245: :|a<title.text>

500: :|a<note.text>

Table D-4. Combination box optional elements

Element Description

NoValue This element may have a value of True or False (default). If 
the value is True, Cataloging will place the value (no 
change) at the top of the list of possible values. This value 
becomes the default value if none of the items in the 
combination box match a value in a record. Whenever a 
combination box has the value True, the value in the 
original, underlying record is allowed to stand without 
change.
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Figure D-28 shows part of a [BibMarcMapping] stanza that defines from where 
data for the MARC 521 field will be pulled. In this case, data is pulled from a 
combination box entitled, audience. The value it pulls from that combination box 
comes from the Code control property value corresponding to the Display item 
selected from the drop-down box.

Figure D-28. Sample line in the [BibMarcMapping] stanza

The instruction in Figure D-28 must be followed further down in the template 
definition file by the stanza in Figure D-29 (outlining a combination box definition 
for possible destinations for a new serial).

DefaultCode Sets the initial value of the combination box for new or 
existing bibliographic records that do not have data set for 
that field or subfield. If this is not set, then the combination 
box will display the first available value upon opening a new 
record, or the existing value upon opening an existing 
record.

DefaultValue Similar to DefaultCode, except that a value and not a code 
is offered. Either DefaultCode or DefaultValue can be set at 
one time. If DefaultCode is set, then DefaultValue will not 
be read.

521:__:|a<audience.code>

Table D-4. Combination box optional elements (Continued)

Element Description
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The definition in Figure D-29 produces the display in Figure D-30.

Figure D-30. Sample Combination Box Display

Use the following to put Figures D-28 through D-30 into a sample workflow.

1. The template operator selects the Children item from the drop-down list in 
the Intended Audience combination box (see Figure D-30).

Based on the [BibMarcMapping]line in Figure D-28, the template is 
configured to place the Code value from of the selected item in the 
Intended Audience box into the 521a, so:

2. The template locates the set of controls, in the [audience] stanza, which 
include the Display control value of Children (see Figure D-29), and pulls 
the Code control value (Children’s book) from that set of controls.

[audience]

Type=ComboBox

Caption=Intended Audience:

Code=General

Display=General Audience

Equivalent=All ages

Code=Children’s’ book

Display=Children

Equivalent=Ages 6-10

Figure D-29. Sample Combination Box Definition
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3. Once the record is saved, this Code control value is placed into the 521a of 
the record.

If you change the control property specified in Figure D-28 to 
<audience.equivalent>, the appropriate value for the Equivalent control 
property is placed into the 521a (in this case Ages 6-10).

Example of Converting Operator Entered 
Information to MARC Records

Figure D-31 shows an example of a new record template as seen by the template 
operator in The Voyager Cataloging module. It consists of a number of text boxes 
and drop-down boxes. For the purposes of this illustration, we consider one text 
box (the Source text box), and one drop-down box (the Size drop-down box).
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Figure D-31. Sample new record template in Voyager Cataloging

Sample Text Box

The properties of the Source text box in this example are governed by the control 
specification stanza in Figure D-32.
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Figure D-32. Sample control specification stanza

The specific variables in this stanza are discussed in [BibMarcMapping] Stanza 
Using Text Boxes on page D-44. This stanza determines how the text box 
appears to the template operator (in The Voyager Cataloging module).

How the information entered into the text box by the operator gets placed into the 
MARC fields of the record being created using this template is determined by the 
[BibMarcMapping] stanza. This is where you establish what information to pull 
from which boxes and how the information gets placed into the MARC fields of the 
record. 

For example, if you want the information entered into the Source text box to get 
placed into the 773t in the resulting record, you might enter a line in the 
[BibMarcMapping] stanza as in Figure D-33.

Figure D-33. Sample 773t specification in the [BibMarcMapping] stanza

For each MARC field, it is necessary to supply the field number, followed by a 
colon, both indicators (fixed values, spaces, or objects), another colon, the 
subfield indicator (vertical bar with subfield character), and the control 
specification for that field/subfield. The control specification uses the following 
format:

<controlname.controlproperty>

The controlname in Figure D-33 is source, so Voyager uses the information 
entered into the box created by the [Source] stanza. 

The controlproperty in Figure D-33 is text, which means that the 
information from the text box (created by the Source stanza) is placed into the 
MARC field as the text entered by the operator.

[Source]

Type=TextBox

Caption=Source

Width=Medium

773:0#:|t<source.text>
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If the template operator entered text into the Source box as in Figure D-34, the 
resulting field (773t) in the MARC record would be as in Figure D-35 (once the 
record was saved).

Figure D-34. Sample Source box text

Figure D-35. Sample 773t created from Source box text

Sample Combination Box

The properties of the Size combination box in this example are governed by the 
control specification stanza in Figure D-36.
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The specific variables in this stanza are discussed in Combination Boxes on 
page D-21. This stanza determines how the combination box appears to the 
template operator (in The Voyager Cataloging module). Since this stanza is for a 
combination box, it is also where you enter the values for each individual control 
property. 

The possible control properties for combination boxes are Code, Display, 
Equivalent, and Other. The control properties are essentially variables, the 
values of which you set in the control specification stanzas. Display is the 
control property value the operator sees in the combination boxes (Figure D-37 
shows the Display control property values in the Size combination box created 
by the control specification stanza in Figure D-36.

Line#

1 [size]

2 Type=combobox

3 Caption=Size

4 Width=Narrow

5 SameLine=T

6

7 Code=21.6 X 27.94 cm.

8 Display=Letter size newsletter

9 Equivalent=8.5 X 11 in.

10 Other=Print copies of department newsletters avail. in 
dept. office.

11

12 Code=21.6 X 35.56 cm.

13 Display=Newspaper

14 Equivalent=8.5 X 14 in.

15 Other=Print copies of school newspapers avail. in 
stacks.

Figure D-36. Sample control specification stanza
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Figure D-37. Display values in Size combination (drop-down) box

Each item available for selection in drop-down boxes is created by the Display 
control property values in each control stanza.

In the sample control specification stanza in Figure D-36 on page D-40, the two 
control property stanzas (lines 7 through 10 and lines 12 through 15) are shown in 
Figure D-38.

Figure D-38. Control stanzas

Again, think of the three other control properties (Code, Equivalent, and Other 
as variables, the values of which you enter for placement into the MARC fields of 
your records according to the [BibMarcMapping] stanza. In this example, the 
Code property is used for the size measurements of the material in centimeters, 
the Equivalent property for the measurements in inches, and the Other 
property for print material availability notes which happen to correspond to the 
material sizes.

Code=21.6 X 27.94 cm.

Display=Letter size newsletter

Equivalent=8.5 X 11 in.

Other=Print copies of department newsletters avail. in 
dept. office.

Code=21.6 X 35.56 cm.

Display=Newspaper

Equivalent=8.5 X 14 in.

Other=Print copies of school newspapers avail. in 
stacks.
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A more detailed explanation of this example (including a corresponding 
[BibMarcMapping] sample) can be found in Using Multiple Control Properties 
in a Single Stanza on page D-42.

Using Multiple Control Properties in a Single Stanza

The example in this section illustrates the use of multiple control properties in a 
singe stanza.

For a school and department news template, if the print material availability 
corresponds to the size of the newsletters, you can attach the print material 
availability note to the Size drop down items. Instead of creating a separate 
stanza and control properties, you can use the .other property in the [size] 
stanza for the print material availability. 

In this example, the template operator sees the display control property values in 
the Size drop-down box (see Figure D-39 for an illustration, and lines 13 and 18 of 
Figure D-40 for the Display control values used in the drop-down box).

Figure D-39. Size drop-down values as seen by the template operator

When the operator makes a selection in the drop-down box and saves the record, 
the template:

1. Pulls the corresponding size.code control property value from the 
[size] stanza and puts the value into the 300c field of the record.

2. Pulls the corresponding size.other control property value from the 
[size] stanza and puts the value into the 500a field of the record.
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Figure D-41 on page D-44 shows a sample record, illustrating the preceding 
example. This example shows how the 300c and 500a are populated if the 
operator selects Letter size newsletter from the Size box (see lines 12 through 15 
of Figure D-40 for the control properties used by the template in this example).

Line#

1 [BibMarcMapping]

2 -----------------Display Truncated-----------------

3 300:--:|c<size.code>.

4 500:--:|a<size.other>

5

6 [size]

7 Type=combobox

8 Caption=Size

9 Width=Narrow

10 SameLine=T

11

12 Code=21.6 X 27.94 cm.

13 Display=Letter size newsletter

14 Equivalent=8.5 X 11 in.

15 Other=Print copies of department newsletters avail. in 
dept. office.

16

17 Code=21.6 X 35.56 cm.

18 Display=Newspaper

19 Equivalent=8.5 X 14 in.

20 Other=Print copies of school newspapers avail. in 
stacks.

Figure D-40. Excerpt of sample [BibMarcMapping] stanza
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Figure D-41. Sample record

[BibMarcMapping] Stanza Using Text Boxes

Controls that are text boxes have a property name of either .text (default), or 
.nonfiling, which is only specified for indicators of certain fields (for example, 
the 245 field). The .nonfiling property tells Voyager to look for nonfiling words 
in the text entered into the text box, based on the [nonfiling] stanza of the 
template.ini file.

Figure D-42 shows part of a [BibMarcMapping] stanza which defines from 
where data for the MARC 245 field is pulled. In this case, data is pulled from a text 
box entitled, title, and if the text begins with a nonfiling word, the nonfiling word 
count (including spaces) will be entered into the second indicator of the 245 field.

Figure D-42. Sample 245 [BibMarcMapping] specification

245:1<title.nonfiling>:|a<title.text>
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The above instruction must be followed by (further down in the template definition 
file), the following stanza (outlining a text box definition for the title field of a new 
book record).

The definition in Figure D-43 produces the display in Figure D-44.

Figure D-44. Sample Text Box Display

Figure D-45 shows a sample title in the Title text box of a template. Figure D-47 
shows the title, as entered into the record by Voyager, based on the 245 
[BibMarcMapping] stanza specification in Figure D-46. Notice that the second 
indicator of the 245 in the record sample in Figure D-47 contains the “4” indicating 
the number of non-filing characters in the title (The ).

Figure D-45. Sample title in the Title text box

[title]

Type=TextBox

Caption=Title:

Width=wide

Scroll=0

Lines=2

Figure D-43. Sample [title] stanza
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Figure D-46. Sample 245 [BibMarcMapping] specification

Figure D-47. Sample title as it appears in the record

The following is the part of a [BibMarcMapping] stanza that defines from where 
data for the MARC 520 field is pulled. In this case, data is pulled from a text box 
entitled, abstract.

520:3_:|a<abstract.text>

This instruction must be followed by the stanza in Figure D-48 (outlining a scrolled 
text box definition for the abstract field of a new book record) in the order that you 
want it to display in the template (in relation to the other box specification 
stanzas).

The definition in Figure D-48 will produce the display in Figure D-49.

245:1<title.nonfiling>:|a<title.text>

[abstract]

Type=TextBox

Caption=Abstract:

Width=wide

Scroll=1

Lines=5

Figure D-48. Sample [abstract] stanza
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Figure D-49. Sample Text Box Display with Scroll
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[Date] stanza, 3-90
Default Field Order Configurations, 11-5

default folder
using to create new record, 5-25

Default Tab button, 3-35, 3-39, 3-46
default template

using to create new record, 5-24
DefaultCode element, D-34
Defaults

templates, 11-16
defaults

searching, 3-83
DefaultValue element, D-27, D-34
Delete Item check box, 7-10
Deleting

records, 4-2–4-3
templates, 8-5

deleting
search terms in builder search, 3-46

delimiter symbol
element in derivation field, 5-9

derivation field, 5-8–5-17
element

bracket, left (opening) angle, 5-9
bracket, right (opening) angle, 5-9
delimiter symbol, 5-9
subfield, 5-9
tag, 5-9

example, 5-12–5-15
format, 5-8
multiple subfields, 5-11
non-matching subfield, 5-11
reading, 5-10–5-11
rule, 5-12–5-15

diacritic characters
entering, 6-2

diacritic mode, 6-3
diacritics, 6-1, 6-3
dialog box

Browse Headings List, 3-42
Headings List, 3-57, 3-70, 3-72, 3-80, 3-113
Holdings Index, 3-55, 3-67, 3-106, 3-111
Reference Information, 3-61, 3-62, 3-114
Remote Search, 3-77
Search, 3-31, 3-32, 3-44
Search Limits, 3-69, 3-72, 3-73, 3-85, 3-99
Search Status, 3-80
Select Bibliographic Template, 5-20, 5-21, 5-26
Select Directory, 5-23
Select one or more authority records, 3-64
Session Defaults and Preferences, 3-83, 5-17, 5-

18, 5-22
Simultaneous Search, 3-78
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Titles Index, 3-48, 3-49, 3-66, 3-69, 3-72, 3-80, 
3-106, 3-107, 3-109, 3-113, 3-116, 3-118

Voyager Connection Options, 3-75, 3-76
Display Bibliographic Record Directly If Search 

Results In Only One Title, 3-84
Display element, D-22, D-26
Display menu, 11-29, 11-39
document summary, xviii
DOI, 2-22
DOI and URN link examples, 2-25
Duplicate Barcode, 2-63
Duplicate Checking, 4-15
dynamic noise word reduction, 3-36

E

Edit menu, 11-32
[Edit Templates] stanza, D-7
Editing

records, 4-1–4-2
templates, 8-4

editing
search terms in builder search, 3-46

element
Caption, D-20
Code, D-26
DefaultCode, D-34
DefaultValue, D-27, D-34
derivation field

bracket, left (opening) angle, 5-9
bracket, right (opening) angle, 5-9
delimiter symbol, 5-9
subfield, 5-9
tag, 5-9

Display, D-22, D-26
Equivalent, D-26
Lines, D-27
NoValue, D-33
Other, D-26
SameLine, D-21
Scroll, D-28
Source, D-21
Type, D-20
Width, D-20

Equivalent control property, D-25
Equivalent element, D-26
example

for derivation field, 5-12–5-15

exclamation point (!), 3-34
Exiting, 1-5

F

feedback, customer, xxi
field

007 control
position 01, 3-92

008 control
position 06, 3-95
position 07-10, 3-91
position 15-17, 3-94
position 35-37, 3-90

authority
008, 2-33
variable, 2-35

Bib, 5-21
bibliographic

005, 2-8
006, 2-8
007, 2-11
008, 2-14
880, 2-16
variable, 2-16

Holding Location, 7-11
holdings

007, 2-45
008, 2-48
variable, 2-50

Item Status, 7-9
Leader control

position 06, 3-93
position 07, 3-93

Media Type, 7-7
Permanent Location, 7-6
Permanent Type, 7-7
Search For, 3-34, 3-39
Search for, 3-45
Search In, 3-45
search type drop-down, 3-38
Statistical Categories, 7-9
Template, 5-23
Temporary Location, 7-6
Temporary Type, 7-7

field codes, 4-36
file

initialization
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template.ini, D-5
initilization

limits.ini, 3-86
Voyager.ini, 3-52

File menu, 11-28, 11-30
files on a server examples, 2-24
Find radio button, 3-38
find search, 3-41, 3-69
folder

Catalog, 5-20, 5-23
default

using to create new record, 5-25
defining a default, 5-22–5-24
MARCTemplate, 5-20, 5-23
Tag Tables, 5-20, 5-23
Template, 5-20, 5-23

Folders section
Folders/Files tab, Cataloging module, 5-22
Template field, 5-23, 5-25

Folders/Files tab, 5-17–5-24
defining a default folder, 5-22–5-24
defining a default template, 5-18–5-22
Folders section, 5-22

Template field, 5-23, 5-25
Templates section, 5-20

bib field, 5-21
Font

bold, 11-24
fonts, 11-20
Free text keyword search, 3-106, 3-109
Free Text radio button, 3-33

G

[General] stanza, D-9, D-13
get call number from bib record, 2-51
Getting Started, 1-1

prerequisite skills and knowledge, 1-1
global headings change, 9-7

batch job, 9-20

H

Heading column
Headings List, 3-60

Heading Type column
Headings List, 3-60

Heading Types Filter, 3-39, 3-69
Headings Index, 4-18
Headings List

Bibs column, 3-60
Heading column, 3-60
Heading Type column, 3-60

Headings List button, 3-59
Headings List dialog box, 3-57, 3-70, 3-72, 3-80, 3-

113
headings search

results, 3-60
headings searching, 3-37, 3-68, 3-113
Help menu, 11-30, 11-41
History tab, 3-47, 3-73

authority record, 2-39
sorting, 2-40

bibliographic record, 2-29
sorting, 2-30

holdings record, 2-60
sorting, 2-62

history tab
searching, 3-48

Holding Location field, 7-11
Holdings Boolean keyword search, 3-106, 3-111
Holdings Boolean radio button, 3-33
holdings boolean search

results, 3-55, 3-56
Holdings Index

Holdings Record column, 3-56
Holdings Index dialog box, 3-55, 3-67, 3-106, 3-111
holdings keyword definition

SPAC, 3-104
Holdings Record column

Holdings Index, 3-56
Holdings records

007 field, 2-45
008 field, 2-48–2-50
colors of, 11-19
create, 3-5
description, 2-41
get call number from bib record, 2-51
History tab, 2-60
leader, 2-43–2-45
linking to other records, 3-133, 3-134, 3-136
locations, 3-132
MARC tab, 2-41
retrieving, 3-127–3-128
suppress from OPAC, 2-41
System tab, 2-58
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unlinking from bibs, 3-135–3-136
variable field, 2-50
Verify Hypertext links, 2-25

holdings records
hypertext links, 2-57

hypertext links - authority records, 2-36
hypertext links - bibliographic records, 2-25
hypertext links - holdings records, 2-57

I

Image Server
creating bibliographic record, 3-28

Image Server link examples, 2-24
Importing records, 3-13–3-18
index selection

searching, 3-37, 3-68
Index Selection tab, 3-37
index selection tab, 3-68
Information about... section

Voyager Connection Options dialog box, 3-76
initialization file

limits.ini, 3-86
template.ini, D-5

Insert URL from Browser, 4-3
intended audience

of this document, xvii
Invalid records, 3-27
ISBN validation, 4-13, 11-8, 11-37
ISSN validation, 4-13, 11-8, 11-37
Item menu, 11-39
item note, 2-66
Item records

create, 3-8
description, 2-62–2-63
linking to other records, 3-133, 3-134, 3-136
resequencing, 3-131
retrieving, 3-130
statistical categories, 2-75–2-76
statuses, 2-69–2-73

Item Status field, 7-9

J

journal index searching, 3-45

K

keyword search
Boolean, 3-106
Free text, 3-106, 3-109
Holdings Boolean, 3-106, 3-111
results, 3-48, 3-50

keyword searching, 3-32, 3-65
Cataloging, 3-106

Keyword tab, 3-32, 3-65

L

Labels, spine and piece, 4-28
language search limit, 3-84, 3-87
[Language] stanza, 3-89
Leader

authority, 2-32–2-33
bibliographic, 2-6–2-8
holdings, 2-43–2-45

Leader control field
position 06, 3-93
position 07, 3-93

left-anchored search
results, 3-50

left-anchored searching, 3-37, 3-68, 3-113, 3-116
Limit button, 3-35, 3-40, 3-47, 3-99
limiting your search, 3-84

not allowed, 3-84
[Limits] stanza, 3-87
limits.ini file, 3-85, 3-86
Lines element, D-27
link text, 2-22
link text examples, 2-24
link-capable fields/subfields, 2-22
Linking records, 3-133, 3-134, 3-136

unlinking holdings from bibs, 3-135–3-136
links

DOI and URN link examples, 2-25
files on a server, 2-24
Image Server, 2-24
link text examples, 2-24
overview, 2-22
table of contents, 2-27
thumbnail images, 2-27
URL examples, 2-23
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location search limit, 3-84, 3-87
Locations

holdings, 3-132
Locations Filter, 3-69
Locations Filter List, 3-39
Logging in, 1-3
login information, 1-5

M

MARC Field Ordering Rule, 11-5, 11-38
MARC fields

in [Bibinitialization] stanza, D-16
in [BibMarcMapping] stanza, D-32

MARC leader field, D-14, D-31
MARC Record Derivation

derivation field, 5-8–5-17
example, 5-12–5-15
format, 5-8
multiple subfields, 5-11
non-matching subfield, 5-11
reading, 5-10–5-11
rule, 5-12–5-15

explanation, 5-8
overview, 5-8–5-11
using cataloging template, 5-8–5-17

example, 5-15–5-17
saving record, 5-17

MARC standards, 3-89
MARC tab, 2-4, 3-108, 3-110, 3-112, 3-117, 3-119

authority record, 2-31
holdings record, 2-41

MARC tag tables, A-1–A-23
MARC validation, 11-7
MARC21 Character set validation, 11-7
MARCTemplate directory, D-5
MARCTemplate folder, 5-20, 5-23
media search limit, 3-88
[Media] stanza, 3-96
Media Type field, 7-7
medium search limit, 3-84, 3-87
[Medium] stanza, 3-91
Menus

description of, 11-27
Display, 11-29, 11-39
Edit, 11-32
File, 11-28, 11-30
Help, 11-30, 11-41

Item, 11-39
Options, 11-29, 11-40
Related Records, 11-38
Window, 11-40

merge bibliographic records, 4-5
MFHD keyword index searching, 3-45
MFHD-Bibliographic Combined Keyword Search, 3-

102

N

narrower term, 3-63
[New Template] stanza, D-7
NOISEWORDFILTER, 3-36
[NonFiling] stanza, D-8
non-keyword searching

Cataloging, 3-113
Note additional references, 3-58, 3-61
Note dialog box, 2-66, 2-67
NoValue element, D-33

O

OCLC Control Number, 3-14
On-line shelf list, 3-39
OPAC

Table of Contents in, 2-27
Verify Hypertext links, 2-25

OPAC headings search, 3-38
OPAC, suppress from

bibliographic records, 2-4, 2-42
holdings records, 2-41

Opening
records, 3-9–3-10

option
authority

OK to export, 2-39
bibliographic

OK to export, 2-28
Suppress from OPAC, 2-4

holdings
OK to export, 2-59
Suppress from OPAC, 2-42

Options, 11-1
Options menu, 11-29, 11-40
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Other control property, D-25
Other element, D-26
overlay bibliographic records, 4-5
Overlaying and merging bibliographic records, 4-7

source record, 4-5
target record, 4-5

owning library, 4-4

P

Passwords, 1-3
percent sign (%), 3-34
Permanent Location field, 7-6
Permanent Type field, 7-7
photocopying

documentation, xx
pick and scan

using, 7-16
Piece labels, 4-28
place of publication search limit, 3-84, 3-87
[Place] stanza, 3-93
plus sign (+), 3-34
Preferences

Bib MARC Tag Colors tab, 11-24
cataloging options, 11-1
Colors/Fonts tab, 11-19
Folders/Files tab, 11-15
General tab, 11-2
Item Defaults tab, 11-13
Mapping tab, 11-17
Validation tab, 11-6
Work Flow tab, 11-10

Print Template stanza
action codes, 4-34
changing font size, 4-36
initiating and ending action codes, 4-34
inserting a blank line, 4-36
inserting a tab, 4-36
printing field information, 4-35
printing in the alternate font, 4-35

Printing
action codes, 4-34
alternate font, 4-35
field codes, 4-36
labels, 4-28
records, 4-20
spinelabel.cfg, 4-31
templates, 4-32, 4-38

publication status search limit, 3-84, 3-87
purpose

of this document, xvii

Q

question mark (?), 3-34
quick sort, 3-51
Quitting, 1-5

R

radio button
Boolean, 3-33
Browse, 3-38
Find, 3-38
Free Text, 3-33
Holdings Boolean, 3-33

RDA Toolkit, 11-26, 11-33
Record

authority, 2-31–2-36
bibliographic, 2-3–2-27, 4-2
closing, 4-44
colors of, 11-19
copying, 4-20
creating, 3-1–3-5, 3-8
deleting, 4-2–4-3
description of, 2-1
editing, 4-1–4-2
holdings, 2-41
importing, 3-13–3-18
invalid, 3-27
item, 2-62–2-63
linking, 3-133
opening, 3-9–3-10
printing, 4-20
retrieving

authority, 3-129
holdings, 3-127–3-128
item, 3-130

saving, 4-10
templates, 8-1–8-5, 11-16
types, 2-2
unlinking, 3-133
validate heading, 4-18
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validation, 9-1–9-2
record

creating with a default template, 5-24
creating with template, 5-24–5-26

Record menu
Overlaying Bibliographic Records, 4-8

record type
creating template, 5-5

Ref/Note additional references, 3-61
Reference additional references, 3-58, 3-61
Reference Information dialog box, 3-61, 3-62, 3-114
reissue

reason for, xvii
Related Record

source record, 5-2
Related Records

Cataloging module
saving, 5-17

Related Records menu, 11-38
Cataloging module, 5-1

example, 5-2
Relevance column

Titles Index, 3-50
Remote button, 3-35, 3-40, 3-47, 3-74, 3-76
remote databases

searching, 3-76
Remote Search dialog box, 3-77
remote searching, 3-74
Reorder Fields, 11-38
reproduction, of documentation, xx
Resequencing items, 3-131
re-sort, 3-51
re-sort configuration, 3-52
results

headings search, 3-60
holdings boolean search, 3-55, 3-56
keyword search, 3-48, 3-50
left-anchored search, 3-50

Retain Last Search, 3-83
Retain search limits between searches check box, 3-

101
retaining

search limits between searches, 3-86
retrieve bibliographic records

shortcut, 3-131
Retrieving

authority, 3-129
holdings, 3-127–3-128
item, 3-130

rule
for derivation field, 5-12–5-15

S

SameLine element, D-21
Save Settings button, 3-46
Saving

records, 4-10
to database, 4-12

saving
Related Records, 5-17

scope note, 3-62
Scroll element, D-28
search

holdings boolean results, 3-55
keyword results, 3-48
OPAC headings, 3-38
staff headings, 3-38

Search dialog box, 3-31, 3-44
Builder tab, 3-44
Index Selection tab, 3-37
Keyword tab, 3-32

Search for, 3-45
Search For field, 3-34, 3-39
Search In, 3-45
search limit

carrier, 3-88
content, 3-88
date, 3-84, 3-87
language, 3-84, 3-87
Limit Type column, 3-86
list of limits, 3-86
location, 3-84, 3-87
media, 3-88
medium, 3-84, 3-87
place of publication, 3-84, 3-87
publication status, 3-84, 3-87
setting, 3-99
type, 3-84, 3-87
Value, 3-86

search limits
stanza, 3-88

Search Limits dialog box, 3-69, 3-72, 3-73, 3-85, 3-
99

search preferences
setting, 3-83

Search Result Colors, 11-23
search results

headings, 3-60
holdings boolean, 3-56
keyword, 3-50
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left-anchored, 3-50
Search Status dialog box, 3-80
search type drop-down field, 3-38
searching

accessing search history, 3-73
authorities, 3-37
automatic truncation, 3-84
builder, 3-44, 3-70
Cataloging examples, 3-106
command, 3-35
command line, 3-35
defaults, 3-83
Display Bibliographic Record Directly If Search 

Results In Only One Title, 3-84
for item keyword search, 3-65
headings searches by call number, 3-42
headings/index selection, 3-37, 3-68
headings/non-keyword, 3-113
history tab, 3-48
iournal index, 3-45
keyword, 3-32, 3-65
left-anchored, 3-68, 3-113, 3-116
limits, 3-48, 3-84
MFHD keyword index, 3-45
remote databases, 3-74, 3-76
retain last search, 3-83
unable to limit, 3-84
URI option, 3-35, 3-40, 3-47, 3-82
with relevance, 3-33
without relevance, 3-33

[SearchURI] stanza, 3-83
Security

logging in, 1-3
see also, 3-63
Select Bibliographic Template

dialog box, 5-20, 5-21, 5-26
Select Directory

dialog box, 5-23
Select one or more authority records dialog box, 3-64
Selected Locations section

Voyager Connection Options dialog box, 3-76
self check

magnetic media, 2-68, 11-15
sensitize, 2-68, 11-15

Session Defaults and Preferences
Bib MARC Tag Colors tab, 11-24
Cataloging module, 5-17–5-24

Folders/Files tab, 5-17–5-24
Cataloging Options, 11-1
Colors/Fonts tab, 11-19
dialog box, 5-17, 5-18, 5-22

Folders/Files tab, 11-15
General tab, 11-2
Item Defaults tab, 11-13
Mapping tab, 11-17
Validation tab, 11-6
Work Flow tab, 11-10

Session Defaults and Preferences dialog box, 3-83
setting

search limits, 3-99
search preferences, 3-83

Show Results button, 3-80
Simultaneous Search dialog box, 3-78
sort by, 3-51
sorting

History tab
authority, 2-40
bibliographic, 2-30
holdings, 2-62

Source element, D-21
source record, 4-5

Related Record, 5-2
SPAC, 3-104
Special Character Entry, 6-1
Special Character Mode, 6-3
Special Character Mode mapping, 6-3
Special Characters.cfg, 6-7
Spine Label Print Template, 4-31
Spine labels, 4-28
spinelabel.cfg, 4-31
staff headings search, 3-38
stanza

[Print Options ...], 4-32
[Print Options Bibliographic], 4-31
[Print Template Piece ...], 4-33
[Print Template Piece Bibliographic], 4-31
[Print Template Spine ...], 4-33
[Print Template Spine Bibliographic], 4-31
[Templates], 4-32
[Bibinitialization], D-9, D-14
[BibMarcMapping], D-9, D-28
[Carrier], 3-97
[Content], 3-95
[Date], 3-90
[Edit Templates], D-7
[General], D-9, D-13
[Language], 3-89
[Limits], 3-87
[Media], 3-96
[Medium], 3-91
[New Template], D-7
[NonFiling], D-8
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[Place], 3-93
search limits, 3-88
[SearchURI], 3-83
[Status], 3-94
[Type], 3-92
Voyager.ini [Global Log], 3-52

Statistical Categories field, 7-9
Statistical categories for items, 2-75–2-76
status (publication) search limit, 3-84, 3-87
Status button, 3-81
[Status] stanza, 3-94
Statuses for items, 2-69–2-73
Stop button, 3-50, 3-56, 3-59
Stop Search button, 3-80
subfield

element in derivation field, 5-9
multiple

in derivation field, 5-11
non-matching

in derivation field, 5-11
System tab

authority record, 2-38
bibliographic record, 2-27
holdings record, 2-58

T

tab
Builder, 3-44, 3-70
History, 3-47, 3-73
Index Selection, 3-37
index selection, 3-68
Keyword, 3-32, 3-65
MARC, 3-108, 3-110, 3-112, 3-117, 3-119

table of contents links, 2-27
tag

element in derivation field, 5-9
Tag Tables folder, 5-20, 5-23
Tag tables, MARC, A-1–A-23
target record, 4-5
template, 5-4–5-8

creating, 5-5–5-6
default

authority, 5-4, 5-20, 5-23
bibliographic, 5-4, 5-20, 5-23
defining, 5-18–5-22
holdings, 5-4, 5-20, 5-23
using to create new record, 5-24

deleting, 5-7
editing, 5-6–5-7
Related Records

creating, 5-8–5-17
derivation field, 5-8–5-17
example, 5-15–5-17
explanation, 5-8
overview, 5-8–5-11
saving, 5-17

using to create new record, 5-24–5-26
template configuration files

in Templated Input, D-5, D-8
Template field, 5-25

Session Defaults and Preferences, Cataloging 
module, 5-23

Template folder, 5-20, 5-23
Template, Spine Label Printing, 4-31
template.ini file, D-5
Templated Input

combination box, D-20, D-21
creating records with, D-3
editing records, D-4
logging in, D-2
requirements, D-1
retrieving records, D-4
Select a MARC Template, D-3
setup in Voyager System Administration, D-2
template configuration files, D-5, D-8
text box, D-20, D-27
user IDs, D-1
using multiple control properties in single stanza, 

D-42
using other configuration files with, D-21
what is it?, D-1

Templates
creating, 8-2
default, 11-16
deleting, 8-5
description of, 8-1
editing, 8-4

Templates section
Folders/Files tab

Cataloging module, 5-20
Folders/Files tab, Cataloging module

bib field, 5-21
Temporary Location field, 7-6
Temporary Type field, 7-7
thumbnail images, 2-27
thumbnails, 2-24
Titles Index

Relevance column, 3-50
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sort by, 3-51
Titles Index button, 3-49
Titles Index dialog box, 3-48, 3-49, 3-66, 3-69, 3-72, 

3-80, 3-106, 3-107, 3-109, 3-113, 3-116, 3-118
truncation

searching, 3-84
Type column

Voyager Connection Options dialog box, 3-76
Type element, D-20
type search limit, 3-84, 3-87
[Type] stanza, 3-92

U

Unicode
BulkImport, C-8
cataloging templates, C-9
database conversion, C-4
diacritics, 6-1, C-3
font options, C-1
Leader position 9, C-2
MARC21 compliance considerations, C-3
message logs (database conversion), C-5
nc in the Title Bar, C-4
non-converted records, C-4
overview, C-1
Special Character Entry, 6-1
subfield character, C-9

Unicode character set, 3-50, 3-56, 3-60
Uniform Resource Identifier (URI), 3-35, 3-40, 3-47, 

3-82
Unlinking records, 3-135–3-136
Update, 4-11
update record alert, 4-11
URI, 2-22
URI search option, 3-35, 3-40, 3-47, 3-82, 3-83
URL, 2-22
URL examples, 2-23
URN, 2-22
user-defined alternate search button, 3-82
using

pick and scan, 7-16

V

Validating records, 9-1–9-2
Validation

Authority Control Validation, 11-7
ISBN, 4-13, 11-8, 11-37
ISSN, 4-13, 11-8, 11-37
MARC, 11-7
MARC21 Character set validation, 11-7

validation of bib heading, 4-18
Variable fields

505 field, 2-27
authority, 2-35–2-36
bibliographic, 2-16–2-27
font bold for, 11-24
holdings, 2-50

Verify Hypertext links, 2-25
view

holdings locations, 3-132
line items, 3-121

Voyager Connection Options dialog box, 3-75, 3-76
Available Locations section, 3-76
Connection column, 3-76
Database Name column, 3-76
Information about... section, 3-76
Selected Locations section, 3-76
Type column, 3-76

Voyager.ini
[Global Log] stanza, 3-52

voyager.ini file
URI search option, 3-83

W

Width element, D-20
wildcard characters, 3-34
Window menu, 11-40
Work files, 4-10
work space

Database Definitions, 3-74
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